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What is Userlane?
Last Modified on 19.01.2024

Userlane is a no-code Digital Adoption Platform (DAP) used by organizations to discover, understand, and
improve the value of their technology investments. By identifying and eliminating adoption barriers across
software applications, enterprises can deliver employees and customers a more engaging, rewarding, and
productive software experience while realizing the full value of their software investments. 

Our all-in-one solution
Discover:

Gain full visibility of your organization's technology stack with Userlane’s App Discovery. Track and reveal
which applications are used by employees across the organization quickly and easily by securely deploying our
Browser Extension without any need for interaction with end-users or any integrations. 

Reduce shadow IT,  uncover duplicate software and pinpoint areas for improved software adoption. 

Understand:

Understand value drivers by monitoring usage, identifying points of friction and understanding interaction
patterns with Userlane’s HEART analytics. 

It allows you to measure the success of digital transformation initiatives across your organization by tracking
user behavior across software applications.

Our Platform Reporting tracks the performance and engagement of your support content, so you can iterate
faster and drive further software adoption.

Improve:

Improve value realization by engaging users, driving software usage and increasing proficiency with Userlane’s
in-app Engagement Suite.

Our content creation engine enables you to create interactive step-by-step guides, tooltips and tags in your live
app within minutes. Instantly announce updates, start surveys and promote specific topics.

Who can use it

Userlane can be used by any organization that wants to:

Experience the value of their organizations’ technology investments

Improve employee productivity and efficiency when using digital tools



9

Facilitate web-based software rollouts or streamline training

Empower employees to learn better and faster

If you are new to Userlane and want to learn more about how we can support you in unlocking the full
potential of your software, see how our customers have seen success with Userlane:
www.userlane.com/success-stories 

Learn more

To help you get started, you can refer to our other Get Started help articles to learn more about our features. If
you want to speak with us about how Userlane can answer your needs, why not book a demo with one of our
product experts. We are always happy to help.

http://www.userlane.com/success-stories
https://www.userlane.com/book-demo/
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Requirements and Guidelines for
Developers
Last Modified on 29.09.2023

To ensure that Userlane will run smoothly on your application, follow these guidelines as much as possible. 

They are recommendations from our Userlane IT Team. Should you have any questions regarding any of those
points, do not hesitate to reach out to us.

Required
The underlying app needs to run with an encrypted protocol (HTTPS) to ensure a secure and encrypted
communication.

The underlying app does not use a plugin such as Adobe Flash or Microsoft Silverlight.

The underlying app does not register event callbacks in capture mode.

The underlying app does not remove DOM nodes that it does not recognize, especially DOM nodes
added by Userlane need to remain untouched.

The underlying app does not modify native browser functions, for example with polyfills or XHR
overrides.

The underlying app does not use framesets, or does not expect Userlane to highlight elements in a
frameset.

The maximum z-index of the underlying app does not exceed 1,000,000.

Ensure Userlane is allowed by your Content Security Policy. Find more details on it here.

If a firewall is active, it has to be set to allow communication to Userlane servers.

Every client needs access to the internet to communicate with Userlane’s services.

Third-party cookies must be enabled. Find more details on what cookies are stored.

Based on the chosen implementation the supported browsers differ. Find more details on it here.

Optional

Handover of relevant user data, e.g. permissions of the current user, to the Userlane JS Snippet API. This
allows you to show Guides more targeted to the end-users. Read more about this here. 

Do not use hover actions or make hover actions also accessible via click. When a hover menu closes on
mouseleave that can cause issues in highlighting the elements reliably for Userlane.

https://docs.userlane.com/docs/which-hosts-to-allow-in-your-content-security-policy-csp-for-userlane
https://docs.userlane.com/docs/userlanejs-cookies
https://docs.userlane.com/docs/implementation-options-snippet-or-browser-extension
https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
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Use relevant URLs that allow knowing what page the user is currently seeing. This helps you to show
Guides specific to the page the user is currently looking at.

If your application uses Cross-Origin iframes, please review this article here.

Include semantic identifiers to relevant elements. 
We recommend using data-automation-id, data-test-id, data-userlane-id, data-userlane-role, or data-
action-name attributes with semantic names (e.g. “createTutorialButton”, “deleteUserAction”). This helps
you to make Userlane more stable regarding any updates in the HTML code of the application.

https://docs.userlane.com/docs/cross-origin-iframe-support-in-userlane
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Userlane Support & Services
Overview
Last Modified on 12.01.2024

Userlane offers two different support packages - Standard and Priority: 

Support, SLA, Customer Success
Overview

Standard Priority

Standard Support

See below for additional details.
Includes 24x7 service availability
monitoring, online ticket support,
and unlimited included incidents.

Included Included

SLA and Priority Queue

Includes all Standard Support
features, as well as priority queue,
application uptime SLA, and support
response times SLA.

Not Included Included

Dedicated Customer Success
Manager

Userlane customers can receive ad
hoc Customer Success Management
services. 

Priority customers will receive an
individually assigned CSM and
additional services.

Not Included Included

The support packages differ concerning the included services:

Support Standard Priority

24x7 Service Uptime Monitoring Included Included
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Online Ticket Support Included Included

Email Support Included Included

1:1 Phone and Webmeeting
Assistance

Not Included Included

High-Priority Queue Not Included Included

Priority Support Response Time SLA
Not Included

Included

Support Standard Priority

Depending on the selected support package, the response times differ: 

Standard-level Support: 

For all support issues relating to Userlane Production Tenants, Userlane will make efforts to respond
promptly to all tickets submitted through Userlane’s designated support channel, in any event within two
(2) Business Days after receipt.

Priority-level Support: 

Userlane will provide the following technical support response commitment for all Production Tenants:
Response Commitment is the maximum time within which Userlane will respond (via Userlane’s Support
Channels) to each support issue reported by Customer during business hours.

Incident Level Response Commitment

Severity Level 0 (Service Unavailability)

Customer experiences complete loss of Service
 60 minutes

Severity Level 1 (Severe Issues)

Customer experiences a severe defect or configuration
issue with the Service that materially impacts
Customer’s business in a negative way relating to
issues that don’t qualify as Severity Level 0

 2 hours
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Severity Level 2 (Delayed Performance)

Customer experiences transactional and operational
slowness in the Service relating to issues that don’t
qualify as Severity Level 0 or 1

 8 hours

Severity Level 3 (Routine Requests)

Routine Service support requests relating to issues that
don’t qualify as Severity Level 0, 1 or 2.

 2 days

Incident Level Response Commitment
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Support Response Times SLA
Last Modified on 12.01.2024

Depending on the selected support package, the response times differ: 

1. Standard-level Support 

For all support issues relating to Userlane Production Tenants, Userlane will make efforts to respond promptly
to all tickets submitted through Userlane’s designated support channel, in any event within two (2) Business
Days after receipt.

2. Priority-level Support

Userlane will provide the following technical support response commitment for all Production Tenants:
Response Commitment is the maximum time within which Userlane will respond (via Userlane’s Support
Channels) to each support issue reported by the customer during business hours.

Incident Levels and Response Times

Incident Level Response Commitment

Severity Level 0 (Service Unavailability)

Customer experiences complete loss of Service

Sixty (60) minutes

Severity Level 1 (Severe Issues)

Customer experiences a severe defect or configuration issue with the Service
that materially impacts Customer’s business in a negative way relating to issues
that don’t qualify as Severity Level 0.

Two (2) hours

Severity Level 2 (Delayed Performance)

Customer experiences transactional and operational slowness in the Service
relating to issues that don’t qualify as Severity Level 0 or 1.

Eight (8) hours

Severity Level 3 (Routine Requests)

Routine Service support requests relating to issues that don’t qualify as Severity
Level 0, 1 or 2.

Two (2) days

3. Remedies for Breach of Response Time Commitments

If Userlane fails to meet the response time commitments above, the customer’s exclusive remedy and
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Userlane’s sole obligation will be: (a) for Userlane to make efforts to respond promptly after the customer
notifies Userlane that it failed to meet the relevant response time commitment; and (b) if Userlane fails to meet
the relevant response time commitments three (3) times during a calendar quarter, for Customer to terminate
the applicable Order Form and receive a refund, on a pro-rata basis, of any Fees paid for the Production
Tenant(s) that are unused as of the termination effective date.

4. Customer Duties

Issues regarding customization or regarding the functionality of specific guides may require the customer to
complete a network assessment, and/or give Userlane access to the Customer’s network, in order to diagnose
the issue.
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Application Uptime
Last Modified on 12.01.2024

 � Userlane's availability is guaranteed to exceed 99.5%. We regularly achieve higher uptime and the live
status as well as historic data can be viewed on Userlane's Status page.

Uptime Commitment

The Quarterly Uptime Percentage for the Service will be ninety-nine and fifty percent (99.5%) (the “Uptime
Commitment”). Subject to the exclusions below, “Quarterly Uptime Percentage” is calculated by subtracting
from 100% the percentage of 1-minute periods during any quarterly billing cycle (i.e., 3 calendar months) in
which the Customer’s Production Tenant(s) is(are) unavailable out of the total number of minutes in that
quarterly billing cycle. 

“Unavailable” and “Unavailability” mean that, in any 1-minute period, all connection requests received by the
Customer’s Production Tenant(s) failed to process (each a “Failed Connection”); provided, however, that no
Failed Connection will be counted as a part of more than one such 1-minute period (e.g. a Failed Connection
will not be counted for the period 12:00:00-12:00:59 and the period 12:00:30-12:01:29). 

The Quarterly Uptime Percentage will be measured based on the industry standard monitoring tools Userlane
uses. 

Exclusions from Quarterly Uptime Percentage 

Notwithstanding anything to the contrary in this exhibit, any Service Unavailability issues resulting from any of
the following will be excluded from the calculation of Quarterly Uptime Percentage: 

1. regularly scheduled maintenance of the Service that does not exceed six (6) hours per 3-month period
and is communicated by Userlane at least twenty-four (24) hours in advance via Userlane’s Normal
Support Channels. 

2. any failures of the Userlane Standard and Custom Reporting Services 
3. any problems not caused by Userlane that result from (a) computing or networking hardware, (b) other

equipment or software under the Customer’s control, (c) the Internet, or (d) other issues with electronic
communications; 

4. Userlane’s suspension or termination of the Service in accordance with the Agreement and/or its
associated Order Form; 

5. software that has been subject to unauthorized modification by Customer; 2.6. negligent or intentional
misuse of the Service by Customer; or 

6. “Beta” or “limited availability” products, features, and functions are identified as such by Userlane.

https://status.userlane.com/
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Scope of Userlane Support &
Success Services
Last Modified on 12.01.2024

Discover Userlane's extensive range of consulting and professional services, covering improvement sessions,
quarterly reviews, onboarding, API integration, guide-building, and more based on the package chosen.

Consulting & Professional Services Standard Priority

Consulting Session

1x per 2 months 30-minute sessions
on improving Guides

Included Included

Priority Improvement Sessions

2x per month 30-minute
improvement sessions about best
practices & storyboard structure

Not Included Included

Quarterly business reviews

Quarterly web meetings discussing
goals, analytics and next steps
towards success

Not Included Included

Bi-monthly Onboarding & Training
Session Extra 60 min web training
session for new editor users every
two months

Not Included Included

API & Advanced Integration
Sessions Consulting on how to
modify sample code to meet specific
use cases

Self - Service / Additional Fees
apply

Self - Service / Additional Fees
apply
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Guide-Building Services

Remote Guide-Building Services by
our UX-Consulting Team

Self - Service / Additional Fees
apply

Self - Service / Additional Fees
apply

Onsite Guide-Building Workshop

Onsite (EU)

Topics: How to build effective
Userlanes

Self - Service / Additional Fees
apply

Self - Service / Additional Fees
apply

Onsite Consulting Workshop

Onsite (EU)

Topics: How to build a storyboard,
structure chapters and Userlanes
and add learning effects

Self - Service / Additional Fees
apply

Self - Service / Additional Fees
apply

Consulting & Professional Services Standard Priority

For tracking support requests and new development requests, Userlane offers the following: 

Feature Request & Issue Tracking Standard Priority
General feature / functionality
information & feedback

Included Included

Provide updates on the status of any
previously filed feature request or
issue/bug

Included Included

Submission of issues/bugs into the
Engineering tracking system

Included Included

Submission of feature requests into
the Product Management tracking
system

Included Included

Prioritized feature development
requests

Not Included Included

Individual new feature demos with
Q&A session and implementation
guidance

Not Included Included
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Reporting & Analytics Standard Priority

Key analytics available in the
Dashboard

Included Included

Custom Report 

Monthly reporting based in PDF
format

Not Included
Self - Service / Additional Fees
apply

Data Export 

Exporting usage data and reports in
a custom format

Not Included
Self - Service / Additional Fees
apply
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Userlane Portal
Last Modified on 12.01.2024

The Userlane Portal is the browser component of the Userlane solution. It includes your account settings and
everything else you need to manage, customize, and organize your content. The features available are
dependent on your user role.

HEART

HEART tells you if users are using software to its full potential and in return maximizing the value that
software was designed to bring. With the HEART framework, we are providing you with an effective way to
learn more about digital adoption insights.

Content Analytics

Evaluate how different users interact with your support content, and get live engagement insights on your in-
app notifications, Guides, and Tooltips and find content that needs optimization easily.

Guides

Here you can manage, organize, and customize your Guides. 

Messages

Messages are shown to your users through Assistant’s pop-ups. There are 3 types of Messages you can send
to your users. 

Announcements are used to share news and information, you can monitor their performance in content
analytics. 

Standard Surveys allow you to ask your users any type of question. 

An NPS Survey is a method of collecting application feedback with a dedicated way of calculating the score.

Segments

Here you can define user and page segments. User segments allow you to target content to specific user
groups using a range of attribute options. Page segments allow you to define the web pages on which your
Guides and Announcements are available to users.

Customize

On the Customize tab you can define general settings for your Userlane Assistant and content. Learn more
about the customization options in the following articles:

1. Assistant: Define the behaviour of your Assistant
2. Guides: Define the behavior of your Guides
3. Search: Ensure what content your users can find

https://userlane-bacb488bc4c8.intercom-attachments.com/i/o/130655905/25eb7693d7a8ee52a60fe0ec/HS4wv_mSVt7D386b1L8sefmRUKeQMg5-8zP8tT4ToCG3oBEI_p36xXFQ12B7n6TnEFsbAtj9Pad5RW6I6fhRu6iaoBYuXhBwc6datZ9Lvw2DCl5A-G25XgPf4HyKKMwyO5PpJ5ZQ
https://docs.userlane.com/docs/create-and-activate-announcements
https://docs.userlane.com/docs/survey
https://docs.userlane.com/docs/nps
https://docs.userlane.com/docs/user-segmentation
https://docs.userlane.com/docs/page-segmentation
https://userlane-bacb488bc4c8.intercom-attachments.com/i/o/130655908/b53de1da532e2ab73b5264a9/iD74bxOuCyryIIfAASBsdjf7CcrRklE3k6b9kD_x_g70fNQoC7HNahVP4zpLGO_QYV-fme9DyeRsuigi_5zvaLCJht97tQZbFDARKWM9Fp9TMN5FWkuRTaoPiOWm-IjQOzYGp0lj
https://docs.userlane.com/docs/what-is-the-userlane-assistant
https://docs.userlane.com/docs/define-the-behavior-of-your-guides
https://docs.userlane.com/docs/search-through-the-userlane-assistant
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4. Help: Embed additional resources
5. Languages: Add and manage multiple languages
6. Texts: Customize button and slide texts
7. Design: Customize colors and design
8. Welcome Slide

Settings

It provides access to the following features:

Global Settings: 

Applications: add and change your application's name and URL
Implementation Options

Snippet
SSO
Browser Extension

Integrations: create and manage connections with a knowledge base or collaboration tool
Team: invite users to your Team
User: add and invite users to Userlane (Admins only)
Attributes: create custom attributes
File Transfers: view a history log of account processes, e.g. user and text import/exports

Personal Profile: 

Login: view and edit your Userlane credentials
Notifications: receive email alerts when a Guide breaks
API Token: generate a new access token to use for authentication

Access the Userlane Editor

The Open Application button brings you directly to your underlying application and the Userlane Editor.

https://docs.userlane.com/docs/what-is-the-userlane-assistant
https://docs.userlane.com/docs/add-and-manage-multiple-languages
https://docs.userlane.com/docs/customize-button-and-the-slide-text
https://docs.userlane.com/docs/customize-colors-and-designs
https://docs.userlane.com/docs/welcome-your-users-with-the-welcome-slide
https://docs.userlane.com/docs/set-up-your-application-url
https://docs.userlane.com/docs/implement-the-userlane-snippet
https://docs.userlane.com/docs/sso-implementation
https://docs.userlane.com/docs/central-browser-extension
https://docs.userlane.com/docs/userlane-integrations-userlane-integrations
https://docs.userlane.com/docs/user-roles
https://docs.userlane.com/docs/importing-users-for-a-browser-extension-rollout
https://docs.userlane.com/docs/user-segmentation
https://docs.userlane.com/docs/editor-overview
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Set up your Account
Last Modified on 16.10.2023

1. Get Account Access

If your company already has an account with Userlane, please reach out to your colleagues to get invited to the
team.

Should your company not have an account with us yet, book a demo and get started.

2. Invitation Email

You will then receive an invitation email.

You have not received this email yet but know it was requested? Please check your spam folder and ensure
mails from userlane.com are not blocked.

3. Get Started

Click on "Get Started", you will be redirected to Userlane and can fill in your details.

Please note that

your name and email address will be visible to the whole team that is working on the Userlane account
no information is visible to end-users

https://www.userlane.com/book-demo/
https://userlane.com
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4. Password

Follow these requirements to set up your password: 

Password must be at least 10 character long
Password must include at least 1 uppercase letter
Password must include at least 1 lowercase letter
Password must include at least 1 number
Password must include at least 1 of the following special characters: !@#$%^&*-

5. Set up your Application URL

The Application URLs is a list of all URLs Userlane should be related to.

For more information, see here.

https://docs.userlane.com/docs/set-up-your-application-url
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Set up your application URL
Last Modified on 02.02.2024

What it is

The Application URLs is a list of all allowed domains or URLs Userlane should be related to.

Why use it

You need to add Application URLs if you want to

be connected to the Userlane Editor
track HEART analytics for the URL
have the Userlane Browser Extension activated for your Application

Number of Application URLs

The number of Application URLs you can set up is based on your contract. Should you reach your limit of
allowed domains, please contact your Customer Success Manager.

Requirements

Please make sure the default URL is complete (i.e. the link can be found) and starts with https. 

Optional: Wildcards

You can also add URLs containing wildcards. Userlane will then run on all web pages that match this pattern
(e.g. *.google.com accepts test.google.com or instance.google.com).

How to set it up

The URL of your application should be set in the Userlane Portal.

First Setup

After Creation of the Account, you will be prompted to add an Application URL

when creating your Userlane Account
if no Application URL was set before, when first time clicking Open Editor 
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Adding or Changing Application URLs

In the Portal, select Settings from the Application dropdown, then select Application URLs in the left sidebar.

Set up a Default URL

Within the Application URLs you can set one Default. 

The Default Application URL will automatically be opened when you click the "Open Application" button in
the Guide section or for redirecting your users when they start a Guide with a link.

A Default Application URL can not be a wildcard.

ℹ️  If you trigger a Guide via a link, users will be redirected to the default URL. If you would like to redirect
your users to different URLs, check out our Share Guides directly with a link article.

Implementation Difference
Browser Extension Snippet

Userlane will only show up for URLs that have been
added as Application URLs.
The Editor will not show for wildcard URLs.
Assistant will show for manager after inviting oneself
as end-user when using wildcard URLs.

Userlane will also show up if your URL has the snippet
implemented but the Application URL has not been
added.
However, you will not be able to 

see the Userlane Editor
track HEART analytics

Application URLs with HEART

The Userlane HEART Analytics, if activated, will work on the URLs added as Application URLs. 

If you have many subdomains for your application, by adding a wildcard, you will instruct HEART to be active
on any of them. 

Example: Instead of adding us.app.com, eu.app.com, etc., you can just add a wildcard: *.app.com and it will

https://userlane-knowledge-center.knowledgeowl.com/docs/share-guides-directly-with-a-link
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activate HEART  for any URLs ending in app.com .

For more details about managing HEART, like activating URL exceptions, please check this article. 

How to disable a URL

To disable an application URL, go to Settings > Application URLs and disable the toggle for the specific
application. 

ℹ️  Disabling a URL applies only when Userlane has been implemented using the browser extension. If you
have implemented Userlane via the JavaScript snippet, your Userlane content will still be accessible to
your users.

How to delete an Application URL

If an Application URL is no longer needed, you can remove it by deleting it.

https://docs.userlane.com/docs/analytics-privacy-settings
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Userlane Editor
Last Modified on 04.03.2024

What it is

The Userlane Editor is a powerful tool for creating interactive Guides, Tooltips, and Tags within applications,
enhancing user experiences and facilitating content creation and editing.

How to open the Editor

1. Implement Userlane. Check out this article to learn about our implementation options. 

2. For enabling Editor you need to add an underlying Application within the Portal. Sign into Portal
family.userlane.com > Click on the Application Dropdown button > Settings > Application URLs > + Add
Application URL.

3. Check out this article on how to access Editor 

What to create with Editor

In Userlane Editor you can create the content that needs to be created directly on your Application and needs
interaction with your Application's elements. You can create Guides that are interactive step-by-step processes
or Guides within the application or Tooltips that are ways to add explanations to an element within the
application for your users. 

How to record Guides 
How to record Tooltips
How to record Tags

More options when using Editor

There are some extra functionalities added to the Editor to make your Editing experience smoother. There is a
sidebar that includes 4 options: 

1. Userlane icon brings you back to the Portal 
2. Guide icon to see all your existing Guides
3. Tooltip icon to see all your existing Tooltips
4. Tags icon to see all your existing Tags

https://docs.userlane.com/docs/implementation-options-snippet-or-browser-extension
http://family.userlane.com/
https://docs.userlane.com/docs/access-to-the-userlane-editor
https://docs.userlane.com/docs/record-a-guide
https://docs.userlane.com/docs/create-tooltips
https://docs.userlane.com/docs/tags
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On the top, you can see a search bar there quickly you can search for any Guide, Chapter, Tooltip or Tag. 

You can close the Editor by clicking on the x icon in the top right corner or if you do not need to exit the
Editor you can minimize the Editor by clicking on the two arrows icon next to the x icon. When the Editor is
minimized you will see this on your application: 

and you will be able to use your application without the need to record or edit anything. 

As well, while the Editor is minimized you can click on the arrow to move it up and down the minimized Editor
in case you need to work on this area of the application. When you require to go back to the editing mode just
click on the purple two arrows icon and that would open the Editor again and you can keep recording or
editing. 
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Userlane Assistant
Last Modified on 23.02.2024

What it is

The Userlane Assistant is your users' main navigation tool for your content, providing access to all of your
Guides and Messages. 

When the Assistant is enabled for your users, an avatar is displayed in your application providing direct access
to the Assistant menu:

Guides
Messages
Search
Help

ℹ️  This navigation is not available if passive mode was activated for your account.

What it looks like

How to set it up
Enable relevant menu options
Customize the Assistant Look
Assistant Position
General Settings

 

Enable relevant menu options

Menu Option Functionality

 
Guides 

organize your Guides into chapters
structure your chapters
use segmentation to define who sees what where

Messages

communicate updates, share links, share Guides
share surveys

https://docs.userlane.com/docs/hide-userlane-on-specific-pages-of-your-application
https://app.knowledgeowl.com/#EnableOptions
https://app.knowledgeowl.com/#CustomizeElement
https://app.knowledgeowl.com/#AssistantPosition
https://app.knowledgeowl.com/#GeneralSettings
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Search

enable search to find Guides and Announcements quicker
set up an integration to have additional resources connected, so users do not
have to leave your application

Help

link users to additional resources such as a help center, support chat, or a
communication platform channel such as Slack or MS Teams

Menu Option Functionality

You can set this all up under Customize.  

Customize the Assistant Look

You can adjust

the avatar image
the default colours
the default texts
the Help image

You can change the design under Customize > Design.

ℹ️ View our Working with images article to learn more about image file recommendations.

 

Assistant Position 

Fixed Position

You can customize the Avatar to show it in any corner of your application. 

Choose the position that fits the underlying application best and doesn't hide anything.

You can change the position under Customize > Assistant.

Movable Avatar

Sometimes the Assistant avatar gets in the way of important UI elements. Thus, we also offer the option to
have a movable avatar.

https://docs.userlane.com/docs/working-with-images-in-userlane
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You can turn on the movable avatar under Customize > Assistant.

Users can move it by hovering over the Assistant avatar, click-hold, then dragging and dropping it from
any of the six suggested spots. 
The avatar position will remain in the selected position until the user drags it into another one, or until the
feature is turned off.

⚠️ Limitations

If the underlying app has event listeners in place that target drag events, the event listener may block
the avatar mobility from working.
If the Avatar Reposition toggle is turned off under Customize > Assistant, then the assistant will
return for all users to the default position specified in the Portal.
If a user has enabled cookies to be deleted after each session, the assistant will go back to the
default position specified in the Portal.

 

General Settings

The following options are available on your application's Settings page in the Portal to customize the Avatar
behaviour.

Switch on the entire product for your end users

Settings > General > Switch Userlane on/off

With this setting, you can deactivate Userlane Content for your end users. You will still be able to use the
Editor.

Hide Userlane for your end users who signed up prior to this date (and time)

Settings > General > Hide Userlane from users who signed up after a specified time
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If you specify a date and time here, only end users who signed up for your service after this date and time will
be able to see your Guides. This requires some changes in your code snippet. Read this article to learn about
the required changes in the snippet.

Hide Userlane on screens smaller than a specific size

Settings > General > Hide Userlane on screens smaller than a specified size

You can define the minimum width of screens in px. The recommended size for a mobile screen is 769px. On
screens smaller than this width Userlane will not be available for your users. When left blank Userlane will be
shown on all screen sizes.

Target specific application areas

Settings > General > Target specific application areas

Specify where Userlane Suite content should be available in your application. Your users will see it in the areas
indicated in the segment. Check this article to learn more about Page Segments and this article to explore User
Segments.

https://docs.userlane.com/docs/implement-the-userlane-snippet
https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/user-segmentation
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Manage your Team
Last Modified on 27.02.2024

What it is

Under your Team settings you can

invite other team members to help you create, edit, and manage your Userlane content 
update existing ones
check out your current team
enable 2-factor authentication
set up and enable single sign-on for Managers

Why use it

By utilizing the team settings and user roles described in this article, you can streamline collaboration and
enhance productivity within your Userlane environment. With the ability to customize permissions and roles,
you can maintain control over access levels, optimize workflows, and effectively manage your Userlane
content.

ℹ️ Important

Only Admins can invite team members.
The Team Members are not visible to your end-users.
If a limit for your team is reached, reach out to your Customer Success Manager.

Overview of User Roles

Thanks to the three different user roles you will have control over what they will be able to do:

https://docs.userlane.com/docs/2-factor-authentication
https://docs.userlane.com/docs/single-sign-on-for-managers
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Admin: Has full edit rights anywhere and can manage and invite other team members. 

Moderator: The following table shows in detail how the rights of the moderator differ at the company and
application level.

Permissions
Moderator with access to all
applications

Moderator with restricted access to
individual applications

Global setting

Activate integrations (Attention:
only admins can set up integrations
in Userlane, but then they can be
activated individually per
application, see application settings)

no no

View team members
yes yes

Add or edit team members no no

Edit company user profiles for
browser extension, e.g. delete 

no no
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Apply company user profiles for
browser extension in application,
e.g. segments

yes yes

View file transfers yes yes

Application settings

Configure Corporate Identity and
User Interface 

yes      yes for relevant applications

Customize offered content yes      yes for relevant applications

Activate
integrations

yes      yes for relevant applications

Languages & Translations yes      yes for relevant applications

Manage
content

Create content yes yes for relevant applications

Publish content yes yes for relevant applications

Take screenshots in Editor yes
yes for relevant applications

Auto translate yes yes for relevant applications

Analytics 

View Userlane analytics yes yes for relevant applications

Viewing application-related HEART
analytics

yes yes for relevant applications

Troubleshooting notifications yes yes for relevant applications
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Personal profile

Profile & Security Settings yes yes

Contributor: The following table shows in detail how the rights of the contributor differ at the company and
application level.

Please note the view of a Contributor is limited. They do not see the Segments and Customize. 

Permissions
Contributor with access to all
applications 

Contributor with restricted access
to individual applications 

Global settings

View team members yes yes

Manage
content

Create content yes yes for relevant applications

Publish content no no

Take screenshots in Editor no no

Auto translate yes
yes for relevant applications

Analytics

View Userlane analytics yes yes for relevant applications
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Viewing application-related HEART
analytics

no no

Troubleshooting notifications no no

Personal profile

Profile & Security Settings yes yes
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Configure 2-Factor Authentication
(2FA)
Last Modified on 27.11.2023

What it is

2-Factor Authentication (2FA) is an additional security layer in the login flow for Userlane Manager Users.
Once enabled, Managers will be prompted to configure 2FA with their Authenticator App of choice. 

They will then need to enter an authentication code after providing their username and password to access the
Userlane Portal.

Why use 2FA

There are 3 commonly accepted Authentication Factors:

1. Knowledge: Something you know, like a password.

2. Possession: Something you have, like a smartphone with an authenticator app.

3. Inherent: Something you are, like your fingerprint or faceID.

2-Factor Authentication requires the use of two of the above three authentication factors for login. At
Userlane, the two authentication factors needed are Knowledge (your password associated with your email
address) and Possession (the Authentication Code generated by your authenticator app).

Userlane 2FA supports the use of the following 3 authenticator apps:

Microsoft Authenticator
Google Authenticator
FreeOTP

How to Enable 2FA

On the Team Management page in the Userlane Portal, Managers with the Admin Role will see the option to
enable 2FA for all Team Members in their Userlane company.

After clicking ‘Enable Authentication’, Admins will be asked to confirm that they want 2FA enabled for their
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Team Members.

How to Set Up 2FA

Once enabled, all Team Members in that company will be prompted to set up 2FA during their next log-in to
the Userlane Portal. After entering their username and password they will be prompted with:

Userlane Managers will then need to configure 2FA with their preferred authenticator app by scanning the QR
code with their app or manually entering the alphanumeric code. They will then be prompted to enter their
authentication code in order to complete the login process. 

Note: if you accidentally enter the code incorrectly when setting up 2FA, you will be prompted to scan the QR
code again in order to generate a new authentication code for set up.

Once enabled and configured, managers will be prompted to enter their authentication code every time they
log in to the Userlane Portal as shown below. 
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Disabling and Resetting 2FA

Admin Users can also disable 2FA for all Team Members in their organization or reset the 2FA configuration
process for individual team members, for example, in case a User has lost the phone they used to configure
2FA with an Authenticator App. These settings can also be found on the Team Management page.
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Single Sign-On for the Userlane
Portal
Last Modified on 02.05.2024

What is it?

Single Sign-On (SSO) allows users to authenticate with multiple applications using just one set of credentials.
In the context of Userlane, we have two separate SSO configurations:

Single Sign-On for Managers concerns access to the Userlane Portal, where Managers can add new
applications to Userlane, view HEART and content analytics data, as well as manage Userlane content
and customize their Userlane application. 
Single Sign-On for End Users authenticates users to see and interact with the Userlane Assistant as well
as contribute to HEART data. To set up SSO for End Users please read on here.

Why use SSO for Managers?

SSO is a secure way to authenticate Userlane Managers that offers two key benefits once enabled:

Central User Management: With SSO enabled, IT Admins can centrally manage who has access to the
Userlane Portal. For example, if a user leaves the company, their access can be centrally disabled in the
company's Identity Provider and Access Management tool.
Increased Security: SSO also increases security to business-critical data such as that found in the
Userlane Portal. By authenticating with one set of credentials, the risk of compromised passwords leading
to data breaches is heavily reduced.

 How to set up & enable SSO for Managers

On the Team Management page in the Userlane Portal, Managers with the Admin Role will see the option to
enable SSO for all Team Members in their Userlane company.

After clicking 'Set Up Single Sign-On', Admins will be directed to a new page to complete the set up and
enable SSO. As shown below, there are 3 steps to setting up and enabling SSO for Managers.

https://docs.userlane.com/docs/sso-implementation
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Step 1

To configure SSO, you must first add Userlane as a trusted application to your Identity Provider (IdP). In this
step, you are provided with the metadata needed to do so. You can access that metadata either as a link or by
downloading it as an xml file. Please pass it along to your IT team who can add Userlane as a trusted
application.

Helpful links from common Identity Providers:

Microsoft Entra ID
Add an Enterprise Application
Enable Single Sign-On with SAML

ℹ️ If you plan on triggering Userlane from the Microsoft MyApps Portal, make sure you add
https://family.userlane.com as the Sign-On URL in the Entra ID configuration. 

Google Workspace
Set up your own custom SAML App

OneLogin
SAML Custom Connector (Advanced)

ℹ️ For OneLoginensure that: (1) the Recipient field is filled with the EntityID URL; (2) the Login URL is filled
with https://family.userlane.com; and (3) the SAML Initiator setting needs to be changed to 'Service
Provider'

https://learn.microsoft.com/en-us/entra/identity/enterprise-apps/add-application-portal
https://learn.microsoft.com/en-us/entra/identity/enterprise-apps/add-application-portal-setup-sso
https://learn.microsoft.com/en-us/entra/identity/enterprise-apps/add-application-portal-setup-sso
https://support.microsoft.com/en-us/account-billing/sign-in-and-start-apps-from-the-my-apps-portal-2f3b1bae-0e5a-4a86-a33e-876fbd2a4510
https://family.userlane.com
https://support.google.com/a/answer/6087519?hl=en&sjid=11866459409429088439-EU#zippy=
https://support.onelogin.com/kb/4266907/saml-custom-connector-advanced
https://family.userlane.com
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Microsoft ADFS
Create a Relying Party Trust
For AD FS, you must add a claim Rule to your configuration. Please refer to this article on how to do
so.

Step 2

In step 2, you need to add the metadata from your own Identity Provider in Userlane to establish the SSO
connection. There are two ways to do so:

If you received the metadata from your IT team in the form of an xml file, you can simply click 'Upload IDP
Metadata' and select the MetaData.xml file from your file explorer. This will auto-fill the form fields for
you with the right information.
You can also enter the metadata information manually into the form. Or edit the information as needed, for
example, if you need to update a SAML certificate.

After the metadata has been entered, be sure to save your configuration. Upon saving, the metadata you
entered will be saved in the Userlane Portal but SSO will not be enabled.

Step 3

In step 3 you can enable SSO for Managers when you are ready. Once enabled, the SSO login flow will be
activated for your Userlane Team. All users will be required to authenticate with Userlane via SSO, except for
those who have been marked as being able to 'Bypass SSO'.

Bypass SSO

Admins can determine if any of their Userlane Team Members should be able to bypass SSO and still log in to
the Userlane Portal with their email and password. For new users, you can activate this setting when inviting
them to Userlane for the first time.

https://learn.microsoft.com/en-us/windows-server/identity/ad-fs/operations/create-a-relying-party-trust
https://docs.userlane.com/docs/portalsso-transform-userprincipalname-to-nameid
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For existing users, if you would like to activate the bypass SSO setting, simply edit their permissions by clicking
on the 3 dots next to their user entry and open the permissions window.

By default, this setting is active and cannot be deactivated for Admins!

Why would I activate bypass SSO?

There are two primary use cases for which the bypass SSO setting is used:

In the event that the SSO connection does not work, it is necessary that at least one Manager can access
the Userlane Portal in order to update or deactivate SSO and allow other Managers to access the Portal.

As SAML certificates often need to be updated, it can happen that the SSO configuration has
expired and needs to be updated with a new certificate from your identity provider.
This is why Admins have bypass SSO activated by default.

If your company works with any external contractors or consultants to manage Userlane, it is possible
that these users are not managed in your identity provider, meaning that SSO will not work for them. To
ensure that they can still access the Userlane Portal, we recommend that bypass SSO is activated for
them.

Modify or Disable SSO

Once SSO for Managers is enabled, Admins can easily and quickly Modify the SSO configuration from the Team
Management page.
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Upon clicking 'Modify Single Sign, Admins are brought to the configuration page where they can:

Edit the existing configuration
Delete the existing configuration
Disable SSO using the toggle at the bottom of the page

Deleting the configuration will permanently remove the IdP metadata from Userlane!
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Portal SSO: Transform
UserPrincipalName to NameID
Last Modified on 03.05.2024

To successfully configure Single Sign-On (SSO) to the Userlane Portal using Microsoft ADFS as your Identity
Provider (IdP), you must add a Rule to the Claim Issuance Policy of the Relying Party Trust you created for
Userlane. 

To do so, follow the steps outlined and shown below:

1. Go to the Control Panel > All Control Panel Items > Administrative Tools and open the AD FS
Management

2. On the left column, select Relying Party Trust, select your Userlane configuration and click on Edit Claim
Issuance Policy on the right column.

3. In the new window, click on Add Rule
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4. Then select Transform as Incoming Claim from the dropdown and click on Next
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5. In the next screen complete the following form and press OK:
1. Claim rule name: Transform UserPrincipalName to NameID
2. Incoming claim type: UPN
3. Outgoing claim type: Name ID
4. Outgoing name ID format: Email
5.  Select “Pass through all claims”
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Implementation Options Overview
Last Modified on 17.01.2025

This article outlines the different possibilities that exist to implement Userlane into your IT landscape or a
specific application.

Userlane Browser Extension

Why use it

Implementing Userlane through the Userlane Browser Extension represents a scalable and secure way of
making content available to a large audience while benefitting from Userlane’s Analytics features. No access
to the source code of the underlying application is required.

There are two different scenarios when choosing the Browser Extension as your preferred implementation
option:

Seamless Rollout

Why use it

The roll out of the Userlane Browser Extension including automatic user authentication via Single Sign On
(SSO) ensures that Userlane is silently and seamlessly rolled out to all end users, so that no additional manual
action is needed to easily access content. By choosing this implementation method, Userlane is easily scalable
within your organization. SSO is a secure way to authenticate your users and additionally allows to add user
attributes for more sophisticated targeting and greater insights into analytics. 

This implementation option is recommended for a full-scale roll out to all end users.

Requirements

Configuration of SSO
Central rollout of the Userlane Browser Extension
Firefox: 109 and above, Chrome: 88 and above, Edge: 88 and above.

Manual User Invitation via Email

Why use it

If a seamless central rollout of the Browser Extension is not an option, it is possible to upload a specific
amount of users manually to the Userlane Portal. This will trigger an invitation email and the users will be
required to follow an installation process for the Browser Extension individually.

The manual user invitation process is recommended for small user groups and testing purposes, not for full-
scale roll outs.
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Requirement

Firefox: 109 and above, Chrome: 88 and above, Edge: 88 and above.

Userlane Snippet

Why use it

If you have access to the application’s source code, the Userlane snippet can be inserted. Userlane will be
loaded and accessible as soon as the application is opened by the end user independently from the browser.

�Good to know

The manually installed browser extension can still be used in the early stages to build and test your first
Guides. Userlane will be shown in the application independent of the browser. Check this article to see
how to import users to use the browser extension for testing.

Requirements

Ability to deploy custom JavaScript in the application 
The application only works with one domain
Edge: 79 and above, Firefox: 60 and above, Chrome: 70 and above,  Safari: 12 and above.

⚠️ Please note that App Discovery does not work for a Snippet implementation.

https://docs.userlane.com/docs/email-invitation-based-browser-extension-rollout
https://docs.userlane.com/docs/app-discovery
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Adding hosts to your Content-
Security-Policy (CSP) for Userlane
Last Modified on 13.11.2023

About Content Security Policies (CSP)

A Content Security Policy (CSP) is a security mechanism implemented by web applications to mitigate the risk
of various types of attacks.

It allows to define a set of policies that specify which sources of content, such as scripts, stylesheets, images,
and fonts, are allowed to be loaded and executed within their web application.  By restricting the origins of
content, CSP helps prevent the execution of malicious scripts or the loading of unauthorized resources, thereby
enhancing the overall security of the application.

If you are using Content Security Policies (CSP) to protect your Application, you need to add some policies to
make sure Userlane can work correctly and can be shown to your users.

Allowing the script execution for userlane.com

Add the following hostnames to your CSP default-src , script-src  , style-src  , img-src  , connect-src  , and font-
src  attribute:

https://*.userlane.com 
https://*.sentry.io

This allows all userlane.com images, scripts, fonts, and styles to be loaded into your Application. This is
necessary to make sure Userlane can function correctly.

ℹ️ We use Sentry for monitoring real-time our Application's code health.

http://userlane.com/
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Cross-Origin iFrame support in
Userlane
Last Modified on 12.04.2024

What is a Cross-Origin iFrame

A Cross-Origin iFrame is a section of your application (your page) hosted on a different domain or server and
injected into your application via an iFrame element.

What is it used for

Another application can be displayed within another application in a dedicated section of the page without the
need to open it in a separate tab. 

Installation for Snippet customers 

Cross-Origin iFrame support is available for customers implementing Userlane with a snippet.  The Userlane
code (userlane.js) needs to be implemented in the main application, and the application added via the iFrame. 

To activate the Editor for the iFrame section, the domain of the iFrame application needs to be added to the
Userlane Portal. 

Support for Browser Extension customers 

We support the cross-origin Iframes in the Userlane Browser Extension as well. No further implementation is
required; ensure that the URL of the iFrame application is added to the App URL list in the Userlane Portal.
Check out how to set up your application URL here. 

ℹ️ To activate the support for Cross-Origin iFrames, please get in touch with your Customer Success
Manager. 

 

https://docs.userlane.com/docs/set-up-your-application-url
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SSO Implementation
Last Modified on 31.10.2024

About SSO

Single Sign-On is a convenient, yet secure way of authenticating a user. 

Most customers are already running an Identity Provider (IDP) that supports Single Sign-On through the SAML
2 protocol, e.g. Active Directory, OneLogin, or Okta.

Benefits of using SSO

Integrating SSO into Userlane makes sure that 

your user can benefit from its content by using credentials they are using each day and in multiple places

Userlane is silently and seamlessly rolled out to all end users

your users do not have to do anything in order to see Userlane.

How it works

In the following section, we  refer to three different stakeholders who need to align in order to get the
integration up and running smoothly:

Company IT Administrator Company Application Owner Userlane Customer Success Manager

Sets up the installation on the
customer's side.

Has requested that Userlane
runs on their application

Point of contact at Userlane for the
installation and person who supports
App Owner regarding any requirements

In concept, this is how users are seamlessly authenticated for Userlane:

User authentication logic

First time authentication is triggered immediately when User opens the browser with an installed Userlane
Browser Extension. If the authentication is not successful, the attempt is repeated exponentially (every 2, 4, 8
minutes and further) until it reaches the frequency of 48h. After that the re-try is triggered every 48h until
successfully authenticated. 

An already authenticated user will try to refresh the user attributes according to the setting in the Userlane
Portal. The refresh is done by re-authenticating. 

Configuration

https://docs.userlane.com/docs/release-note-set-up-sso-within-userlane-portal
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1. Receive relevant data

Reach out to your IT to receive the 

IDP entrypoint URL
IDP certificate

2. Add to the Userlane Portal

Sign in to Userlane Portal > Settings > Single Sign On

Add Userlane to your IDP to connect SSO

You need to pass the Userlane metadata to your IT.

You can find detailed instructions per provider:

ADFS
Azure Active Directory
Google Workspace

3. Testing in Userlane Portal

Test the SAML connection with the test link in the Userlane Portal.

It should bring the user to your IDP login page or (if they are already logged in to their IDP), then to the
Chrome or Edge extension store to install the Userlane BE or (if they already have the extension installed) they
are brought to a Userlane page with a list of Userlane properties.

Any of these results mean that SSO has been successfully configured. 

4. Authenticating the user via Single-Sign-On

To authenticate the current user towards Userlane, a Single-Sign-On (SSO) flow can be started in a new tab or
in the background. Through this, it is also possible to provide more details about a user to Userlane so that
specific content can be shown to user segments. This can be done by simply enabling automatic authentication
via SSO under the Browser extension tab within your Userlane Portal. 

https://docs.userlane.com/docs/enabling-single-sign-on-sso-via-saml
https://docs.userlane.com/docs/setting-up-single-sign-on-with-azure-active-directory
https://docs.userlane.com/docs/setting-up-single-sign-on-with-google-workspace
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5. Choose the SSO window mode

Choose in which window you want the single sign-on to be processed. Multiple options are available:

Iframe The SSO will be opened in an invisible iframe that does not allow the user to interact at all. This is
the recommended option but most IDPs do not support it.
Inactive Tab The SSO will be opened in a new Tab that the user will be able to see, but the Tab will not
automatically come into focus.
Active Tab The SSO will be opened in a new Tab that will automatically be focussed. Beware that this
might interrupt the workflows of users.

⚠️  At a later stage, the authentication will be automatically triggered by the Userlane Browser Extension.
Please make sure that all users who receive the extension are able to authenticate via the SSO. This is to
avoid users seeing an inactive tab with authentication error. This behaviour may occur e.g. on private
browser profiles or for users who are not part of the SSO group. 
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Setting up Single Sign On with
ADFS
Last Modified on 18.04.2024

Single Sign-On is a convenient, yet secure way of authenticating a user. Most customers are already running an
Identity Provider (IDP) that supports Single Sign-On through the SAML 2 protocol, e.g. Active Directory,
OneLogin, or Okta.

In order to configure the Single Sign-On for Userlane, follow these steps below:

Setting up SSO with ADFS

Userlane can accept authentication via the SAML 2.0 Protocol. 

Of the many implementations of this protocol, Microsoft Active Directory Federation Services (ADFS) is one of
the most widespread. In this scenario, an ADFS server acts as the Identity Provider (IDP) and Userlane as the
Service Provider (SP).

1.1. Adding the Identity Provider (IDP) details to Userlane

To register your IDP with Userlane, the IT Admin needs to provide the following info about the company IDP to
the SA:

Entry point/target URL that users will be redirected to for authentication

X509 Certificate/Signatures so that Userlane can securely validate authentication claims

This information is often contained in a Metadata XML file.  

Then, sign in to Userlane Portal > Settings > Single Sign-on and add the required information. 

1.2. Adding Userlane as a Service Provider (SP) to your IDP

For the company’s IDP to accept authentication requests by Userlane, the IT Admin must first register Userlane
as a Service Provider (SP).
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ℹ️ The Userlane Service Provider Metadata differs for each customer. Your Userlane SA will provide you
with a .xml file to import into your ADFS Server.

Registration steps:

1. Download the Metadata file onto your ADFS Server

2. Open the “AD FS Management” app

3. In the menu on the right, select “Add  Relying Party Trust”

4. Select “Claims aware”



59

5. Select the Metadata file you’ve downloaded or follow the instructions for manual setup below

6. Specify any display name or description you like
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7. It is essential to configure which employees are targeted for Userlane.
In general, any employee who has access to the connected application that uses Userlane for enablement
purposes should also have access to the Userlane app. However, we recommend that App Owner confirms the
target group after consulting with SA to avoid any misunderstanding.

Note: Do not configure MFA (Multi-factor Authentication) as a requirement in order to make the sign-in easier
and seamless for your users.

8. Confirm in order to add the Trust and continue with configuring a claims issuance policy for your application
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8.1. Select “Add Rule”

8.2. Userlane requires a “nameID” (please keep the exact letter-case form) in the Outgoing Claim Type. This
will be the unique identifier on Userlane level and it is the only mandatory attribute required. This ID must be
unique for each user and is not meant to be changed over time in order to keep historical information clean.

Additional user information required by App Owner for improved targeting is explained in the article Expanding
the Settings

Save and apply the Claim Rule

https://docs.google.com/document/d/1lzyrzroG7TCnhZ-UwcUoaE0sI8yw4RTdblKyf6IoSr8/edit#heading=h.wt4n6jh151oa
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Make sure to choose how often you want to repeat the SSO for already authenticated users. This assures that
user attributes are kept up to date. For doing this: sign in to Userlane Portal > Settings > Browser
Extension then in the dropdown SSO Refresh Interval choose one of the available options. Keep in mind that
the shorter the interval, the higher the load on your IDP will be.

Test the single sign-on implementation

To test the integration after the setup has been completed, open the following URL in a browser:

https://sso-saml.userlane.com/c/USERLANE-COMPANY-ID/authenticate or you can do it within the Portal:

Then, sign in to Userlane Portal > Settings > Single Sign-on and click the Test SSO button. 

The user will be redirected to the IDP. 

After successful authentication, the user will be redirected back to Userlane and the Browser Extension will be
authenticated.

Users with given permission will be authenticated and end up on the overview page:

https://family-reviews.usln.rocks/app/qwx0dk46vz/settings/company/attributes
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Installing and Configuring the
Browser Extension for Microsoft
Edge on Windows (SSO)
Last Modified on 01.04.2025

Microsoft Edge, Mozilla Firefox and Google Chrome allow the silent installation of Browser Extensions. This
way, the users do not have to manually install the Browser Extension themselves, but rather the IT Admins can
roll out the Browser Extension in the background via a MDM solution, such as Microsoft InTune, Enteo NetInstall,
or Matrix42 Empirum.

Each browser needs to be set up separately.

Browser Extensions in Edge can be installed and configured through Enterprise Policies. Refer to the official
documentation at https://docs.microsoft.com/en-us/deployedge/microsoft-edge-policies#extensions-policies for
more info.

Requirements
Userlane Customer Success Manager needs to provide companyID and information on region
IT Admin with access to Browser Installation and Policies
Userlane Account Admin to set Integrity Token in Userlane Portal

Steps to Complete the Setup
1. Installation and Configuration
2. Verification

 

1. Installation and Configuration
ExtensionInstallForceList browser policy

Add the Userlane Extension (ID for Edge: joephgegnilhnnnocnkigpmmamgghage) 
to the ExtensionInstallForceList: https://docs.microsoft.com/en-us/deployedge/microsoft-edge-
policies#extensioninstallforcelist to install the Userlane Extension from the Edge Add-ons.

Example registry file

Windows Registry Editor Version 5.00 
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\ExtensionInstallForcelist] 
"1"="joephgegnilhnnnocnkigpmmamgghage"

https://docs.microsoft.com/en-us/deployedge/microsoft-edge-policies#extensions-policies
https://app.knowledgeowl.com/#installation
https://app.knowledgeowl.com/#configuration
https://app.knowledgeowl.com/#verification
https://docs.microsoft.com/en-us/deployedge/microsoft-edge-policies#extensioninstallforcelist
https://microsoftedge.microsoft.com/addons/detail/joephgegnilhnnnocnkigpmmamgghage
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Note: The Registry Key might need to be modified if multiple Browser Extensions (other than Userlane) are
installed to Edge.

 

Browser Policy Configuration

Registry keys in the path. 

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\3rdparty\extensions\joephgegnilhnnnocnkigpmmamgg
hage\policy

All keys should have type REG_SZ. 

Please note that you need to get the correct companyId and region from your Customer Success Manager!

Example registry file:

Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Microsoft\Edge\3rdparty\extensions\joephgegnilhnnnocnkigpmmamg
ghage\policy]
"companyId"="abc"
"companyIntegrity"="xyz"
"region"="eu"

Attention: "region" key is used to define where your Userlane Application is hosted: 

If the Userlane Application is hosted in the EU, the corresponding value for "region" is "eu". 
If the Userlane Application is hosted in the US, the corresponding value for "region" is "us".

 

2. Verification

Visit the Userlane Browser Extension Settings

Do a right click on the Browser Extension 
Choose Options
Navigate to Managed Storage
Confirm that all values are present

Example of the information is not set up correctly:
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If you see this, please go through the installation and configuration steps again.

⚠️  The Userlane Browser Extension will trigger automatic SSO authentication. Please make sure that all
users who receive the extension are able to authenticate via the SSO. This is to avoid users seeing an
inactive tab with authentication error. This behaviour may occur e.g. on private browser profiles or for users
who are not part of the SSO group. 
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Installing and Configuring the
Browser Extension for Chrome on
macOS (SSO)
Last Modified on 01.04.2025

Microsoft Edge, Mozilla Firefox and Google Chrome allow the silent installation of Browser Extensions. This
way, the users do not have to manually install the Browser Extension themselves, but rather the IT Admins can
roll out the Browser Extension in the background via a MDM solution, such as Microsoft InTune, Enteo NetInstall,
or Matrix42 Empirum.

Each browser needs to be set up separately.

This article explains the configuration for Chrome on macOS.

Browser Extensions in Chrome can be installed and configured through Enterprise Policies. Refer to the official
documentation of Chrome at https://cloud.google.com/docs/chrome-enterprise/policies/ for more info.

Requirements
Userlane Customer Success Manager needs to provide companyID and information on region
IT Admin with access to Browser Installation and Policies
Userlane Account Admin to set Integrity Token in Userlane Portal

Steps to Complete the Setup
1. Installation and Configuration
2. Verification

 

1. Installation and Configuration
ExtensionInstallForceList browser policy

Add the Userlane Extension (ID for Chrome: oaienfpdbimabhlgjlbdpocbogaijnam) 
to the ExtensionInstallForceList: https://cloud.google.com/docs/chrome-enterprise/policies/?
policy=ExtensionInstallForcelist to install the Userlane Extension from the Google Chrome Store.

Example org.google.Chrome.plist file:

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/PropertyList-

https://cloud.google.com/docs/chrome-enterprise/policies/
https://app.knowledgeowl.com/#installation
https://app.knowledgeowl.com/#configuration
https://app.knowledgeowl.com/#verification
https://cloud.google.com/docs/chrome-enterprise/policies/?policy=ExtensionInstallForcelist
https://chrome.google.com/webstore/detail/userlane-extension/oaienfpdbimabhlgjlbdpocbogaijnam
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1.0.dtd">

<plist version="1.0">

<dict>

  <key>ExtensionInstallForcelist</key>

  <array>

    <string>oaienfpdbimabhlgjlbdpocbogaijnam</string>

  </array>

</dict>

</plist>

 

Browser Policy Configuration

Chrome Extensions can be configured the same way they are installed.

Example com.google.Chrome.extensions.oaienfpdbimabhlgjlbdpocbogaijnam.plist file:

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/PropertyList-
1.0.dtd">

<plist version="1.0">

  <dict>

    <key>companyId</key>

    <string>abc</string>

    <key>companyIntegrity</key>

    <string>xyz</string>

    <key>region</key>

    <string>eu</string>

  </dict>

</plist>
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Attention: "region" key is used to define where your Userlane Application is hosted: 

If the Userlane Application is hosted in the EU, the corresponding value for "region" is "eu". 
If the Userlane Application is hosted in the US, the corresponding value for "region" is "us".

 

Verification

Visit the Userlane Browser Extension Settings

Do a right click on the Browser Extension 
Choose Options
Navigate to Managed Storage
Confirm that all values are present

Example of the information is not set up correctly:

If you see this, please go through the installation and configuration steps again.

⚠️  The Userlane Browser Extension will trigger automatic SSO authentication. Please make sure that all
users who receive the extension are able to authenticate via the SSO. This is to avoid users seeing an
inactive tab with authentication error. This behaviour may occur e.g. on private browser profiles or for users
who are not part of the SSO group. 
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Installing and Configuring the
Userlane Browser Extension for
Firefox on Windows (SSO)
Last Modified on 11.11.2024

Microsoft Edge, Mozilla Firefox and Google Chrome allow the silent installation of Browser Extensions. This
way, the users do not have to manually install the Browser Extension themselves, but rather the IT Admins can
roll out the Browser Extension in the background via a MDM solution, such as Microsoft InTune, Enteo
NetInstall, or Matrix42 Empirum.

Each browser needs to be set up separately.

This article explains the configuration for Firefox on Windows.

Browser Extensions in Firefox can be installed and configured through Enterprise Policies.

Requirements
Userlane Customer Success Manager needs to provide companyID and information on region
IT Admin with access to Browser Installation and Policies
Userlane Account Admin to set Integrity Token in Userlane Portal

Steps to Complete the Setup
1. Installation and Configuration
2. Verification

 

1 Installation and Configuration
ExtensionInstallForceList browser policy

Add the Userlane Extension (Link for Firefox: https://browser-extension.userlane.com/firefox/userlane.xpi) to
the Extension\Install list:

https://github.com/mozilla/policy-templates#extensionsettings 

For the installation_mode we recommend force_installed.

New registry entry (example):

Path: HKEY_LOCAL_MACHINE\Software\Policies\Mozilla\Firefox

https://app.knowledgeowl.com/#installation
https://app.knowledgeowl.com/#configuration
https://app.knowledgeowl.com/#verification
https://app.knowledgeowl.com/#verification
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New entry name: ExtensionSettings

Entry type: REG_MULTI_SZ

Example value for the registry entry :

{ 
  "{9f6832a6-ec0c-11e8-8eb2-f2801f1b9fd1}": { 
    "installation_mode": "force_installed", 
    "install_url": "https://browser-extension.userlane.com/firefox/userlane.xpi" 
  } 
}

Note: The Registry Key might need to be modified if multiple Browser Extensions (other than Userlane)
are installed to Firefox.

Browser Policy Configuration

Firefox Extensions can be configured in many ways, e.g. through system policies:
https://extensionworkshop.com/documentation/enterprise/adding-policy-support-to-your-extension/

On Windows, the easiest way is to use system registry. Prepare the following data that you will find in the
Portal: Settings - Single Sign On  and  Settings - Browser Extension

companyId (provided by your Customer Success Manager!)
companyIntegrity 
region

Here is the registry path to add the configuration: 

Software\Policies\Mozilla\Firefox\policies\3rdparty\Extensions\{9f6832a6-ec0c-11e8-8eb2-f2801f1b9fd1}

Example .reg file:

Windows Registry Editor Version 5.00

https://extensionworkshop.com/documentation/enterprise/adding-policy-support-to-your-extension/
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[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Mozilla\Firefox\3rdparty]

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Mozilla\Firefox\3rdparty\Extensions]

[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Mozilla\Firefox\3rdparty\Extensions\{9f6832a6-ec0c-
11e8-8eb2-f2801f1b9fd1}]

"companyId"="12345"

"companyIntegrity"="12345"

"region"="eu" 

"authMethod"="openUrl"  

"authToken"=""  

"userId"="user123"

Attention: "region" key is used to define where your Userlane Application is hosted: 

If the Userlane Application is hosted in the EU, the corresponding value for "region" is "eu". 
If the Userlane Application is hosted in the US, the corresponding value for "region" is "us".

Here is additional info about the specific values shown above. The first three are required:

Name
Default
value

Description Required

companyId Id of the company from Admin Center yes

companyIntegrity
Value to prove the integrity of the companyId, you can set it
in the Portal

for SSO-SAML

region eu
Region, EU by default; need to be specified for US
customers

for US

authMethod Option to override default Auth method set in Portal no
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authToken Authentication Token for Passwordless Authentication
only  for non
SAML

userId
ID of the user, depends on internal settings; e.g. email for
SSO

no

userAttributes User attributes in JSON format no

2. Verification

Visit

moz-extension://EXTENSION_INTERNAL_UUID/options/index.html?stay#/nativeconfig, where  
EXTENSION_INTERNAL_UUID can be found on about:debugging#/runtime/this-firefox  page: 

for example: moz-extension://b6c3cff5-7f22-4a44-8f35-7296b53f2a14/options/index.html?stay#/nativeconfig

Please note that the Internal UUID is always unique.
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Setting up Single Sign On with
Azure Active Directory
Last Modified on 26.09.2023

Single Sign-On is a convenient, yet secure way of authenticating a user - without them having to set up a new
password. 

Requirements
access to Azure Portal 
access to Userlane Portal

Set up SSO for Azure Active Directory

1. Open the Azure Portal and navigate to Azure Active Directory / Enterprise applications.

2. Click on “New application”

3. Click on “Create your own application”

4. Enter a name for your application. This can be whatever you like, for example “Userlane”. Confirm the
creation.
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5. Open the “Properties” page from the menu on the left

6. Set the “Assignment required” option to “No”. This allows all users to sign into Userlane if needed.

7. Open the “Single sign-on” page from the menu on the left

8. Select “SAML” as the single sign-on method

9. Click “Edit” on the Basic SAML Configuration fields
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10. Now fill the Identifier and Reply URL with the value that you can find in the Userlane Portal under
Account > Global settings > Single Sign-on. This typically looks like a URL starting with https://sso-
saml.userlane.com/.. We tried to make this as easy as possible for you at Userlane, so this same value
goes into both the Identifier and the Reply URL. Save these changes.

11. Optional step: If you want to segment users based on attributes in their profile, you can add “Attributes &
Claims” in the second step of the “Set up Single Sign-On with SAML” page.
Typically we see that customers want to include attributes like country, department, or other
organizational attributes to show the right training & enablement content to users.

12. This completes the setup on the side of Azure Active Directory. The remaining steps are about configuring
Userlane to trust your Azure Active Directory and also need to be completed to enable Single Sign On.
Scroll down to Step 4 of the “Set up Single Sign-On with SAML” page, and copy the Login URL.
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Paste this Login
URL into the “IDP Entrpoint URL” field in the Userlane Portal’s SSO configuration page (Account > Global
settings > Single Sign-on).

13. Back on the Azure Portal page, click on “Download” of the SAML Certificate in Base64 format in Step 3.

14. Open the downloaded .cer file in a Text Editor of your choice (e.g. Notepad by right-clicking on the file and
then Open With) and copy the part inside of the -----BEGIN CERTIFICATE----- and -----END
CERTIFICATE----- part to your clipboard.
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15. Back in the Userlane Portal, paste this into the “IDP Certificate” field and save these changes.

16. Now it’s time to test the Single Sign On. You can do this by clicking on the “Test SSO” button on the
Userlane Portal, or by opening the Entity ID URL used before in a new tab manually. The Single Sign On
flow is working correctly if the tab closes automatically (after being redirected around a few times) and
not showing any errors. 
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Setting up Single Sign on with
Google Workspace
Last Modified on 26.09.2023

Single Sign-On is a convenient, yet secure way of authenticating a user - without them having to set up a new
password. 

Requirements
access to Google Admin center
access to Userlane Portal

Set up SSO for Google Workspace

In order to configure the Single Sign-On with Google Workspace for Userlane, follow these steps below:

1. Open the Google Admin center (admin.google.com) and navigate to Apps / Web and mobile apps

2. Click on “Add app” and select “Add custom SAML app”
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3. Enter “Userlane” as App name. Optionally add a description and App icon (these are non-essential
parameters). Continue to the next screen.                                                                                   

4. Copy the SSO URL from Google and paste it into the “IDP Entrypoint URL” field in the Userlane Portal’s
SSO configuration page (Account > Global settings > Single Sign-on).

5. Copy the Certificate from Google and paste it into the “IDP Certificate” field on the same page in the
Userlane Portal.
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6. Then remove the “---BEGIN CERTIFICATE---” and “---END CERTIFICATE---” lines from the beginning
and ending of the textbox.

7. Confirm these edits by clicking “Save” on the Userlane Portal.

8. Copy the “Userlane Entity ID & Consumer URL” from the Userlane Portal. This typically looks like a URL
starting with https://sso-saml.userlane.com/..

9. Back on the Google Admin page, continue to the next step.

10. We tried to make this as easy as possible for you at Userlane, so the copied URL same value goes into
both the “ACS URL” and “Entity ID” on the Google Admin configuration screen. Tick the “Signed
response” checkmark.

11. For the Name ID confirmation, you can leave the default configuration unchanged.
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12. On the next step, you can optionally add attributes that should be handed over from Google Workspaces
to Userlane for each user. This allows you to enhance the Userlane profile in Userlane, which can be used
to segment users and show them targeted content. You can leave it blank or add a few relevant
mappings:

13. Complete the configuration of Userlane as SAML App in Google Admin.

14. Make sure to enable access to the Userlane SAML App in Google Admin for your entire organization.

15. Now it’s time to test the Single Sign On.

You can do this by clicking on the “Test SSO” button on the Userlane Portal, or by opening the Entity ID URL
used before in a new tab manually. The Single Sign On flow is working correctly if the tab closes automatically
(after being redirected around a few times) and not showing any errors. 
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Expanding SSO Settings
Last Modified on 12.12.2023

Why use it

Expanding SSO settings allows for greater control and customization of the single sign-on (SSO) experience. 

By expanding SSO settings, organizations can 

add additional user attributes
connect Userlane to further applications

This flexibility helps enhance user experience, and ensure seamless and secure access across multiple
applications and systems.

Add additional User Attributes

The App Owner often needs to feed more user data into Userlane for more sophisticated targeting or greater
insights into analytics.

Our SA will support the App Owner with defining what is needed based on best practice examples.  

The IT Admin will have to check data availability as well as configure the additional attributes as described in
step 8.2 in this article.

https://docs.userlane.com/docs/enabling-single-sign-on-sso-via-saml
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ℹ️ Make sure to choose how often you want to repeat the SSO for already authenticated users. This assures
that user attributes are kept up to date. For doing this: sign in to Userlane Portal > Settings > Global
settings > Browser Extension then in the dropdown SSO Refresh Interval choose one of the available
options. Keep in mind that the shorter the interval, the higher the load on your IDP will be.

Connect Userlane to further applications

After Userlane has been launched within one application, it is typically launched in more applications used
within the company.
For this reason,  the App Owner of the new application has to request, once again, the necessary access
permissions for his target group as described in 2.1 (step 7) in this article and this config needs to be added to
the existing settings.

ℹ️ Note for the IT Admin: 
The user profile registration via SSO reflects the overall company user data and is not per-app basis. This
distinction will happen later on at the application level.

https://family-reviews.usln.rocks/app/qwx0dk46vz/settings/company/attributes
https://docs.userlane.com/docs/enabling-single-sign-on-sso-via-saml
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Installing and Configuring the
Browser Extension for Chrome on
Windows (SSO)
Last Modified on 01.04.2025

Microsoft Edge, Mozilla Firefox and Google Chrome allow the silent installation of Browser Extensions. This
way, the users do not have to manually install the Browser Extension themselves, but rather the IT Admins can
roll out the Browser Extension in the background via a MDM solution, such as Microsoft InTune, Enteo
NetInstall, or Matrix42 Empirum.

Each browser needs to be set up separately.

This article explains the configuration for Chrome on Windows.

Browser Extensions in Chrome can be installed and configured through Enterprise Policies. Refer to the official
documentation of Chrome at https://cloud.google.com/docs/chrome-enterprise/policies/ for more info.

Requirements
Userlane Customer Success Manager needs to provide companyID and information on region
IT Admin with access to Browser Installation and Policies
Userlane Account Admin to set Integrity Token in Userlane Portal

Steps to Complete the Setup
1. Installation and Configuration
2. Verification

 

1. Installation and Configuration
ExtensionInstallForceList browser policy

Add the Userlane Extension (ID for Chrome: oaienfpdbimabhlgjlbdpocbogaijnam) 
to the ExtensionInstallForceList: https://cloud.google.com/docs/chrome-enterprise/policies/?
policy=ExtensionInstallForcelist to install the Userlane Extension from the Google Chrome Store.

Example registry file

Windows Registry Editor Version 5.00

https://cloud.google.com/docs/chrome-enterprise/policies/
https://app.knowledgeowl.com/#installation
https://app.knowledgeowl.com/#configuration
https://app.knowledgeowl.com/#verification
https://cloud.google.com/docs/chrome-enterprise/policies/?policy=ExtensionInstallForcelist
https://chrome.google.com/webstore/detail/userlane-extension/oaienfpdbimabhlgjlbdpocbogaijnam
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[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome\ExtensionInstallForcelist]

"1"="oaienfpdbimabhlgjlbdpocbogaijnam"

You can also download it here.

Note: The Registry Key might need to be modified if multiple Browser Extensions (other than Userlane) are
installed to Chrome.

 

Browser Policy Configuration

Registry keys in the 

HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome\3rdparty\extensions\oaienfpdbimabhlgjlbdpocbogaij
nam\policy

path. 

All keys should have type REG_SZ.

Please note that you need to get the correct companyID and region from your Customer Success Manager!

Example registry file:

Windows Registry Editor Version 5.00
[HKEY_LOCAL_MACHINE\SOFTWARE\Policies\Google\Chrome\3rdparty\extensions\oaienfpdbimabhlgjlbdpocbogai
jnam\policy]
"companyId"="abc"
"companyIntegrity"="xyz"
"region"="eu"

Attention: "region" key is used to define where your Userlane Application is hosted: 

If the Userlane Application is hosted in the EU, the corresponding value for "region" is "eu". 
If the Userlane Application is hosted in the US, the corresponding value for "region" is "us".

2. Verification

Visit the Userlane Browser Extension Settings

https://browser-extension.userlane.com/chrome/UserlaneChromeExtension.reg
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Do a right click on the Browser Extension 
Choose Options
Navigate to Managed Storage
Confirm that all values are present

Example of the information is not set up correctly:

If you see this, please go through the installation and configuration steps again.

⚠️  The Userlane Browser Extension will trigger automatic SSO authentication. Please make sure that all
users who receive the extension are able to authenticate via the SSO. This is to avoid users seeing an
inactive tab with authentication error. This behaviour may occur e.g. on private browser profiles or for users
who are not part of the SSO group. 
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Installing and Configuring the
Userlane Browser Extension for
Firefox on macOs (SSO)
Last Modified on 11.11.2024

Microsoft Edge, Mozilla Firefox and Google Chrome allow the silent installation of Browser Extensions. This
way, the users do not have to manually install the Browser Extension themselves, but rather the IT Admins can
roll out the Browser Extension in the background via a MDM solution, such as Microsoft InTune, Enteo
NetInstall, or Matrix42 Empirum.

Each browser needs to be set up separately.

This article explains the configuration for Firefox on macOS.

Browser Extensions in Firefox can be installed and configured through Enterprise Policies.

Requirements
Userlane Customer Success Manager needs to provide companyID and information on region
Admin with access to Browser Installation and Policies
Userlane Account Admin to set Integrity Token

Steps to Complete the Setup
Installation and Configuration
Verification

 

1. Installation and Configuration
ExtensionInstallForceList browser policy

Add the Userlane Extension (Link for Firefox: https://browser-extension.userlane.com/firefox/userlane.xpi) 
to the Extension\Install list: https://github.com/mozilla/policy-templates#extensions 

There are 2 ways to achieve this.

Option A: With a plist file:

Example org.mozilla.firefox.plist file:

https://app.knowledgeowl.com/#installation
https://app.knowledgeowl.com/#configuration
https://app.knowledgeowl.com/#verification
https://github.com/mozilla/policy-templates#extensions
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<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/PropertyList-
1.0.dtd">

<plist version="1.0">

<dict>

  <key>EnterprisePoliciesEnabled</key>

  <true/>

  <key>Extensions</key>

  <dict>

    <key>Install</key>

    <array>

      <string>https://browser-extension.userlane.com/firefox/userlane.xpi</string>

    </array>

  </dict>

</dict>

</plist>

Option B: With a policies.json file

Place a policies.json file inside the Firefox.app container at
Firefox.app/Contents/Resources/distribution/policies.json.

Example policies.json file:

{

  "policies": {

    "Extensions": {

      "Install": [

        "https://browser-extension.userlane.com/firefox/userlane.xpi"
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      ]

    }

  }

}

 

Browser Policy Configuration

(1) Firefox Extensions are configured through Managed Storage Manifests: https://developer.mozilla.org/en-
US/docs/Mozilla/Add-ons/WebExtensions/Native_manifests#Managed_storage_manifests.

Example managed storage manifest .json file::

{

  "name": "{9f6832a6-ec0c-11e8-8eb2-f2801f1b9fd1}",

  "description": "Config for the Userlane Extension in Firefox",

  "type": "storage",

  "data": {

    "companyId": "abc",

    "companyIntegrity": "xyz"

    "region": "eu"

  }

}

}

Attention: "region" key is used to define where your Userlane Application is hosted: 

If the Userlane Application is hosted in the EU, the corresponding value for "region" is "eu". 
If the Userlane Application is hosted in the US, the corresponding value for "region" is "us".

Place this .json file anywhere on the client.

https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/Native_manifests#Managed_storage_manifests
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(2) For Firefox to find the file, we need to add it’s path to a Registry Key: https://developer.mozilla.org/en-
US/docs/Mozilla/Add-ons/WebExtensions/Native_manifests#Manifest_location. The Name of the Userlane
Extension for Firefox is {9f6832a6-ec0c-11e8-8eb2-f2801f1b9fd1}.

 

2. Verification

Visit

moz-extension://EXTENSION_INTERNAL_UUID/options/index.html?stay#/nativeconfig, where  
EXTENSION_INTERNAL_UUID can be found on about:debugging#/runtime/this-firefox  page: 

for example: moz-extension://b6c3cff5-7f22-4a44-8f35-7296b53f2a14/options/index.html?stay#/nativeconfig

Please note that the Internal UUID is always unique.

https://developer.mozilla.org/en-US/docs/Mozilla/Add-ons/WebExtensions/Native_manifests#Manifest_location
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Central Browser Extension Rollout
Last Modified on 12.12.2023

Browsers can be configured via so-called Enterprise policies. Those policies are provided by the Browser
manufacturers (Mozilla, Google, or Microsoft) and allow IT Admins to regulate what users can or can’t do with
the Browser. To do that, companies use a tool to manage devices and software packages (MDM) such as
Microsoft InTune, Entel or Matrix42 Empirum. It is possible to automatically install specific Browser Extensions
and to provide configuration parameters to them.

Requirements
Userlane Customer Success Manager needs to provide companyID and information on region
IT Admin with access to Browser Installation and Policies
IT Admin creates integrityToken
Userlane Account Admin to set Integrity Token in Userlane Portal

Installation and Configuration
1. Userlane Browser Extension must be added to the ExtensionInstallForceList browser policy
2. Browser Policies must be configured for the Userlane Browser Extension

You need to configure the Browser to install the Userlane Extension through the given options by the
respective browser:

Microsoft Edge on Windows
Chrome on Windows
Chrome on macOS
Firefox on macOS
Firefox on Windows

Then, sign in to Userlane Portal > Settings > Browser extension

Here, you can add your Integrity Token to verify the integrity of the settings and be able to manage
authentication centrally. The integrity token secures the configuration for legitimate users.

https://docs.userlane.com/docs/installing-and-configuring-the-browser-extension-for-microsoft-edge-on-windows-sso
https://docs.userlane.com/docs/installing-and-configuring-the-browser-extension-for-chrome-on-windows-sso
https://docs.userlane.com/docs/installing-and-configuring-the-browser-extension-for-chrome-on-macos-sso
https://docs.userlane.com/docs/installing-and-configuring-the-userlane-browser-extension-for-firefox-on-macos-sso
https://docs.userlane.com/docs/installing-and-configuring-the-userlane-browser-extension-for-firefox-on-windows
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Seamless Rollout Troubleshooting
Last Modified on 06.03.2024

Single Sign-On (SSO) with Browser Extension Rollout can be a powerful way to enhance security and
streamline access to various applications for users. 

However, like any technology implementation, it can come with its own set of challenges. 

General advice 

ℹ️ Please make sure that all the data you implement is correct and has the right syntax.

Here are some common issues that organizations may encounter when using SSO with browser extensions:

Error Messages

You need to have the Company ID and can then visit

For EU Region: 

https://sso-saml.userlane.com/c/USERLANE-COMPANY-ID/authenticate

For US Region: 

https://sso-saml.us.userlane.com/c/USERLANE-COMPANY-ID/authenticate

Invalid CompanyId
Review with Userlane Customer Success Manager that correct companyID is
used.

Invalid Signature

Try renewing the certificate. This requires your IT to provide a new certificate
code.

Add the new certificate to the Userlane Portal.

Error status Code 500
Reach out to Userlane Customer Success Manager to review datatype
settings.

PEM_read_bio_PUBKEY
failed

Check that the certificate in the Userlane Portal from the customer’s metadata
.xml is correct and not missing any characters with help of their developers.

Outdated certification
Add a new certificate into Userlane Portal.
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Invalid certificate format
Review certificate format. Check for blank spaces, missing content or
additional content.

422 Set up SSO trust for Userlane.

If the link opens the login page of your IDP and shows no error but you are still not authenticated (no Company
User shown in the Userlane Portal), check the Entry Point URL, it usually should contain the word "SAML".
Check the XML file for the right entry point URL.

Extension shows "Userlane not running"
Make sure your application is added as an underlying application

Ensure that your software is added to your Portal. Sign in to the Userlane Portal. Click the Application
dropdown then select Settings > Application URLs.

Review setup and syntax for Browser Extension Policies

Make sure companyID, integrityToken and region are set up correctly for respective browser and use the right
syntax. 

How to check? 

Do a right click on the Browser Extension. Click on Options.

Navigate to Managed Storage.

Here you can see what information is currently being passed on. 

Review whether the data that is being passed on is correct.

If any of these values is marked in red, it means that there is an error, see example:



97

If there is no table visible, it means that the Browser was not configured yet. 

You need to configure the Browser to install the Userlane Extension through the given options by the
respective browser:

Microsoft Edge on Windows
Chrome on Windows
Chrome on macOS
Firefox on macOS
Firefox on Windows

For any question regarding this, please reach out to your Userlane Customer Success Manager and IT team
internally to confirm.

Content Security Policy

Should you have chosen Iframe as SSO Window Mode, it could be that your Content Security Policy does not
support Iframes. 

How to check? 

Do a right click on the Browser Extension. Click on Options.

Navigate to Managed Storage.

Should that be the case, you will see a message similar to this: 

In this case, please try using Inactive or Active Tab as alternative SSO Window Mode in the Userlane Portal >
Browser Extension.

Review Browser Extension Policies Restrictions

https://docs.userlane.com/docs/installing-and-configuring-the-browser-extension-for-microsoft-edge-on-windows-sso
https://docs.userlane.com/docs/installing-and-configuring-the-browser-extension-for-chrome-on-windows-sso
https://docs.userlane.com/docs/installing-and-configuring-the-browser-extension-for-chrome-on-macos-sso
https://docs.userlane.com/docs/installing-and-configuring-the-userlane-browser-extension-for-firefox-on-macos-sso
https://docs.userlane.com/docs/installing-and-configuring-the-userlane-browser-extension-for-firefox-on-windows
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If your IT has implemented restrictions on what URLs the Browser Extension is active, Userlane needs to be
added to that URL list by adding *://*.userlane.com. 

Review users have been added to your IDP

A user must be included in your IDP (e.g. Azure, ADFS, Google Workspace) and to any groups applicable in
order to be authenticated and see Userlane content.

Users with multiple logins

The automatic authentication will only be successful if the User has just one login to the IDP. 

With multiple logins, your application will first ask which to use for the authentication. Userlane would not
show such prompt.

How to test:  in the testing phase, please set the SSO Window mode to Active Tab in the Userlane Portal:
Settings - Browser Extension. The authentication process will open a login page on your app. 

If it lets you select which login to use, it means that Userlane will not be able to do automatic authentication
with such user.

Make sure that your segmentation is set up

Make sure that the user profile you use in your application matches these segmentation settings and the user is
supposed to see content.

Allow 3rd party cookies

Some browsers block 3rd party cookies by default, including the ones coming from Userlane. This will block
some of the Userlane elements. You can check if this is the case by allowing all cookies in your browser
settings (only for the sake of testing). 

If this has solved the problem, you can put the following domains in your browser's "3rd party cookie allowed
list"

your app's domain you want to use Userlane on
Userlane's domain [*.]userlane.com 

After you added these domains, you can switch the main cookie setting back to default. 

You may need to ask your colleagues in IT for help.

ℹ️ For more on enabling the third-party cookies, please review the links below for your browser: Google
Chrome, Mozilla Firefox, Safari, and Microsoft Edge. 

http://userlane.com/
https://support.google.com/chrome/answer/95647?hl=en&co=GENIE.Platform%253DDesktop#zippy=
https://support.mozilla.org/en-US/kb/third-party-cookies-firefox-tracking-protection
https://support.apple.com/en-gb/guide/safari/sfri11471/mac
https://support.microsoft.com/en-us/search?query=enable%20cookies%20in%20edge
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If none of the links above is beneficial for you, check the guidelines in the browser's help center.

As an alternative, there are extensions that allow third-party cookies. If you would like to use this solution,
Userlane's underline application URLs should be added to those extensions.

Deactivate any Adblockers

Some adblockers can prevent any cookies collection. Allow Userlane for your adblocker or deactivate it.

Separate window opens asking to log in again and does not close
automatically

Security Software blocks content or User is not connected to company's network.

Export Browser Extension logs

The Browser Extension allows you to check and export logs for troubleshooting. Send the export to the
Userlane Support Team.

Here is a short instruction video:

Your browser does not support HTML5 video.
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Installing and Configuring the
Browser Extension for Microsoft
Edge on macOS (SSO)
Last Modified on 01.04.2025

Microsoft Edge, Mozilla Firefox, and Google Chrome allow the silent installation of Browser Extensions. This
way, the users do not have to manually install the Browser Extension themselves, but rather the IT Admins can
roll out the Browser Extension in the background via an MDM solution, such as Microsoft InTune, Enteo
NetInstall, or Matrix42 Empirum.

Each browser needs to be set up separately.

This article explains the configuration for Edge on macOS.

Browser Extensions in Edge can be installed and configured through Enterprise Policies. Refer to the official
documentation of Edge at Use group policies to manage Microsoft Edge extensions | Microsoft Learn for more
info.

 

Requirements
Userlane Customer Success Manager needs to provide companyID and information on the region
IT Admin with access to Browser Installation and Policies
Userlane Account Admin to set Integrity Token in Userlane Portal

 

Steps to Complete the Setup
1. Installation and Configuration
2. Verification

1. Installation and Configuration

ExtensionInstallForceList browser policy

Add the Userlane Extension (ID for Edge: joephgegnilhnnnocnkigpmmamgghage) to the
ExtensionInstallForceList: Use group policies to manage Microsoft Edge extensions | Microsoft Learn to install
the Userlane Extension from the Microsoft Edge Store.

Example org.Microsoft.edge.plist file:

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/PropertyList-

https://learn.microsoft.com/en-us/deployedge/microsoft-edge-manage-extensions-policies#force-install-an-extension
https://learn.microsoft.com/en-us/deployedge/microsoft-edge-manage-extensions-policies#force-install-an-extension
https://microsoftedge.microsoft.com/addons/detail/userlane/joephgegnilhnnnocnkigpmmamgghage
http://www.apple.com/DTDs/PropertyList-1.0.dtd


101

1.0.dtd">

<plist version="1.0">

<dict>

  <key>ExtensionInstallForcelist</key>

  <array>

    <string>joephgegnilhnnnocnkigpmmamgghage</string>

  </array>

</dict>

</plist>

 

Browser Policy Configuration

Edge Extensions can be configured the same way they are installed.

Example com.Microsoft.Edge.extensions.joephgegnilhnnnocnkigpmmamgghage.plist file:

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE plist PUBLIC "-//Apple//DTD PLIST 1.0//EN" "http://www.apple.com/DTDs/PropertyList-
1.0.dtd">

<plist version="1.0">

  <dict>

    <key>companyId</key>

    <string>abc</string>

    <key>companyIntegrity</key>

    <string>xyz</string>

    <key>region</key>

    <string>eu|us</string>

http://www.apple.com/DTDs/PropertyList-1.0.dtd
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  </dict>

</plist>

 

2. Verification

Visit the Userlane Browser Extension Settings:

Do a right click on the Browser Extension 
Choose Options
Navigate to Managed Storage
Confirm that all values are present

Example of the information is not set up correctly:

If you see this, please go through the installation and configuration steps again.

⚠️  The Userlane Browser Extension will trigger automatic SSO authentication. Please make sure that all
users who receive the extension are able to authenticate via the SSO. This is to avoid users seeing an
inactive tab with authentication error. This behaviour may occur e.g. on private browser profiles or for users
who are not part of the SSO group. 
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How to implement the Userlane
snippet
Last Modified on 28.02.2024

About the Snippet

The Userlane Snippet is a piece of JavaScript code that your engineers need to add to your application's source
code. Once added, Userlane will appear for your users.

By implementing the snippet, software providers can onboard users and improve user retention. To use the
snippet, you need to be able to customize JavaScript in your application. 

Userlane can be added directly through the Userlane snippet in your application's code as long as the
application has only one domain. 

In the initial stages, you can still use the browser extension to create and test your first Guides.

Benefits of implementing the Snippet

Userlane will be shown in the application independent of the browser and is available to all end-users. 

Requirements
access to Userlane Portal
access to source code of application

Setup Snippet for your Application
1. Admin: Share the snippet with the developers

To locate the Userlane snippet, select Settings and then select Setup. Copy the snippet and send it to your
developers.

� The snippet makes Userlane visible for your end users. 

If you do not want content to be visible yet, set all chapters to private or switch Userlane off under
General Settings.

2. Developer: Implement the snippet

The load function loads Userlane in your application. The initialize command executes Userlane and is needed
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for the Userlane Assistant to appear. The Snippet should be implemented into the application's front-end,
before the closing </body> tag.

// load Userlane
(function(i,s,o,g,r,a,m){i['UserlaneCommandObject']=r;i[r]=i[r]||function(){(i[r].q=i[r].q||[]).push(arguments)};a=s.cre
ateElement(o),m=s.getElementsByTagName(o)[0];a.async=1;a.src=g;m.parentNode.insertBefore(a,m)})(window,doc
ument,'script','https://cdn.userlane.com/userlane.js','Userlane');

// identify your user (see Chapter 3. below)

Userlane('identify','user_ID');

  
// initialize Command

Userlane('init', 'your_property_ID');

Make sure that the initialize command contains your account’s property ID that can be found in the Userlane
Portal snippet. The initialize command executes Userlane. Therefore, all the commands that you want to
additionally use should be called before ‘init’.

Note: Should you use Userlane on MS Dynamics, please read more detailed instructions here.

ℹ️  You need to load and initialize Userlane to make it visible in your application. Any other commands are
optional.

3. Developer: Add additional user information in your code snippet

We recommend that you add the user ID in your snippet with the identify command.

This will help you with better user segmentation, more insights in both HEART and Content Analytics and
show your users the status quo about their Guide accomplishments. 

// Pass the user ID without any Custom User Attributes

Userlane('identify','user_ID');

ℹ️  We recommend that you use the user ID in the identify command as well. Keep in mind that if this
command is not used, Userlane will generate a random user ID and will save it in a cookie.

Additionally, you can add Custom User Attributes within this command. A custom attribute could be a user
role or a subscription to a specific feature of your application.  This allows applying user-based segmentation in
the Userlane Portal later. This article provides more info on how a snippet with passed custom data attributes
looks. Here you’ll find further information on user-based segmentation. 

https://docs.userlane.com/docs/snippet-implementation-in-ms-dynamics
https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
https://docs.userlane.com/docs/user-segmentation
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// Pass a Custom User Attribute (data types: number, string, datetime, array, boolean)

Userlane('identify','user_ID',{
  Attribute_key:'Attribute_value'
});

ℹ️  If you include any extra commands in the snippet, remember to place them before the initialize
command. The initialize command verifies the user information provided. So, whenever the page is
refreshed, the user information is updated.

Good to know
Every snippet is connected to a specific Userlane Account. 
We do not recommend using Snippet if you want to create Guides over multiple domains as Userlane can
not pick up the context. 
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Secure Snippet
Last Modified on 12.01.2024

About Secure Snippet

Userlane supports SRI (Subresource Integrity) for its JavaScript Snippet. 

SRI enhances security by adding a secure signature to embedded JavaScript packages in the app. It uses a
unique code that the resource must match, ensuring the Userlane packages remain unaltered and protected
from unauthorized changes.

Concept

In concept, this is how Userlane’s Subresource Integrity works:

Step 1: Fetching the current SRI value

The underlying application must fetch the current SRI value from a REST endpoint provided by Userlane. The
communication is secured via HTTPS to ensure that the SRI value is delivered without unexpected
manipulation.

Example response:

{
   "userlane.123.js": "sha384-abcdefg..."
}

The response must not be cached! The SRI value for userlane.js is subject to change from one moment to
another, when new updates are deployed to the customer by Userlane, as typical for a Cloud SaaS vendor.

https://developer.mozilla.org/en-US/docs/Web/Security/Subresource_Integrity
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Step 2: Embedding userlane.js with SRI

The underlying application can use the fetched SRI value to load userlane.js into the Browser.

<script src="https://secure.userlane.com/userlane.123.js" integrity="sha384-abcdefg..."></script>

Secure Snippet

The secure snippet is as easy to implement as the classic snippet. Replace the loading part of the classic
Snippet with this:

(function (i, s, o, g, r, a, m) {
    i['UserlaneCommandObject'] = r;
    i[r] = i[r] || function () {
        (i[r].q = i[r].q || []).push(arguments);
    };
    var req = new XMLHttpRequest();
    req.open("GET", "https://api.userlane.com/integrity/artifacts/main", false);
    req.send();
    var resp = JSON.parse(req.response);
    a = s.createElement(o), m = s.getElementsByTagName(o)[0];
    a.async = 1;
    a.src = g.replace("userlane.js", resp["entryPoint"]);
    a.integrity = resp["integrity"];
    a.crossOrigin = "anonymous";
    m.parentNode.insertBefore(a, m);
})(window, document, "script", "https://secure.userlane.com/userlane.js", "Userlane");

After Userlane is loaded it still needs to be initialised with a command like Userlane('init', '<put-your-propertyid-
here>') .

Browser Support

SRI is widely supported across modern browsers.

Chrome Edge Firefox Safari
45 17 43 15
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Snippet Implementation in MS
Dynamics
Last Modified on 27.09.2023

This documentation will explain how you can implement the Userlane .js code snippet globally in Microsoft
Dynamics CRM by implementing Userlane behind a ribbon button.

1. It is possible to implement a ribbon button via “Application Ribbons” on the global command bar named
‘Mscrm.GlobalTab.’ This command bar is available globally across Dynamics CRM. 

2. Call the function with an enable rule so that a click is not required to invoke the function and start the
Userlane assistant. Please see the screenshot below for an example.

3. Finally, return ‘false’ so that the ribbon button is not visible to users, but the function is still called. Please
see the screenshot below for an example. 

Note that window.top. Must be added before all Userlane command (eg. ‘init’, ‘identify’ in order for them to
work in this configuration).
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E-Mail Invitation based Browser
Extension Rollout
Last Modified on 05.10.2023

 Learn how to organize the Userlane rollout, manage user access, and enhance user profiles for targeted
engagement.

About User Import for Third-Party Applications

The user import feature allows you to upload a list of your users that can use Userlane via the browser
extension. This not only allows you to address all your users easily but also enables user-group-specific
targeting. 

When to use it

There are different use cases why you should import your users: 

1. Single Activation: Test Userlane with some users only
2. Complete Rollout: The first rollout for all users
3. Segmentation
4. Maintenance

For each use case, you need a CSV or Excel file with your users. 

Prepare the CSV/Excel File for Import

To upload a list of users, you'll need a file in CSV or Excel format (.csv or .xlsx) with their email addresses and
optional attributes. You can either ask your tech department for the file or create it yourself.

In the file, each row represents one user. 
The first row should contain column headers for email and any custom attributes. 
The email column is the identifier and must have the header "email." Email addresses need to be entered
in all lowercase letters. 

If ID is your identifier, it should be used instead of email.
The column headers must be the same as the ones you set up as attributes. The order of columns doesn't
matter, and you can skip columns during the import process.
Please remove any formatting.

 

Example: Table Sheet

https://app.knowledgeowl.com/#SingleActivation
https://app.knowledgeowl.com/#CompleteActivation
https://app.knowledgeowl.com/#Segmentation
https://app.knowledgeowl.com/#Maintenance
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Example: Converted into a CSV file

 

Single Activation: test Userlane only with some users

Roll out Userlane only for specific test users via:

1. Self-Invitation: Your employees can register themselves with their working email address via
https://family.userlane.com/mll if the working email domain is registered in Userlane (ask your Customer
Success Manager if you are not sure). Then they’ll receive a confirmation email with their Userlane
access. 

2. Uploading: You can create a short test user list to send the email invite directly to those test users only.
You can upload new Users by selecting Settings > Company Users - Add Users

 

Rollout Userlane to all users

If you plan to roll Userlane out for the first time to all your users, you can import a complete user list and
trigger the invitation mail to all users at once. You can upload new Users by selecting Settings > Company
Users - Add Users

In the uploading process, you have the choice to: 

Invite all your users automatically: After this process, all your imported users will receive an invitation
email to activate their accounts.

Finish the user upload without the invitation for now: In this case, you can send the email invites to all
users later under  Settings > Company Users - Send Invite.

After adding the users you’ll see all the uploaded users with their status in the User overview.

 

Segmentation: Target your users with specific content

You can use custom user attributes to define user segments that should see specific content (e.g. a chapter that
is only useful for admins). To do this: 

https://family.userlane.com/mll
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1. Create a segmentation concept: to have a clear plan of who should see which tours and how you’ll
differentiate between users.

2. Create the attributes you decided to use from the Portal under Account > Global Settings: you can also
do this during the import process.

3. Create your user CSV/Excel file with the respective attributes. 

4. Follow the import process and match the attributes in the Portal with those in your list. You can create
now the attributes that are still not in your Portal.

5. Create your user segments: using the attributes you create you can now create your user segments (aka.
user groups).

6. Apply your user segments: once this is done, only the users within those segments will have access to
the Guides/chapters you applied the segmentation.

� Good to know 

The users you import will be called Company Users.
You can use any attributes of these users to group them in the Segment section. Find out more about
how to show different chapters/Guides for other user groups. 
After importing and inviting your users, you will see your new Users only in the Settings > Company
Users section, but not in the Segment - Users section. The User overview in the Segment section
only shows users that opened the application after they activated Userlane.  Once a user activates
the browser extension via the invitation email and accesses one of your applications, they will also
appear in the Segment section.

 

Maintenance
1. Understand Status

After uploading a user list you’ll see the status of each user under  Settings > Company Users.

Imported: the user is already uploaded but isn’t invited yet. 

Pending: the user already received the invitation mail, but didn’t confirm yet. 

Active: the user already completed the Userlane browser extension activation via email within at least
one browser and can now use Userlane in the software.

Created: the user was created via SSO and becomes active once going to the application and seeing
Userlane.

2. Change Status

If you want to change this status, you can 

(re-) invite individual users by clicking on the options (three little dots) next to the user and choosing

https://docs.userlane.com/docs/create-a-solid-segmentation-concept
https://docs.userlane.com/docs/user-segmentation
https://docs.userlane.com/docs/sso-implementation
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“Activate”.

Invite all imported users at once by clicking on Send Invite and choosing to Send to imported users.

Re-invite all your pending users at once by clicking on Send Invite, and choosing to Resend to pending
users. This action will only address pending users who have not been sent an email invite within 48
hours.

Terminate access for individual users by clicking at the options (three little dots) next to the user and
choosing Delete. This will prevent them from seeing Userlane.

3. Change Attributes for users

Create your user CSV/Excel file with the respective attributes and upload it under Settings > Company
Users

This file is the same style as the one used for the initial invitation as described in How it works but
with the updated list of users and/or attributes

4. Inviting new Users later on

Regularly promote magic link https://family.userlane.com/mll to allow for self-invitation
Manually re-invite users via uploading of users under Settings > Company Users

� Good to know 

What happens when a user has a new device? 
If a browser profile has been saved and is activated again, Userlane is still available. No further
action needed.

If a browser profile was not saved, Userlane is not available anymore.

https://family.userlane.com/mll
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Userlane SharePoint Extension
Last Modified on 16.04.2024

About Userlane Sharepoint Extension

To extent the SharePoint user experience, you can implement Userlane. With this your Users can access
Userlane content.

Install the Extension from an .spkgg file

1. Open the SharePoint Admin Center, navigate to More features and open the Apps page.

2. Click on Upload and select the spkgg file provided by Userlane.
You can download this file from here: app-sharepoint-extension-1.1.0.sppkg 

3. Confirm that the App should be enabled and added to all sites.

Configure the Extension

4. Continue to the Tenant Wide Extension settings. This is the place where SharePoint accepts configuration
properties for each of the extensions.

SharePoint simply offers to edit the configuration in JSON format in a small input box, so it’s useful to edit and
validate the JSON configuration in another editor before pasting it into SharePoint.

https://desktop.userlane.com/app-sharepoint-extension/app-sharepoint-extension-1.1.0.sppkg


115

The following options are available:

parameter required description

propertyId yes
The Property ID that should be used to initialize the Snippet. Can
be found in Portal. Only if a propertyId other than _off is provided,
Userlane will be loaded.

userIdSource
no (defaults to
userprincipalname)

Which of the many User IDs that SharePoint offers should be used
for the identify call in the Snippet? Options available:

none: Don't call the identify command at all. This will lead to
Userlane using a randomid in a cookie to identify a user.

id: Use the Id field of the current SharePoint User. This was
observed to be a numeric id counting up from 1.

nameid: Use the UserId.NameId field of the current
SharePoint User. This was observed to be an alphanumeric
string.

email: Use the Email field of the current SharePoint User.

userprincipalname: Use the UserPrincipalName field of the current
SharePoint User. This was observed to be the email of the user and
is the recommended option.

region
no (defaults to empty for
EU)

Which data residency region to use when loading Userlane. This
can be us or empty. Don't explicitly put in eu as this will not load.
To maximize flexibility, the region is not validated.

5. As an example, a JSON configuration might look like this:

{"propertyId":"123_replace_me","userIdSource":"userprincipalname"}

6. After the configuration has been saved, Userlane will automatically be loaded onto all SharePoint pages
(see which ones below).
Note that in case of any issues, it’s also possible to disable the Extension immediately here.

Where will Userlane be visible?

When enabled and added to all sites during installation, Userlane will be loaded on all these SharePoint pages:

All sites

All site settings pages

Userlane will never be loaded onto any of these pages:

SharePoint Admin Center
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SharePoint Tenant-Wide Settings

Please consider that due to SharePoints caching mechanisms, sometimes the page needs to be refreshed in
order for updated settings to become available. If Userlane does not appear where it should, please try
refreshing the page.

Troubleshooting

1. Permissions: In order to install and configure the App, you need to be not just a SharePoint Admin, but
also a Global Admin in order to be able to configure a Tenant-Wide Extension.

2. Caching: SharePoint has a built-in caching mechanism, which leads to any configuration (such as
installation, configuration, or removal) of the Userlane for SharePoint App might take up to ~30mins to
propagate to all clients and sites.
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How to set up Userlane for self-
hosting
Last Modified on 12.01.2024

About Self-Hosting

This article describes how to implement Userlane for the self-hosting version which allows you to 

download and self-host the Userlane executable file and all content
run Userlane completely independent from an internet connection or from behind strict firewalls.

This requires involvement from both someone with access to your Userlane Portal and a developer.

Please follow the steps to set it up: 

As a Userlane Manager
As a Developer
Further Considerations

 

As a Userlane Manager
Download the Self-Hosting-Package zip file and send it to your developers

1. Download the Self-Hosting Package and share it with your developers. Ensure your Guides are ready.
Sign in to the Userlane Portal, go to Settings > Snippet Setup, and click Download.

2. The package size is under 10MB, facilitating quick download and easy forwarding via email to your
developers.

 

https://docs.userlane.com/docs/self-hosting
https://app.knowledgeowl.com/#Manager
https://app.knowledgeowl.com/#Developer
https://app.knowledgeowl.com/#Considerations
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As a Developer 
1. Unzip and save the zip file

The downloaded zip file contains only .css, .js, .json, .txt and .html files. How exactly the content looks like in
detail depends on you and your environment.

Copy the unzipped contents to a location where they are accessible through getting requests. A typical
location is the assets folder of the application itself. 

2. Test that the files are accessible 

Open the userlane.html that was included in the zip in your browser using an HTTP or HTTPS protocol (Note:
do not use the “file” protocol that your browser might support). You should see a small page that also contains
the snippet for the next step.

3. Get your snippet

If the snippet worked fine in the previous step, use the snippet that is provided by userlane.html. Otherwise,
you can manually generate a snippet:

Copy the part of the URL from the beginning until before “userlane.html”.

In the example snippet below you see two URL-parts. Paste the copied URL into those two parts for the
placeholder text 'example.com':

For both of those URL-parts and for the init command in the example code below, replace the example
property id “31204” with your individual property id (five signs). You find your individual property id in
the name of the zip file (e.g. “userlane-app-31204”).

<script>

(function(i,s,o,g,r,a,m){i['UserlaneCommandObject']=r;i[r]=i[r]||function(){ (i[r].q=i[r].q||
[]).push(arguments)};a=s.createElement(o), m=s.getElementsByTagName(o)
[0];a.async=1;a.src=g;m.parentNode.insertBefore(a,m) })(window,document,'script','https://example.com/userlane/31
204/userlane.js','Userlane');

Userlane('init', 31204, {
   enableHybrid: true,
   hybridBaseUrl: 'https://example.com/userlane/31204/'
});

</script>

4. Implement the snippet

Implement the snippet before the '</body>' tag in the HTML template to execute it on every page reload. Test if
userlane.js loads correctly and no XHR requests fail. Access the Userlane Assistant in your application. 

 

Further Considerations
This service is available only for Hybrid Hosting plan customers. 
Self-hosting lacks some analytics and process-tracking features due to the absence of connection to the
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Userlane cloud.
Starting a Userlane via a link differs in Userlane Self-Hosting. 
Whenever you make changes to your property in the Portal or Editor, re-download and implement the ZIP
file in your self-hosting setup.
Refer to the provided link for a detailed description of Self-Hosting limitations.

For more information please reach out to your Customer Success Manager.

https://docs.userlane.com/docs/capability-comparison-limitations-for-self-hosting-mode
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Capability comparison / limitations
for Self-Hosting Mode
Last Modified on 15.01.2024

This text provides an overview of the features and capabilities available in Self-Hosting mode compared to
Userlane hosted. 

It covers various functionalities such as analytics, tooltips, interactive guides, data validation, user
segmentation, progress tracking, and integration with external knowledge bases.

Capabilities
Self-

hosted
Hosted

HEART Analytics
The ability to gain insight into the usage of an application, identify issues,
increase user satisfaction, and ultimately improve the ROI.

Content Analytics
The ability to measure and understand the performance of your Userlane
content.

Tags
The ability to measure the usage of the specific elements/features within
the external application.

Tooltips (Hints and Beacons)
The ability to explain and highlight individual elements within an
application.
Interactive Guides

Step by step guidance through a process or workflow in an underlying
app.

Data Validation
Help Managers validate users' input.

Automation
Automate process to navigate users quicker.

PDF Export
Take screenshots of every step of a Guide.

Auto translation
Translate your text in other set up languages.

Messages
Push notification to users announced within the external application,
including Welcome Slide, Announcements, NPS Survey.
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Userlane Assistant

A support menu that overlays the underlying app and provides access to
the Userlane features.

Help menu in the Assistant

A tab menu within the Assistant where managers can connect external
help documentation or external support assistance (e.g., link to ticket form)

Page Segmentation

Functionality that allows content to be targeted to a specific page in an
application.

Guide links to share on request

The ability to provide a URL that links directly to starting a Guide within
the application.

Userlane JS API

The ability to export data.

Basic User Segmentation
The ability to target specific content to groups of users. Basic capability
uses tags to define user segments.
Advanced User Segmentation
The ability to target specific content to groups of users. Advanced
capability uses user attributes to define user segments, which can be
imported into Userlane or automatically added via SSO.

Visual progress tracking for the individual users
Showing end-users completion status of individual Guides and Chapters

Guide promotion
The ability to provide users with a push notification in the Userlane
Assistant to complete a specific Guide.

Search in the Assistant
The ability to search for content in the Userlane Assistant (Guides,
Announcements, Knowledge Base articles)

Knowledge base integration
The ability to connect Userlane with external knowledge bases and
present the content in the Userlane Assistant.

Capabilities
Self-

hosted
Hosted
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Userlane Content Types
Last Modified on 09.01.2024

With Userlane users can learn and complete a specific task or process without requiring previous training. 

Userlane overlays the application, guiding the user through an end to end process. 

Process Tracking

To better understand what processes need additional support, you can measure the usage of the specific
elements/features in your application by using Tags.

Create the tracking in the Userlane Editor.

   

What Why Where

Tags
Understand if users are able to
successfully complete predefined
processes

Create a Tag in Editor

Track its performance in Task
Success on the Portal

Messages

Share messages directly on your application at the right time via the Userlane Assistant.

Create messages within the Userlane Portal.
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What Why Where

Announcements

update Users on important update,
process changes  or reminders

Add additional content, such as
images, guides, links Create messages on the Portal

Track performance in Content
Analytics Standard Surveys

Ask users questions about
application functionality or content

NPS Survey
track your user’s loyalty and opinion
based on how likely they are to
recommend your app

Welcome Slide
welcome new users to the Userlane
Suite within the external application

Guidance

Provide your users with information and instructions to successfully complete processes. 

Create and maintain this content in the Userlane Editor.

What Why Where

Guides
Guide your users through processes
step-by-step within the external
application

Create in Editor

Maintain in either Editor or on
Portal

Track performance in Content
Analytics 

Tooltips - Hints
explain an element to help users
complete a process Create in Editor

Track performance in Content
Analytics Tooltips - Beacons

highlight an element by drawing the
user's attention with the help of a
pulsating icon
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Userlane Editor checklist
Last Modified on 18.01.2024

Why use it

The Userlane Editor is visible only to users that had been invited to the Userlane Portal as an admin,
contributor, or moderator. These user roles have distinct rights to create, edit, or manage content. Some factors
can influence the visibility of the Editor. This article contains a checklist of possible issues to look into for editor
troubleshooting. 

Open the Editor

There are three ways to open the Editor: 

 Sign in to the Userlane Portal at family.userlane.com, go to Guides and click on Open Application. You'll
go directly to your software where you will be able to edit the content.  

If Userlane is implemented via the browser extension, you can open the Editor via the browser extension.
Go to your application, click the Userlane extension, then select Start Editor.

https://docs.userlane.com/docs/user-roles
http://family.userlane.com/
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You can open the Editor via the Userlane Assistant. Go to your Assistant, then select Start Editor.

Editor Checklist

1. Make sure you are logged into the Userlane Portal

Check if you’re signed in to the Userlane Portal at family.userlane.com in the same browser. Then, reload the
page after you sign in to the Portal.

ℹ️  The cookie that stores the information about your account and access rights only works within one
browser. 

http://family.userlane.com/
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2. Make sure your application is added as an underlying application

Ensure that your software is added to your Portal. Sign in to the Userlane Portal at family.userlane.com. Click
the Application dropdown then select Settings > Application URLs.

3. Allow third-party cookies

Some browsers block 3rd party cookies by default, including the ones coming from Userlane. This will block
some of the Userlane elements. You can check if this is the case by allowing all cookies in your browser
settings (only for the sake of testing). 

If this has solved the problem, you can put the following domains in your browser's "3rd party cookie allowed
list"

your app's domain you want to use Userlane on
Userlane's domain [*.]userlane.com 

After you added these domains, you can switch the main cookie setting back to default. 

You may need to ask your colleagues in IT for help.

ℹ️  For more on enabling the third-party cookies, please review the links below for your browser: Google
Chrome, Mozilla Firefox, Safari, and Microsoft Edge.

If none of the links above is beneficial for you, check the guidelines in the browser's help center. 

As an alternative, there are extensions that allow third-party cookies. If you would like to use this solution,
Userlane's underline application URLs should be added to those extensions.

4. Install the latest Userlane browser extension version

Userlane's browser extension should be updated to the latest version. This process may vary depending on the
browser that you use. Please follow the guidelines provided by different browsers on how to update
extensions. 

5. Ensure you are not using an incognito mode / private tab

http://family.userlane.com/
https://support.google.com/chrome/answer/95647?hl=en&co=GENIE.Platform%253DDesktop#zippy=
https://support.mozilla.org/en-US/kb/third-party-cookies-firefox-tracking-protection
https://support.apple.com/en-gb/guide/safari/sfri11471/mac
https://support.microsoft.com/en-us/search?query=enable%20cookies%20in%20edge
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Note that the Userlane Editor does not work in private modes unless you have enabled private mode for
extensions. 

6. Deactivate any ad blockers

Some adblockers can prevent any cookies collection. Allow Userlane for your adblocker or deactivate it. 

7. Your page is blocking Userlane

Sometimes the Userlane elements are not loading properly due to a Content Security Policy or CORS (Cross
Origin Resource Sharing) Policy running on the underlying app and blocking unfamiliar sources. An indicator of
this is usually a red error in the browser console where CORS or content security policy is mentioned along
with Userlane. If this is the case, please share with your developers this article.

ℹ️  CSP is an added layer of security that helps to detect and mitigate certain types of attacks.

8. Clear your Cache and Cookies

At times previous website settings and histories impact how good websites run. After the browser history for
all time is cleared, sign in to the Userlane Portal again and refresh your application page.

By following this Editor Checklist, you will be able to access and use the Userlane Editor seamlessly, allowing
you to create, edit, and manage content effectively within the Userlane Portal.

https://docs.userlane.com/docs/which-hosts-to-allow-in-your-content-security-policy-csp-for-userlane
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Text Formatting in Userlane
Last Modified on 10.12.2024

Text formatting empowers content creators to craft more engaging and professional content. With this
improvement, you can now enhance your text with bold and italic formatting, organize information using
bulleted and numbered lists, and insert hyperlinks for seamless navigation.

How to Format Text

When in the Userlane Editor or Announcement Builder, the formatting toolbar will appear when you highlight
the text you wish to format as shown in the screenshot below.

Which content types can be formatted?

Text formatting is available for the following Userlane content types:

Step descriptions in Guides
Tooltips (both Hints and Beacons)
Announcements

Why This Matters
Improved Engagement: Highlighting key information ensures that your audience quickly identifies the
most important parts of your content.
Better Organization: Lists make complex information more digestible and easier to follow.
Enhanced Navigation: Hyperlinks help guide readers to deeper insights and related materials without
breaking their flow.

Tips for Getting Started
Experiment with different formats to see what resonates best with your audience.
Combine features, like bold headings and bulleted lists, for a polished look.
Use hyperlinks strategically to connect users with valuable resources.

Additional Info

If you have formatting use cases that we do not currently address, please drop us the feedback at
roadmap.userlane.com so that we can collect opportunities for improvement. 

Text formatting is unavailable for:

Select content

https://roadmap.userlane.com
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Welcome Slide
Guide titles and subtitles
Step titles
Announcement titles
Standard Surveys and NPS
Standard slide and button texts that can be configured on the Customize/Texts page in the Userlane
Portal

PDF Export
Formatted text will appear in the markdown syntax in your exported PDF
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Working with images
Last Modified on 15.10.2024

We all know the power of a well-placed, well-chosen image. With Userlane you can quickly upload an image
to enrich your Userlane content.

Why use it

Adding images helps to 

provide users additional context in your content
make your content more discoverable 
promote your organization's branding and voice
directly increase user engagement

Where to use it

You can customize images for the following content types:

Userlane Assistant Avatar
Welcome Slide
Announcements
Assistant Help 
Individual steps in Guides

Enlargable images

Images added to the Welcome Slide, Announcements, and Guide steps can be enlarged with a simple click so
that users can view the image in greater detail. This enables you to add detailed images of process diagrams,
organizational charts, and even screenshots of your application so the user has additional context to quickly
and easily understand the task at hand.

Supported File Types

Depending on where you add images, there are different file recommendations and behaviors. Use the quick
reference table below to learn more about the requirements for each use case.
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Record a Guide
Last Modified on 10.09.2024

Who can create a new Guide?

Any user role can create a new Guide, but only Moderators and Admins can publish or edit active Guides. If you
are new to creating Guides, we recommend that you review our best practices and have a clear plan of the tour
or process that you want to capture. 

Recording a Guide

To record a Guide, you need to access the record mode corresponding to the content type (e.g., Guide or
Tooltip) that you wish to create. For Guides that can be accessed in two ways from the Editor:

Select Guides from the left sidebar, and then click on the Create button
Click on the button located next to Create and select the Guide option from the dropdown.

Guide record mode

Once you access the recording mode, a modal will pop up explaining to you what actions can be performed:

Left click to create an interactive step: interaction steps require user interaction with your app, which is
particularly useful for deeper product tours and learning processes.
Right click to create an explanation step: the simplest Guides are a path of explanation steps where
users click Next in your Guide to proceed.
CTRL key to pause record mode
ESC key to exit record mode.
Don't show the modal again: the modal will not show up if checked.

Record a Guide

To create a Guide:

https://docs.userlane.com/docs/best-practice
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1. Click Start Recording. The recorder captures every click you conduct and automatically creates a step.
You can easily add steps to a Guide later if required.

2. Click through the process you would like to guide your users through. You can add the text and change
other options later. 

3. If you need to pause the recording to adjust your screen between steps, press the CTRL key. Press the
CTRL button again to resume recording. This option works also when re-selecting elements.

4. Once you have recorded the steps, click the Stop recording button or press the Esc key. Your recorded
step sequence is displayed with the last recorded step selected.

Now that you created the flow to be performed by your users, let's configure the steps.

Step options

Once you exit the record mode, each step can be configured in various ways. For example, you can change the
example title and text of a step directly in the window of the recorded step. 

All step options are located right next to the step box:

Reselect Element

Here, you can reselect an element. This is useful if you have selected the wrong element by accident.

Alignment

Here, you can change the preferred alignment of your step box. This is where the explaining text box should be
shown. You are selecting a preference only, as the optimal position can differ depending on your users' screen
size or visible elements.

Refine selector

The features available in this section provide the necessary flexibility to adapt and adjust element identification
to the unique structure of your application.

Skip

The Skip option allows you to make specific steps of your Guide optional for users.

If a step contains a Skip option, the Step will be represented in the Editor panel with a dashed line.

Step type

During recording mode, you can create interaction and explanation steps. However, there are scenarios where
you may want users to perform certain actions before moving forward other than clicking on the element or
pressing the "Next" button. For example, you may wish to validate inputs or automate specific steps. 

To learn more about all step types available in Userlane, please check the following help article.

Interaction

You can define which type of interaction to apply for explanation steps:

https://app.knowledgeowl.com/61bb2adb5f6a068a3c7b2705/language/en/version/650873b395bee5273c5c3a47#addStep
https://docs.userlane.com/docs/refine-the-selector
https://docs.userlane.com/docs/including-skip-steps-in-a-guide
https://docs.userlane.com/docs/add-step-input-validation
https://docs.userlane.com/docs/process-automation-via-guides
https://docs.userlane.com/docs/define-step-navigation-for-your-guides
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If allowed, users can interact with the highlighted elements without moving to the next step.
If prevented, users cannot interact with any of the highlight elements.  

Page reload

When a user does a full reload page, and the URL changes, or you move on to a new browser tab, you can set
the option to ‘Yes’.

When moving on to a new browser tab, Userlane closes the Guide in the current tab without triggering an exit
or an error and opens the Guide in the new tab.

Add Media

Click the + icon to add a link, info box, image, or video to a step. See Adding media to your Guides to learn
more.

Saving a Guide

After recording the Guide, hit the Save button, choose the corresponding name and Chapter, and apply the
changes.

Edit a Guide

Once you access the Guide you wish to edit, the Editor panel will look like this:

You can anytime access your Guide to add, edit, or remove steps. All possible actions are listed below.

Additional Guide actions

Next to the title of the Guide, there is a more-menu button that contains three actions:

https://docs.userlane.com/docs/adding-media-to-your-content
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1. Auto-Translate Guide: The translate functionality button is enabled after the latest Guide changes are
saved and the corresponding ISO code of your language is in use.

2. Take screenshots: If you wish to export the Guide as a PDF, you need first to take screenshots of each
step with the underlying app. 

3. Manage & Publish: Once done editing the Guide, click this button to be redirected to the Portal in a new
tab. Here, you can segment the Guide and publish it.

4. Analyze: once clicked, a new tab will be opened where you will be redirected to the Portal to visualize
the analytics of the corresponding Guide.

5. Delete: if clicked, you need to confirm once more that you wish to delete the Guide.

Edit the Guide content in different languages

Below the Guide title is a dropdown from where you can edit the text shown to the users who wish to consume
the Guide in another language. To learn more about translation in Userlane, check the following article.

Add a step

You can add one or more steps at any point in your Guide if required. First, click on the step before the point you
want to insert the additional step(s), and then click on the "plus" button located under that step to enter the
Record mode. 

Another option is to hover in-between step card panels and click the "plus" button to enter the Record mode.

Edit a step

To edit a step, you need first to select it. To do that, click on the desired step card panel and adjust the step
options and content. 

Preview a Step

Once you are done editing your Guide, you can either test it by pressing the Preview button next to the Save
button or start testing a Guide by previewing it from a certain step (by clicking on the Play icon). For the latter,
click on the step from where you wish to start the preview, and click the Preview button on the right side of the
step card panel. 

� You can preview your Guide anytime to review changes and language versions or to test links. 

Learn more about the different ways you can test your Guides in How to test your Guides before publishing
them.

Take screenshot of a step

If you wish to take a new screenshot of the step, click the step options menu and then the New screenshot
button.

Auto-translate step

If you wish to delete a step, click or hover it, go to the step options menu, and then click the Auto-translate step
button. 

https://docs.userlane.com/docs/supported-iso-codes-for-content-auto-translation
https://docs.userlane.com/docs/export-a-guide-as-a-pdf
https://docs.userlane.com/docs/translate-a-guide
https://docs.userlane.com/docs/how-to-test-your-guides-before-publishing
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Delete a step

If you wish to delete a step, click or hover it, go to the step options menu, and then click Delete step button.

Step notifications

Besides the step preview, the Preview from this step, and the step options menu, the step card panel includes
two additional icons displayed on the left side under specific circumstances.

The first icon is displayed when you are located on a page where the corresponding element of the step cannot
be found (it is either on a different page or could be located in a modal or dropdown).

The second icon is displayed when Userlane requires your attention. It indicates that at least one warning was
triggered due to multiple errors on the step and needs to be checked.

Note: If you want to learn more about building successful Guides, please check these best practices.

https://docs.userlane.com/docs/how-to-build-successful-guides
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Define step navigation for your
Guides
Last Modified on 08.02.2024

You can choose several options to determine how users proceed through your Guide steps.

Step types

You can record two types of steps: Explanation or Interaction steps. 

Explanation steps

The simplest Guides are a path of Explanation steps where users click Next in your Guide to proceed.

There are two kinds of explanation steps, where you can proceed with the “Next” button: 

An explanation step where interaction is prevented (Interaction prevented)

ℹ️ Explanation steps with interaction: prevented are considered optional and will be skipped if the element
is not found.
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An explanation step where the end user should interact with the highlighted area (Interaction allowed)

ℹ️ This step allows the User to interact with an element as many times as they want before moving to the
next step. This could be used for elements that are self-explanatory and recording every element that
does not make sense, e.g. date pickers.

Interaction steps

Interaction steps require user interaction with your app. These are particularly useful for deeper product tours,
learning processes, or where input validation is required.

ℹ️ We recommend explanation steps for simple product walkthroughs and navigation tours and interaction
steps for more complex navigation or process flows.

More step options:
Any value

When a user needs to fill out a field at any step of your Guide, and you want the user to enter any value into an
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input field, you can use the “Any value” option. This option can only be chosen if an input field or a system
dropdown is recorded.

By clicking on Any Value you can specify what action needs to be taken to continue:

Specific value 

If it is required for users to input a specific value or select a specific option in a system dropdown you should
use the specific value option. The user can type in the needed value or use the autofill button. You can decide if
the Guide should automatically proceed with "field remains active for input validation" (default setting), if it
should automatically proceed with "field becomes inactive with input validation" or if the user needs to hit the
enter key.

By clicking on Specific Value you can specify what action needs to be taken to continue:

You can also use this step type to validate user input. For more information on validation, check the
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following support article.

Hover

Use this option if the user needs to hover over an element in order to proceed to the next step. This step can
not be recorded directly and needs to be adjusted in the Editor. 

Double click

Use this if a double click is required for your application.

Drag & Drop

Use this when a user needs to drag and drop. This cannot be recorded directly. In a Userlane Guide, dragging
and dropping are two individual steps. Thus, record the step where the drag should start in the Editor and
choose “Drag” in the “Next” section. Then, record the step that the element should be dropped and choose
“Drop” in the “Next” section. 

https://docs.userlane.com/docs/add-step-input-validation
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Right click

The Guide will proceed when the user performs a right-click.

Left click mouse-down & right click mouse-down 

Sometimes a left or right click element doesn’t work. This might be the case if certain elements are defined as
mouse-down elements in the page code of your application and would not react to a regular click. In these
cases, you just redefine a step as a “left click mouse-down” or “right click mouse-down”.

Some step types can be automated. To learn more about the automation options available in Userlane,
check the following support article.

https://docs.userlane.com/docs/process-automation-via-guides
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Including skip steps in a Guide
Last Modified on 06.02.2024

What are skip steps

Skip steps can be used for navigation or based on specific user behaviors and element visibility. You can
activate skip conditions to ensure all users begin from the same starting point or skip redundant steps. The skip
steps will not show for an end-user in all scenarios. 

When to use skip steps

You can use skip steps 

For navigation

For a specific behavior or action your end-users might perform

Skip steps for navigation

Navigation steps in Userlane Guides bring users to the correct starting point for the process in your application.

Example:

From a User perspective:    

You are on the Portal.
You want to customize a color.
You are currently not in the corresponding area (Customize area).

From a Guidebuilder perspective:

You would record the Customize button and apply the “Skip if the next element is found” option. This
way, users not in the Customize area would be directed there first and then see the following step.
Users that are already in the Customize area would not see the step.

Skip steps for a specific action
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️Use the skip condition to show the step only to users who have performed a specific action. For example, your
user forgot to fill in a field or forgot to save progress before moving on with the guide.

Example:

From a User perspective:

You are on the Userlane Portal.
You changed a guide's step description but did not save it. 
You now want to start a Guide to learn more about Search.
You will see the first slide, but then immediately, it will highlight this notification: 

From a Guidebuilder perspective:

Not everyone might have forgotten to save, so you would record the “Save your changes” as a step and
apply the “Skip if the element is not found” option.

Step skip options

The following two skip options are available in step settings:

Skip if the element of the next step is found

Some steps are only necessary for the next step element to be visible. These are redundant when the element
is already displayed to the user.

Skip if the element is not found

Some elements only appear in specific situations and not for all users. Thus, the step can become redundant for
some users.

How to activate skip conditions

To apply skip conditions:

1. Select the specific step.

2. Click Skip in the side menu of the step box.

3. Select between the 2 options:
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4. Click Apply to activate your changes.

5. Once applied, you will see dotted lines around the step that contains a skip condition.

Contact your Customer Success Manager anytime if you have questions about skip logic.
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How to record a form
Last Modified on 08.02.2024

If an input field or a system dropdown is recorded, your users need to enter an input to continue to the next
step. 

ℹ️ This option is only applicable for form input fields and dropdowns. If Userlane does not detect an input
field for the step, neither Any Value nor Specific Value will be available as an option.

Why use it

Using an input field 

Guides the end-users directly through a process quickly
Saves end-users time by ensuring they fill in e.g. a mandatory field
Reduces errors that occur when end-users manually enter information 
Avoids asking the end-users to enter/remember complicated texts that can be auto-filled

Input Field Types

Userlane offers two input types for smart form field recording.

Any value means that a user can type in any text or number that they want to. That could be their name
or address in a form field or the number of working hours during their last working day. 

By clicking on Any Value you can specify what action needs to be taken to continue: 

Specific value the user has to type in something specific. This is the perfect option if you need to allow
only a specific text or number to appear in an input field. Then, your users could either type in the
specified value themselves or could use the auto-fill option. This step type has also the option to
implement a filter (Regular Expression) that would accept only specific content.  Read more about this
option.

By clicking on Specific Value you can specify what action needs to be taken to continue: 

https://docs.userlane.com/docs/add-step-input-validation
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Record an input field step

1. In Editor during the recording, click on the input field and optionally type in some value as well.

2. Stop the recording.

3. Then edit this step in Editor and check the Next selection.

4. If it is a form field, Any Value is automatically selected as the Next option. Your users now can type in
whichever value they like into the form and easily continue by clicking enter, tab, or Next button. 

5. If you would like to switch to Specific Value, choose Specific Value in Next Selection. Then you will be
asked to type the required specific value. 

6. With Specific Value, you can decide how the user will proceed after the condition has been fulfilled. A
user can proceed automatically with the input field remaining active or inactive or by hitting the Enter key.

 � When you are using Specific Value steps, check whether the specified value is the same in all
languages.
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Adding media to your Guides
Last Modified on 09.02.2024

Why use media

Adding media to a Guide step has various benefits:

Content Enrichment: Give your users additional information, tips, tricks, and/or examples. Link to
knowledge articles, other relevant websites, or another Guide.
Increase Understanding: Visualize abstract processes or concepts that may be difficult to explain
through text alone. Use images, videos, to preview the end results to help users grasp the content more
easily
Attract Attention: Use images, videos, or gifs to capture your user's attention in a specific step or slide.
Branding: Use your personalized videos or images to position your product.
Gamification & Motivation: Welcome your users with an introduction video, reward them with a GIF, or
simply make them smile. 

ℹ️  Remember that you are responsible for the content that you share. Ensure that you have the copyrights
or permissions for the media elements you use.

How to add and delete media
To add a media item to your Guide step, click on the "+" icon on the step to see the media options. 

to delete media, click on the delete icon on the step.

What can be added

You can add one media item to each step in a Guide. There are four types of media you can add:

Info Box This media type allows you to highlight important information relevant to the
context of the step. You can use an info box to provide a top tip, a warning, or any
other noteworthy details.

Link Add a link to an additional resource such as your help center, another Guide, or an
insightful blog post.

Image Images can be added via URL or file upload.
Please learn here more about recommended file formats, sizes and resolution per
use case.

https://docs.userlane.com/docs/working-with-images-in-userlane
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Video You can add a video by URL. The URL must be publicly accessible or if choosing
private option, the setting to embed the video elsewhere must be enabled and that
embed link should be used.
Example for using the URL from an embed video code, only the underlined part is
relevant to Userlane:

Multiple language versions

If you have more than one language available for a Guide step, you can choose to apply this media to all
languages versions. Enabling this option will overwrite existing media items in other languages, regardless of
the media type.

If you delete a media item, it is removed only from the language version in which you are currently working.
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Target specific text for an element
Last Modified on 06.02.2024

Why use it

You can add an element's text to the code selector to ensure accurate element identification in various
situations. By smart matching of visible text within recorded elements, it allows for precise targeting.

The content selector looks for visible text in your recorded element. If the text matches your input, the element
will be found.

ℹ️ Important

Only use this option when you can’t select the element intuitively.
You can’t use “text does not contain”. The available options are “contains” and “matches”.

How to add the text to the code selector

For Guides, access a Step and click on Refine selector step option. For Tooltips and Tags, click on the entry you
wish to edit, open the Selected element section, and click on Refine selector.

Then, open the code selector and look for "Add element text" button.

Add the element's text automatically

When Userlane detects a text, you have the option to click on the “Add element text” button. This will
automatically update the selector to include text from the element. If the button is not available or the content
of the element isn’t found, you can add and update the selector text manually.

Add the element's text manually

Add a comma at the end of the “orderNum” line 

Copy and paste this code just after the added comma:

"content": {
    "type": "contains",
    "value": "Insert your text here"
}
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Replace the “insert your text here” part with the text you want the selector to look for (e.g., “Settings”).

Click “Apply” to save your code selector.

Use the parameter "matches" instead of "contains" to select elements that have no less no more but the
exact text that is added

How to use OR and support multiple languages

If your application has more than one language and Userlane content is also available in more than one
language, it is important to ensure that the code selector covers all applicable languages.

Copy and paste this code at the value line in your selector window:

"value": ["text-first-language", "text-second-language", "etc."]

This code will do the following: If Userlane finds "text-first-language" OR "text-second-language" OR "etc." as
text in the element, then the element will be found. 

Change the placeholder texts to your different languages.



152

Refine element selection with the
code selector
Last Modified on 26.07.2024

Why use it 

The code selector allows you to fine-tune the selected element in Guides, Tooltips or Tags within your
application. By manually defining the code selector, you can ensure it finds the desired elements accurately. It
provides the necessary flexibility to adapt and adjust element identification to the unique structure of your
application.

ℹ️ Some of these settings can be implemented through the UI. Read more about refining the selector here.

How it works

You can define a code selector by manually adding:

An element class or an element ID or an element attribute

Add element text

A subSelector (e.g. for iFrames shadowDOMs)

ParentNum for a bigger element frame

Append a Tooltip to the target element

Where to find it

For Guides, access a Step and click on Refine selector step option:

For Tooltips and Tags, click on the entry you wish to edit, open the Selected element section, and click on
Refine selector.

https://docs.userlane.com/docs/refine-the-selector
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Userlane Code Selector structure
Structure basics:

Red: The value for the code selector defines the highlighted element, e.g. a DIV box or an INPUT element.

You can separate multiple elements by space or greater than character (>). Doing so allows you to go
one level deeper in the code structure (you select a more specific element within the bigger element).

Blue: The class of an element is added to the element with a dot (‘.’). If the element class has a space in
its value, use another dot instead of the space. A space would mean to go an undefined level deeper in
the code structure.

Yellow: The ID of an element is added to an element with a ‘#’ (see Example 1)

You can refine element selection with = or *=. If you apply `=`, the class, for example, must be exactly the
value that follows `=`. If you add  `*=`, the class must contain the value that follows `*=`(see Example
3).

orderNum defines the number of elements that match the code selector value. It starts with 0, so if the
orderNum is 2, the third element that matches the code selector value will be chosen. 

Example 1: General code selector structure with class and ID: 

{
"selector": "DIV.element.class > INPUT#elementid",
"orderNum": 0
}

Example 2: Code selector structure with attributes

{  
"selector": "INPUT[readonly=\"true\"].main-element",  
"orderNum": 0
}

Example 3: Code selector structure with (stable) parts of attributes or classes



154

{
“selector”: “DIV[class*=CustomerSearch__InputContainer] INPUT[class*=SearchInput__StyledInput]“,
“orderNum”: 0
}

How to manually adjust the code selector
Change the value of an element

With the rules above, you can look up any element in your browser’s developer tools and define the code
selector value. To get to the HTML code, you can right-click on the element and click at ‘Inspect’.

Example:

Add element text

You can modify the selector to ensure it chooses an element with that specific content or text. The detailed
process is described in target specific text for an element with the content selector. 

Example:

{
"selector": "label",
"orderNum": 1,
"content": {
"type": "contains",
"value": ["text-first-language", "text-second-language"]
}
}

This is a content selector with "type": "contains". Therefore, only a part of the element's text must be typed into
the code selector. If you want to make sure that an element with the exact same text written in the element is
selected, you can use a content selector with "type": "matches":

https://docs.userlane.com/docs/target-specific-text-for-an-element-with-the-content-selector
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{
"selector": "label",
"orderNum": 1,
"content": {
"type": "matches",
"value": ["text-first-language"]
}
}

Adding a subSelector (e.g., for iFrames and shadowDOMs)

SubSelectors are necessary for iFrames, shadowDOMs, or complex underlying applications where you would
like to restrict Userlane to look for the selected element only within a specific section of the web page. That
way, you can find a smaller ‘child’ element within a defined bigger ‘parent’ element. Each subSelector has the
same general syntax structure as a normal selector.

Example:

{
"selector": "IFRAME#same-origin-iframe-id",
"orderNum": 0,
"subSelector": {
"selector": "DIV.example.class",
"orderNum": 0
}
}

With this selector code, the Userlane selector would search for a DIV element with the class ‘example class’
(subSelector ), which is inside the iFrame element with the ID ‘same-origin-iframe-id’ (selector ).

Adding parentNum

ParentNum will take the selected element's ascendant (‘parent’). This is useful when you need to enlarge the
highlighted area of a specifically defined element. This is also helpful for selecting elements bigger than the
target element you want to highlight, especially when you want your Guide to appear visually more appealing.
Here is a code example with parentNum value of 2 - it selects the ‘grandparent’ element (two levels up) of the
targeted DIV-box.

Example:

{
"selector": "DIV.element-class",
"orderNum": 2,
"parentNum": 2
}

Ignoring Opacity

This is useful when some elements in your page have oppacity:0 until a user hovers over them. You can add
this to your selector if you wish to have Userlane find the element even if it's not visible to the end user.

Example:
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{
 "selector": "DIV > DIV > DIV > DIV > BUTTON > SVG",
 "orderNum": 0,
 "ignoreOpacity": true
}

Adding appendToTarget (tooltips only)

This selector helps with issues related to the z-index settings of your application. 

Z-index is a setting that decides which elements are in front on a webpage, with higher values moving
elements to the front.

We calculate the z-index of the target element to ensure that different content types, such as Hints with icons
or Beacons, are correctly displayed when end-users interact with the underlying app. However, there are
situations in which the styling of the underlying app impacts the z-index calculation. A consequence of this is
having Hints with icons or Beacons displayed on top of elements of the underlying application (e.g., modals or
dropdowns).

If that is the case, Managers can manually adjust the code selector value of the Userlane content type by
appending it to the target element. Add the “appendtoTarget”: true key-value pair to the code selector to do
that. 

Selector Example:

{
"selector": "DIV.element-class",
"orderNum": 2,
"appendToTarget": true
}

The result: 

Note: Depending on the CSS styling of the underlying app, the Userlane content types may be impacted
differently by having it appended to the target element. Therefore, we recommend testing this

Before After
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functionality using the Preview function for each Userlane content type before making the change
available to all users.

�Good to know

The code selector can only be saved when the syntax is correct. We suggest you always copy-paste the
examples from this article and then adapt the new selector so you do not forget a comma or quotes.
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Add Step input validation
Last Modified on 06.02.2024

About Data Validation

Data validation is a feature available in specific value steps allowing managers to validate users' input. The
Managers can use the data validation feature available in Userlane to ensure data quality while helping users
learn processes and complete tasks. 

Why use it

This feature will help you achieve the following results:

1. Enhance Data Quality: Utilizing the input validation option in Userlane's specific value steps allows
managers to validate users' input, ensuring accurate and reliable data for processes and tasks.

2. Improve User Learning: By implementing data validation, managers can guide users through the correct
input format or pattern, helping them learn and understand the required input criteria.

3. Streamline Processes: With data validation, you can enforce specific rules or patterns, such as validating
email addresses or enforcing password complexity, reducing errors and enhancing the efficiency of your
processes.

Examples

This functionality can be used in various scenarios - check a few examples below:

when entering your business expenses, you want to increase the data quality by asking your users to
submit the final cost using a comma (,) as a decimal separator
ensure that no empty form fields can be submitted
when collecting email addresses from various stakeholders, confirm if each entry contains @ and a dot (.)
throw a validation error if the password a user wants to use is too weak (e.g., less than 12 characters)

Ultimately, the goal is to collect correct and useful information for your processes.  

How to use this feature 

For data validation, the Managers can match the user input with a pre-defined Text or the user input with a
pattern created with the help of a regular expression (regex).

Data validation with the help of a pre-defined text

If the Text option is chosen, you can define the text users must enter to proceed. 
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If the text is not matched, users cannot continue the Guide.

Data validation with the help of a regular expression

You can define a regular expression to validate the user input if regex is chosen. The following fields are
available:

Explanation field

Use this field to explain to the users what needs to be filled out to proceed to the next step.

Regular expression
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Enter here the sequence of characters that specify a match pattern in a text.

ℹ️ To learn about regular expressions, please check the following help section.

Test field

Test your regex in this field to see if the pattern is correct.

Ask the AI to generate the regex

Ask Userlane to generate a regex following the described pattern and testing example. For example, you
can ask Userlane to generate a RegEx that accepts only email domains from your organization.

ℹ️ The "Generate" feature relies on OpenAI API, a service provided by Microsoft. No Personal Identifiable
Information (PII) or Sensitive Personal Information (SPI) is being processed when used. No prompts or
completions are stored in the model during these operations, and prompts and completions are not used
to train, retrain or improve the models.

For additional questions, please don't hesitate to contact your Customer Success Manager or our Support
team.

ℹ️ A different regular expression will be created whenever you press Generate. For example, if you only ask
for German mobile numbers to be accepted, Userlane may generate either the international or local format.
Therefore, we recommend checking and using the testing field to confirm whether the generated regex is
the one you wish to use to validate the entries.

Define text or pattern for each language

If you work with a multilingual underlying application and audience, you can define a specific text input or
regex for each language. If users complete the Guide in English, they need to type in "string A" to proceed to

https://docs.userlane.com/docs/how-to-create-a-regular-expression
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the next step, while users in German need to type in "string B".

Proceed to the next step

Managers can decide to have their users proceed to the next step automatically or by pressing the enter key.

ℹ️ Use the "Enter" key option to allow end-users more time to check what they entered in the input field.

Check Portal > Customize > Texts > Specific value steps to customize the step box design and colors.
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Translate a Guide
Last Modified on 30.01.2025

About Translation

After a Guide was recorded and language management best practices were followed, you can start translating
your Guide content. 

The guide can be translated either:

within Userlane
the Userlane Editor
the Userlane Portal

outside Userlane via export and import (XLSX or CSV) to work offline on it anytime, and import it when
ready.

ℹ️ Important

Before continuing, ensure the languages are available in Userlane by adding them from the Portal. For
more information on language management, check the following article.

Translate Guides within Userlane

Within Userlane, you can translate a Guide and its corresponding steps from the Portal or the Editor.

Translate Guides within the Userlane Editor

You can translate Guides from the Editor automatically or manually.

Automatic Guide translation

One option to translate your content is to use the auto-translate functionality. Some advantages include:

Cost savings: Automating certain parts of your processes allows users to focus on tasks that bring more
value to your organization.
Increased efficiency: Translators will provide only minor changes by double-checking the translation
before setting the Guide live.
Improved User Experience: Providing content in users' native language enhances their experience,
making it easier for them to understand and engage with the information.
Enhanced Communication: Utilizing different languages allows you to effectively communicate with
diverse user groups, including international customers, employees, or partners. It fosters better
understanding and strengthens relationships.

 ⚠️ Auto translation also has limitations and potential drawbacks, so we recommend all translations be
double-checked before setting them live.

https://docs.userlane.com/docs/record-a-guide
https://docs.userlane.com/docs/add-and-manage-multiple-languages
https://app.knowledgeowl.com/#editor
https://app.knowledgeowl.com/#portal
https://app.knowledgeowl.com/#outside
https://docs.userlane.com/docs/add-and-manage-multiple-languages
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ℹ️ To have the auto-translation button enabled in the Editor, ensure that your latest Guide changes are
saved and that you use the right language key.

To translate a Guide, open the more-menu section and click on Auto-Translate Guide.

This feature helps you translate your Guide's text from the source language to the selected target languages.
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During the auto-translation process, you cannot edit the Guide's text - a notification will be displayed once the
translation is finalized.

If you want to translate only steps, please open the step's more-menu section and click the auto-translate
button.

ℹ️ The "auto-translate" feature relies on OpenAI API, a service provided by Microsoft. No Personal
Identifiable Information (PII) or Sensitive Personal Information (SPI) is being processed when used. No
prompts or completions are stored in the model during these operations, and prompts and completions are
not used to train, retrain or improve the models.
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For additional questions, please don't hesitate to contact your Customer Success Manager or our Support
team.

Benchmark tests

Depending on the Guide's complexity and length, Userlane may need extra time to finalize the auto-translation
process. When the process is started, it runs in the background for a couple of minutes until it is finalized. 

Case Steps Languages Total time
1 8 10 0:01:33
2 8 20 0:04:03
3 15 10 0:07:06
4 5 5 0:00:14
5 10 15 0:03:45
6 3 12 0:01:11
7 12 7 0:02:30

Manual Guide translation

To manually translate Guides in the Editor:

1. After you open the Editor, access the Guide you wish to translate.

2. Click on the Language dropdown and select the Language you wish to work on.

 

Translate Guides in the Userlane Portal

To translate Guides from the Portal directly:

1. Login to Portal 

2. Select Guides from the left sidebar menu

3. Access a Chapter, and then click on the Guide you wish to translate

4. Click on the step you wish to translate

https://family.userlane.com
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5. Click on the Language dropdown to change the language you wish to translate.

ℹ️ Access the Customize section from the sidebar to edit and translate buttons and popovers.

To translate Guides from the Portal by exporting and importing texts:

You can also export the text for an individual Guide by clicking on the three dots:

This will generate a file you can work on offline and import again.

Translate Guides outside Userlane

Use the Export/Import Text feature to import your initial default texts or bulk export your texts in all active
languages to a CSV or XLSX file. You can use this file to review, edit, and translate texts, then import it to
apply all your changes at once.

To access it, go to Customize > Languages > Export/Import
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When you click Export/Import, a modal describing the export and import processes will pop up.

If you want to work with text for individual Guides and chapters, go to the Guides page and select Text
Export/Import from the corresponding Guide or Chapter Options menu.

ℹ️ Important

Any "<missing element>" placeholders in the exported text will be replaced with relevant info box
content or localized links upon re-upload. 
Modifying the file (including the original language) will apply changes after importing, even to the
original language. Delete other "language" columns to import languages in the exported Excel file. 
Identify each language using the language code in the first row (e.g., "en"). Do not delete or change
the first 2 columns.
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Process automation via Guides
Last Modified on 08.10.2024

Process automation via Guides

Some processes require a lot of steps by the user that have no deeper purpose other than navigating to the
correct place in the application or entering the same information repeatedly. 

To reduce the effort for your users, Userlane can now perform repetitive actions. 

Managers can now automate individual and sequences of steps in Guides, making the process learning
experience more efficient. Moreover, Guides can also be used to automate certain processes within your
organization.

Why use it

Automation helps you achieve the following results:

1. Efficient learning process: With automation, you can eliminate the learning steps with no other role than
navigating to the correct place in the application.

2. Increased user productivity: Help users spend less time on trivial tasks by automating parts of your
processes (e.g., opening menus or filling out standard fields).

3. Cost savings: Automating certain parts of your processes allows users to focus on tasks that bring more
value to your organization.

Examples

This functionality can be used in various scenarios:

automate certain tasks where the Userlane performs all the actions. 
For example, opening the right menu from where your user can create a new Opportunity or
Support ticket.

create Guides for various processes that will automatically fill out most of your form fields except the
ones where your input is needed.
use the automation feature to either teach users a process (delay and show the step to the user for visual
guidance) or to automate certain redundant steps (accelerate steps for faster navigation).

Use process automation via Guides with step input validation to reduce errors and increase data quality.
To find out more about validation, check the following support article.

How to use Automation 

Step automation is supported in the following step types:

https://docs.userlane.com/docs/add-step-input-validation
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Left click
Specific value
Right Click
Double Click
Left mouse button down

Once you visualize the step on your screen, look into the step settings section and click on the automate icon
(located next to step type):

Once clicked, the following modal will be shown:

Here you can instruct Userlane how to perform the steps automatically:

delay and show the step to the user - use this type for visual guidance. In that way, end users also
understand what is happening in the background.
accelerate steps - use it when you want to speed up the automation process. We recommend using it
when you wish to open for the end user a group of steps (representing menus, dropdowns, popups, or
modals) fast in the background.

Once automation is applied, you can see in the step settings that the automation icon is enabled. To disable
automation, click again on the icon and then on the "clear automation" button.
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Export a Guide as a PDF
Last Modified on 18.03.2025

Export Guides as PDFs

Not every user, content reviewer, or translator has access to your application or Userlane. To solve this
problem, Managers can share existing Guides in their original app context by having them exported as PDF
files.

Why use it

This feature will help you achieve the following results:

1. Increased efficiency: Provide visual context to your translators and content reviewers to avoid
unnecessary feedback loops.

2. Cost savings: Export your Guides as PDFs to provide visual context to your translators and content
reviewers. That way, you don't need to assign them any additional licenses to access the underlying
application.

3. Process documentation: Some organizations must document processes for compliance reasons. Simply
export a process as a PDF in Userlane, share it with your colleagues, and upload it to your knowledge
base. 

4. Improved learning process: Combine the learning process offered by Userlane with offline
documentation that can be used on-site when onboarding new employees or analyzing processes.

Examples

This functionality can be used in various scenarios - check a few examples below:

It's always great to reach out to your users in their native language. Support translators in understanding
the context of the content they translate by sharing with them the Guide exported as a PDF.
In some departments, you are required to document processes within your internal knowledge base tool.
Export each process available in Userlane as a PDF in a few clicks.
Some of your users or employees may prefer to use training materials offline (onboarding, on-site
training, meeting with prospects, etc).

How to enable this feature

To receive access to this feature, please reach out to your Customer Success Manager.

Who can access this feature

Once enabled, you can take screenshots of steps only if you are an Admin or Moderator.

How to use this feature

To export a Guide as a PDF, you must take screenshots of each step within the respective Guide.

How to take screenshots

https://docs.userlane.com/docs/translate-guide
https://docs.userlane.com/docs/translate-guide
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You can take screenshots for the whole Guide or only for certain steps.

Guide level screenshots

Access the Guide from the Editor, click the corresponding Guide Options menu, and click the Take screenshots
button.

A screenshot will be taken each time you navigate to a new step. 

A small picture icon will be shown in the Editor panel for each step that contains a screenshot:

Step level screenshots

Sometimes you wish to take screenshots only of certain steps. That could happen in the following scenarios:

you edited the Guide and wish to update the process in your knowledge base
some steps contain Skip conditions
you wish to replace the previously taken screenshot to emphasize the context of the underlying app
better

To do that, access the Guide from the Editor, click on the corresponding Step Options menu, and then on New
screenshot button.
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⚠️ After taking screenshots, click the Guide Save button. Otherwise, no screenshots will be saved, and the
previous Screenshot version will be kept for the Guide export process.

Multi-language support

You can take different screenshots for each language available in Userlane. That way, you can provide the right
visual context to your audience by connecting steps in English to the English version of the underlying app and
German to the German version of the underlying app. 

If a language does not contain any screenshots, Userlane will use the screenshots available for the default
language.

Example 

Let's assume that your Guide is in English (default language), German, and French and that the underlying app
supports only English and German.

If you take screenshots only in the German version of the underlying app:
then both English and French versions of your Guide will use the screenshots corresponding to the
German version of the underlying app.

If you take screenshots in the English version of the underlying app:
the German language will continue to use the screenshots corresponding to the German version of
the underlying app.
the English language will use the screenshots corresponding to the English version of the
underlying app.
the French language will use the screenshots corresponding to the English version of the underlying
app because English is the default language of your Userlane application.

How to export a Guide as a PDF

To export a Guide, access the Portal, open the Guides sections, and look for your Guide. Click on the Options
menu and export the Guide as a PDF.
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The Guide will be explored as a ZIP file containing multiple PDFs separated per language. Each PDF contains
metadata information such as Property name, Language, Export Date, Account, and Guide link.

ℹ️ If a Guide step does not contain a screenshot, that step will still be part of the export. However, the
visual context will be missing.

Example generated PDF with Userlane

Example PDF generated with Userlane: .

Limitations
The content located within iframes will not be shown in the screenshot.
The content located within ShadowDOMs will not be shown in the screenshot.
There is no auto-reload of Processes pages (Portal) - therefore, if the PDF Export process is in progress,
you need to refresh the page to see status changes manually.
If some pages are not properly shown in the screenshots, please contact our Support.
The old PDF Exports can no longer be accessed from the Processes page (Portal). If old screenshots are
available for the Guide, simply export that Guide as PDF again from the Portal to access the information
from the Processes page. 

21Aug_Create a Task in the underlying application_English.pdf �

https://dyzz9obi78pm5.cloudfront.net/app/image/id/64e39841daf22e67f4088c83/n/21aug-create-a-task-in-the-underlying-application-english.pdf
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Refine the selector
Last Modified on 12.12.2023

Why use it

Refine selector to configure element selection in Guides, Tooltips or Tags. By refining it, you can ensure it
accurately finds the desired element. The features available in the "Refine selector" section provide the
necessary flexibility to adapt and adjust element identification to the unique structure of your application.

Structure

The "Refine selector" contains the following 4 sections:

Element uniqueness

Selector navigation (HTML tree)

Additional selector options

Code selector

Where to find it

For Guides, access a Step and click on Refine selector step option:

https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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For Tooltips and Tags, click on the entry you wish to edit, open the Selected element section, and click Refine
selector.

How to automatically adjust the code selector

Element uniqueness

Element uniqueness check informs you if multiple similar elements are on the web page. It provides additional
information to the Managers that can be used when preparing Guides or creating and editing Tooltips or Tags. 

The check is done every time you edit the selector. Userlane takes the value assigned to the selector key, and
looks throughout the webpage to see if any other similar elements can be found. A warning will be displayed if
similar elements are found, telling you how many times that similar element was found.

ℹ️ The element uniqueness check provides additional information to help the Manager make the right choice
when preparing the content for their end users. We recommend using the Preview function and testing
thoroughly the changes to ensure the selector of an element works within the flow design for end users.

If Userlane detects multiple similar elements, it does not mean the Guide, Tooltip, or Tag won't work correctly.
For example, if the selector assigned to an element is found 3 times, Userlane will automatically add the
OrderNum key (see below for more information) to the code selector to differentiate between the 3 similar
elements.

Navigate selector

Navigate the HTML element tree to refine the selector - expand the tree view and adjust the selected element.

https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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The impact of the changes is shown live to help Managers better understand if the new selector fits their
needs. 

Selector options

Two options are available here:

Order Num: it determines which sibling element is selected. 
Parent Num: it allows you to increase or decrease the size of the selected area.

Code selector

The code selector allows you to fine-tune the selector. You also have the possibility to refine the selector
further by adding the element's text to the selector. For more information, check the following article on
refining the selector with the code selector. 

FAQs

When are the changes applied?

You can see in the Editor mode the impact of your changes. Click on "Apply changes" to save the updated
selector.

What is the difference between ParentNum and Element Tree?

Navigate selector is used to navigate to the top or bottom of the element tree, while Parent Num allows you to
increase the size of the selected area. You can combine both by going down the element tree to select the
smallest element and then applying Parent Num to go back to the element you wish to select. That way,
Managers can increase a selected element's uniqueness.  

Limitations

1. Navigate selector and Selector options sections will be disabled if the selector cannot be found on the page.

2. Navigate selector and Selector options sections will be disabled if subSelector key is found in the code
selector. The subSelector key is added automatically by Userlane when recording elements inside iFrames or
shadowDOMs.

3. The element uniqueness check focuses only on the selector key. It does not take into account other settings
that can be added to refine the code selector. For more information, see: Refine element selection with the code

https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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selector article.

4. The element uniqueness check looks through similar elements in the HTML tree. Meaning that it will not
check for similar elements inside dropdowns or modals if those are not yet displayed in the HTML tree. 

5. Order Num calculation does not take into account Parent Num. It searches for the siblings of the selected
element by looking only at the selector key.
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Tooltips
Last Modified on 21.06.2024

About Tooltips

Tooltips allow you to explain and highlight elements of the underlying application. 

Using Tooltips, Managers can provide process-related information to users to help them complete certain
processes or show them new features by grabbing their attention with the help of a pulsating icon.

Who can create a Tooltip?

There is a single Tooltip edit mode to create, save, edit, and publish all in one view in the Editor.

Admins and Moderators can create, save, edit, and publish Tooltips in the Editor. Contributors can do almost
everything, except that they cannot publish tooltips or edit or delete already live tooltips.

Record a Tooltip

To record a new Tooltip:

1. Select Tooltip from the Create dropdown in the Editor. If you are already on the Tooltip tab, you can click
Create.

The Editor is minimized in the bottom left of your screen.
2. Select the target element for the Tooltip, e.g., a button, input field, or menu. A description input box

displays.
3. Type a helpful description of the element.

4. Define the settings. You can add choose the Tooltip type, can reselect an element if needed, set a
segment, link it to a Guide, and choose the publishing language.                                                                       

    5. Save the Tooltip. 

https://docs.userlane.com/docs/add-and-manage-multiple-languages
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Tooltip Type

You can choose either Hint or Beacon as Tooltip type depending on your use case.

Hints are used to display the content on hover. They can provide additional information to help users
finalize a process or explain unknown words, features, or specific error messages. 
Beacons are animated icons that display the content on click and disappear after the interaction. They are
used to draw the user's attention to a new feature or change in the underlying application, or they could
be used as a call to action (e.g., to ask end users to report a bug in case an alert pops up).

ℹ️ The state of a beacon is stored in the web browser's local storage. If a user clicks on a beacon, that
beacon will not be shown to him as long as the same web browser is used.

Set icon (only for Hint)

You can choose whether the hint becomes visible only after the user hovers over the selected element or
whether there is a help icon (i) next to the element that the user can hover over to make the hint text
visible. You can set this up in Editor under the Icon tab:

Set icon positioning

If you decide to use the help icon, you can position it in 2 modes: 

automatic (default): the icon's position is automatically determined by Userlane.

manual: manually select the icon position from eight positions, including four internal ones (inside the
element).

Icon color setting

You can set the color of the hint and beacon icons to match your corporate identity or the individual app
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palette.

The color setting of your icons can be adjusted in Customise > Design screen in the Portal.

Tooltip Segment
Page Segmentation and User Segmentation

Show the Tooltip only to the relevant group of users, e.g., based on user behaviour. 
Choose where the Tooltip will be shown with the help of page segments.

Add a Guide

Managers can link a Guide (from any step) to a Tooltip to help users learn the processes based on context and
finalize them more confidently. Guides can be connected to either Hints or Beacons.

https://docs.userlane.com/docs/user-segmentation
https://docs.userlane.com/docs/user-behavior-segmentation
https://docs.userlane.com/docs/page-segmentation


181

When a Tooltip is shown on the page, Userlane determines whether to show the linked Guide based on the
following two criteria:

 the status of the Guide (published or unpublished)
 the segmentation of the Guide

Translate a Tooltip

You can translate Tooltips within the Editor or outside Userlane.

Translating Tooltips within Userlane

You can translate Tooltips from the Editor automatically or manually.

One option to translate your content is to use the auto-translate functionality. To do that, open the more-menu
section and click on Auto-Translate Tooltip.

Follow the instructions available in the Editor to translate your Tooltip's text from the source language to the
selected target languages.

During the auto-translation process, you cannot edit the Tooltip's text. A notification will be displayed once the
translation is finalized.

ℹ️ The "auto-translate" feature relies on OpenAI API, a service provided by Microsoft. No Personal
Identifiable Information (PII) or Sensitive Personal Information (SPI) is being processed when used. No
prompts or completions are stored in the model during these operations, and prompts and completions are
not used to train, retrain or improve the models.

For additional questions, please don't hesitate to contact your Customer Success Manager or our Support
team.

Translating Tooltips outside Userlane

Use the Export/Import Text feature to import your initial default texts or bulk export your texts in all active
languages to a CSV or XLSX file. You can use this file to review, edit, and translate texts, then import it to
apply all your changes at once.

To access it, go to Customize > Languages > Export/Import
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When you click Export/Import, a modal describing the export and import processes will pop up.

Language Management

Sign into Portal > Customize > Languages 

you can see if there are any Tooltips related to a language.

Tooltips are part of the content that can be published or unpublished via one action under this tab.

Tooltip content is removed if the corresponding language is deleted.

Element Status

A tooltip will show a notification with an orange dot in case the element is not visible on this page:

How to update and maintain Tooltips

In time, you will have dozens or hundreds of Tooltips published simultaneously. Userlane contains different
features that help Managers easily find the Tooltip they wish to edit.

Tooltips naming

When you create a Tooltip, Userlane will grab all relevant information associated with the selected element
and assign it to the Tooltip name.

Example: button 'Dashboard' Tooltip 16 Nov, 18:02

You can edit the Tooltip name anytime - we recommend doing that after you decide on a pattern you wish
to follow with your team. For example, you could also add the page or process to the Tooltip name.

Tooltips search

Use the search functionality on the top of the Editor to find the Tooltip you wish to edit. Userlane filters the
results by looking at the Tooltip name and text description.
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Tooltips available on current page

To find the Tooltip you wish to edit, you don't have to go through the entire list of Tooltips available in the
Editor. You can click on "Show on current page" and Userlane will filter for you the Tooltips that can be found
on that page.

Tooltips that are hidden behind a modal or dropdown won't be made available using this feature. For that,
we recommend the method below, which also provides more contextual information to the editors.

Edit Tooltips on the spot

To find the Tooltip you wish to edit or improve, you need to see what your end-users see. 

When the Editor is minimized or in the Preview mode, navigate the underlying application, find the Tooltip you
wish to edit, hover over the textbox, and then click the settings button. Userlane will redirect you to the Tooltip
you want to edit, allowing you to edit the Tooltip text and settings on the spot.
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Tags
Last Modified on 10.09.2024

About Tags

A Tag marks a single element that should be tracked to measure users’ interaction with that element within
the underlying application. For example, you can track interactions with buttons that indicate an important
interaction, such as “Submit” or “Finish”. 

The tracking results are shown in the Portal under the Task Success page. There, you can understand if users
complete tasks or interact with important features of your application. 

ℹ️  To see how you can use the information available in Task Success to reduce support effort and increase
productivity, please visit the following section.

Who can create Tags?

Tags can be created and edited from the Editor. The new feature can be accessed by Admins and Moderators.
Contributors do not have access to Tags-related actions in the Editor.

Create a Tag

To create a new Tag:

1. Select Tag from the Create dropdown in the Editor. If you are already on the Tooltip tab, click Create.

The editor is minimized in the bottom left of your screen. You can press once CTRL to pause recording mode to
find elements located in dropdowns or modules.

2. Select the target element for the Tag, e.g., a button or menu.

3. Define the Tag settings.

Userlane will automatically assign a name to the Tag which includes details about the selected element.

https://docs.userlane.com/docs/task-success
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You can edit the Tag name anytime.
You can reselect an element or manually adjust the Code Selector. 

4. To start tracking, first, save the Tag and then click Activate Tracking. You can also only save the Tag and
later activate it either from the Tag or from the Tags view list.

⚠️ To start tracking the tagged elements, you must have Advanced analytics enabled in Analytics privacy
settings. You will also be warned in Tags list view if the setting is not enabled.  

ℹ️  Check the following section to learn more about what needs to be considered when implementing Tags
in your underlying application. 

Test a Tag

To test a Tag without having it activated first, follow these steps: 

1. Click the Test Tag button.
2. Click on the target element.
3. Confirm if tracking information is sent to Analytics.
4. Result: A green popup appears in case of successful tracking confirmation. It confirms that tracking

information is sent to Analytics.

Manage Page Segmentation

You can use page segments to show Tags only on a specific page or pages (URLs). To learn more about page
segmentation, continue reading the following section.

https://docs.userlane.com/docs/analytics-privacy-settings
https://docs.userlane.com/docs/how-to-tags
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To manage page segments, click the Manage page segments link available in the Editor, and you will be
redirected to the page segmentation management section in the Portal:

there, you can see the existing page segments and their usage
you cannot delete a page segment that is still being used by a Tag or any other content type

Element Status

A message will be shown in the Editor view in case the selected element is not visible in the current view.

How to update and maintain Tags

In time, you will have dozens or hundreds of Tags active. Userlane contains different features that help
Managers easily find the Tags they wish to edit.

Tags naming

When you create a Tag, Userlane will grab all relevant information associated with the selected element and
assign it to the Tag name.

Example: button 'Create' Tag 16 Nov, 17:02

You can edit the Tag name anytime - we recommend doing that after you decide on a pattern you wish to
follow with your team. For example, you could also add the page or process to the Tag name.

Tooltips search

Use the search functionality on the top of the Editor to find the Tag you wish to edit. Userlane filters the results
by looking at the Tag name.

Tooltips available on current page

To find the Tag you wish to edit, you don't have to go through the entire list of Tags available in the Editor. You
can click on "On current page" and Userlane will filter for you the Tags that can be found on that page.
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Tags that are hidden behind a modal or dropdown won't be made available using this feature. 
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Create and activate
Announcements
Last Modified on 18.03.2024

About Announcements

Announcements are powerful push messages delivered through the Userlane Assistant within your
application. With Announcements, you can directly communicate with your users and involve your audience
early on. 

With Announcements you can

Communicate anything you want to your users directly in your app
Get insights on the actual users’ needs, verify initial concept and goals
Fill the gap within the content concept phase with relevant information and involve your audience at an
early stage

When to use it

Before Rollout of Userlane:

presenting and promoting Userlane as additional resource for support

After Rollout of Userlane:

promoting specific Guides 
sharing resources, e.g. link to release notes, new URLs, best practice articles
Share generic application-related information, e.g. downtime, responsible person shift, updates
Share generic information, e.g. company news, reminder 

Who can create Announcements?

Admins and Moderators can create, save, edit and publish Announcements in the Userlane Portal.
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Contributors can do almost everything, except that they cannot publish the announcement.

Create an Announcement

Go to your Userlane Portal. Navigate to Messages > Announcements.

Follow the steps.

Once you activate the Announcements for your end-users, the Bell icon appears in your Assistant.
Through this bell, they will be able to reach the Announcement menu to find older announcements. 

If you are not seeing the Announcement button within your Assistant, make sure to enable it in the Portal
under Customize > Assistant.

Let's dive into the details
Announcement Status

If you publish an Announcement, set it to private, and publish it again; it will only pop up for the users
who didn't see it the first time.
Once an Announcement pops up for a user it is considered as pushed. It won't pop up again for them. 
"Draft" refers to an Announcement that has never been published, while "used" refers to an
Announcement, that was public once but not anymore. 

Pushing more than one info at a time

When a user is targeted for more than one Announcement for the first time they will see the last
published Announcement first. Then they can click through the rest.
Announcements vs. Promotions: Announcements and Promotions will never get mixed up.
Announcements have a higher priority than Promotions.
Announcements vs. Welcome Slide: the Welcome Slide is seen as an introduction element into the
overall Userlane offering. When enabled, it will always be shown first when the user is targeted with any
Userlane content (including Announcements) for the first time. 

Adding and linking different content

Images should be a maximum of 8 MB with a 4:2 ratio, and a recommended resolution of 326x160px.
View more details on image requirements for your different content types in Working with images.

https://docs.userlane.com/docs/working-with-images-in-userlane
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If you link a Guide to an Announcement, we'll inherit that Guide's segment (yes you can also segment
your Announcements!). However, you can change it. 
For users who can see the Announcement, but should not actually play through the linked Guide (e.g. not
segmented for the user to see), we won't show the link button.

Translating Announcements

The easiest and fastest way to translate your Announcements into your target languages is to use the auto-
translate function located to the right of the language selection dropdown.

After clicking the auto-translate button, your texts will be automatically translated into the target languages
you have added to your Userlane Portal under Customize > Languages. If any of the language codes are
incorrect, texts for that language will not be translated and the Announcement will be blank.

Auto-translate is also available for NPS and Surveys!

After using auto-translate, you can then check the translations by selecting a language from the dropdown. If
you need to send the translated texts to a local market for review, you can also export all texts on
the Customize > Languages page.

If you prefer to manually translate your Announcements, you can do so by switching between languages in the
Announcement creation form or by exporting the source text and then importing your translations.

ℹ️ When using the export/import option, make sure you don't delete or adjust any of your source text as
these changes will also be imported.

Note that you can only publish an Announcement for a certain language after text has been added.

Considerations

Don’t activate too many Announcements in parallel for your users, especially not for the same page segment.
The more Announcements you stack, the less your users will interact with them.
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ℹ️ Important

If there are no Guides shown to a User because of their Segmentation but there is an Announcement
active, the User will still see the Assistant with empty Guide list but with the Announcement in the
Announcement list.
Even if the Announcement menu is deactivated, if you publish an Announcement it will be pushed to
the desired user segment. This makes it very easy to test and communicate information.
When updating an existing announcement, a user who has already seen the announcement before,
will not see the pop-up again. The user can review “seen announcements” though and see the
updated announcement there.
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Welcome your users with the
Welcome Slide
Last Modified on 12.01.2024

About the Welcome Slide

The Welcome Slide is a pop up grabbing your users’ attention right from the start to promote your Guides and
get them immediately started on them.

It will result in greying out the background and puts the focus on the pop up: 

How to activate it

The Welcome Slide settings and the activation toggle is located in the Customize - Welcome Slide section of
the Userlane Portal. 

Elements of the Welcome Slide

The Welcome Slide can consist of the following elements:

the avatar image
a description
an image 
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a button to immediately start the first guide
an option to close the welcome slide

The elements can be set or activated/ deactivated in the Welcome Slide settings. 

How to use it
To introduce your users to Userlane and raise awareness for the Assistant.
To ensure the users immediately start with the guides.

Who sees the Welcome Slide

After the Welcome Slide is enabled, anyone who goes to the page where Userlane is running will see the
Welcome Slide.

It will only pop up once per user (except for when cookies are not saved anymore).

 � If the Welcome Slide is disabled and only enabled later, all users will see the Welcome Slide as it is the
first time them seeing it.

� The Guide starting from the Welcome Slide will always be the first Guide available for that end-user in
the Assistant.

Best Practices

Tell your users what the Assistant button is and what benefit it offers. You could write that those tours
will guide them through the platform. Users can access the tours at any time through the Assistant icon in
the respective edge.

We recommend adapting the wording and style of the Welcome Slide to your corporate identity. Your
users will feel more attached to your style and can relate to you as a company providing the Guides.
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Create and activate NPS
Last Modified on 04.03.2024

Why track the NPS with Userlane? 

Userlane provides you with the tool to set up and automate your NPS. Asking the right user at the right time
directly in the application provides higher response rates than e.g., doing so through email. With Userlane you
can target a specific user group with the survey. We do all the calculations for you and are able to track the
NPS over time, read users’ comments and filter the results by user segment.

Setup

To create an NPS survey for your app, go to the Messages menu in the Portal and click on 'Create a Message',
then choose the NPS option.

NPS survey behaves like an Announcement, it is displayed for the user automatically. Userlane collects and
analyzes the results, which you can view in your Analytics.
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Benefits
Easy, automated tool for collecting users' opinions in predefined cycles

With Userlane, you activate a single NPS survey which is displayed in predefined cycles. The NPS survey is
hidden from users once they respond to it. These users will be targeted automatically again in the new cycle.

 ℹ️ NPS will run in cycles until you deactivate it or until the end date is reached.

Automatic reminders for users that have not responded 

NPS will remain in the Announcement list in the Userlane Assistant if a user did not respond yet. You can set
up a reminder with desired frequency to nudge these users, so the NPS pop-up is displayed for them again.
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Create and activate Surveys
Last Modified on 18.10.2024

About Surveys

Understanding how well users adopt your application is at the core of Userlane's mission, and the ability to
measure user satisfaction plays a key role in this.

This tool allows you to ask any question and publish multiple surveys simultaneously across different pages
and user segments within your application.

With the emoji-based scale, survey participants can easily provide feedback by selecting one of 5 emojis
representing different sentiments. The leftmost emoji corresponds to the lowest rating, and the rightmost to
the highest. This user-friendly, easy to use system allows for quick responses, encouraging engagement and a
high participation rate.

Setup

Overall, the process is similar to setting up an NPS Survey or an Announcement.

To create a new Survey for your app, go to the Messages page  in the Portal and click on 'Create a message',
then choose the Standard Survey option.



198

First, you can decide between an Emoji and Star rating scale, depending on your needs.

Then enter your question and the score labels, as well as the ‘Thank you’ message for your users.

You can translate the Survey into other languages by switching the Language.

You can decide who should participate in the Survey by setting up a dedicated User Segment. If you want to
display it on specific pages only, select a Page Segment. You can also specify the activation date of the Survey
and how often you want to send reminders to users who haven't responded to it yet.
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Remind Users & Repeat Surveys

In the 'Schedule your survey' section you can choose to remind users who have not yet responded to the survey
with a certain frequency. By default, users will be reminded about Surveys every 3 days.

You can also schedule Surveys to repeat at certain intervals. This is a great way to automatically collect
responses on the same questions over time and check for similarities and differences. By default Surveys are
not set to repeat but you can select a repeat frequency from the dropdown.
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Supported ISO codes for Content
Auto-Translation
Last Modified on 20.11.2023

The auto-translation feature available in Userlane supports the following ISO 3166-1 codes:

Code Language
am  Amharic
ar  Arabic
az  Azerbaijani
be  Belorussian
bg  Bulgarian
bn  Bengali
br  Breton
bs  Bosnian
ca  Catalan
cs  Czech
cy  Cymraeg
da  Danish
de  German
dv  Dhivehi
en  English
es  Spanish
et  Estonian
eu  Basque
fa  Persian
fi  Finnish
fr  French
gl  Galician
el  Greek
ha  Hausa
he  Hebrew
hi  Hindi
hr  Croatian
hu  Hungarian
hy  Armenian
is  Icelandic
it  Italian
id  Indonesian
ja  Japanese
ka  Georgian
kk  Kazakh
km  Khmer
ko  Korean
ku  Kurdish
ky  Kyrgyz
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lt  Lithuanian

lv  Latvian
mk  Macedonian
ml  Malayalam
mn  Mongolian
mr  Marathi
ms  Malay

nb  Norwegian Bokmål

nl  Dutch

nn  Norwegian Nynorsk

no  Norwegian
pl  Polish
ps  Pashto
pt  Portuguese
ro  Romanian
ru  Russian
sd  Sindhi
sk  Slovak
sl  Slovene
so  Somali
sq  Albanian
sr  Serbian
sv  Swedish
sw  Swahili
ta  Tamil
tg  Tajik
th  Thai
tr  Turkish
tt  Tatar
ug  Uyghur
uk  Ukrainian
ur  Urdu
uz  Uzbek
zh  Chinese
vi  Vietnamese

Note: If your language is unavailable on the list, let us know by reaching out to your Customer Success
Manager.
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Add and manage multiple
languages
Last Modified on 15.03.2024

About Managing Languages

In Userlane you can manage languages and translations both directly in the Userlane Portal and Editor as well
as offline by exporting and translating texts in a .csv or .xlsx file, then importing them back into Userlane.

In this article we'll cover the following topics:

adding and publishing languages
auto-translation
manual translation
best practices

Adding and publishing languages

You can create a new language in the “Customize” - “Languages” section of the Portal. Please note that
Userlane follows specific priorities to detect which language is shown to end users, as outlined here.

The language name is displayed to identify the language. 

The language key will be compared to the HTML and browser languages in order to automatically detect
the language. It typically consists of the first two letters of the language name (e.g. English = EN) or 5
letters (e.g. American English = en-us). 

Use the following ISO codes to organize your languages 

The Copy-From option allows you to decide which language the texts of your new language should be
copied from. This helps you to write the correct translations later. 

If you no longer require a language, you can archive or delete it. 

Archived languages cannot be published for any content but can always be moved back to the
current languages. 

Deleting a language will also remove all content associated with that language.

Publishing languages

After creating a language, you can work in this language and publish it.

Publish a language for all existing content in the “Customize” - “Languages” section via the dot menu
next to the language you want to publish. Make sure you have existing texts in this language before
publishing them here.

Publish a language for specific chapters or Guides only in the manage section using the options next to
the respective Guide/chapter. This allows you to translate and publish your Guides in a new language
step by step. Make sure to activate a language for the chapter and for the Guide to show the chapter title,

https://app.knowledgeowl.com/#add
https://app.knowledgeowl.com/#auto-translation
https://app.knowledgeowl.com/#import
https://app.knowledgeowl.com/#bestpractice
https://docs.userlane.com/docs/userlane-language-detection
https://docs.userlane.com/docs/supported-iso-codes-for-content-auto-translation
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subtitle, and Guide texts in this language.

Be mindful to ensure texts are updated in all public languages before setting content live.

� Good to know

We support right-to-left languages like Hebrew or Arabic, but adjusting formatting for right-to-left
is not currently available.

Auto-Translation

You can use Userlane auto-translation for both Guides and Messages to quickly and easily translate content
into your target languages.

Entire Guides or individual Guide steps can be auto-translated in the Userlane Editor. For more detailed
information, please refer to this article.
Messages content (Announcements, Standard Surveys, and NPS Surveys) can be auto-translated in the
Userlane Portal when you create or edit Messages. 

ℹ️ The "auto-translate" feature relies on the OpenAI API, a service provided by Microsoft. No Personally
Identifiable Information (PII) or Sensitive Personal Information (SPI) is being processed when used. No
prompts or completions are stored in the model during these operations, and prompts and completions are
not used to train, retrain or improve the models.

For additional questions, please don't hesitate to contact your Customer Success Manager or our Support
team.

Manual Translation

You can also choose to manually translate your Userlane content in the Portal or Editor, or by exporting your
texts, translating them offline, and then importing the translations back into Userlane. 

We recommend having a dedicated process for translations involving the export/import approach and that you
regularly export your texts after bigger changes, so you can better track your work.

To translate your content into different languages, you can use our text import/export feature: 

Download all your existing texts 

Download texts for a specific chapter or Guide only,

update the texts for each language, and 

upload the new file. 

You can use excel (XLSX) or comma-separated values (CSV) formats for export and import. 

https://docs.userlane.com/docs/translate-guide
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ℹ️ Important

Any "<missing element>" placeholders in the exported text will be replaced with relevant info box
content or localized links upon import. 
Modifying the file (including the original language) will apply changes after importing, even to the
original language. To import languages, delete other "language" columns in the exported excel file. 
Identify each language using the language code in the first row (e.g., "en"). Do not delete or change
the first 2 columns.

Best Practices
Choose a fallback language

Let's say you created two languages: English and French. We will match the corresponding language
automatically for every French and English-speaking end user. To cover every other language, like German or
Spanish, you can define a general fallback solution for every chapter or Guide.

Show the default language instead (Your Default Language). This option will show the text in the
default language you defined in the “Customize” - “Language” section for all those users that don’t have
a matching language.

Hide content for those users completely. This Guide will not appear in the Assistant for users without a
matching language.

Where to edit the language for each content type

Portal Editor Language Export/Import
Guides yes yes yes 

Chapter Titles yes no yes
Welcome Slide Text yes no yes

Messages yes no yes
Tooltips no yes yes

Default Texts yes no yes
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Userlane Assistant Help
Last Modified on 12.01.2024

About Assistant Help

The Assistant Help option allows you to add two links to additional resources such as a help center, support
chat, or a communication platform channel such as Slack or MS Teams. Enable the Help button to link users
directly to these resources without leaving your application.

Add and enable links

We display two default use cases for the links but you can provide links to any resource that you think would
be most helpful to your users. Remember to change the default texts of the links if you are linking to resources
other than documentation or your application's support. See Customize the Help option, below.

To add a link:

1. Go to Customize > Help in your Userlane Portal.
2. Enter the full URL of your link in the Documentation Link input field, e.g. https://docs.userlane.com.
3. To add a second link, enter the full URL in the Support Link input field.
4. Once you are ready to activate a link for your users, enable the corresponding Display Link toggle.

ℹ️  The Help button in the Assistant is only displayed to users if you have enabled at least one link.

Customize the Help option

To edit the default texts for the title and links:

1. Go to Customize > Texts in the Portal.
2. Locate Assistant in the right sidebar, then select Help.
3. Enter the new text in the dashed input fields for the title and link labels as needed.

https://docs.userlane.com
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4. Click Save Your Changes.

To change the default Help image:

1. Go Customize > Design in the Portal.
2. Locate Help Desk in the right sidebar, then click Upload Image.
3. Drag an image file to the upload window or click Select File to choose an image from a storage folder. A

preview of the Help window displays.
4. Click Save Your Changes.

ℹ️  You can upload a PNG, JPEG, or GIF file with a maximum size of 8MB. The recommended image
proportions are a 4:2 ratio and 652x320px resolution. See more about how Userlane displays your
images in our Working with images article.

https://docs.userlane.com/docs/working-with-images-in-userlane
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How to test your Guides before
publishing
Last Modified on 12.01.2024

There are several ways to test your Guides depending on the functionality you are testing and where you are in
the rollout stage. 

Here is what you can do:

1. Preview a single Guide

With the Preview mode, you can test the functionality of a specific Guide and preview changes before saving
them. Only people with access to the Userlane Editor can start the preview.

To preview a single Guide:

Open the Guide in the Editor and click on the preview button.

2. Send out the Guides via link

You can test Guides by sending a link to any user. The Guides need to be set to public and the Userlane snippet
implemented. They won't be visible to your end-users and can be kept private. Testers don't need access to the
Userlane Portal.

To test Guides via a link:

Ensure that the Guide is set to public and the chapter is private. The Guide won't appear in the Userlane
Assistant but can still be sent via link.

3. Partially implement Userlane

Some users can test the entire Userlane training experience. This method is useful for training employees on
third-party applications. You can test the Userlane Assistant with a small group of users who don't require
access to the Userlane Portal.

To partially implement Userlane:

To test Guides and chapters, set them to public in the Userlane Portal.

Then, share this link with your test users to register and download the Userlane Browser extension:

https://go.userlane.com/31610/21116
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family.userlane.com/mll.

Once they have the extension installed, testers will see the Userlane Assistant when using the relevant third-
party applications.

4. Test your Assistant in a staging environment

Test the whole Userlane Assistant in your staging environment before you implement Userlane into your
production environment. The Userlane snippet has to be implemented only into your staging environment. 

To test in a staging environment:

Set at least one Chapter and one Guide to public in your Userlane Portal. Since Userlane will only appear when
the snippet is implemented, the Userlane Assistant will only appear in staging, not in production. 

5. Test only some Guides and functionalities in a staging environment

The Userlane snippet must be implemented into your staging environment. It can also be implemented into your
production.

To test new Guides in a staging environment:

If you already have the snippet implemented in staging as well as production, do the following: 

1. When implementing your snippet into the staging environment, add the following code line (with your
respective user_ID) just before the init command into the Userlane snippet:

Userlane('identify','user_ID',{staging:true});

2. After doing this, create an Attribute in the Userlane Portal with the attribute name 'staging' and the data
type 'boolean'.

3. Filter your user list based on this attribute with 'staging'  'equals' 'true' and save it as a segment that you
e.g. name 'only for staging'.

4. Apply this segment to all the chapters and Guides that should only appear on your staging for now.

After applying the described segmentation, set all the chapters you want to test to “public” so they appear on
your staging page.

6. Testing user and attribute segmentation

Once you've applied a user segment based on user ID or specific attributes, you can check if the segmentation is
working correctly. Simply use your browser's console, provided you have the snippet implemented, to easily
verify the segmentation.

1. Open the browser's console by clicking the right mouse button on the page and selecting the option

http://family.userlane.com/mll
https://go.userlane.com/31610/21117
https://go.userlane.com/31610/21114
https://go.userlane.com/31610/21116


211

"inspect" from the menu that appears and then selecting "console" in the new section that opened.

In the console, you can enter commands that will allow you to change some Userlane settings which is
helpful for testing.
 

2. In order to test the behavior of Userlane with a specific user ID, you can enter the following command into
the console and press ENTER. The green part needs to be replaced with your own value:

Userlane('identify', 'yourTestUserID');
Now, you'll see what Chapters, Guides, and Announcements this specific User sees. Remember, some
notifications only appear once per user. After page reloads, the User will return to their original state.

3. You can use the console to emulate not only a user but also some attributes. To do that, please add the
following line in the console and press ENTER:

Userlane('identify', 'anyTestUserID', {  attribute_key: 'example_value' });
This will show you the Chapters, Guides, and Announcements visible for Users with a given Attribute.

4. Also for checking languages, you can utilize the console. To test Userlane for a specific language setting,
you can enter the following line to the console (we used English in the example: EN):

Userlane('lang', 'EN');
This will change the language of your Userlane so you can test if all texts are in place and translated.
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Userlane Assistant Checklist
Last Modified on 18.01.2024

Use the checklist to make sure you and your users can see Userlane. Userlane's targeting settings can prevent
users from seeing Userlane. 

Here is what you can do:

1. Make sure Userlane is loaded in the correct application

Userlane can be loaded in your application via the implementation of the Userlane snippet or via the browser
extension. If you only use the browser extension, for now, ensure that you are signed in to the Userlane Portal
and that the application URL under Settings > Application URLs is correct. Refresh your application page after
any changes.

2. Make sure that you have a public language

Go to Customize > Languages and make sure that at least one language is public. Only public languages are
shown to your users.

3. Add Guides to a public Chapter

Add at least one public Guide to a public chapter in the Manage section of Userlane Portal. Guides in the
"Unsorted guides" folder are not part of a chapter.

4. Make sure that your segmentation is set up

Open the segmentation options by clicking on the three dots next to a chapter or a Guide. Select Edit
Segmentation. Make sure that the user profile you use in your application matches these segmentation
settings. Note that the chapter segmentation affects all Guides within this chapter. 

5. Enable Userlane for your Application

Select Settings and confirm that the Userlane toggle is enabled on the General Settings page:
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Please note that Userlane will be shown on all pages and URLs where the Userlane snippet is implemented. If
the snippet is not implemented yet you can use the Userlane browser extension to test and build your Guides.

6. Activate Guide List

To ensure that your Guides are available from the Assistant, Go to Customize > Assistant and confirm that the
Activate Guide List toggle is enabled:

7. Your page is blocking Userlane

Sometimes the Userlane elements are not loading properly due to a Content Security Policy (CSP) or CORS
(Cross Origin Resource Sharing) Policy running on the underlying app and blocking unfamiliar sources. An
indicator of this is usually a red error in the browser console where CORS or content security policy is
mentioned along with Userlane. If this is the case, please share with your developers this article.

ℹ️  CSP is an added layer of security that helps to detect and mitigate certain types of attacks.

8. Allow 3rd party cookies

Some browsers block 3rd party cookies by default, including the ones coming from Userlane. This will block
some of the Userlane elements. You can check if this is the case by allowing all cookies in your browser
settings (only for the sake of testing). If this has solved the problem, you can put your app's and Userlane's
domain ([*.]userlane.com) in your browser's "3rd party cookie allowed list" and switch the main cookie setting
back to default. You may need to ask your colleagues in IT for help.

https://docs.userlane.com/docs/implementation-options-snippet-or-browser-extension
https://docs.userlane.com/docs/which-hosts-to-allow-in-your-content-security-policy-csp-for-userlane
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9. Clear your Cache and Cookies

At times previous website settings and histories impact how good websites run. After the browser history for
all time is cleared, sign in to the Userlane Portal again and refresh your application page.

10. Install Userlane Browser Extension via Invitation

If you are using Userlane with the Browser Extension, please make sure that you activated and installed the
extension via the invitation link you received per E-Mail or the activation link that was shared with you. A
separately installed extension will not recognize you as a user. 

11. SSO installation

If Userlane was implemented via SSO (Single Sign On) which usually is preconfigured by your developers, for
issues that could not be solved with the points above, please get in touch with your Userlane Customer
Success Manager.  

12. Contact us

Should none of the mentioned points before solve the behaviour, please do not hesitate to reach out to our
Support Team.

https://docs.userlane.com/docs/sso-implementation
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Share Guides directly with a link
Last Modified on 04.03.2024

Why use it

Use a link to direct your users to a specific Guide. Each Guide has one unique ID.

You can use this link for all your users; when clicked, they are redirected to the default URL that you have set
up in the application settings. The linked Guide starts at the default URL.

Where to find it

Click on the Guide and then on Triggers:

How to trigger a Guide on a different URL

You have 2 options:

Option 1)

Add this to the trigger link: "?redirectTo=thespecificURL". Replace thespecificURL with the URL where you
want the Guide to start.

Example:

https://go.userlane.com/31610/21112?redirectTo=www.family.userlane.com 

Option 2)

Add "?userlaneStart=12345" to your URL. Replace the number 12345 with the ID of the Guide you want to
trigger.

� Good to know

Guides can be triggered by a link if the snippet has been added to your source code or in browser
extension implementation cases as long as the recipient is authenticated as an end user (via SSO or
user import).
You can include the link in your help articles, in emails, or send them via your support chat.
If you have different subdomains for different clients, you will need to adapt the URL for each of them
as explained above. 

https://go.userlane.com/31610/21112?redirectTo=www.family.userlane.com
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Please note that some applications define specific redirect URLs. In such cases, you might get
automatically redirected to a different URL as defined in redirectTo. This is a setting on your
application and can not be adjusted by Userlane.
For Option 2: if your URL contains a hash character (#), you need to add the Userlane code before the
hash, example: www.example.com/?userlaneStart=12345#/contact/ 

How to start a Guide with a custom JavaScript trigger

Read this article to learn how to start a Guide with a custom trigger.

https://docs.userlane.com/docs/start-startonce-trigger-a-userlane-in-your-code
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Promote your Guides
Last Modified on 20.11.2023

Why use it

With the Userlane Promotion feature, you can highlight important processes and features of your app in a
Guide. The users will see a pop-up next to the Userlane Assistant avatar and can decide if they directly want to
start the promoted Guide or close it for later.

By using guide promotions, you can 

increase user engagement, 
improve user understanding and adoption of key app functionalities, 
provide a valuable and guided experience for your users. 

It helps users discover and navigate through the app effectively, ensuring they make the most of its features.
Ultimately, guide promotions contribute to enhancing the overall user experience and maximizing the value
users derive from your app.

Activate a Guide Promotion

You can find this setting in the Userlane Portal under Guides. 

Within your Application it will look like this:

You can adjust the text for the Promotion under Customize > Texts.

Visibility of Promotions

The underlying algorithm is based on the following criteria: 

Only one Promotion is shown at a time.
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If two promoted Guides target the same user group, the one with a page segment takes priority.
Promotions can also occur for public Guides in private chapters.
Users can start, close, or continue using the app when a Promotion appears.
Once a promoted Guide is started, it won't appear again.
Promotions won't repeat on the same page without reloading.
If a user doesn't start a promoted guide, it waits at least six hours before triggering again.
A promoted Guide can appear up to three times for non-starters, or two times if closed actively.
Resetting an active Promotion brings it back for users who started the Guide.

Best Practices

Use page segmentation in combination with Promotions to highlight the most important and valuable
feature on a specific page.

Don’t activate too many promotions in parallel for your users, especially not for the same page segment. 

Regularly change the content you’re promoting to create a fresh, valuable experience for your users.

https://docs.userlane.com/docs/page-segmentation
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Copy Guides between multiple
applications
Last Modified on 12.01.2024

If you manage multiple similar applications, this article will walk you through the process of duplicating Guides
from one application to another. It covers

Why use it
Permissions
Overview of copied items
How to Copy Guides
Language Mapping 

Why use it

The option to copy Guides within Userlane Portal offers significant benefits when managing multiple similar
applications:

Time-saving: Instead of creating Guides from scratch for each application, you can simply copy existing
Guides, saving you valuable time and effort.

Consistency: Copying Guides ensures consistency across applications, maintaining a standardized user
experience and reducing the chances of errors or inconsistencies.

Efficiency: With the copy option, you can quickly replicate Guides across multiple applications,
streamlining the onboarding and training process for your users.

Easy adaptation: By copying Guides, you can easily adapt and customize them to fit the specific
requirements of each application while maintaining the core structure and content.

Simplified management: Copying Guides allows for centralized management within Userlane Portal,
providing a convenient way to organize and update Guides across different applications.

Permissions

Any manager role (admin, moderator & contributor) can copy Guides from one application to another.

A manager requires application access to the target application.

 

Overview of copied items

What is copied over What is NOT copied over

https://app.knowledgeowl.com/#UseIt
https://app.knowledgeowl.com/#Permissions
https://app.knowledgeowl.com/#Overview
https://app.knowledgeowl.com/#Steps
https://app.knowledgeowl.com/#Language


220

Guide title; subtitle

Guide structure (steps)

Step configurations

Step texts including media elements

User segments

Page segments

Chapter allocation

PDF recordings

 

How to Copy Guides
1. Sign into Portal (Source Application) > Manage >  Guides > Single action menu.
2. Click on the "Copy to another application" button.

3. Select the target application from the dropdown menu. 

4. Select the language that you would like to copy the Guides. 
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5. Click on ''Copy Guide".

ℹ ️Good to know

The original application is called the source application and the application that the Guides are
copied over is called the target application.
When a Guide is copied, it becomes a draft in the target application. To make it live, you must assign
it to a chapter, add any needed segmentation, and publish it in the target application's Portal. 
Deleted or archived Guides cannot be copied. 

 

Language mapping

You can select the language you want to copy content from. The available language options depend on the
number of languages in the target application. For example, if there are 3 languages in the target application,
you will see 3 options. If you want to copy the Guide in just one language, simply choose that language in all
available language dropdowns.

By default, Userlane suggests a language mapping based on the following criteria:



222

If there is a matching language KEY between the target and source application, we suggest using that
language version.
If there is no matching language KEY, we suggest using the default language version.

ℹ️ This is not applicable to self-hosting customers.
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Define the behavior of your Guides
Last Modified on 12.01.2024

Why use it

You can customize the Guide behaviour to

adjust the user experience
enforce a specific behaviour

Where to find it

The following options are under the Customize > Guides tab in the Portal.

Customize the behaviour
Require your end users to complete Guides in a specified order

If activated, users must complete all Guides in the predefined order. If deactivated, users can complete Guides
in any order they prefer. 

Notify your users when a step can not be found

If activated, users will see a loading step and error notification in case a step can not be found. Should the last
step still be available on this page, the Back button will be present.

Confirm exit from a Guide
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Determine if your end users should be required to confirm that they want to exit the Guide when they click on
the "X" in the top right corner of a step.

ℹ️ An exit confirmation increases the completion rate. 

Display an additional hint

If your end users have to interact with your application and remain inactive, we’ll show a large arrow that
points at the elements that they need to interact with.

Add the option for end users to go back one step

An extra button to the left of the main button will be displayed. It can be omitted entirely or used to offer your
users more flexibility.
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Search through the Userlane
Assistant
Last Modified on 19.03.2024

About Search

Finding specific content can be challenging when you have a lot of it. That's why we created Userlane Search!
Your users can easily search for content right from the Userlane Assistant. 

Connect the Search feature to popular knowledge bases like Confluence, Zendesk, Sharepoint and
KnowledgeOwl.

�  Through our own integration with KnowledgeOwl, you can easily search and read our help articles
directly from your Userlane Assistant! 

In this article we cover

how it works
content and ranking of the search results
how to customize labels
how to provide additional support

 

How it works

Once Search is enabled, users can simply click the Search icon in the Assistant and type a query in the Search
input field.

Userlane Search applies queries to the following: 

https://docs.userlane.com/docs/integrations-with-confluence
https://docs.userlane.com/docs/zendesk-integrations
https://docs.userlane.com/docs/sharepoint-integration
https://docs.userlane.com/docs/knowledgeowl-integrations
https://app.knowledgeowl.com/#how
https://app.knowledgeowl.com/#ranking
https://app.knowledgeowl.com/#customize
https://app.knowledgeowl.com/#noresult
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Content Type Included Elements

Interactive Guides
Chapter title, Chapter subtitle, The title of the Guide, The subtitle of the Guide,
Intro/Outro Title, Step title, Text and content of a step, Infobox content, Link title,
Link description, Content of specific value-inputs

Announcements
The public title of the Announcement, The message, The text of the button of the
primary link, The text of the button of the secondary link

Documents
The page title of the document, The body text of the document

When you click on the result:

an Interactive Guide will immediately start

an Announcement will be shown to you, e.g.

a Document will show you the text of the document and also offer the option to go to the original article, e.g. 

 

Search results and ranking

Now that we know which content types can be found through the Userlane Search, let's talk about how Search
structures the results. 

What's included

The Userlane Search ensures that only accessible content is shown in the search results. What do we mean by
accessible content? 

Guides
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Only show active Guides in active chapters

Only show Guides that match user segmentation

Only show Guides that match page segmentation 

Only show Guides in the language of the user or with a fallback language

Announcements

Only show Announcements active at the time of searching

Only show Announcements that match user segmentation

Only show Announcements that match page segmentation

Only show Announcements in the language of the user or with a fallback language

Documents

Documents searched through an integration with a knowledge base are accessible based on the
permission settings for the connected instance. 

Ranking 

Userlane Search ranks according to Term Frequency / Inverse Document Frequency

Term Frequency

e.g. searching “user” ranks a tutorial that contains the word “user” five times, higher than a tutorial that
contains “user” only once.

Inverse Document Frequency

e.g. searching “user” ranks a short announcement that contains only 10 words, one of which is “user”, higher
than a long tutorial that contains twenty steps, one of which contains the word “user” once. 

Content filters

If results include more than one content type, users can select content filters to refine their results to specific
types (Guides, Announcements, and documents). A maximum of 50 results is displayed. 

 

Customize content filter labels

You can customize the default filter label texts from the Portal by going to Customize > Texts, then select
Search under Assistant.
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No matching results

To provide users with additional support or resources, enable an external help link that displays automatically
if they receive zero results for their search. This link can direct them to either an external documentation page
or to their managers via a "mailto:"

To enable Search for an application, go to Customize > Search in the Userlane Portal.
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Customize default texts
Last Modified on 12.01.2024

About Default Texts

Your Userlane content should match your organization's style and branding. Userlane has one area (Customize
> Texts) for you to manage default texts.

By default texts, we define any generic texts that are already offered by us, like buttons' texts (e.g. next, back,
skip), which you can adjust according to your needs, anytime in your Userlane Portal.  

ℹ️ Keep in mind that any changes to the default texts would be applied to your whole Assistant and will
affect all step types of the adjusted type.

In this article we cover

the benefits
who sees the default texts
what content types can be customized
how to handle translations

 

Why use it
to match your style
to translate default texts easily

 

Who sees the Default Texts

All your users see the default text for any Userlane content type (e.g. Guides) when it appears for them. 

Example: This is the overview of the First Slide. The First Slide always appears at the beginning of a Guide.
Thus, any Guide currently shows this button with the content "Let's Go", but you can edit this text in case you
prefer something else. 

https://app.knowledgeowl.com/#benefit
https://app.knowledgeowl.com/#audience
https://app.knowledgeowl.com/#types
https://app.knowledgeowl.com/#translations
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Content Types

Content Types that can be adjusted under Customize > Texts: 

Explaining Steps
Interactive Steps
Any Value Steps
Specific Value Steps
Others
Assistant 
Announcements

 

Translating Default Texts

You can either translate them directly within the Userlane Portal or export all texts and translate them in bulk
under Customize > Languages.
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Customize colors and designs
Last Modified on 12.01.2024

About customized colors and designs

Your Userlane Design should match your organization's style and branding. 

In this article we cover

the benefits
what to customize
how to set it up

 

Why use it

Customizing the color and design has several benefits: 

Branding consistency: Customized colors allow you to align your Userlane Design with your
organization's brand identity, ensuring a consistent and cohesive visual experience.

Enhanced user experience: By choosing colors that resonate with your target audience, you can create a
more engaging and visually appealing Userlane interface, leading to a better user experience.

Increased brand recognition: Consistently using your brand's colors across various touchpoints, including
Userlane Guides, helps reinforce brand recognition and reinforces your organization's visual identity.

Improved accessibility: Customizing colors allows you to consider accessibility guidelines and make
adjustments to ensure proper color contrast, making your Userlane Guides more accessible to users with
visual impairments.

Tailored visual hierarchy: By selecting the right colors for different elements such as buttons, infoboxes,
and hints, you can create a visual hierarchy that guides users' attention and improves the overall usability
of your Userlane Guides.

Personalization and differentiation: Customized colors allow you to stand out from competitors and
create a unique visual identity that reflects your organization's personality and style.

 

What to customize

You can change the following settings:

the Assistant avatar, e.g. logo of your company, a question mark (View our Working with images article
for more details on image file recommendations.)
the color of infoboxes
the color of buttons
the color of additional hints

https://app.knowledgeowl.com/#benefit
https://app.knowledgeowl.com/#customize
https://app.knowledgeowl.com/#set
https://docs.userlane.com/docs/working-with-images-in-userlane
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the color of tooltip icon
the corner radius

ℹ️ Important

The Design settings will affect the whole Assistant. 

If you e.g. change the color of a button here, you'll change the colors of all step buttons in all of your
Guides.

 

Set it up

To customize the colors and designs of your Guides, go to Customize > Design in the Userlane Portal.

You can define a color in two ways:

Add a Color Code 

Type the color name

� Good to know

Userlane elements (size, position, etc.) can be modified by using CSS (Cascading Styles Sheets), in case it's
required to adjust more than is available in the Userlane Portal. 

You are responsible for this type of implementation and its maintenance.

Please talk to your web developers to implement those additional changes in your webpage's code for
Userlane elements. 
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Adding custom fields to user
attributes
Last Modified on 10.01.2024

About custom data for attributes

Custom data are fields that you can add as user attributes to your user profiles. They can be filled with data.

In this article we cover

the benefits
when to use it
the implementation within the Snippet
reviewing what data is passed on

 

Why use it

Personalization: Custom data allows you to tailor user experiences by capturing specific user attributes
relevant to your application or platform.

Targeting: With custom attributes, you can create user segments based on specific criteria, enabling
targeted messaging, content, or features for different user groups.

Analytics: Custom attributes help gather valuable data for analysis, allowing you to gain insights into
user behavior, preferences, and trends.

Automation: By leveraging custom attributes, you can automate processes or workflows based on user
attributes, such as triggering personalized Guides, tooltips or announcements.

Flexibility: Custom attributes provide flexibility to adapt and extend user profiles as per your
application's evolving needs, ensuring scalability and customization options.

 

When to use it

If you want to pass on data to target specific user groups. You can use the attributes to base your User
Segments on them.

Before you proceed, make sure you’ve already planned and created all custom data fields that you will need.

 

The Implementation within the Snippet
1. Your general Snippet

https://app.knowledgeowl.com/#benefit
https://app.knowledgeowl.com/#use
https://app.knowledgeowl.com/#implementation
https://app.knowledgeowl.com/#review
https://docs.userlane.com/docs/user-segmentation
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Every account has a unique account ID which is also included for the Java Script snippet to load Userlane
within an application. This can be found in the Userlane Portal.

2. Know where to amend the Snippet

To amend the snippet to save data in the user profile of the current user, you need to add an identify command
in the snippet:

Userlane('identify', currentUser.id, {
  attribute_key: 'attribute_value'
});

Example snippet:

// load Userlane

(function(i,s,o,g,r,a,m){i['UserlaneCommandObject']=r;i[r]=i[r]||function(){ (i[r].q=i[r].q||[]).push(arguments)};a=s.cr
eateElement(o), m=s.getElementsByTagName(o)[0];a.async=1;a.src=g;m.parentNode.insertBefore(a,m) })(window,d
ocument,'script','https://cdn.userlane.com/userlane.js','Userlane');

// TODO: the command below is just for illustration purposes
// it's definition must be changed to work for your application

var currentUser = please_replace_this_with_your_api_call.getCurrentUser(); // returns an object with id and other data 
of the current user who’s using the application in this moment

// identify the user for Userlane

Userlane('identify', currentUser.id, {

 // TO DO: these fields below are defined by you.
 // Below are just examples. You must individually customize your own attributes and variables here.

 name: currentUser.name,
 email: currentUser.email,
 permissions: currentUser.permissions
});

// initialize Userlane with your account ID, in this example it is “12345”
Userlane('init', 12345);

3. Decide which custom field data type to use

Every custom field has a data type. It can only accept data that fits this type. These types are defined when the
custom data field is first created and can not be changed afterward.

Supported data types:
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True/false:

Custom true/false fields accept JavaScript booleans. We also parse values like 1, 0, “yes” and “no” to their
respective true/false value.  
Example:

Userlane('identify', currentUser.id, {
  is_admin: true
});

Text:

Custom text fields accept JavaScript strings. There is no length limit on individual strings but all custom
data may not exceed the size of 500kb.
Example:

Userlane('identify', currentUser.id, {
  description: 'Some text description'
});

Number: 

Custom number fields accept JavaScript numbers, both integers and decimals/floats.
Example:

Userlane('identify', currentUser.id, {
  store_number: 224
});

Date and time:

Custom date and time fields accept strings that represent a timestamp in any of these formats:

YYYY-MM-DD HH:mm:ss 2017-04-28 20:12:55

yyyy-mm-ddThh:mm:ssZ
2017-04-
28T20:12:55Z

yyyy/mm/ddThh:mm:ssZ 2017/04/28T20:12:55Z

yyyy-mm-dd 2020-02-20

yyyy-mm-dd hh:mm:ss 2020-02-20 23:42:51

yyyy/mm/dd hh:mm:ss 2020/02/20 23:42:51

yyyy/mm/dd 2020/02/20

Example:

Userlane('identify', currentUser.id, {
  date_created: '2020/02/20 23:42:51' 
});

List:
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Custom list fields accept JavaScript arrays. We only accept string and integer elements in the array. The
order of the elements in the array is not considered. When a new array is provided, we’ll override the
previous array entirely.
Example:

Userlane('identify', currentUser.id, {
  roles: ['admin','editor','user']
});

ℹ️ An Attribute that is passed via the snippet but has not been set up in the Portal will be ignored by
Userlane. This also applies to Attributes that have a different name in the snippet and in the Portal. 

After creating the Attributes, you can create a User Segment you can then apply to specific Userlane content.

 

Check what Attributes are passed on

When you already implemented the Snippet, you can check in the Developer Tools what information is being
passed on.

1. Open the Developer Tools and navigate to the Network tab

2. Once in the Network tab, enter ‘bootstrap’ in the filter:

3. After entering ‘bootstrap’, refresh the page to re-trigger the Userlane commands

4. Then you will find two bootstrap options under the ‘Name’ column, click to open the bootstrap

https://docs.userlane.com/docs/user-segmentation
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5. Upon opening the bootstrap, you will be able to see the implemented attribute keys as well as their
values for your users in the ‘Payload’ tab under customerUser/customData
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User segments for better targeting
Last Modified on 13.06.2024

About User Segments

User segments are an important and powerful tool you can use to filter Userlane analytics as well as target
your content to specific audiences.

Userlane provides a standard set of attributes you can use to create user segments but you can also enrich user
profiles with custom attributes and utilize those for user segments.

In this article we'll cover: 

the benefits of user segmentation
using custom attributes
creating user segments with AI
creating user segments manually
further considerations

Why Use User Segmentation
Data-Driven Decision Making - Filter HEART analytics with user segments for more precise data.
Enhanced User Experience - Tailor experiences for different user groups.
Efficient Resource Allocation - Prioritize efforts for high-value segments.
Personalization at Scale - Automate personalized content delivery.
Targeted Marketing - Improve campaign relevance and boost conversion rates.
Higher Conversion Rates - Focus on segment-specific pain points.

Using Custom Attributes for User Segmentation

Userlane provides you with behavioral data out of the box that can be used for user segmentation (read more
on that here), but user segmentation becomes even more powerful when you enrich user profiles with custom
attributes.

Browser Extension (BX) Implementation

SSO

When configuring a Single Sign-On (SSO) integration, you can opt to send additional attributes to Userlane.
These attributes are then sent automatically to Userlane from your Identity Provider (IdP) for each user. Find
more info here.

Attributes that are commonly sent via SSO are:

country
department
mail
userType
jobTitle

You can find SSO created attributes in Userlane on the 'company attributes' page and they can automatically

https://docs.userlane.com/docs/user-behavior-segmentation
https://docs.userlane.com/docs/expanding-sso-settings
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be used for user segmentation.

You can also import additional attribute values manually as described in this article.

Note that you must be an Administrator or Moderator in order to create and edit user segments.

Snippet

Your developers can pass custom attributes via the Userlane .js snippet using the 'identify' command. Find
more info here.

To use custom attributes from the .js snippet in user segmentation, you must first create the attribute on the
'attributes' page in the Userlane Portal.

Leverage AI to create User Segments

We implemented a conversational AI interface to help you create user segments faster and easier. Using
natural language, you can describe the attributes and logical connections you want in your user segment. The
AI does the hard part and you simply need to review, save, and apply the segment once it's done.

We provide example segments to get you started in our AI interface so that you can easily create user
segments using the most common standard and custom attributes. Note that examples for the 'role' and
'country' attributes will only appear if you use those attributes in Userlane.

When utilizing the AI to create a segment based on Guide Interaction, be sure to use the Guide ID so that the AI
knows exactly which Guide you're referring to. To find your Guide ID navigate to the Edit Guide page.

Create User Segments Manually

Choose data:

You can build a Segment based on 

standard data

https://docs.userlane.com/docs/importing-users-for-a-browser-extension-rollout
https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
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user behavior
attributes

Choose a connection type:

There are various ways to segment and target your users. With User ID and any attribute you can choose
between these connection types: 

Connection Type Logic Example

Equals
Checks for an exact match of the

input.
Role equals "admin" results in a segment of all

users with the value "admin" for the "role" attribute.

Does not equal
Checks for values that are not an

exact match of the input.

Role does not equal "admin" results in a segment of
all users where the "role" attribute is anything but

"admin".

Starts with
Checks for values that start exactly

as the input.

Role starts with "admin" results in a segment of
users where the "role" attribute has values like

"admin", "admins", or "administrators".

Contains
Checks for values where the input is

present. 
Email contains "userlane" results in all email

addresses where "userlane" is present.

Does not contain
Checks for values where the input is

not present. 
Email does not contain "gmail" results in all email

addresses that do not have "gmail" present.

Is one of

Checks for values that match the
input in a set of specified set of

values.

Id is one of "123", "456", "789" results in a segment
of users with one of those ids.

Is not one of
Checks for values that do not match
the input in a set of specified set of

values.

Id is one of "123", "456", "789" results in a segment
of users without those ids.

Is empty
Checks for values that are empty for

the given attribute.
Country is empty results in a segmentof users

where the country attribute has no value.

Is not empty
Checks for values that are not
empty for the given attribute.

Country is empty results in a segmentof users
where the country attribute has any value.

Apply the Segment: Filter analytics and target content.

To use a user segment to filter analytics, select the segment you want to use a filter from the dropdown that
says 'Everyone' by default on the analytics pages.

You can apply a segment to content in the Portal (for Guides, Chapters, Messages) and in the Editor (Tooltips,
Tags). 

Further Considerations
Direct links or integrated Guides do not follow user segments.
Create test segments before going live for in-depth testing.
Applying a segment to a Chapter affects all Guides.
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Page segments for context-based
content
Last Modified on 10.01.2024

About page segmentation

Page segmentation lets you show content types or track task success only on specific URLs. 

Note: You can find below a list of page segment rules.

Why use it

The benefits of page segmentation include the following:

Targeted Content: Page segmentation allows you to show specific Guides, tooltips, and tags only on
relevant URLs, providing users with content tailored to their needs.
Improved User Experience: By displaying content relevant to a particular section or process, page
segmentation enhances the overall user experience, making it more intuitive and streamlined.
Easy Customization: Page segmentation eliminates the need for implementing complex code. For
example, you can easily customize and control the visibility of your Tooltips or Tags without requiring
technical expertise.
Flexibility and Adaptability: Page segments can be easily created and modified, allowing you to adapt
your content to your application's URL structure changes.
Enhanced Assistant Experience: Page segmentation affects the behavior of the Userlane Assistant,
including the icon displaying the number of uncompleted Guides, providing users with a seamless and
personalized assistant experience.

Understand your problem

You can add any patterns of the URL to the page segment:

To understand which pattern you need, first, create a concept by trying to answer the following questions:

Should your content be shown everywhere?
Example: The Userlane Assistant can be hidden on the login page

Do you want to show specific content per section of the underlying app?
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Example: Show a particular set of guides in the Profile section and another set of Guides in the
Opportunity section of your application.

Are there specific parts of a process that need some further explanations?
Example: Use page segments if you wish to show specific content on the landing page of a
marketing campaign.

Do you want to test your content before pushing it to the production environment?
Example: Segment your content to be shown only on the test environment for testing purposes.
After, change the page segment of the respective content, and make it available to the production
environment.

How to create a page segment 
Access page segmentation

Access the Portal to create the page segment: Portal > Segments > Page Segments

Create a page segment

Overall, there are three ways in which you can create a page segment:

Use path parameters (everything after the first slash "/")
Example: use users to ensure the content is available only in the users section of your underlying
app.

Use (sub)domain name and path parameters
Example: use test.mycompany.com/users when you want to ensure that the content is available
only on your test property in the users section

Use (sub)domain name
Example: assign customer-id.mycompany.com page segment to a Chapter with Guides to ensure
that only that customer can access the respective content.

You can then decide either to show the content on a page or hide the content on a page. 

Advanced cases

There are two functionalities that you can use to customize your page segment further:

when you have varying parts in a URL between 2 unique parts, you can use asterisks (*) - an asterisk acts
as a wildcard. For example: customer-*.mycompany.com or mycompany.com/users=*/profile
use the "plus" sign to connect multiple conditions with a logical OR.

Note: Userlane supports asterisks only for subdomains and path parameters.

How to apply a page segment

Depending on the content you wish to segment, you may need to apply it in the Portal (for Announcements,
Chapters, Guides, Assistant, Welcome Slide) or in the Editor (for Tooltips and Tags).

Delete a page segment

Segments that are in use can’t be deleted. If you want to delete a page segment, you must remove the applied
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segmentation first.

To check if a page segment is in use, access Portal > Segments. In the segments table, you can check whether
a content type is connected to a segment with the help of the Usage column.

Page Segmentation rules

The rules can be summarized in the following way:

subdomain, domain, and domain suffix support for page segments
wildcard support for subdomains has been added
the domain and domain suffix must be added to the page segment rule. If only one is added (e.g.
.com), Userlane will look only at matching path parameters
wildcards are not supported for domains and domain suffixes. If you use mycompany.* , then
Userlane will look only at matching path parameters

The security protocol (https and http), IPs, and port numbers are ignored and not considered in the
segmentation rule.
If you add path parameters after the domain name, the accessed URL must fully match the page
segment's rule.

if only path parameters are added to the page segment rule (without the domain name), then partial
match logic is used.

If you work only with one domain, you can use only path parameters to segment your content.
You can use wildcards for path parameters

Examples: old logic vs new logic

Accessed URL Page Segment Rule
Previous logic
(True / False)

New logic
(True /
False)

Explanation

https://sub.mycompany.com/id=test1 id=* True True
Path parameters (and
wildcards) are supported
in both scenarios

https://sub.mycompany.com/id=test1 *.mycompany.com False True
The subdomain and
domain name (including
domain suffix) match.

https://sub.mycompany.com/id=test1 mycompany.de False False
It is false because the
domain suffix does not
match (.de vs .com)

https://sub.mycompany.com/id=test1 subdomain.mycompany.com/test1 False False
It is false because the path
parameters should also
match.

https://sub.mycompany.com/id=test1 sub.mycompany.com/id False True

It is true because the
accessed URL matches the
page segment rule,
including path parameters.

https://sub.mycompany.com:443/id=test1http://sub.mycompany.com:80/id=test1 False True
The security protocol and
port number are ignored.

Considerations
Page Segments applied for a whole chapter will affect every Guide within this chapter. 

If you apply another page segment for a Guide within this chapter, the chapter and Guide segment will be
connected with a logical AND for this Guide.
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A chapter will no longer be visible on general pages if all the Guides within it are only visible on specific
pages.

The icon in the Userlane Assistant (showing the number of Guides uncompleted in a chapter) varies
depending on the active page segmentation. It shows the number of uncompleted Guides in the first
uncompleted chapter.
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Using tags to define user segments
Last Modified on 10.01.2024

About using Tags for User Segments

If you are about to create your user segmentation, we recommend that you use custom data attributes when
you are using a Snippet implementation. You can pass any user information within a custom attribute.
Compared to tags, attributes provide more flexibility and data types.

If you still want to use tags for defining user groups, you can implement the following commands to tag and
untag users.  

ℹ️ Tags used in the Snippet implementation are different to Tags being set up for HEART analytics. If you
want to track a process, please continue reading here.

Dev task: Implement your tags

A tag can be any string. However, we recommend limiting the length to 128 characters. You can use the
following tag commands

// Tag Command
Userlane('tag', 'admin');

// Multiple Tags Command
Userlane('tag', 'admin', 'exampleTag', 'anotherOne');

// Remove Tags Command
Userlane('untag', 'myCustomTag');

// Remove Multiple Tags Command
Userlane('untag', 'myCustomTag', 'exampleTag', 'anotherOne');

// identify the current user
Userlane('user', 'user_ID');

Positioning and page reloads

Before initializing Userlane with Userlane('init', yourPropertyId), make sure to set all segmentation
commands. The 'init' command should be called once, after all segmentation commands, to confirm the
changes. This automatically updates the assistant based on tag and segmentation changes. You don't
need to call 'init' after each segmentation command.

Note that tags are not saved when the page reloads. After every reload, users start with no tags. So, you
need to call tag or untag commands after each page reload to apply the desired tags.

https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
https://docs.userlane.com/docs/tags
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Manager Task: Create and apply your user segmentation 

 Learn more about adding custom fields to user attributes and user segmentation.

https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
https://docs.userlane.com/docs/user-segmentation
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Segment based on User Behavior
Last Modified on 26.02.2025

About User Behaviour Segmentation

One of the sections in the User Segmentation is Behavioral Data. This group of parameters is based on the User
activity related to Userlane in general (First Time, Last Time Active) or on their Guide interaction. 

You can use this data to create segments that target specific groups of users and better understand their needs,
optimize user experiences, and drive desired outcomes, ultimately improving business performance.

There are three behavioral data settings:

First Time Active
Last Time Active
Guide Interaction

First Time Active parameter

The User segment option allows you to filter users based on their first interaction with Userlane in your app,
called "First Time Active." You can use this segmentation to target users who have been active since a specific
time or for a certain period.

Options for First Time Active segmentation:

Relative time frames: These parameters are relative to the current time, looking backward or forward.
They adjust daily based on the current day.

From...to...: This setting looks at the time difference between today and the selected time, allowing you to
choose a time frame longer than one day.

Example:
You want to show an Announcement to Users who were activated between 7 and 10 days ago.
We select the option from a past time - to a past time. We add the days in the fields.
To illustrate it in a user-friendly way, the time scale below will update with the data you selected.

https://app.knowledgeowl.com/#First
https://app.knowledgeowl.com/#Last
https://app.knowledgeowl.com/#Guide
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The option "exactly": This setting triggers the segment for users whose First Time Active matches an
exact day. Content segmented with this option shows for only one day, matching the selected time.

Example:

You want to show an Announcement that will congratulate on the first week of the User in the
application and promote a Guide that is linked to it. 

This Announcement should only show exactly on the 7th day after the first time active. For this,
select the option in the past and enter 7 in the day field. 

Absolute time frames: This setting selects an exact calendar date or date span when a user was first
seen.

After, on, before: These settings filter users based on whether their First Time Active was after, on, or
before a specific calendar day.

Example:

You want to inform your older Users about a change in one of your processes depicted in one of the
Guides. That change will happen on 01.12 and you would like all of the Users who were active before
that date to see an Announcement informing about the change and promoting the new Guide. 

You select the option before and set the date to 01.12. This will include only the Users who were first
time active before that date. 
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The settings "is unknown" and "has any value" should not be used for segmentation purposes but can be used
when looking for users with unspecified values.

 

Last Time Active parameter

The "last time active" parameter is based on the date when a user was last detected by Userlane. This date is
updated to the current date whenever the user logs in. It always shows the current date while the user is logged
in or the past date when they were last active.

The settings for "last time active" are similar to the "first time active" option, but only the absolute filter is
relevant due to the date being updated constantly.

As the last time active gets updated every time the user is active, it cannot be used with relative segment
parameters for content segmentation.

You could consider using it though to display a list of users who have not been active for some time and use
the relative parameter for that. 

Absolute time frames

This setting allows you to select a specific calendar date or date range when a user was first seen.

On, after, before: You can filter users based on their last time active on a specific day (on), and the content
will only be shown on that date. By using before and after, you can exclude users who were active before
or after a specific date from the segment. Note that this setting works best with current and future
calendar dates.

Example: To show a guide to users who are active until December 31st because the process will end
on that day, select the option "before 31.12" to ensure that users active after that date won't see the
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guide anymore.

Guide interaction

This segmentation option helps filter users based on their interaction with guides. It ensures users complete
guides in a specific order by making them available one by one.

Options in this section:

Started, not started: This focuses on users who have either started the selected guide or haven't started it
at all.

Example: To promote the "Welcome to Userlane" guide to users who haven't started it yet, create a
segment for that specific group. Select "not started" and the guide.

Completed, not completed: This creates a segment based on whether a guide has been completed or not,
regardless of whether it was started.

Example: If users need to complete one task before moving to the next, create a segment of users
who completed the first guide before starting the second one. Select "completed" and add the guide
it refers to.
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Userlane Analytics
Last Modified on 12.01.2024

Measure, understand, improve

By measuring and tracking the success of strategic software adoption, you can expect the following results: 

Increase usage & adoption
Improve employee experience
Reduce underused software
Increase productivity

Additionally, you can track the performance and engagement of your support content, so you can iterate faster
and drive further software adoption.

HEART Analytics

Userlane’s HEART analytics are the world’s first standardized model to monitor value realization across
enterprise applications.

Based on user interaction metrics and usage patterns, a single score indicates the current value realization for
each application based on five core value drivers:

1. Happiness

2. Engagement

3. Adoption

4. Retention

5. Task Success

The output metrics signal if an application delivers the expected value and allows identification of areas for
improvement to assess and optimize the return on investment for key technology initiatives.

Learn more about HEART Analytics here.

Content Analytics

Userlane improves user experience with an interactive overlay for in-application guided learning to drive
adoption and productivity while reducing training and support costs.

You can create Guides, Tooltips, Announcements, Pop-Ups (Welcome Slide), and NPS with Userlane and see
how they are performing.

https://docs.userlane.com/docs/what-is-heart
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Learn more about our Content Analytics here.

https://docs.userlane.com/docs/analytics-overview
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HEART Analytics
Last Modified on 28.06.2024

HEART Analytics

Uselane's HEART Analytics offers you deep insights into the usage and value of your software investments.
Using the HEART framework, Userlane can show you where your users are experiencing digital friction in a
given application and how to address it proactively. 

HEART is a user-centered metrics framework that Google developed to evaluate the quality of user
experience. At Userlane, we adopted and adjusted the framework for the world of B2B enterprise SaaS
applications so that you can measure digital adoption across your entire software stack with ease and
precision.

Why use HEART

The HEART framework is comprised of 5 letters that each track a different metric in order to give you both
comprehensive as well as detailed insights into the status of your digital adoption. The screenshot and table
below provide you with a visual and in-depth explanation of the individual letters, respectively. 

Each letter allows you to dive into a particular aspect of digital adoption and better understand where your
users are struggling and how you can help them. You can leverage the Userlane Improve Suite to create
impactful, in-app content to assist and support your users or engage with your Userlane CSM to brainstorm
internal campaigns. The goal of HEART is to enable you to identify areas of digital friction and make data-
driven decisions about how to address them. 
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Each HEART letter focuses on a different pillar of digital adoption and user experience as described below:

Goal Metrics

"H" - Happiness
Users are satisfied with the application and are

likely to recommend it.
NPS and Survey

responses
Read more

"E" - Engagement Users interact with the application actively.
Engaged sessions

Average session duration
Read more 

"A" - Adoption
Users come to the application and utilize it

broadly.
Users Growth Rate

App Coverage
Read more 

"R" - Retention Users keep coming back to the application.
Retention rate

Stickiness
Read more 

"T" - Task success Users accomplish their Tasks. Tag Interaction Read more 

� Note that after enabling HEART, you may need to wait up until 1 month to see results for all letter
dashboards.

AI-Powered Insights for HEART

HEART also includes AI-powered insights to help you quickly and easily digest the data. AI does the hard work
for you of processing the data and provides you with two types of meaningful insights for each letter:

Summary:
To the right of the overall letter score, you will find an AI-generated summary that interprets the
trends and changes in data for that score and gives an indication of the significance or meaning of
those trends. 

Recommendations:
To the right of the summary, you'll find an 'Improve' section when the scores for that letter are low.
Here the AI evaluates the scores and recommends actions you can take to improve both the overall
letter score, as well as the more granular metrics.

https://docs.userlane.com/docs/happiness
https://docs.userlane.com/docs/engagement
https://docs.userlane.com/docs/adoption
https://docs.userlane.com/docs/retention
https://docs.userlane.com/docs/task-success
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How are scores rated?

To calculate whether a score is Low, Moderate, or High we employ a benchmarking algorithm that aggregates
all HEART letter scores and breaks them down into quantiles that represent the is Low, Moderate, or
High ranges. Below you can see an example of a score that is in the High quantile and how it would appear on
your HEART letter dashboard.

How to enable HEART?

To enable HEART for your application, navigate to Settings > Analytics Settings and turn on HEART for all or
just some applications. This is also where you can disable HEART if needed.

⚠️ If you go to General settings and disable the "Switch Userlane on/off" toggle, HEART will be disabled
as well as the Userlane assistant!
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Analytics privacy settings - Basic
and Advanced (HEART) analytics
and Application discovery
Last Modified on 02.02.2024

About the Analytics settings

Our analytics privacy settings enable you to select the level of event tracking that you need to help you
understand well your applications are being adopted. In these settings you can manage what applications use
HEART analytics if your company is using the App Discovery option

To find this settings follow these steps:

1. Click on the Settings icon in your navigation in the left sidebar.
2. Under the Global settings go to "Analytics" and you will be on the Analytics settings page.

How do we process the data?

The raw events are stored in our servers and used to calculate aggregates that help you improve your Userlane
content. All the data collected is in accordance with our Data Processing Agreement (DPA).

HEART analytics

https://www.userlane.com/trustcenter/data-processing-agreement/
https://drive.google.com/file/d/1stjnG0lM-8KKQdn4_LvcD-93FTpVSlcd/view?usp=sharing
https://drive.google.com/file/d/1GeTqy8gb20TLpnRLocVXl7CniZgT95nH/view?usp=sharing
https://docs.userlane.com/docs/app-discovery
https://docs.userlane.com/docs/app-discovery
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Enable HEART to understand how users interact with your applications (e.g. click events, viewed pages, time
spent). HEART analytics allows you to track your application's Adoption, Retention, Engagement and Task
success metrics. 

ℹ️  Good to know
Userlane does not track user inputs (what a user types in the text field), only the general activity
events. 
If you have enabled an integration to a knowledge base or other enterprise system, we only track
search activity in the Assistant; not interactions with the content or the host application.

Set it up
1. On the settings page, you will see a HEART toggle in the Table next to your applications.
2. HEART analytics tracking: Track interactions with anonymous event tracking for your underlying app.
3. Basic tracking: If you do not select the HEART option, your application will be on the "Basic" tracking

option that tracks interactions with Userlane only.

These analytics options are available in both our browser extension and snippet integrations. They work on
multi- and single-page applications, though the raw events generated around page navigations might differ.
This difference affects only how we will calculate the HEART metrics, and does not affect any Userlane or host
application functionalities.

Basic tracking (Default)
What do we track?

If you do not want HEART analytics, our Basic anonymous event tracking captures interactions with Userlane
such as a Guides started, Assistant opened, or Announcement viewed. 

What does the data show you?

Calculations from the data are available in Userlane's Analytics dashboard reports. They represent insights such
as completion rate and conversation rate. Reports are provided for Guides (with step analysis), Announcements,
and the Welcome Slide. You can use these insights to improve your content and how you deliver it.

Advanced HEART tracking
What do we track?

In addition to our Basic event tracking, Advanced tracking captures interactions in your underlying applications
including clicks, URL changes, and URL views. A detailed list is provided below. When enabled, this option
records raw events for tracked user interactions, regardless of whether any other Userlane feature is enabled,
e.g. Guides, or Announcements.

HEART tracking events

User Interaction Example event sent to Userlane

A user loads the application by the browser
Back or Forward buttons

"action": "back_forward"

https://docs.userlane.com/docs/userlane-integrations-userlane-integrations
https://docs.userlane.com/docs/analytics-dashboard
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A user loads the application by any other means
(clicking on the application URL elsewhere,
copy-pasting the application URL in the browser
address bar)

"action": "navigate"

A user reloads the application by clicking the
browser Refresh button

"action": "reload"

A user clicks an element in the application
"action": "click"

A user clicks on the Tagged element in the
application

"action": "interaction"

A user right-clicks an element in the
application 

"action": "rightClick"

The browser tab containing the underlying app
becomes inactive (because the user switches to
a different tab)

"action": "hideAppWindow"

The browser tab containing the underlying app
becomes active (because the user switches tab)

"action": "showAppWindow"

A user changes URL on a single-page
application (via application router or manual
change in the browser address bar)

"action": "changeUrl"

User Interaction Example event sent to Userlane

URL exceptions for HEART events

Userlane will track data on URLs that are added in the Userlane Portal section  Application URLs . If you want to
prevent tracking on a specified URL, you can add it to the exceptions list: 

Click on three dots icon next to the application in the Table
Go to the Manage Exceptions then click Add Exception. Use the Manage Exceptions page to add and
remove URLs to the exception list as needed.

How do we process the data?

The raw events are stored in our servers and used to calculate aggregates that help you improve your Userlane
content and understand how well your application is being adopted. All the data collected is compliant with our
Data Processing Agreement (DPA). Advanced tracking relies on cookies saved on the host application under

userlane.com  domain name. The use of this cookie is declared in here.

What does the data show you?

Calculations from the data are rendered in Userlane's Analytics dashboard reports. Our HEART analytics
provides insights for your underlying application to help you evaluate how well your application is being
adopted and where you can improve engagement.

Limitations
Iframes

https://www.userlane.com/trustcenter/data-processing-agreement/
https://docs.userlane.com/docs/userlanejs-cookies
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The feature, as currently implemented, only tracks user interactions in the underlying application’s main HTML
document. It does not track user interactions in iframes contained within this document. It is not possible to track
user interactions in cross-origin iframes.

Browser compatibility

On modern browsers (see browser compatibility), Userlane analytics also distinguish when browser window
buttons are used to load or navigate to the host applications. On incompatible browsers, we do not distinguish
how the host application is loaded, but we do track when the host application is loaded.

App Discovery tracking

Enable App Discovery to identify and discovery the applications your employees utilize throughout your
company. Learn more about how this feature works in this article.

Do I need to enable App discovery for all my applications or once per company?

App Discovery is company-level tracking, unlike HEART, where you need to enable it for each of your
applications

When will tracking work for App discovery?

If App Discovery is enabled the Userlane browser extension will monitor the usage of the top SaaS application
when:

1. The user has the Userlane browser extension installed. 
2. The user is registered as a Company user inside your company. 
3. Only visits to top SaaS apps are being tracked. 

What apps are being tracked?

App Discovery does not track every page your user visits. It only registers visits to the predefined list of top SaaS
applications (e.g. Salesforce, Jira, Trello, SuccessFactors). You can check the list of tracked applications here: Top
SaaS apps included in the App discovery. 

In the future, this list may expand to include additional SaaS applications, but it will strictly contain work-related
tools. It will not track websites that your employees might access during their personal time. 

Once I am using the App discovery, can I turn it off?

You can opt in or opt out of using App discovery for your company at any time in your Analytics Settings. 

What metrics can I see in my dashboard?

The metric you receive through App Discovery for is the total user count for all your discovered applications. This
will help you in identifying which applications get traffic within your organization. 

https://developer.mozilla.org/en-US/docs/Web/API/PerformanceNavigationTiming/type
https://docs.userlane.com/docs/app-discovery
https://docs.userlane.com/docs/list-of-apps-that-are-counted-in-the-app-discovery
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In the future, we may also consider including session numbers as part of this data.

Can I see which user visited the discovered application?

No. That this data will not reveal the identities of individual users. In your dashboard, only the total count of
users who have visited each application will be displayed.

How does the event look like?

This is how the event passed on to Userlane looks like if the company user visits one of the apps from the
tracked SaaS list:

{"data":[{
  "subject": {
    "key": "companyUser",
    "value": "49024680",
    "display": "any" 
  },
  "action": "urlMatch",
  "dirObj": {
    "key": "application",
    "value": "<html>"
  },
  "prepObj": {
    "key": "button",
    "value": "primary"
  },
  "context": {
      "appId" : "app",
    "sessionId": "21012q4eedohlfqtvywu",
    "chosenLanguage": "en-en",
    "appSessionId": "6112027536a23-f3fe-4df6-8801-39841003f9d2",
    "appPageVisitId": "701122234e4e1-4e75-475d-b9fa-bf7e756d4bd8",
    "appUrl": "https://family.userlane.com/app/8mp77/analytics/overview",
    "userAgent": "Mozilla/5.0 (Windows NT 10.0; Win64; x64) AppleWebKit/537.36 (KHTML, like Gecko) Chrome/111.0.0.0
 Safari/537.36",
    "viewportHeight": 929,
    "viewportWidth": 1920
  },
  "companyId": "4",
  "propertyId": "qwx0dk46vz",
  "clientUuid": "402a4def40-11b7-462e-aaa3-c20a2be0201e",
  "clientTimestamp": 1679921768826,
  "version": "2"
}]}
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H - Happiness
Last Modified on 13.05.2024

About Happiness

Understand how users feel about your app with our Happiness tool. You can monitor this by utilizing either our
Net Promoter Score (NPS) or Surveys. The NPS measures user loyalty by asking about the likelihood of users
recommending your application. With Surveys, you have the opportunity to go deeper into user satisfaction
regarding your application and its features.

 ℹ️ The Happiness factor will not be included in the overall HEART score unless NPS or Surveys are
activated. If only one of these options is activated, then only the corresponding score will contribute to
your H score.

Why use it

Employee Happiness is a crucial indicator that provides insights into productivity. When employees are
frustrated, they are less likely to engage with an application and may decrease their efforts to the minimum.

A high Happiness score significantly affects your business results by resulting in higher productivity, lower
costs associated with employee motivation, and an elevated employee retention rate.
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How is it calculated?

"H" score

(Surveys AVG score * #Survey responses + NPS *
#NPS responses) / (#Survey responses + #NPS
responses)

Survey AVG score and the NPS score are both
normalised in range [0,100]

NPS is normalised from [-100, 100] to [0, 100] like
this: (NPS+100)/2

NPS score (promoters - detractors) / all responses
Survey score AVG of all Survey scores

Best Practices

Here are our Tips for Happiness:

1. Consider our recommendations when setting up your NPS Survey

You can find our tips of what to consider here.

2. Read user feedback

Review the feedback provided by users.

3. Conduct user research

Conduct a follow up survey or interview session to better understand the why behind the feedback. Initiate a
user testing session to uncover usability flaws.

Do not only focus on Detractors but also Passive ones, so you can have dedicated sessions to better
understand their needs and expectations.

4. Improve the experience

Users often become dissatisfied when they lack understanding of a tool. To address this, ensure
communication about the importance of a tool and the NPS survey within the company is clear and
consistent.

You may also provide helpful Guides and Tooltips, use announcements and integrations to drive
engagement with the application. If necessary, prioritize reducing bugs or improving user experience in areas
detractors complained about.

Additionally, also review the NPS setting to ensure that the original question, timing and audience was
correctly chosen. 

https://docs.userlane.com/docs/how-to-set-up-nps
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E - Engagement
Last Modified on 09.10.2023

About Engagement

Engagement show your user’s involvement by tracking how many engaged (meaningful) sessions they had and
how much time they spent in your application or on a certain page.

Why use it

You will learn if users engaged with your application or if they just opened it briefly and left without any action.
Engaged users tend to learn faster, have higher chances of returning, and are more likely to make purchases. 

By analysing the average time users spend in your application and its various sections, you can understand for
how long the application was interesting to your users and if this improved over time. 

Low engagement can indicate that your application attracts traffic, but users tend to leave without actively
interacting. This can help identify opportunities to reduce costs by scaling down licenses or uncover potential
areas for improved efficiency through retraining your users.

On the other hand, high Engagement score could be a positive indicator as your users are more likely to engage
and explore your application. This can have an impact on your business results and higher application ROI.
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How is it calculated?

E Score
Percentage of Engaged sessions
(Engaged sessions / all sessions) * 100

Sessions number Total number of sessions

Engaged sessions
An engaged session is a session that lasts more than
10 seconds and/or has more than 3 clicks or other
activity events, such as a page change.

Sessions per user
Average session number per user in the selected time
frame. 

Average session time
Average duration of all sessions in the selected time
range. It excludes the sessions that lasted 0 seconds.

Total session duration over time (Bars)
Average (cumulative) time spent in the application in
the date interval averaged per user.

Average time on page (URL table)
Average duration of all visits to a URL in the date
range.

Best Practices

Tips for improving your Engagement:

1. Learn what or who drives the engagement

Understand where your users are spending the most or least time by going trough the URLs. Additionally,
comparing the Engagement metrics across different user segments allows you to identify groups with
higher or lower levels of engagement. 

2. Review and understand

Review the content and features in the areas that do not drive engagement. Additionally, asking your users
about these areas will help you understand why they were not interesting. 

3. Engaging content

Use Announcements or Beacons to promote important parts of the application that are not driving the
engagement. Create Guides to explain the areas that your users avoid to interact with. 

4. Consider alternatives

If an area is not being used, consider removing it. Similarly, if there is a group that doesn't require the
software, reduce the number of licenses for that group, if possible.
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A - Adoption
Last Modified on 30.08.2024

About Adoption

The goal of any application is that (expected) users are coming to it and that they use it widely. The user
number is the key metric you need to measure. With the Adoption Score, you can see how many users arrived
and you can track this number compared to the ratio of the expected number of users. 

Why use it

Adoption signals the extent to which an application is used. You will be able to understand if your users are
declining or if they are remaining stable or growing. Also, with this metric, you will be able to understand
which pages of your application have been visited and how widely users use it.

A low adoption rate means that users are only working with a limited part of an application, leaving significant
potential for additional productivity untouched.

A high Adoption Score has a big impact on your business results such as a higher app ROI and higher
productivity.
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How is it calculated?
Adoption score Average of Pages Visited and User Adoption Rate

Smart Insights

More specific information on how good or poor your
Adoption Score is, which provides you with a clearer
and quicker overview of where your application stands
currently, and what steps you can take to improve its
overall health

User adoption rate
Ratio of unique users in the selected date range to
expected users

User growth rate
Ratio of the difference between unique users in the
selected time range and users from the previous period
over users from the previous period

Pages visited Ratio of unique pages visited in the selected date range
to unique pages visited all time
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Total users

Total of unique users in the selected date range to
expected users 

Add the expected number of users as a user goal, so
you can track the adoption. This could be e.g. based on
the amount of licences you have for an application.

You can change the user goal at any time.
Users over time Number of unique users in the selected date range

Pages your users visited
An overview of the pages visited along with the
number of visits and unique users
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R - Retention
Last Modified on 30.08.2024

About Retention

The retention score is a measure of how many of your users are coming back to your application.

Why use it

Users will continue using an application and repeatedly return to it if they find value in it.

A low retention indicates that users might not see value in interacting regularly with an application or struggle
to achieve the intended usage. On the other hand, a high Retention Score significantly impacts your business
results, leading to a higher return on investment (ROI) for your app.

How is it calculated?
Retention score Average of the Retention Rate and Stickiness

Smart Insights

More specific information on how good or poor your
Retention Score is, which provides you with a clearer
and quicker overview of where your application stands
currently, and what steps you can take to improve its
overall health
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Returning users
The metric compares the number of users who
returned to the application during the selected period
with the users from the previous period.

Retention rate
Ratio of returning users to all users (compared with the
previous period).

Stickiness

Average daily stickiness in the selected date range in
the date picker. Daily stickiness is the ratio of Weekly
Active Users to Monthly Active Users on that day
(WAU/MAU)

Funnel "How often do your users return" 

Based on your selected time range in the date picker, we take all returning users and classify them into
monthly, weekly, daily, and multiple times per day groups (Multi-Daily). We look at the last 90 days (or since
the user's first session) and calculate the number of sessions, days, weeks, and months they returned.

Returning
The user has returned at least once within the selected
timeframe 

Monthly The user was active 2 out of 3 months

Weekly
User active 75% of weeks in this period (about 9 out of
12)

Daily
A weekly user that’s also active >40% of the days in
this period (about 3/7)

Multi-Daily A daily user that has more engaged sessions than days

The warmup period

Keep in mind, that some retention metrics require a warmup period: 

Stickiness compares weekly to monthly active users. In the first 2-3 weeks HEART does not know the
number of your monthly users, so stickiness will be higher than usual.
Your Retention rate compares users with the previous period, so if there is no data in this period, retention
will appear higher in the beginning. 

Limitations

HEART may encounter difficulties in accurately assessing returning users in these scenarios: 

When users switch devices: HEART relies on the browser to determine if a user is returning, either using
cookies or through the Browser Extension
Cookie-related problems:  For instance, if a user's browser blocks or restricts cookies, it can hinder the
ability of HEART to identify them as returning users accurately. Using the SSO to identify the user is a
good way to mitigate the issue. 

Best Practices

To get the most value in understanding and improving the Retention numbers, we suggest monitoring the
numbers for at least 1 month. 

Here are our Tips for Retention: 
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1. Define user groups

There might be different expectations for different users on how often they should be returning to which
application or page. Define those user groups and create user segments, so you can better analyze the data.

2. Understand why 

Conduct user research to understand why users are not retaining. How much value do people get from the
application? What is the application being used for? 

Understand whether there might be roadblocks in using the application. Something might be broken that
keeps people from coming back / creates frustration.

3. Improve onboarding

Send users an email to invite them into your application and highlight the values of it. 

4. Awareness and promotion

Send a reminder over email or other internal channels.

5. Check for limitations 

Check if your system is restricting cookies from the user's browser.
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T - Task Success
Last Modified on 13.08.2024

About Task Success

The Task Success Rate will help you measure user interaction with tasks and interesting elements to be aware
if users complete tasks or interact with important features easily and efficiently.

It enables you to tag and measure the usage of the specific elements/features in your underlying app. Upon,
tagging in our Editor important elements show the process. (e.g. “submit” button, “save”, “finish” or anything
that indicates an important interaction with the engaged element) you will understand:

What percentage of your user base is doing tasks/interacting with these important elements?

Are important parts of your app being used? 

How many users interact with your killer feature?

Why use it

Task Success shows if users are able to successfully complete predefined processes.

A low Task Success Rate indicates a broken business process and potential to reduce support effort and
increase productivity.

A high Task Success Rate has big impact on your business results: 

Lower support cost
Higher productivity
Reduce usage mistakes
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How is it calculated?

Sessions that had interactions with Tags / all engaged Sessions = Task Success Score

Best Practices

Here are our Tips for Task Success: 

1. Consider our recommendations when setting up your Tags

You can find our tips of what to consider here.

2. Understand incomplete tasks

Investigate where people get stuck and educate or adapt processes. 

Conduct user research: understand better why they get stuck. 

https://docs.userlane.com/docs/how-to-tags
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3. Create awareness and promote content

Propose to use the Guide feature/add more guides since users seem to have issues

Promote certain Guides / consider an internal training / simplifying certain tasks.

Good to know
When you remove an application URL, tags will no longer be tracked but still appear in Task Success
overview. Remember to manually delete or reselect these tags.
The % of all users indicator starts to be populated after a significant number of users is reached. This is in
relation to all Users as indicated in the Engagement section.
At least one interaction is needed for a new Tag to appear in the All Tags list.
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Survey analytics
Last Modified on 04.03.2024

Why use it

Having the ability to ask any question regarding your application and its features provides you with the means
to measure user satisfaction. Understanding user sentiment plays a key role in comprehending how your
digital adoption is progressing. .

About Surveys

With the new emoji-based scale, survey participants can effortlessly provide feedback by selecting one of 5
emojis representing different sentiments. You can run multiple Surveys simultaneously across various pages
and User Segments within your application.

Each Survey has its own analytics page, allowing you to monitor its responses and view the comments users
have left. Use the date and segment filters to view results for a specific time frame or user group.

How is it calculated?

Survey score AVG of all Survey scores
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NPS analytics
Last Modified on 12.12.2023

Why use it

Measuring the Net Promoter Score (NPS) is the key to understanding your users’ opinion about your
application. Sending the NPS survey via email requires a lot of manual setup and the response rate tends to be
lower. It is time to move your NPS to where your users are - into your application.

About NPS

NPS is a recognized method to track your user’s loyalty and opinion based on how likely they are to
recommend your app. 

User responses range from 0-10 and they are divided in 3 groups:

Detractors: responses of 0-6. These users are not satisfied and could potentially share their negative
experiences with the others around them.

Passives: responses of 7-8. These users have a neutral attitude towards your product. Passives are not
unhappy, but also not likely to recommend your app. 

Promoters: responses of 9-10. These users enjoy using your app and are likely to recommend it to
others. In the B2C case, these users are likely to purchase from you again.  

ℹ️ NPS score is calculated by subtracting the percentage of your detractors from your promoters -> NPS =
% of Promoters – % of Detractors.

NPS analytics 

You will be able to see your NPS on your Analytics page. It also displays various trends, such as the score
going up or down over time.  You will also see comments that users left that can suggest improvements. For
deeper analysis, you can apply existing user segments to all responses.
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How is it calculated?

NPS score
(promoters - detractors) / all responses
NPS score can be from -100 to 100.

Promoters response scores 9 and 10
Passives response scores 7 and 8
Detractors response scores 6 or lower
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Segment Analysis
Last Modified on 19.02.2025

About Segment Analysis

Segment Analysis gives you a clear snapshot of segment scores across your application in a single view. This
makes it easy for you to compare scores, identify high performers, spot areas for improvement, and make data-
driven decisions to maximize value and ROI. 
You can find Segment Analysis on the HEART Overview page.

How to use it
Green indicates the highest score within the column.
Red indicates the lowest score within the column.
Filter by HEART section:
(Overview, Happiness, Engagement, Adoption, Retention, Task Success)
Filter by Segment:
The default view shows your top 5 segments by user count. Use the filter to adjust the number of
segments displayed.

Good to know
The data represents a rolling snapshot of the last 90 days and updates daily.
Newly created segments will appear in the filter but won’t show in the heatmap until tomorrow. 
User growth rate is not displayed in Segment Analysis.
The user goal is configured on the application level. Therefore the user adoption rate will be the same for
segments with the same number of users. User adoption rate = (actual users divided by user goal)
multiplied by 100.

Why use it
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Segment Analysis gives you a single, at-a-glance view of all your segments, making it easy to compare
scores and eliminating the need to navigate multiple pages.
With Segment Analysis, you can quickly identify high and low performers, helping you focus on areas
that need improvement.
By identifying high-performing and underperforming segments, you can allocate resources more
effectively, focusing on areas that drive the most value while minimizing unnecessary costs.
This feature helps you make better, data-driven decisions by providing clear insights into how your
segments are performing across your application.
By reducing manual data gathering and minimizing errors, Segment Analysis streamlines workflows and
improves efficiency, so you can focus on analysis rather than data collection.
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Userlane Content Analytics
Last Modified on 25.06.2024

Content Analytics

Evaluate how different users interact with your Userlane content and get live engagement insights on your
Guides, Announcements, and Tooltips.

Why use it

Use the analytics to

measure your content performance

find content that needs optimization

analyze Guides, Announcements, and Tooltips in-depth

The table below provides you with a high-level overview of Userlane Content Analytics with links to dive
deeper as needed:

Goal Metrics

Userlane
Content Overall

Users view and interact with
Userlane content

Views
Interactions

Content Types

Guides
Users start Guides and can

complete them

Overall Performance

Individual Performance

Analytics Error Log

Read more

Announcements
Users view and interact with

 Announcements

Overall Performance

Individual Performance
Read more

Tooltips
Users view and interact with 

Tooltips

Overall Performance

Individual Performance
Read more

https://docs.userlane.com/docs/guide-analytics
https://docs.userlane.com/docs/announcement-analytics
https://docs.userlane.com/docs/tooltip-analytics
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Guide analytics
Last Modified on 12.01.2024

Why use it

Use Guide Analytics to monitor how well each of your Guides is driving software adoption, based on how far
users have progressed through it. 

It helps you to:

evaluate the performance of each individual step
identify crucial drop-off points
make continuous improvements.

Metrics
Guides started over time

Guides' Starting Points

Where the user found and started the Guide.



283

Total: The number of times a Guide was started from each source.

%: The percentage of times a Guide was started from each source out of the total Guide starts. 

Individual Performance

Here, you will be able to find performance metrics for each individual Guide that you have published.

Next to each of your Guides, you will see the Guides' current status:

green dot: Guide is currently live
grey dot: Guide was live but is now unpublished

Step Details

You can click on any individual Guide to analyze its performance further and understand exit points and errors. 

Step Type
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First/Last Slide: appear as squares in the step list. 
Mandatory Step: appear as a solid circle in the step list. These steps require user interaction before they
can proceed to the next step. 
Optional Step: appear as a dotted circle in the step list. These steps either don't require user interaction
before users can proceed (e.g. explanation step) or they might have some skip logic linked. 
Step Alert: appear as a red circle in the step list. Users have experienced errors in these steps. Review
these errors by opening the error log contained within the step details.

Step Events

For every step you can review the events to better understand whether errors occurred. 

For more information around errors, review the following article:  Alert notifications

Best Practices
Utilize the Health Score 

Each Guide has a calculated Health Score. The Health Score indicates how far your users progressed through a
Guide. 

� Health Score = [Number of times a Guide was completed / (Number of times a Guide was started -
Number of times a Guide was exited on the first step)]

The score ranges from 0 to 100 where a 100 means all users are completing the Guide. 

https://docs.userlane.com/docs/alert-notification
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Understand the reason for the low Health Score

Error Alert was triggered: Users have challenges completing this Guide.
Action: Take a look at this article on resolving alerts.

No Error Alert but low Health Score compared to others: Users have challenges completing this Guide. If
the Guide is not breaking, then the users are exiting intentionally. 

Action: Review the Guide to consider why a user might exit. 
Example: If you included a link within one of the steps in the Guide, it is possible that the users are
clicking on the link but then never returning to complete the Guide. Consider only including links in
steps that are towards the end of the Guide so that users are not being encouraged to leave the
Guide before completing important steps. 

Leaving Guide earlier than expected: Users may find the answer to a question they had before reaching
the end of the Guide and will exit early. 

Action: Review whether links are embedded in the beginning of the Guide or process can be
finished without completing the Guide. Consider adjusting the Guide or segment.

https://docs.userlane.com/docs/alert-notification
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Guide step details
Last Modified on 12.01.2024

Why use it

Step details provide insights into each of your Guide steps to help you understand exit points and errors. First,
select the time range that you want to analyze and apply any filters to narrow down the user group you are
interested in.

All Guides

At a glance you can see all your Guides and see 

Current status: Check here to see if your Guide is currently Public, meaning available to your users, or
Private, meaning it is hidden from your users.
First time published: The date you first made your Guide available to your users.
Page Segment: If applicable, this will show the page segment you have applied to this Guide. 
User Segment: If applicable, this will show the user segment you have applied to this Guide. 

By clicking on a Guide you will be redirected to Details about the Guide

Guide Details

How did your Guide perform?

Health score: The Health Score indicates how far your users progressed through the Guide.
Failure rate: It's the percentage of users that left a Guide due to an error, in ratio to all users that started
the Guide. 

ℹ️ Health Score = [Number of times the Guide was completed / (Number of times the Guide was started -
Number of times the Guide was exited on the first step)]

The score ranges from 0 to 100 where a 100 means all users are completing the Guide. It is important to note
that users can still be receiving value from Guides even if they are not completing them. See this article for
scenarios where this may be the case.

Guide started: The number of times this Guide was started. It could include the same user multiple times
if they started the guide more than once.
Unique Guide started: The number of users who started this Guide. Each user will only be counted once
towards this number.

https://docs.userlane.com/docs/guide-analytics
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How did specific Guide steps perform?

Evaluate the performance of each step within your Guide. 

Step shown: The number of times this step was shown to your users. 
Users: Number of users that saw this step.
Exit rate: Intentional exits / Step shown
From previous/next steps: Explains if the step was shown due to users coming from previous steps or if
they went back to it from the following steps.
Skips: Number of times the optional step was skipped.
Intentional exits: Number of times the step was intentionally exited (close button or escape key).
Errors: Number of times this step was not found and the error pop-up was shown.
(total) Error exits: Number of times users exited the Guide from the error pop-up.
Error rate: Errors / (Errors + Skips + Shown)  

If the error rate is low, there is likely no cause for concern as it is entirely possible the user simply had
technical difficulties on their end, such as a lost internet connection. Otherwise, it could be that Userlane
was unable to find the element on the page for this step. 

To find out more information about which users experienced the error, click the symbol within the error
window in order to open the Error Log.

For more information around errors, review the following article: 
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Alert notifications

Step Key

First/Last Slide: appear as squares in the step list. 
Mandatory Step: appear as a solid circle in the step list. These steps require user interaction before they
can proceed to the next step. 
Optional Step: appear as a dotted circle in the step list. These steps either don't require user interaction
before users can proceed (e.g. explanation step) or they might have some skip logic linked. 
Step Alert: appear as a red circle in the step list. Users have experienced errors in these steps. Review
these errors by opening the error log contained within the step details.

https://docs.userlane.com/docs/alert-notification
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Analytics error log
Last Modified on 12.01.2024

Why use it

If you need to resolve an alert, the Error Log can provide more information to help you understand why the
error occurred. 

Guide details

Current status: Displays the status of this Guide. This is either Public or Private. 

First time published: Displays the date that this Guide was first published.

Page segment: If applicable, displays the page segment applied to this Guide. 

User segment: If applicable, displays the user segment applied to this Guide. 

Error details

Errors recorded for a particular step display the following information: date and time that the error occurred, ID
of the user who experienced the error, and which browser and screen resolution they were using at the time of
the error. 

Click the user ID to find more information about that particular user, for example, their email address or other
attributes. 
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The error list table above displays errors in date order. By default, only 30 errors are shown, but you can click
"Load more" to load up to 90 errors on this page.  

The blue highlighted "Guide Updated" row displays the date and time of the last update to the Guide. Any
errors occurring after this time will be displayed in bold text.

For finding the Error log you need to go to the Analyze tab > Guides. Then you need to have a Guide with errors
and go to the particular step and click the arrow next to it to open a tab like below. Then click on the Errors to
open the Error log.

Best Practices

Sometimes, the same user will trigger multiple errors. Review the user ID column and to see if any IDs
repeat. If so, this could mean that the error is not a widespread issue, but limited to a particular user.
Action: Find out more about that particular user by clicking their user ID. 

If all of the errors are occurring for the same browser, consider if most of your users use the same browser
or if they use a variety of browsers.
Action: If they use a variety, test this guide using the browser where your users seem to be experiencing
errors to identify what the problem could be. 

If all of the errors are occurring in a smaller screen size, it is possible that some of the elements being
highlighted in your guides are being hidden while a user is in smaller resolution.
Action: Shrink your browser window and test this guide in the smaller resolution.  

If all of the errors occur before the Guide Updated date rather than after, it could be that you have already
resolved the problem with your most recent change to the guide.
Action: Check back in later or wait to see if another Alert email is triggered for this guide.

After reviewing the timestamps of the errors, consider if the underlying application was down at any point
when these errors occurred. If so, there is likely no problem with the guide.
Action: None. In order to remove the red alert symbol, you can always make a small text change. Any edit
to a guide will remove the alert.  
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User Details and Activities
Last Modified on 12.01.2024

About User Details and Activities

Userlane can give you insights into the User data that is being passed to us depending on your individual
configuration. This data can be accessed in the Userlane Portal.

⚠️ If privacy regulations within your company do not allow displaying such information, please reach out to
your Customer Success Manager to have this option disabled.

In this article, we will show you where to find the data and explain how you can use the data.

Why use it

You can 

check if a specific User has completed the Guides.
check if a user was “targeted” and, if needed, update the segment so this and other users are included in
it. 
review user activities, e.g. completed Guides
check User information e.g. if you want to validate/test that an attribute you are sending is associated
with the user

How to access it

To access the User Details section of the Portal, follow these steps:

1. Go to the Segments > Users section.
2. You will see a list of Users. 
3. Note that the list contains a limited number of users, and the total number is displayed above the list.
4. To view details of a specific User, click on their entry in the list.
5. The User section is divided into Details and Activities. The Details section provides general user data. The

Activities section displays the User's interaction with the Guides.
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Below, we will present both of the sections. 

User Details

This section shows some general information on the User (Standard Attributes). It will also contain the data
you decide to pass to Userlane in the Attributes (Application Attributes and Company Attributes). 

In this chart, you will find the explanation of the data items.

Customer User ID This is the ID that is assigned to that user to identify them

If no specific ID is assigned, a random ID will be generated

Source

Shows how the User was created:

Unknown: is the default value

snippetCustomer: The Customer passed this id via the Snippet 

snippetUserGenerated: Userlane player generated a random id (because none
was set by customer)

browserExtensionSTE: Userlane's end user ID provided by the Browser Extension
(with a registered companyUser)

browserExtensionMGR: Userlane's browser extension provided the ID in manager
mode

First Time,
Last Time Active

Showing the first time Userlane recognized the User or showing the last time Userlane
was shown to the user

Application and
Company Attributes

Shows additional data that is passed for the User by the client in the form of Attributes.

The difference is if Data is passed via a Snippet (Application Attributes) or a Browser
Extension (Application and Company Attributes)

User Activities

The Activities section will show you the Guides the User has interacted with and the ones he is targeted with.
The list is organized by Chapters.
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The list will show you the interaction type of a given Guide:

Targeted: means if the Guide is available to that user (User is included in the segment)

Started:  shows if the User has started the Guide (not necessarily completed)

Completed: shows if the user has completed it

Date: shows the completion date

The dots next to the Guide and Chapter titles indicate whether they are published (green) or 

private (gray). 

How to find specific Users and display their Data

The User List shows a limited number of Users, ones who were most recently active with Userlane. 

To display a specific User or group of Users:

1. Go to User Segmentation

2. Apply the criteria that are needed to specify the user, e.g. ID, behavior, attributes. You can also have a
combination of them

3. Review the list of users matching the criteria

4. Click on the User ID
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Announcement analytics
Last Modified on 12.01.2024

Why use it

Use the Announcement Analytics to understand how your notifications are performing and how to optimize the
experience.

Views and interactions
How many users saw your announcements?

Any of the following events would be considered an Announcement view:

announcement was automatically opened via an announcement prompt or opened intentionally by the
user

announcement(s) were pushed to users and popped up automatically (one announcement push could
include multiple announcements if you have more than one active at once)

� The number of Views could include the same user multiple times, while the Unique Views will only count
a unique user once.

How many users interacted with your announcement?

Any of the following events would be considered an Announcement interaction:

Guides started: a Guide was started from an Announcement 

Links clicked: a link was clicked from an Announcement

� The number of Interactions could include the same user multiple times, while the Unique Interactions will
only count a unique user once. 

Performance

Here, you will be able to find performance metrics for each individual announcement that you have published. 
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Next to each of your announcements, you will see the image that was included with the announcement (if
applicable), as well as the announcement's current status:

green dot: announcement is currently live
grey dot: announcement was used or is in draft mode

 

Interaction Rate

Each announcement has a calculated Interaction rate:

Interaction rate = (Unique Interactions / Unique Views) * 100

 

Best Practices

There are valid reasons for a low Interaction rate. Find here concrete tips what to consider then.

The Announcement did not include a link or direct the user to begin a guide. 

Action: Consider the purpose of your Announcement.

If your goal was to simply relay information to your users, then the best metric for you to use is the
number of views your Announcement has, rather than referencing its interaction rate. If your goal
was to have the user start a Guide, try including the Guide in the Announcement.

The announcement did direct the user to a guide, but not many users actually started the guide from the
announcement. Note that the included guide will not appear to any users who are not included in the
segmentation for that guide. 

Action: Try checking the segmentation that has been applied to the guide and make sure that the
users who are viewing the announcement are also users who you would like to begin the included
guide.

The announcement was pushed at the same time as other announcements. The users may not see or read
through all of them. 

Action: Try staggering your announcements apart so that the users do not become overwhelmed
with them all at once. Don't forget to consider how frequently your users log into your application.
They will not see the announcement until they log in, regardless of the announcement publish date.
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You have reused an old announcement (you published an announcement, set it to private, and later
published it again). Since announcements will only be pushed to a Unique user once, repurposing old
announcements will not trigger a pop up for any user who had already viewed the old announcement in
the past. 

Action: Instead of reusing old announcements, try duplicating the old one or creating a new one
from scratch.
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Tooltip Analytics
Last Modified on 04.04.2024

Why use it

Use Tooltip Analytics to monitor how well your Tooltips are driving software adoption and supporting your
users where they need help. This page allows you to track the interactions with all Tooltips over time, as well
as dive deeper to see more granular data for individual Tooltips. 

Metrics
Views over time

In the chart above you can see the total views for all of your Tooltips as well as the number of unique viewers
plotted over time. 

Individual Performance

Below the Views over time chart, you will find a table with all Tooltips.
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Each row corresponds to an individual Tooltip and offers you a helpful overview of that Tooltip's performance.

The horizontal bar chart in the middle of the table represents total values:

Visits: a visit is counted when a user comes to a page and the Tooltip loads
Views: a view is counted when a user has clicked on a Beacon or hovered over a Hint
Link clicks: if a Guide has been linked to Tooltip, a link click is counted when a user clicks on the linked
Guide.

The View Rate metric corresponds to the total visits and views shown in the bar chart and is calculated as
(Views / Visits) * 100.

ℹ️ It's possible to have a View Rate greater than 100% for Hints. This is expected because we calculate the
View Rate using Total Views and a user can view a Hint type Tooltip multiple times in a single visit.

The table also shows you Unique Viewers and Unique Visitors, which correspond to unique users who have
respectively viewed the Tooltip and/or visited the page where the Tooltip is available.

� You can filter the table using the metrics described above. For example, filter by Most Unique Viewers to
see which Tooltips are reaching the most individual users. 

Tooltip Details
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You can click on any individual Tooltip to see how it has performed over time. In this case, you will see a
representation of View Rate and Click Rate, with Click Rate being calculated as (Total Clicks / Total Views) *
100.

Below you will find a graphical representation of Total Events and Unique Users, similar to the All Tooltips
table on the overview page.
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App Discovery
Last Modified on 09.04.2024

About App Discovery

 Userlane App Discovery helps you assess your organization's SaaS landscape by revealing the applications
your employees actually use. It leverages the power of our browser extension to give you a clear overview of
the most frequently used apps from a wide range of popular SaaS tools.

Why should you use it?

The bigger a company gets, the more money and time it spends on various software applications. A lack of
visibility into the actual app and license usage across the entire business is not only hard to manage, but can
quickly lead to an exhausted or exceeded IT budget and a higher compliance risk. 

App Discovery can easily find, rank, and filter active user applications by software type and country, providing
you with a clear overview of your company’s SaaS portfolio.

You're spending a lot on licenses for certain apps, but aren't sure if and to what extent employees actually
use them? Let's find out and reduce unnecessary costs!

You rolled out a new application, and want to know if your employees are actively using it? We can show
you the level of adoption and where to focus your training efforts.

Different teams in your company use redundant applications for a similar or the same purpose? Consolidate
apps and reduce your software spend by phasing out the ones with a lower HEART score.

You're in the final stages of migrating from one application to another, and you're not sure how many users
are still active in the old one? We can get the exact number for you.

There are SaaS apps your employees aren't allowed to use? Use App Discovery to make sure they really
don't.

How do you enable it?

App Discovery is enabled for all customers by default, but it requires the Userlane browser extension to be
implemented in order to start discovering apps. 

Once implemented, the browser extension will monitor the usage numbers for the most popular SaaS
applications. If it observes traffic on one of those apps (by at least one user), the results will be shown on your
dashboard. 
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ℹ️ The Userlane browser extension does not track every page the user visits. It only registers visits to the
predefined list of top SaaS applications (e.g. Salesforce, Jira, Trello, SuccessFactors).

ℹ️ App Discovery will not work when you have Userlane implemented with a Snippet as then only
information about the page where the Snippet is implemented can be passed on.

If you need to disable App Discovery, you can always do so on the Analytics settings page in your Userlane
Portal.

How do you get the most out of your discovered apps?

App Discovery will give you an overview of the revealed applications your employees actually used. For each
app, you will see how many users have been detected. To get an ever deeper understanding of the usage of
these applications, you can: 

Turn on HEART Analytics for more granular insights 

To get more detailed analytics for a specific application, simply click the 'plus' icon to add the application to
Userlane. We will then start tracking the HEART metrics to measure its user engagement, adoption and
retention in more detail, which allows you to identify specific points of action.

Improve your application's adoption with our in-app engagement suite

Based on the app's HEART analysis, you can improve individual metrics by providing targeted in-app help and
guidance to your employees.

No applications were discovered for my company

If App discovery fails to identify any apps for your company, here are some steps to consider:

1. Browser extension not rolled out: Ensure that the browser extension has been correctly deployed within
your company. If you've only used Userlane snippet until now, this might be the case. App discovery
requires a browser extension to function properly. Additionally, confirm whether the extension is
installed by most of your users.

2. Browser extension not updated: Check if the Userlane browser extension has been updated for your
users to the latest version.

3. Company users: Confirm that your users are registered as Company users within your organization.

4. Application list: Verify if you are using apps from our tracked app list. If you're not finding the apps you
need, please reach out to us so that we can enhance our app tracking list.

5. Custom domains: Contact us to determine if your company utilizes custom domains for specific apps that
should have been discovered by App discovery.

https://docs.userlane.com/docs/list-of-apps-that-are-counted-in-the-app-discovery
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Top SaaS apps included in the App
discovery
Last Modified on 27.01.2025

In order for App discovery feature to discover the applications used in your company, the Userlane browser
extension observes the usage of leading SaaS application. However, it will only track visits to a predefined list
of top SaaS applications.

The tracking operates by identifying the app's domain, so when the domain includes the specified pattern, it is
presumed that the user is on that page. For instance, if "workday" is detected in the domain.

This list may expand in the future to include more SaaS applications, but it will specifically include only work-
related tools and not websites that your employees might visit during their leisure time.

We will maintain transparency and regularly update this list for you to check.

List of applications included in the App discovery
15five
360Learning
99designs
Absorb
Accolade by Sopheon
ActiveCampaign
Adobe Creative Cloud (Web)
Aha!
ahrefs
Amazon AWS
Amplitude
Animoto
ApplicantStack
Aprimo
Aqua Security
Asana
Atlassian
Autodesk
Awario
Balsamiq
BambooHR
Basecamp
Beautiful.ai
BigPanda
Bill.com
BIM360
BIMcollab
bit.ai
Bitbucket
BIt.ly



306

Blackboard
Bold Sign
Box
Brain.fm
BreezyHR
Bubble
Calendly
Canva
Capdesk
Capterra
CARA
Caret Legal
CaseFleet
Casetext
Ceipal
CharlieHR
Chaser
ChatGPT
Clara
ClearCompany
cleverbridge
ClickUp
Clio
Clockify
Code Academy
Codepen
Consensus AI
ConstantContract
Continu
ContractSafe
Cookiebot
Cornerstone
Coupa
Coursera
Crazy Egg
CrunchBase
Cvent
d3js.org
Dassault Systèmes - 3DExperience
Databricks
DataCamp
Datadog
DataGuard
DeepL
Demio
Devpost
Docebo
DocSend
DocuSign
Dovetail
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DreamHost
Drift
Dripify
Dropbox
Dropbox Sign
D.Vinci
Everlaw
Excalidraw
Expensify
Feedly AI
Figma
Finway
Fireflies
Fiverr
Flickr
FormAssemby
Frase
Freshbooks
Freshdesk
Freshworks
Funnel
Fyle
G2
Gamma
Gartner
Gemini
Ghost
Gimp Online
Github
Gitlab
Google Ads
Google Analytics
Google Calendar
Google Console
Google Docs, Sheets, Slides & Forms
Google Drive
Google Jamboard
Google Mail
Google Meet
Google Sites
Google Trends
Grafana
Greenhouse
Heap
HiBob
Hireology
Holobuilder
hootsuite
Hotjar
HROne
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Hubspot
Hunter.io
Icertis
iGrafX
Infogram
Intercom
Intuit
Ironclad
isolved
Jasper
JazzHR
Jira On-Prem
Jotform
Juro
Kahoot!
Kanbo
Kira
Klaus
Klaviyo
KnowBe4
Krisp
Laserfiche
Lattice
Leadpages
Leapsome
Learnerbly
Ledgy
Legalinc
LegalShifter
LegalZoom
Lever
Lexis Nexis
Linear
LogRocket
Loom
LucidChart
Mailchimp
Mailgun
Mailtrap
Make
Marketo
Master Control
Matomo
Maze
Meetup
Metabase
Microsoft SharePoint
Miro
Mixpanel
Monday
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Mouseflow
MS Dynamics 365
MS PowerApps Portal
Mycase
New Relic
Nextiva
NextRoll
Notion
Officevibe
Olark
One Trust
Ontraport
OpenCollective
Optimizely
Oracle Cloud
PandaDoc
PaperForm
Paylocity
Perplexity
Personio
Phrase
PicMonkey
Pipedrive
Pixlr
Planisware
Poe.com
PowerBI
PPM Express
Prerender.io
Prezi
ProductBoard
ProductHunt
ProofHub
Qualaroo
Quora
Recruitee
Recruiter
Recurly
Relativity
Restream
Retrium
Rippling
Salesforce
SalesHandy
SAP Ariba
SAP BTP
SeedProd
Segment
SEMRush
SendGrid
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Sentry
ServiceNow
Shipa
Shopify
Shopware
Similarweb
SimpleLegal
Sketch
SkillShare
SmartDraw
Smartlook
SmartRecruiters
Sonarcloud
Spendesk
Sprout Social
Squarespace
StackOverflow
Storyblok
SuccessFactors
Supermetrics
Supernova
SurveyMonkey
SurveySparrow
Survicate
TalentLyft
Tanso
TeamTailor
TeamViewer Web Client
Teamwork
Timely
Travelperk
Trello
Trevor AI
TrustArc
Twilio
Typeform
Udemy
UKG
Unbounce
UsabilityHub
UserTesting
Veeva
Vidyard
Vimeo
VisiLean
W3School
Wave Financial
Webflow
Weekdone
Wellfound
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WeTransfer
Whereby
Whimsical
Wirke
Wistia
Wix
Wondercraft
WordPress
Workable
Workday
Workday Adaptive Planning
Workfront
Xero
Zapier
Zendesk
ZEP
Zoho
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The Userlane AI Assistant
Last Modified on 12.02.2025

What is the Userlane AI Assistant?

The Userlane AI Assistant is an intelligent assistant that automates routine tasks, provides real-time
suggestions, and seamlessly integrates into your existing workflows. By leveraging natural language
processing, the Userlane AI Assistant is there when and where your users need it. To ensure a consistent user
experience, the Userlane AI Assistant can be embedded across various systems at your organization via the
same simple and straightforward Userlane implementation.

How can I activate the AI Assistant?

In the Userlane Portal you will find a setting called 'Agentic Assistance' where you can enable the AI Assistant.
You will need to apply a User Segment before you can activate the AI Assistant for your users. This allows you
to choose a specific user group who will receive the AI Assistant, while all other users remain with the classic
Userlane Assistant.

If you have questions or need help activating the AI Assistant, please reach out to your Customer Value
Manager.

How is it different from the classic Userlane Assistant?

The Userlane AI Assistant introduces a conversational chat interface to our product and our users. Users can
chat with the AI Assistant to ask for help in completing a task in their application. Much like LLM products that
users are already familiar with, such as chatGPT, the Userlane AI Assistant will then find the most relevant
answer to the user query from the existing Userlane content for that application. The AI Assistant can return
Guides and Messages to the user query, as well as knowledge base articles if a knowledge base integration
exists. The Guide can then be started as normal, but the AI Assistant will also automate all possible steps to
help the user complete the task faster.

https://docs.userlane.com/docs/process-automation-via-guides
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What if I don't want to activate the AI Assistant?

That's no problem at all. It's up to you whether you'd like to activate the AI Assistant for all or some of your end
users. 

Will the AI Assistant be shown to all of my users?

No. We have curated a careful approach to how the AI Assistant will be rolled out to end users for this release.
You will only be able to activate the AI Assistant for a subset of users who belong to a certain user segment.
We recommend creating a new user segment with a smaller number of more advanced users in your
application. We are also happy to support you in the user segment creation. 

Do I need to prepare anything?

In order to enable the AI Assistant, you will need to select a user segment that represents your test group.
Please review your existing user segments and, if needed, create a new one for the AI Assistant early access
testing. 

Otherwise, please review this help doc on how to optimize your content for the Userlane AI Assistant. This will
ensure that the testing goes smoothly.

https://docs.userlane.com/docs/user-segmentation
https://docs.userlane.com/docs/optimize-content-for-the-userlane-copilot
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How to optimize content for the
Userlane AI Assistant
Last Modified on 12.02.2025

How does the AI Assistant find content?

When a user interacts with the AI Assistant chat interface, the AI Assistant can offer Userlane Guides as a
response to assist the user in completing their task. But how will the AI Assistant know which Guide is
relevant to the users query?

The AI Assistant searches through Guide content to find the most relevant Guide to answer the users question.
In order to do so as accurately as possible and improve performance, the Userlane AI Assistant will only search
through the Guide Title, Intro Slide Title, and Intro Slide content.

The Intro Slide is the first step in a Guide that typically provides a short summary as to the Guides focus and is
not attached to any UI element of the underlying application. The task or purpose of the Guide is typically
present in these text areas of Guides, so we have refined the AI Assistants focus to search only here.

Guidelines and Best Practices

To help you optimize your Guides for the AI Assistant, we have compiled the guidelines and best practices
below. Use these to review your existing content and adapt the texts as necessary or to guide you when
creating new content. 

Guide Title

Craft the title of your Guide after the task it is meant to support users with

For example, ‘Create a new lead’

Use action verbs as the first word in your Guide title to make it clear the Guide is to help users perform a
task

Alternatively, begin your Guide titles with ‘How to…’ 

Intro Slide Title

Mirror the Guide title to ensure it is clear that both the Guide and Intro Slide titles refer to completing the
same task.

Intro Slide Text

Use direct language that speaks to the user and explains the task that the Guide supports

For example, ‘This Guide shows you how to create a new opportunity in Salesforce.’

Sometimes it might be useful to clarify in which situations this Guide can be useful

For example, 'For existing customers, new opportunities are necessary for Upsells and Expansions.'
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Multi-Language Use Cases
Can users write to the AI Assistant in any language?

Yes, users can write to the AI Assistant in any language and it will respond to them in that language as well.
However, the language of the Guides it returns is determined by the language detection checklist described
here.

https://docs.userlane.com/docs/userlane-language-detection
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About Userlane Integration
Last Modified on 06.02.2024

Why use it

Userlane integration helps connect users to information through the Userlane Assistant. Leverage Assistant
Search by linking it to your organization's knowledge base or collaboration tool. Use our Integrations page to
easily add, manage, or remove connections.

Ready to get started? Select your platform below to learn more.

ℹ️ Integrations are not available for self-hosting users. 

Supported platforms
Confluence 
Zendesk
KnowledgeOwl
SharePoint

�  Don't see your platform here? We are committed to supporting integrations with your favorite enterprise
systems. If you would like to see yours featured in our ambitious roadmap, let us know!

How it works

After setting up the integration and enabling Userlane Search, your users can search for content without
leaving your app. They'll see results with related Userlane content, like Guides and Announcements. Icons and
filters make it easier to identify and narrow down the search results.

https://docs.userlane.com/docs/integrations-with-confluence
https://docs.userlane.com/docs/zendesk-integrations
https://docs.userlane.com/docs/knowledgeowl-integrations
https://docs.userlane.com/docs/sharepoint-integration
https://www.userlane.com/contact/
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Users can view documents in the Search window while using your app. They can switch back to search results,
perform new searches, or use the app normally. To keep the preview active, they can click the minimize icon
and pin it to their screen.

If you haven't already enabled the Search feature for your users, you can learn more about its benefits in our
Search through the Userlane Assistant article.

ℹ️ Some apps have IP filters that prevent the connection with Userlane. In that case, please reach out to
your Customer Success Manager or to Userlane Support.

https://docs.userlane.com/docs/search-through-the-userlane-assistant
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SharePoint Integration
Last Modified on 13.02.2024

Your Userlane solution can be integrated with SharePoint providing a simple way for your users to search
SharePoint content without context switching. 

This article covers

how it works
what can be searched
how to set it up

 

How it works

When you search using the Assistant, it looks for information in both Userlane (like guides and
announcements) and SharePoint. If your search includes results from SharePoint, you'll see a document icon. 

Clicking on a SharePoint result will show you an improved view of the content. If the page is long and needs
scrolling, you can open the original page in SharePoint by clicking the link below the document title.

ℹ️ Please note that this requires logging in to SharePoint, which means that users without such a login
won’t be able to open pages directly in SharePoint, and can only view the content from the Userlane
assistant.

What can be searched

Due to the Microsoft Graph API limitations, we cannot search and retrieve all SharePoint content types. 

We do search:

SharePoint pages, but only the web text parts in page names, titles, and page content

lists and list items

We cannot search:

embedded web content, such as images and documents

wiki pages

ℹ️ We are NOT indexing SharePoint content in our own database. Instead, we rely on the Microsoft Graph
API to get the results in real time. Therefore, it is not possible to compare search results from SharePoint’s

https://app.knowledgeowl.com/#how
https://app.knowledgeowl.com/#what
https://app.knowledgeowl.com/#set
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native search with the results that Userlane shows in the assistant.

 

Set-Up
Prerequisites

Use the Microsoft Graph API and not SharePoint's own native API which is the way that is recommended
by Microsoft as its no longer developed further because Microsoft strategically decided to replace it with
Microsoft Graph API
Be an Azure AD admin
Userlane Admin or Moderator role permissions

� Limitation of the Graph API: Our integration only works for SharePoint online, not on-premise!

Enable Integration

1. Register Userlane as an application in the Microsoft Azure Active Directory (This can only be done by an
Azure AD admin)

As a prerequisite for us to connect to SharePoint, Userlane has to be registered as an application in your
organization's Azure AD tenant that is linked to SharePoint. 

� For the integration to work as intended, the Userlane application needs at least the Sites.Read.All
permission for Microsoft.Graph , which has to be assigned under API permissions in the application
registration portal. In addition, this will require consent from an Azure AD administrator in the Azure
portal, which has to be repeated any time the permissions for the app are changed.

After registering Userlane in Azure AD, you'll need the following details to set up the integration:

1. Azure Active Directory Tenant ID: This is the ID of the tenant where Userlane is registered as an
application.

2. Application/Client ID: It's the unique ID assigned to Userlane as a registered app, used for authentication
with the Microsoft Graph API.

3. Application/Client secret: This secret is linked to the above ID and allows Userlane to authenticate with
the Microsoft Graph API. You can generate it in the Certificates and secrets menu of the application
registration portal. Remember to copy it's value (not ID) as it's only shown once during generation.

For step-by-step instructions on how to register an app in Azure AD, please use this Microsoft support article. 

2. Enter the required fields in the Userlane Portal

https://docs.microsoft.com/en-us/graph/auth-v2-service
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To connect Userlane with SharePoint, follow these steps:

1. Log in to the Portal and navigate to

Account > Global settings > Integrations

2. Choose the SharePoint integration from the "Available integrations" section.
3. Fill in the following details in the form that appears:

Integration name: This is how the integration will appear in the search settings.
SharePoint Subsite URL: Enter the URL of the specific subsite in SharePoint that the integration will
search.
Azure Active Directory Tenant ID, Application/Client ID, and Application/Client secret value: These
details were obtained in the previous step.

4. Once you've entered the information, save and connect.

ℹ️ After setting up the connection, it will be tested. If any information is incorrect, you'll see an error
notification below the fields. If everything is correct, the integration will appear in the "Connected
integrations" section of the Integrations page.

3. Activate the integration for your property’s search

In the Portal, go to Customize > Search and make sure that the search is actually activated for the property.
Then scroll down to “Connect search with (SharePoint integration name)” and enable the toggle. This will
activate the integration for the end user, and include the relevant SharePoint subsites in all searches done in
the assistant.

4. Test the integration

Go to the application the property is set up for, and test the search in the assistant to check that the integration
has been set up correctly and that you can see SharePoint search results.
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Confluence integration
Last Modified on 25.07.2024

Connecting Confluence with your Userlane Assistant is a simple way to enable your users to search
Confluence content without context switching. 

This article covers

how it works
what can be searched
how to set it up

 

How it works

Once the integration is set up and enabled, your users can seamlessly access Confluence content through the
Search feature in the Userlane Assistant. Different content types are identified by an icon to help you quickly
identify the source, which include Guides, Announcements, and yes, Confluence pages!

 

Search results and ranking

Alongside your Userlane content, search queries are applied to Confluence page titles and content text, using
partial or complete searches.

Ranking

Search results are prioritized in the following order:

Frequency of search term in title

Frequency of search term in body content

Most recent updated date and time

All content types are treated equally when determining their priority in search results. 

Viewing results from Confluence

Search results are listed in the Assistant in the priority order described above. Your users can easily identify
Confluence content by the document icon. If their results include more than one content type, they can select
content filters to refine their results to specific types (Guides, Announcements, and documents). A maximum of
50 results is displayed.

https://app.knowledgeowl.com/#how
https://app.knowledgeowl.com/#what
https://app.knowledgeowl.com/#set
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To view content in an expanded preview window, users simply select a document result. 

With the document view displayed, they can continue to use your application as normal, return to the search
results view, or perform another search. If they want to keep the preview active while using the application,
they can click the minimize icon in the top right of the preview window to pin it to their screen. Expand it again
to continue from where they left.

� Good to know

If the content is too long for easy scrolling, users can open the original document in a new browser tab by
selecting the original document link under the page title. This action might require a Confluence login, for
example, if the page does not have anonymous access permissions.

 

Setup
Prerequisites

API access to Confluence

Userlane Admin or Moderator role permissions

Permissions

It’s important to note that Confluence permissions for the integration are inherited from the Confluence user for
which the API token is generated. If you want to ensure that the correct permissions apply, create a Confluence
user specifically for the integration and set up the required permissions and restrictions before generating the
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API token.

Generate an API token

Generate the API token by following Atlassian’s step-by-step guide. If you haven’t already created a
Confluence user for this purpose, do so before completing this step.

Enable the connection for your organization

1. Sign in to the Userlane Portal and go to Account > Global Settings > Integrations.

2. Select Confluence under Available Integrations.

3. Enter the following details:

Name (optional): You can change the default name assigned to the connection to help you identify it
if you use more than one

The URL of your Confluence, e.g. https://ourcompanywiki.atlassian.net (the link should end with
.net)

The email address of the Confluence user that you defined for the integration

The API token created for the Confluence user

4. Select Save and Connect. Once the connection is created successfully, it appears under Connected
Integrations on the Integrations page. You can later edit or remove a connection for maintenance
purposes, or if it is no longer required.
Note: If the connection cannot be established, an error message displays with details of the issue, e.g.
URL could not be found, or an API token that did not work.

https://support.atlassian.com/atlassian-account/docs/manage-api-tokens-for-your-atlassian-account/
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Activate the integration for your applications

Before enabling this feature, remember to customize or translate the default texts that are provided for search
filters and document preview. You can do this from the Portal by going to Customize > Texts, then select
Search under Assistant.

 To connect Search with Confluence:

1. Sign in to your Userlane Portal and go to Customize > Search.

2. Under Activate Search, ensure that the Display Search In The Assistant toggle is enabled.

3. Under Activate Knowledge Base Search, enable the toggle for Confluence. If you have multiple
applications, repeat these steps for each application for which you want to enable the integration.

Test the integration

Test your connection before announcing the Confluence integration to your users. 

1. Open an application that has Search and a Confluence connection enabled.

2. Launch the Assistant then click the Search icon.

3. Enter a search query that should have matching results from your Confluence instance.
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KnowledgeOwl integration
Last Modified on 12.01.2024

Connecting KnowledgeOwl with your Userlane Assistant is a simple way to enable your users to find relevant
content without switching applications or opening more tabs. 

This article covers

how it works
what can be searched
how to set it up

 

How it works

Once the integration is set up and enabled, your users can seamlessly access KnowledgeOwl content through
the Search feature in the Userlane Assistant. Different content types are identified by an icon to help them
quickly identify the source; these include Guides, Announcements, and of course, KnowledgeOwl articles.

Search Results and Ranking

Alongside your Userlane content, search queries are applied to KnowledgeOwl page titles and content text,
using partial or complete searches.

 

Ranking

Search results are prioritized in the following order:

Frequency of search term in title

Frequency of search term in body content

Most recent updated date and time

All content types are treated equally when determining their priority in search results. 

Viewing results from KnowledgeOwl

Search results are listed in the Assistant in the priority order described above. Your users can identify articles
by the document icon. If their results include more than one content type, they can select content filters to
refine their results to specific types (Guides, Announcements, and documents). A maximum of 50 results is
displayed. 

https://app.knowledgeowl.com/#how
https://app.knowledgeowl.com/#what
https://app.knowledgeowl.com/#set
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To view content in an expanded preview window, users simply select a document result. 

With the document view displayed, they can continue to use your application as normal, return to the search
results view, or perform another search. If they want to keep the preview active while using the application,
they can click the minimize icon in the top right of the preview window to pin it to their screen. Expand it again
to continue from where they left.

� Good to know

If the content is too long for easy scrolling, users can open the original document in a new browser tab by
selecting the original document link under the page title. This action might require a KnowledgeOwl login,
for example, if the page does not have anonymous access permissions.

 

Setup

Prerequisites

API access to KnowledgeOwl; 

Userlane Admin or Moderator role permissions

Permissions

It’s important to note that KnowledgeOwl permissions for the integration are inherited from the
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KnowledgeOwl project for which the API token is generated. If you want to ensure that the correct permissions
apply, create a KnowledgeOwl project specifically for the integration and set up the required permissions and
restrictions before generating the API token.

Generate an API token

Generate the API token by following KnowledgeOwl's step-by-step guide.

Enable the connection for your knowledge base

1. Sign in to your Userlane Portal and go to  Account > Global Settings > Integrations.

2. Select KnowledgeOwl under Available Connections.

3. Enter the following details:

Name (optional): You can change the default name assigned to the connection to help you identify it
if you use more than one

The URL of your KnowledgeOwl knowledge base, e.g. helpcenter.mycompany.com

Your KnowledgeOwl API key

Your KnowledgeOwl project ID; you can locate the product ID in your KnowledgeOwl knowledge
base URL, e.g. https://app.knowledgeowl.com/kb/articles/id/606c0c03ec161cb96ed0969a.

4. Select Save and Connect. Once the connection is created successfully, it appears under Connected
Applications on the Integrations page. You can later edit or remove a connection for maintenance
purposes, or if it is no longer required.
Note: If the connection cannot be established, an error message displays with details of the issue, e.g.
URL could not be found, or an API token that did not work.

Activate the integration for your applications

Before enabling this feature, remember to customize or translate the default texts that are provided for search
filters and document preview. You can do this from the Portal by going to Customize > Texts, then select
Search under Assistant.

https://support.knowledgeowl.com/help/using-api#api-keys
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 To connect Search with KnowledgeOwl:

1. Sign in to your Userlane Portal and go to Customize > Search.

2. Under Activate Search, ensure that the Display Search In The Assistant toggle is enabled.

3. Under Activate Knowledge Base Search, enable the toggle for KnowledgeOwl. If you have multiple
applications, repeat these steps for each application for which you want to enable the integration.

Test the integration

Test your connection before announcing the integration to your users. 

1. Open an application that has Search and a KnowledgeOwl connection enabled.

2. Launch the Assistant then click the Search icon.

3. Enter a search query that should have matching results from your KnowledgeOwl instance.
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Zendesk integration
Last Modified on 12.01.2024

Your Userlane solution can be integrated with Zendesk providing a simple way for your users to search
Zendesk content without context switching. 

This article covers

how it works
what can be searched
how to set it up

 

How it works

Once the integration is set up and enabled, your users can seamlessly access Zendesk content through the
Search feature in the Userlane Assistant. Different content types are identified by an icon to help you quickly
identify the source, which include Guides, Announcements, and yes, Zendesk articles!

 

Search results and ranking

Alongside your Userlane content, search queries are applied to Zendesk content titles and article text, using
partial or complete searches.

Ranking

Search results are prioritized in the following order:

Frequency of search term in title

Frequency of search term in body content

Most recent updated date and time

All content types are treated equally when determining their priority in search results. 

Viewing results from Zendesk

Search results are listed in the Assistant in the priority order described above. Your users can easily identify
knowledge base content by the document icon. If their results include more than one content type, they can
select content filters to refine their results to specific types (Guides, Announcements, and documents). A
maximum of 50 results is displayed.

https://app.knowledgeowl.com/#how
https://app.knowledgeowl.com/#what
https://app.knowledgeowl.com/#set
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To view content in an expanded preview window, users simply select a document result. 

With the document view displayed, they can continue to use your application as normal, return to the search
results view, or perform another search. If they want to keep the preview active while using the application,
they can click the minimize icon in the top right of the preview window to pin it to their screen. Expand it again
to continue from where they left.

Good to know: If the content is too long for easy scrolling, users can open the original document in a new
browser tab by selecting the original document link under the page title. This action might require a Zendesk
login, for example, if the page does not have anonymous access permissions. 

 

Set-Up
Prerequisites

API access to Zendesk

Userlane Admin or Moderator role permissions

Permissions

It’s important to note that Zendesk permissions for the integration are inherited from the Zendesk user for
which the API token is generated. If you want to ensure that the correct permissions apply, create a Zendesk
user specifically for the integration and set up the required permissions and restrictions before generating the
API token.

Generate an API token

Generate the API token by following Zendesk's support article. If you haven’t already created a Zendesk user
for this purpose, do so before completing this step.

https://support.zendesk.com/hc/en-us/articles/226022787-Generating-a-new-API-token
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Enable the connection for your organization

1. Sign in to your Userlane Portal and go to Account > Global Settings > Integrations.

2. Select Zendesk under Available Integrations.

3. Enter the following details:

Name (optional): You can change the default name assigned to the connection to help you identify it
in your properties if you use more than one

The URL of the Zendesk workspace, e.g. https://ourcompany.zendesk.com

The email address of the Zendesk user that you defined for the integration

The API token created for the Zendesk user

4. Select Save and Connect. Once the connection is created successfully, it appears under Connected
Integrations on the Integrations page. You can later edit or remove a connection for maintenance
purposes, or if it is no longer required.
Note: If the connection cannot be established, an error message displays with details of the issue, e.g.
URL could not be found, or an API token that did not work.

Activate the integration for your applications

Before enabling this feature, remember to customize or translate the default texts that are provided for search
filters and document preview. You can do this from the Portal by going to Customize > Texts, then select
Search under Assistant.

 To connect Search with Zendesk:

1. Sign in to your Userlane Portal and go to Customize > Search.

2. Under Activate Search, ensure that the Display Search In The Assistant toggle is enabled.

3. Under Activate Knowledge Base Search, enable the toggle for Zendesk. If you have multiple applications,
repeat these steps for each application for which you want to enable the integration.
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Test the integration

Test your connection before announcing the Zendesk integration to your users. 

1. Open an application that has Search and a Zendesk connection enabled.

2. Launch the Assistant, then click the Search icon.

3. Enter a search query that should have matching results from your Zendesk instance.
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How to create a solid user
segmentation concept
Last Modified on 30.06.2023

Why use it

Use segmentation to

target specific user groups for your Userlane content based on their roles and accesses
create a personalized user experience

How it works

The segmentation depends mainly on the information you have about your users. The more data you have the
more granular you can segment your users. 

Follow these steps to create a good concept to segment your users: 

1. Analytics

What insights would help you drive engagement and processes? 
How do you differentiate users in reports or conversations?

2. Groups and characteristics 

How do you differentiate users within your application already? 
Collaborate with your developers regarding the segmentation concept to ensure relevant attributes
are considered and keys/names are consistently used and set up. Learn more about it here.

3. Set up your Target Audience

Set up your attributes in the Portal, if applicable.
Create your user segments here:

ℹ️ Good to know

You can combine conditions using AND or OR to create user segments.

Example: 

https://docs.userlane.com/docs/user-segmentation
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You can create a segment with users who are admins OR paying users AND have been active within the
last 14 days.

Applying a segment to a chapter affects all Guides in that chapter.

Applying a segment to a single Guide in a chapter adds additional conditions.

4. Content

Do most of the users fulfill similar processes? Is there any data in forms that some users have to fill out
differently than others?  Or are there many parts that are only used by specific groups? 
You can segment single content items or whole chapters in case of managing Guides within the Assistant.
What content is relevant to what group? 

Examples
User roles

Relevant if you have different user roles (e.g., administrator, regular user) in your rights management
system.
Recommended segmentation: Often used for Guide content at the chapter level.
Points to consider: If individual functionalities can be assigned separately, allocate segments to individual
content like Guides

Departments

Relevant if users from different departments use the software differently or have varying information
requirements.
Recommended segmentation: Apply segmentation to single content items as there may be shared and
department-specific content

Purchased package / Feature sets

Relevant if you offer different product versions with varying features
Recommended segmentation: Organize Guides in chapters based on purchased packages or segment
single Guides based on included features. Segment other content items individually

Trial status

Relevant if your product has a trial period
Recommended segmentation: Create different chapters for trial and converted users

New users

Relevant if your application frequently encounters new users who require additional onboarding
Recommended segmentation: Add an extra chapter and targeted content items for new users
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How to structure your content
Last Modified on 03.04.2024

Creating clear and structured content is essential for maximizing the value of Userlane and saving time and
effort for your team.

Follow these best practices to ensure that your Userlane content is well-planned and aligned with your goals.

 

1. Define your goals and stakeholders
Clearly understand and define your objectives for using Userlane.
Identify the stakeholders involved and their respective goals.
Determine the activities and tasks performed by each stakeholder.
Prioritize the tasks based on importance and frequency.
Address the stakeholders' most common questions.

2. Set priorities
Identify the most significant pain points that need to be addressed.
Determine which goals affect the largest user group.
Evaluate which goals have the highest impact or save the most resources.
Establish a baseline and assign metrics to measure progress.

3. Define content structure
Identify the tasks necessary to achieve the highest priority goal.
Align your Userlane content with the user's tasks.
Structure your Userlane content accordingly.
Determine where and to whom the Userlane content should be visible.
Highlight specific guides through tooltips with linked Guides, promotion or announcements, if necessary.
Link Userlane content to other existing resources, by using an integration or application help.

Best Practice: 

Create a table to organize goals, processes, and content types.
Consider topics or expertise levels for grouping guides. 
Define the priority for this content type.
Determine a Go Live Date per content type.

You can use a table like this:

https://docs.userlane.com/docs/create-tooltips
https://docs.userlane.com/docs/promote-your-guides
https://docs.userlane.com/docs/create-and-activate-announcements
https://docs.userlane.com/docs/create-and-activate-announcements
https://docs.userlane.com/docs/userlane-integrations-userlane-integrations
https://docs.userlane.com/docs/userlane-assistant-help
https://docs.userlane.com/docs/userlane-content


336

4. Change your perspective and ask for feedback
Step back and view your Userlane content from a new user's perspective.
Ensure that new users are aware of Userlane and how to utilize it, e.g. informed via Welcome Slide,
internal communication
Verify that the content structure is easy to understand for new users.
Assess the relevance of tasks shown in the guides for users.
Check if tooltips effectively enhance user understanding.
Evaluate if announcements provide value and useful information.

5. Understand and improve
Utilize Userlane's analytics to gain insights into user interactions.
Continuously monitor and analyze the performance of your Userlane content.
Use the analytics data to make informed improvements and simplify software usage.

ℹ️ Regardless of your goals, always keep in mind that your users should:

Understand the capabilities of your software.
Experience quick wins along the way.
Interact with key features to fully appreciate your solution.
Achieve their desired results as quickly as possible.

By following these best practices, you can create effective Userlane content that guides users towards success
while optimizing their experience with your software.

https://docs.userlane.com/docs/welcome-your-users-with-the-welcome-slide
https://docs.userlane.com/docs/analytics-dashboard
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How to onboard users effectively
Last Modified on 12.01.2024

Users aren't as interested in the product as they are in striving for the best result for their goals. Effective
onboarding, easily and efficiently, guides users to their desired outcomes as quickly and as effectively as
possible - so let us find out, how you can best onboard your users!

How it works

The onboarding phase creates constant associations with your brand and product and sets the mood for the
entire upcoming customer journey. 

Onboarding trial users is a lot more than simply creating a user-friendly environment that is easy to master.
Successful onboarding involves different stages that help with specific goals:

1. Product learning curve
2. Product engagement and habituation
3. Product success enablement
4. Product value realization

In this article, you will learn what main tasks arise from these stages and how to master them.

 

Stage 1: Product learning curve

Make your users understand and use your product in the most efficient way to ensure that they realize its full
potential.

How to do this?

Enable your users to sign up and move on to the actual interface quickly

Take full control over the initial steps your users take to make sure they achieve some quick-wins

Make your users familiar with key elements and features within your application and ensure that their
attention is focused on the feature they're currently learning

Clarify the workflow's structure and how to integrate other solutions

Prevent users from leaving your platform by showing them the most efficient way to get from A to B

Let your users follow a specific checklist of tasks and guarantee that they know where they are in the
onboarding process

 

Stage 2: Product engagement and habituation

Create habit-forming patterns, so that your users keep using the product 

https://app.knowledgeowl.com/#Curve
https://app.knowledgeowl.com/#Engagement
https://app.knowledgeowl.com/#Enablement
https://app.knowledgeowl.com/#Value
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Build the basis for engagement and activation

Make your users accomplish actual tasks immediately so that they directly see results

Motivate your users and reward them for their progress and completion of onboarding guides

Block advanced features to ensure that your users interact successfully with basic functions first.

Create a smooth experience to prevent churn caused by delays and frustration

Set a positive mood for future relationships and make them feel excited to continue working with your
application

 

Stage 3: Product success enablement

Make product success easy to achieve and repeatable by knowing your customer's objectives and enabling
them to reach them effortlessly

Make your users understand the extent a software can help them reach their goals

Eliminate confusion and insecurity

Segment your users, address them personally, and adapt the onboarding as well as the user experience
according to their needs

Follow and monitor your users' behavior and use the collected data to provide adequate information as
well as support when insecurities arise

Interact in real-time with users that get stuck and guide them to the next step

Continuously train users and surprise them with new functionalities based on their feedback

 

Stage 4: Product value realization

Make clear what the actual value of your solution is by showing them the results they can achieve with your
product

Point out what the product is designed for, what its benefits are, and what makes your solution unique

Show the personality of your brand, be authentic and real

Ensure that your users find a way to reach their goals as soon as possible

Prove that you can actually meet your customer’s expectations and over-deliver

Show the user the value proposition of your solution

Sell your solution as if you were pitching it directly to the user
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This, and actually much more, needs to happen fast. Very fast! 

People’s attention span is limited and you need to continuously offer variety as well as novelty elements and
draw the attention of trial users to their roadmap towards their goal. 

You need to 

start with small steps presenting major and basic features 
quickly allow users to reach full proficiency within your product.  
eliminate any frustration points 
allow users to feel good about their choice.
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How to build successful Guides
Last Modified on 20.03.2024

Why use it

Overall, good guides contribute to a positive user experience, increased user adoption, improved productivity,
reduced support dependency, standardized training, user confidence, and the ability to measure and optimize
user success.

Before getting started
Make sure the content of the Guide is relevant to your users.

What do your users want to achieve/learn? What are their pains?
Who should be addressed with this Guide?

Be clear on your goals.
What do you want to achieve with the Guide? How will you measure success?

Set a communication guideline fitting your company culture.
What style do you use when communicating with your end-users? Is the style more formal or
informal? 

Review and improve your Guides regularly.
Is the Guide as successful as expected? Are users achieving what they need to achieve?
How happy are users with the Guide?

How to create a good Guide

1. Add an actionable title and match the title to the goal of the content.  The title and sub-title should answer
the “what” to expect in this Guide and can prevent users from starting a Guide unintentionally.

2. Define the amount of possible interaction of your users.

A) If you want to introduce users to your app or a feature but don’t want them to get confused, reduce the
amount of interaction. 

Use explanation steps with prevented interaction to show the user around. Use the “Specific Value” option in a
step to ensure the user only creates a test object. We also recommend this for the first Guide(s).

B) Improve the quality of interactions with the underlying application. Use our automation and validation tools
to support your users in their learning process. In that way, you don't only teach your users the processes, but
you are also ensuring data quality. 

Use the “Any Value” option to allow users to decide what they want to type into an input field. Or "Specific
Value" option to validate what users can type in an input field.

3. Only have user-relevant information in your Guide and keep it simple. 

https://docs.userlane.com/docs/process-automation-via-guides
https://docs.userlane.com/docs/add-step-input-validation
https://userlane-bacb488bc4c8.intercom-attachments-7.com/i/o/192803237/564589a648cf607e95372922/cjMCrbDIYY5mPy8Vv5rnqMkEH4jBRd7lDXRBRRHpnT-u1dr4sdGkHbCih1lnohH_pkoWAChDzdGe8teBgyvsq2ZQaTlBznFsxP3aRDfsyPbFT7I_sraGvNCpTQ_PLJ7_KQs8JIvu
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Ask yourself for every step and every word that you add: 

Does this step or text add value for the user?

Is this information necessary for the goal of the Guide and the user at this moment?

Does this information help the user to achieve the goal of this Guide? 

Can external resources be linked?

4. Avoid long overview tours, but reduce them to the relevant basics. We recommend max 20 steps per
Guide.

5. Avoid cognitive overload. Stick to a clear and consistent top-down structure in the order of your Guides and
chapters (from general to specific information). Whenever possible, only write one piece of information into one
step box. Use info boxes to highlight specific information. 

6. Keep the user’s attention and motivation. Add praises, Call-To-Actions, emojis, GIFs, images, or whatever
keeps the user motivated whenever the tone is appropriate.

7.  Use the first and last slides effectively. Use the first slide to set expectations or goals. Use the last slide to
wrap up, praise, link additional information, or include a Call-to-Action.

Checklist

Check whether your Guides have everything they need. Find our Guide Checklist here.

https://docs.userlane.com/docs/adding-media-to-your-content
https://docs.userlane.com/docs/guide-checklist
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How to create a good
Announcement
Last Modified on 12.03.2024

An announcement is a push message announced within the external application via the Userlane Assistant.

How to create a good Announcement
1. Have a clear strategy and plan when to use Announcements. 
2. Avoid having too many Announcements activated in parallel. Otherwise an end-user only clicks through

them and the impact is lost.
3. Use an intuitive name for your Announcement. 
4. Clearly define the goal of this announcement - Is it supposed to inform or a call to action?
5. Keep the content as short as possible and don’t make it redundant.
6. Provide an announcement text for each application language to communicate with your users in their

preferred language.
7. Target the right audience for your announcement. Consider setting up user and/or page segments.
8. Add images, links or Guides where applicable.
9. Schedule your Announcements so it reaches your end-users at the right time at the right place but also

only until a certain time. 
10. Use an Announcement cadence to promote and prompt the completion of a task/ process.
11. Change the Announcement category name in the Userlane Portal to align with announcement goal. You

can find more information on this here.
12. Be cautious where to publish the Announcement, so it does not distract a user from completing an

important process. You can use data from Engagement for this to better understand where your users
need to spend more time and then create a Page Segment or User Segmentation accordingly.

ℹ️ For optimal results, combine an Announcement with Guides for new feature launches on your
application. 

Possible Use Cases

Announcement before Rollout

When going live with your Userlane Guides you can share an announcement with your end-users to raise
awareness for this new support resource. 

Send an announcement presenting the point of contact for additional support
Remember: Userlane is new to them and they might have some questions 

Send an announcement one day after first time active in combination with not having started the first tour
(linked to welcome slide) and remind him on the new capability

Remember: You have spent time and energy on the Guides. Let's make sure they make use of them.

https://docs.userlane.com/docs/how-to-create-a-good-announcement
https://docs.userlane.com/docs/customize-default-texts
https://docs.userlane.com/docs/engagement
https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/user-segmentation


343

Example: Announcement for new functionalities

When having a new functionality available in your application you can raise awareness and educate your end-
users about it.

Create a Guide to direct through the new functionality
Create additional resources, e.g. release notes, articles about the new functionality
Link the Guide, Release Note, Help Documentation, Best Practices to an Announcement
Remind end-users about available resources, e.g. Help Documentation, intranet
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How to create good Tooltips
Last Modified on 12.03.2024

Why use it

Tooltips allow you to explain and highlight elements of the underlying application when a user interacts with
the external application.

To choose the right tooltip type, choose the use case you wish to cover. 

Example: 

If you wish to explain a feature, use the hint type. 

If you wish to highlight a feature in the underlying application, use the beacon type. 

ℹ️ For optimal results, always combine Tooltips with Announcements and Guides for new feature launches
on your application. 

Tooltips: Hints
1. The hint type provides extra information to help users with processes, unknown words, features, or error

messages.
2. Keep hints short and concise, avoiding redundancy.
3. Provide hints in different languages for user preference and better communication.
4. Understand user needs and struggles, explaining non-obvious elements with hints.
5. Don't cover up important content or functionality with hints.
6. Avoid blocking users from completing tasks by placing crucial information only when they hover over an

element.
7. Use hints for unlabeled icons or buttons when contextual help is needed.
8. Target specific pages using page segments for relevant hints.
9. Customize hints for different user groups, such as new or experienced users.

10. Assist users in filling out lengthy forms by explaining what to add in each field.
11. Explain specific error messages using content selectors.
12. You can combine a Hint with a Guide to make sure that an end-user starts a process at a specific point.

Tooltips: Beacons
1. Use beacons to grab users' attention towards new features.
2. Boost engagement by highlighting less-utilized features with beacons.
3. Employ beacons in the app for specific calls to action, like form filling or error reporting.
4. Manually position pulsating icons when important elements are covered.
5. Provide beacon text in different languages for better user communication.
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6. Show beacons only on relevant pages that match URL conditions using page segments.
7. Customize beacon display based on user groups, such as those who haven't interacted with the new

feature guide.
8. You can combine a Beacon with a Guide to make sure that an end-user starts a process at a specific point.
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Best practices for setting up your
NPS Survey
Last Modified on 04.03.2024

NPS is the key to understanding your users’ opinion about your application. With Userlane you can collect user
responses right in your application.

Check out these 4 tips below on how we recommend setting up NPS with Userlane:  

1. Do not change the NPS question 

NPS methodology works by asking the user how likely they are to recommend your application. Changing the
question entirely to something unrelated could lead to skewed results. 

2. Set up reminders for those that did not respond

To ensure a beneficial number of responses, use our automatic reminders. Sometimes users will not have the
time to respond, with this setting you can encourage them to respond by popping the question again. 

3. Set up your NPS without the end date or choose the far end date

Your manual effort is reduced because the NPS survey is automated. After a user responds, the NPS will
disappear and pop up automatically for them after 6 months again. In order to get the responses automatically
twice a year from the end user, set up the end date to “not set” and the NPS will run until you turn it off. 
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4. Use segmentation to target your users

If you want to include or exclude certain groups of users, we suggest you target a specific user segment. 

For example, if it is helpful to exclude users from the NPS survey if they have just joined your application - ask
them once they’ve gained a bit more experience. You can set up the segments accordingly.
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Userlane go-live checklist
Last Modified on 19.02.2024

Use the checklist to make sure you are considering the most relevant topics before going live with Userlane on
your application.

1. Understand the difference between the Userlane Portal and Editor 

With the Editor, you build your Guides directly on your application. In the Portal, you can customize, manage,
define settings and structure your Guides and Announcements. 

2. Define a structured concept 

The very first step before building Guides is to define your goals and create a clear content structure to reach
them. Avoid going straight into recording without planning before. 

3. Make sure Userlane is implemented
Implementation options

4. Style Userlane your way

To ensure Userlane matches the way you present and talk to your end-users, you can adjust Userlane so it
matches your brand.

Colour configuration

Default text configuration

Avatar image configuration

Welcome Slide configuration

5. Visibility of Userlane

To ensure Userlane is shown where and to who it is supposed to be shown to make sure to check these
settings.

Minimum screen size setting for whole Assistant

https://docs.userlane.com/docs/editor-overview
https://docs.userlane.com/docs/navigate-the-userlane-dashboard
https://docs.userlane.com/docs/how-to-structure-your-userlane-content
https://docs.userlane.com/docs/implementation-options
https://docs.userlane.com/docs/customize-colors-and-designs
https://docs.userlane.com/docs/customize-button-and-the-slide-text
https://docs.userlane.com/docs/what-is-the-userlane-assistant
https://docs.userlane.com/docs/welcome-your-users-with-the-welcome-slide
https://docs.userlane.com/docs/what-is-the-userlane-assistant
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Page segmentation check for Guides and whole Assistant 

User segmentation check for Guides

ℹ️  If your Assistant is not visible to your users, have a look at this checklist!

6. Languages

Define in what languages your Guides and Assistant should be available.

Translations available

Languages published

Languages tested

7. Content & Communication

Make sure you have everything set up and have a clear plan on how to engage your users.

Tooltips

Guides created

Guides tested

Guides published

Announcements

Promotions

NPS

Internal communication regarding Userlane Go-Live

8. Offer support to your end-users

Make it easy for your end users to receive support and easily find what they need.

Error notification configuration

Search tab configuration/Integration configuration

https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/user-segmentation
https://userlane-knowledge-center.knowledgeowl.com/docs/userlane-assistant-checklist
https://docs.userlane.com/docs/add-and-manage-multiple-languages
https://docs.userlane.com/docs/add-and-manage-multiple-languages
https://docs.userlane.com/docs/create-tooltips
https://docs.userlane.com/docs/record-a-guide
https://docs.userlane.com/docs/record-a-guide
https://docs.userlane.com/docs/how-to-test-your-guides-before-publishing
https://docs.userlane.com/docs/create-and-activate-announcements
https://docs.userlane.com/docs/promote-your-guides
https://docs.userlane.com/docs/nps
https://docs.userlane.com/docs/navigate-the-userlane-dashboard
https://docs.userlane.com/docs/search-through-the-userlane-assistant
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Support contact/Help center link configuration

9. Activate Userlane 

Last but not least, make sure Userlane is switched on.

Switch Userlane on

https://docs.userlane.com/docs/userlane-assistant-help
https://docs.userlane.com/docs/userlane-assistant-checklist
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Alert notifications
Last Modified on 21.03.2024

About Alert Notifications

Alerts indicate that errors are recurring on a specific Guide step. 

Alerts are triggered whenever errors on a step meet the default error threshold of five occurrences within
eight-hours.  If you want to adjust these settings, reach out to your Customer Success Manager.

Why use it

Alerts provide quick feedback when users are struggling with a step within a Guide.

This could be caused by

a recent change within your application regarding the HTML code
behaviour based on a specific role or setting of an end-user
behaviour on a specific browser
behaviour on a specific screen size

Jump to the troubleshooting options.

How it works

When an alert is triggered, we will notify you via email but you can also see it directly in your Guide overview
in Userlane's Analytics dashboard, the Manage section or in the Editor. 

Go into the Guide Analytics and click on the flagged step.

Open the Error Log.

https://app.knowledgeowl.com/#troubleshooting
https://downloads.intercomcdn.com/i/o/315534096/89230241f8307ba229f317ed/Screenshot+2021-03-24+at+10.00.46+AM.png?expires=1620482400&signature=a708383e4e4b06dbd8099d7fe76c92f44a31a30973d8b11c841111016a2c8a4e
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Click the user ID to find more information about that particular user.

ℹ️   Important
Any new save or update to a Guide (e.g. updating segmentation, texts) resets its alert notification
even if the cause of the error isn't resolved.
The emails are sent only once after an alert was triggered for a step. They will not be sent again
until the Guide has been updated and a new alert gets activated.

Adjust E-Mail Notifications

You can change the email notification setting for each Application in your Userlane Account.

Sign in to Userlane Portal > Settings > Notifications

Troubleshooting errors

Here are some steps to help you effectively handle alert notifications. Below, we discuss each step in detail:

investigate the source of the errors
look for the issue in the current step
check the previous steps
check Portal settings
check account setup
test
other causes

Investigate the source of the errors

https://app.knowledgeowl.com/#alert-source
https://app.knowledgeowl.com/#alert-currentstep
https://app.knowledgeowl.com/#alert-previousstep
https://app.knowledgeowl.com/#alert-portal
https://app.knowledgeowl.com/#alert-usersetup
https://app.knowledgeowl.com/#alert-browser
https://app.knowledgeowl.com/#alert-other
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First, identify the step that triggered the alert in one of the following ways:

Click Open Step Details in your alert notification email. This displays the Step Details page in your
dashboard.
Go to Analyze > Guides in your dashboard then look for the alert symbol under Individual Performance.
Click the alert symbol to view the Step Details page.

Open the respective Guide in the Userlane Editor and click through it until you get to the step with the
alert symbol.
Review what users have caused this error. 

Once you identify the trigger step, you can determine how to resolve the cause of the errors.

�   Errors can be in the alert trigger step or in a previous step.

Look for issues in the current step

Open the Guide in the Editor:

Does this step highlight the right element? 
Review the Code Selector. Consider reselecting the element, simplifying the selector or specifying
the selector. Learn more here.

Are the step options appropriate? 
Check the interaction type chosen and possible skip settings. Learn more about the step types here. 

Check the previous steps

Open the Guide in the Editor:

Are your users led to the correct step?
Check how a user is navigated to the step.

Does this step highlight the right element? 
Review the Code Selector. Consider reselecting the element, simplifying the selector or specifying
the selector. Learn more here.

� If Next-Button steps are not found, the error system will skip them and only trigger an error on the first
interaction step that follows them (e.g. Left-Click Step). This means that the error might have been
triggered a number of steps before the step that is marked with the error.

Check your settings in the Portal

https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
https://docs.userlane.com/docs/define-step-navigation-for-your-guides
https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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Open the Portal and Review the Settings for the Guide and Chapter:

What languages are published?
What User and Page Segment are applied?

Errors caused in a specific user setup

Review the Users that caused the error:

What characteristics do they have in common? 
What limitations could they have within your application? 
Will everyone see the same content?

If you identify differences, consider:

using optional steps
adjust your segmentation for the guide

Test the Guide on different browsers

On the Portal, you will find information on every user that caused an error.

Is the issue only appearing for specific browsers?  
Try choosing the bigger element by using ‘change positioning’ or by manually adjusting the
Userlane selector (technically advanced).

Other causes 

Errors may be caused by issues unrelated to your Guide setup:

internet outage for user
application being down 

You can make a small update to a Guide and save it to reset the alert and determine if the problem recurs.

https://docs.userlane.com/docs/including-optional-steps-in-a-guide
https://docs.userlane.com/docs/create-a-solid-segmentation-concept
https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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Guide Checklist
Last Modified on 12.01.2024

About this Checklist

This checklist provides a comprehensive guide on optimizing 

the functionality, 
text & wording, 
engagement of Guides and 
language handling.

It covers various aspects such as setting clear objectives, segmenting users, ensuring stability, and
incorporating interactive elements. Additionally, it emphasizes the importance of user satisfaction and
multilingual support. 

Implementing these strategies can enhance the effectiveness and user experience of Guides across different
platforms.

 

Functionality

1. Does the Guide have a clear goal?

2. Does the Guide have less / around 12 steps (recommended maximum: 20)?

3. Does the Guide work on every page (starting point) where it is visible in the Assistant? If not, use context-
based segmentation to only show it on the right pages.

4. Does the Guide work for every user group (users with different features, limitations, etc.)? If not, segment it
to the right users.

5. Stability: Is the Guide safe from breaking accidentally by clicking somewhere outside the Guide?

 

Text & Wording

6. Is the title of your Guide clear and actionable? Does it answer “what” the Guide is about, what its goal is? 

7. If you have a subtitle, does it tell “why” the user should do this tour?

8. Does the first slide of the Guide tell the user about the content they’ll experience? Is it motivating? Tell your
users why they should do this tour.

9. Does the last slide wrap up what your users have achieved? Does it praise the user for what they have
done? 

10. Does the Guide have a friendly and clear tone that fits your company style?

https://app.knowledgeowl.com/#Functionality
https://app.knowledgeowl.com/#Content
https://app.knowledgeowl.com/#Engagement
https://app.knowledgeowl.com/#Language
https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
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11. Look at your texts: Are there any sentences/parts that don’t contain relevant information? Delete/shorten
any sentences that don’t add value.

 

Engagement

12. Are your Guides as interactive as applicable to the content?

13. Did you add media elements or other relevant resources, e.g. help center articles to improve the user
experience?

14. Are your Guides integrated into and accessible through multiple channels (help docs, emails, support, etc.)?
For example, use link boxes, trigger commands, and the promotion feature.

 

Languages

15. Have you translated the Guides into all languages needed? If not, add and manage multiple languages.

https://go.userlane.com/31610/24658
https://go.userlane.com/31610/16295
https://go.userlane.com/31610/16295
https://go.userlane.com/31610/31715
https://docs.userlane.com/docs/add-and-manage-multiple-languages
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How to create good Tags
Last Modified on 12.03.2024

Why use it

A Tag marks a single element that should be tracked to measure a user interaction within the customer
application. 

It is connected to HEART analytics, which enables businesses to track and improve digital adoption. 

To learn more about Tags in Userlane, check the following section on Tags in the Editor. 
To find out more about understanding the impact, opportunities, and risks regarding underlying
application usage, please check the following section on HEART.  

Before setting up Tags
To work with Tags, the Advanced analyticsoption must be enabled in the Analytics setting menu
located in the Portal.

Check with your team the webpages where you wish not to have analytics running and update the
exceptions before enabling Advanced analytics.

Research the processes within your organization and how they are completed with the help of the
underlying application.

Find out which elements (e.g., buttons) emphasize the best way to process completion.

are they located on multiple webpages? Do you need to differentiate the elements per language?

How to create good Tags

1. Use Tags to understand how many times a process is started and how many times it has ended. (Start
button vs Submit button).

2. Place tags along a process (Onboarding) to access where users are dropping off.

3 Understand if the users are still accessing the wrong/deprecated section/button/functionality to correct the
behaviour.

4. When creating Tags, Userlane will automatically assign a name to each Tag. We recommend deciding on a
name structure as early as possible. In that way, you can easily navigate later to the Tags list view which will
contain dozens of entries.

Example:

https://docs.userlane.com/docs/tags
https://docs.userlane.com/docs/what-is-heart
https://docs.userlane.com/docs/analytics-privacy-settings
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5. If you wish to track an element on a single page or multiple pages, use page segmentation.

6. If your website is multilingual, and you wish to track the user interactions with a single button available in
different languages, create two different Tags, and use the Content Selector for each of them to track only
elements that contain words in the respective language. 

After you set up Tags

Access the Task Success page  in the Portal to understand how users interact with the tagged elements. 

If you wish to track another element, we recommend first deactivating the ones you do not want to have
tracked anymore, and creating a new one from the beginning so that the tracking data does not get mixed.

https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/target-specific-text-for-an-element-with-the-content-selector
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How to use Regular Expressions for
Data Validation
Last Modified on 12.01.2024

About Regular Expression

A regular expression (regex) is a sequence of characters that helps you find specific patterns in text. It's
commonly used to validate data and ensure its accuracy.

Why use it

Regular expressions can be useful in various scenarios. Here are a few examples:

1. Checking if a text contains your organization's domain.
2. Preventing users from submitting empty form fields.
3. Enforcing a specific format for number fields.
4. Limiting the number of words in a text box (e.g., not more than 10 words).
5. Validating age ranges (e.g., 18-65).

Ultimately, the goal is to collect correct and useful information for your processes.  

Example

You want to ensure your colleagues always use the 24-hour format when submitting the expenses of a past
business event. 

The following regex achieves that:

^([01][0-9]|2[0-3]):[0-5][0-9]$

In this scenario, the user must use the HH:MM time format in the input field to proceed.
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ℹ ️Important 

First, try using the Generate functionality as explained in the help article. Then, use the examples below to
improve or adjust the automatically generated Regular Expression to suit your needs. 

How to use it

To better understand how basic regular expressions work, let's look at some simple examples:

RegEx Result Explanation
abc abc is allowed only abc is accepted

Munich|Berlin|Hamburg

The user needs to type in
Munich or Berlin, or
Hamburg to get the result
validated.

"|" is used as "or"

[a-z] A23BCDeF
At least one small letter from a to z needs to be detected
in the string

[0-9] 1user1
The user needs to type in a string that contains at least
one number

[0-9]$ 31231031231... It accepts only strings

[0-9] \$$ 25$
\ is used to escape a special character. In our case, the $
sign. The second $ shows where the string ends

^[A-Z]

Userlane or USERlane are
allowed. uSerlane or
userLANE are not allowed

You need to start the string with a Capital letter. It can
contain more capital letters.

. !Userlane#:; is valid
"." is a wild card. If used, any character is accepted in the
string.

.{3,}
At least three characters
need to be typed in

{3,} means that min 3 characters need to be typed in.

^.{12,20}$
Any string between 12 and
20 characters

{12,20} means the string must contain between 12 and 20
characters. ^ is used to say where the counting starts,
while $ shows when the counting ends.

^[1-9]{1}$|^10$
Validate a number from 1
to 10

^[1-9]{1}$ tells us the first number is 1 to 9.
| means or
^10$ tells us that also 10 is accepted

^[1-9]?[0-9]{1}$|^100$
Validate a number from 1
to 100

The "?" tells us that the preceding character is optional. If
it wouldn't be there, then the user would be allowed to
type in numbers only from 10 to 100

Now, let's take another look at the example from above:

https://docs.userlane.com/docs/add-step-input-validation
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^([01][0-9]|2[0-3]):[0-5][0-9]$

The first part of the regular expression ̂ (([01][0-9]|2[0-3]) tells the user that a value between 00 and 19 is
needed or between 20 and 23. In the second part of the regular expression, [0-5][0-9]$, a value between 00
and 59 is expected. In that way, only entries in the format of HH:MM are accepted.

Advanced examples
RegEx Explanation

^[-\w]+(?:\W+[-\w]+){1,4}\W*$ To proceed, type in 1 to 5 words. 

^.+?@.+?\..+$    
It can be used for email validation. The pattern checks if "@" and
"." exist.

((1[0-2]|0?[1-9]):([0-5][0-9]) ?([AaPp][Mm]))$
      

 It validates if the following time format HH:MM 12-hour AM/PM
is used.

/^[0-9]{5}([- /]?[0-9]{4})?$/ Checks if the US Postal code was entered correctly.
^(?!01000|99999)(0[1-9]\d{3}|[1-9]\d{4})$ It checks if the entered German Postal Code exists.

^DE[0-9]{20}$ It checks if the German IBAN was correctly entered.
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Directing your users to the right
pages
Last Modified on 03.05.2024

Why do it

AppDiscovery gives you insights into the applications your employees are using and therefore, where they
spend their time.

But what should you do if you notice they're using an application they shouldn't? Maybe you already pay for a
project management tool, and they're using a different one, or maybe AI tools like ChatGPT haven't yet been
cleared by your IT department for regular use.

This use case comes up often with Userlane customers, so let's dive into how you can leverage Userlane to
inform and guide your employees to the correct applications.

Here are the points you need to consider for this process. In this article, we will touch upon each of them in
detail:

1. Review and understand
2. Promote the correct pages
3. Show value of the correct pages
4. Monitor change

1. Review applications in use

Use Userlane App Discovery to get an overview of the applications your employees are using.

Do you see any applications that potentially pose a security risk? (eg. AI-powered tools not yet cleared by
your IT security)
Do you see any applications with duplicate use cases? (eg. your company already pays for Jira but you see
employees using Asana or Trello)

2. Get more insight

If you answered yes to either of the above questions, add the applications in question to Userlane to gain more
insight. To add a discovered application to Userlane is quick and easy, simply click the 'Add App' button.

Once you've added the new application, Userlane HEART will automatically start collecting data you can use to
better understand how often your employees return to this app, whether they're actively engaged with it, as
well as how much of it they navigate through.

Additionally, with Userlane Surveys, you can directly ask your employees for qualitative data about the
application they use:

What do you find most valuable in using [name of the application]?
Why do you use [name of the application]?

https://app.knowledgeowl.com/#reviewand
https://app.knowledgeowl.com/#redirectyour
https://app.knowledgeowl.com/#promoteand
https://app.knowledgeowl.com/#monitorchange
https://docs.userlane.com/docs/survey
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What benefits do you see in using [name of the application]? 

3. Act on the data

After analyzing the HEART data and survey responses, you'll be able to make a decision on how to proceed:

If the application in question goes against your internal IT policies, it's best to reach out to your IT team.
They can then decide if the application should be approved for internal use or blocked.

If the application is a duplicate use case for an application already in your company's tech stack, you can
continue to leverage Userlane to drive your employees to the correct application.

How Userlane can help:

We strongly recommend using a combination of Announcements and Tooltips to make employees aware of
what to do. 

With an Announcement  you can inform the user and also give them a clear call-to-action, e.g. 

We moved to [name of the application] for improved functionality and better user experience. Follow the
link and get started.
Important Notice: We regret to inform you that the use of [name of the application] is no longer permitted
due to [reason]. To ensure compliance with our policies and regulations, please discontinue use of the
application immediately. 

A Tooltip can be also used to ensure the information is shown during typical user actions, like on hover over
the Login button:

Sorry, [name of the application] is no longer available for use. Please use this link: [URL of new
application]
Switch to our new internal app for a smoother and more efficient workflow! Explore now: [URL of new
application]
Discover the superior features of [name of the new application]!

4. Monitor change

To ensure that the measures you took had an impact, continue to monitor HEART data for the application:

you can check the Engagement metric to see if engaged sessions have decreased
you can check the Adoption metric to see if the App Coverage has decreased
you can check the Retention metic to see if fewer users are returning

Additionally, you can compare with the HEART data for the approved application, to ensure that traffic there is
increasing.

https://docs.userlane.com/docs/create-and-activate-announcements
https://docs.userlane.com/docs/create-tooltips
https://docs.userlane.com/docs/create-and-activate-announcements
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Quick reference of commands in
Userlane
Last Modified on 24.03.2025

About commands

Commands are useful for issuing specific instructions to cause a specific behaviour.

Various commands

Click on any header to get redirected to an article outlining the command in more depth.

Load the script
// load Userlane
(function(i,s,o,g,r,a,m){i['UserlaneCommandObject']=r;i[r]=i[r]||function(){(i[r].q=i[r].q||[]).push(arguments)};a=s.cre
ateElement(o),m=s.getElementsByTagName(o)[0];a.async=1;a.src=g;m.parentNode.insertBefore(a,m)})(window,doc
ument,'script','https://cdn.userlane.com/userlane.js','Userlane');

Identify your user
//identify command
Userlane('identify', currentUser.id);

Identify the user and pass Custom Attributes
// identify command with custom user attributes
Userlane('identify', currentUser.id, {
  attribute_key: 'attribute_value'
});

Initialize Userlane
// initialize command
Userlane('init', your_property_ID);

Open the Userlane Assistant
// open the Userlane Assistant  
Userlane('openAssistant');

Hide the Userlane Assistant

https://docs.userlane.com/docs/implement-the-userlane-snippet
https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
https://docs.userlane.com/docs/adding-custom-fields-to-user-attributes
https://docs.userlane.com/docs/implement-the-userlane-snippet
https://docs.userlane.com/docs/openassistant-trigger-the-userlane-assistant
https://docs.userlane.com/docs/hide-hide-userlane-on-specific-pages-of-your-application
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// hide Userlane
Userlane('hide');

// show Userlane again with initializing it
Userlane('init', your_property_ID);

Remove Userlane
// remove Userlane
Userlane('removeUserlane');

Language command
// set the language of Userlane
Userlane('lang', 'language_code');

Trigger command
// Start a userlane
// TODO: replace 12345 with your userlane id
Userlane('start', 12345); 

// Start a userlane at a specific step
// TODO: replace 12345 with your userlane id
// TODO: replace 4 with the index of the step
Userlane('start', 12345, 4);

//Start a userlane only once per User
// TODO: replace 12345 with your userlane id
Userlane('startOnce', 12345);

Callback events
// hook into onStart, onComplete or onExit and provide a callback function
//TODO: Optionally replace onStart with onComplete or onExit and adjust the respective output message
Userlane('onStart', function(userlaneId, user) {

// you can put any code in here

console.log('the user started a guide');
});

// remove all callbacks from the onStart event
Userlane('onStart', false);

//Example user object you receive:
{
id: "9717166719265375",
generated: true,
time_signup: "2017-11-22T11:50:48.671Z"
}

https://docs.userlane.com/docs/remove-userlane
https://docs.userlane.com/docs/lang-define-your-language-detection
https://docs.userlane.com/docs/start-startonce-trigger-a-userlane-in-your-code
https://userlane-knowledge-center.knowledgeowl.com/docs/onstart-oncomplete-onexit-event-callbacks
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Implement a command to open the
Assistant
Last Modified on 10.04.2024

About opening the Assistant

Usually, a user opens the Assistant by clicking the Assistant icon (avatar) that is visible in one corner of the
screen. 

In some cases you might want to decide by whom and where Userlane content should be seen and want to
show Userlane only when a user clicks on a specific element.

You might want to in general hide Userlane on specific pages (read here on how to set this up) and then want
to 

open the Userlane Assistant when clicking on a specific button (e.g. a ‘Help’ or ‘Interactive Support’
button in your application)
open the Userlane Assistant when activating a toggle

Why use it

By using this command, you can 

provide interactive guidance and support to users precisely when they need it, 
enhance the user experience and 
improve onboarding and navigation within the application.

Requirements

This option is only available 

if your application has the Userlane Snippet implemented
your developers have added the openAssistant command to the specific button/toggle 

Dev Task: Implement the openAssistant command

Add the following command to the element (e.g. ‘Help’ or ‘Interactive Support’ button). 

When clicked, the Assistant is triggered in the same manner as clicking the avatar.

// open the Userlane Assistant  
Userlane('openAssistant');

https://docs.userlane.com/docs/hide-userlane-on-specific-pages-of-your-application
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This command will immediately open the Assistant.
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Hide Userlane on specific pages of
your application
Last Modified on 12.01.2024

About hiding Userlane content

In some cases you might want to decide by whom and where Userlane content should be seen, e.g. based on
roles and rights, sensitive pages.

This article covers

the benefits

as well as the three options to hide Userlane content on specific pages:

option A: use segmentation
option B: implement a hide command
option C: passive mode

 

Why use it

You might want to 

Hide the Userlane Assistant on dedicated pages (e.g. Login Pages)

Hide Assistant (Guides) on a specific user request or for dedicated users

 

Option A - Manager task: Use Segmentation
Page Segment

You can hide the whole Userlane Assistant on a specific page using context-based segmentation. 

This only works if the respective page has a specific URL content that is not part of the domain and that is only
visible in the URL when being in this section (e.g. /login).

Learn more info on context-based segmentation in this article.

User Segment

You can hide the whole Userlane Assistant  for specific user groups only you can use user-based segmentation.

https://app.knowledgeowl.com/#benefits
https://app.knowledgeowl.com/#segmentation
https://app.knowledgeowl.com/#hide
https://app.knowledgeowl.com/#passive
https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/user-segmentation
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Option B - Dev Task: Implement the hide command

Alternatively, you can hide Userlane programmatically on specific pages (e.g. the login page) using the hide
command:

// hide Userlane
Userlane('hide');

If you want to show Userlane again after hiding it, you can use the initialize command: 

// initialize Command
Userlane('init', your_property_ID);

�Good to know

If you want to open the Assistant with a specific button, you can use the openAssistant command.
If you use links to share Guides, the hide command won’t work on the login page. The Guide will
start on the login page if the login URL is added on the Application URLs page of your application's
settings. If you want this case to work as well, your developers have to remove the Userlane snippet
from the login page.

 

Option C - Userlane Task: Use the passive mode

Should you decide to have your own button which should trigger Userlane, please don’t use the hide
command. Simply contact us, so we can advise you on how to best set it up.

https://docs.userlane.com/docs/openassistant-trigger-the-userlane-assistant


371

Userlane Language Detection
Last Modified on 10.11.2023

About Userlane Language Detection

Userlane automatically detects the language of your application and of the user's browser to match a user's
language preferences.

Language Detection Priorities

Userlane detects languages based on a priority list. You can find that below: 

Priority 1: Language is taken from the settings of the application (lang Command)
Priority 2: Language is taken based on your language settings in the Userlane Portal
Priority 3: Based on the HTML tag
Priority 4: Based on Meta information
Priority 5: Based on the browser language
Priority 6: The language falls back to the default language defined in the Userlane Portal 

ℹ️ In case the application has the language tag hard-coded in the app’s HTML, please contact your
Customer Success Manager. As in those cases, we can adjust the language detection from our side, which
will prioritize the end user’s browser language over the application's language.

Defining a specific Language

If you want to make sure that Userlane always uses the same language as your application, you can explicitly
define the language that Userlane should use with the language command. 

This is especially useful if your application offers a language setting and does not define its language in the
standard html lang-Attribute:

// set the language of userlane
Userlane('lang', 'language_code');

Your language_code might be a 2 letters code (like 'en' or 'de') or a 5 letters code (like 'en-us' or 'en-gb').

Best Practices

The language code used in the command should exactly match the language key that was used when the
language was created in the Portal.

Keep in mind, that the language you pass via the language command must exist and be public in the
Userlane Portal. Otherwise, Userlane will take the defined default language instead.
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Start a Guide with a JavaScript
command
Last Modified on 12.01.2024

Why use it

Start a Guide with a custom trigger natively in your application if you want to customize the user experience.

You can use the trigger command to start a Guide, e.g. within a specific button.

ℹ️  Please note that commands play the Guide and do not take any Segmentation settings into
consideration.

Start a Guide
// TODO: replace 12345 with your Guide ID
Userlane('start', '12345'); 

Start a Guide only once per User
// TODO: replace 12345 with your Guide ID
Userlane('startOnce', '12345');

You can look up the Guide ID in the Userlane Portal and insert it in one of the commands listed below.

Calling this command will also fire the onStart event.

Start a Guide at a specific step

Important: The index of the step starts at 0. It is different from the step number that you see in the Editor or
Portal. The step number in the Editor or Portal starts at 1.

Example: If you want to start the Guide at step 11, you have to insert the index 10. 

// TODO: replace 12345 with your Guide ID
// TODO: replace 4 with the index of the step
Userlane('start', '12345', 4);

� Good to know

When you're signed in to the Userlane Portal, the start command will work even when you've set the
Guide to private. You can use this to test if the trigger works. Your end users won't see the Guide when it's
set to private.

https://go.userlane.com/31610/24408
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Hooking into event callbacks
Last Modified on 12.01.2024

Why use it

The Userlane Javascript API provides some events that you can hook into. This allows you to get notified when
a user does something within Userlane.

Hooking into these events empowers you to 

extend and enhance the functionality of Userlane, 
integrate it with your existing ecosystem, 
trigger other reactions to the activity of your users in Userlane,
forward those events to your analytics solution to correlate them with all the other data you have there
create a more tailored and interactive user experience.

There are three events that you can listen to:

onStart: fired after a user started a Guide

onComplete: fired after a user successfully completed a Guide at its last step

onExit: fired after a user canceled a Guide or the Guide was canceled because of an error

Hooking into events

All events work with the same structure:

// hook into onStart and provide a callback function
Userlane('onStart', function(userlaneId, user) {

// you can put any code in here

console.log('the user started a guide');
});

Use the event name as the first argument and provide a callback function in the second argument. This callback
function will be called with two arguments:

1. userlaneId is a unique identifier for the Guide that triggered the event.

2. user is the object with all the data about the user we have at this point. You can assume that it always has
an ID attribute.

onStart - after a user started a Guide
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This event is fired whenever a Guide is started, even if it is started from the API's start command.

// hook into onStart and provide a callback function
Userlane('onStart', function(userlaneId, user) {

// you can put any code in here

console.log('the user started a guide');
});

onComplete - after a user successfully completed a Guide at its last step

This event is fired whenever a user reached the end of a Guide. This indicated that it was completed
successfully. From now on, the Guide will be marked with a green checkmark in the Userlane Assistant for this
user.

// hook into onComplete and provide a callback function
Userlane('onComplete', function(userlaneId, user) {
  // you can put any code in here
  console.log('the user completed a guide');
});

onExit - a user canceled a Guide

This event is fired whenever a user cancels a Guide using the Close button in the guide step. It is also fired
when a Guide cancels itself after an error or when an important step is not found.

// hook into onExit and provide a callback function
Userlane('onExit', function(userlaneId, user, stepIndex) {
  // you can put any code in here
  console.log('the user canceled a guide');
});

Overwriting callbacks

We only keep one callback for each event. If you hook up to an event again, it will overwrite your previous
hook.

Removing callbacks

If you want to unbind a callback from these events, call the event name again with false, null, or undefined
instead of a callback function.

// remove all callbacks from the onStart event
Userlane('onStart', false);

https://docs.userlane.com/docs/start-startonce-trigger-a-userlane-in-your-code
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The user object

The second argument passed to your callback function is the user object. It contains all the data we have about
the user at the time of the event. It is guaranteed that the user at least has an ID.

In addition to the ID, we provide the flag generated that indicates whether the ID was randomly generated by
Userlane or whether it was provided to our API or snippet.

An example for the user object is 

{
  id: "9717166719265375",
  generated: true,
  time_signup: "2017-11-22T11:50:48.671Z"
}
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User event export
Last Modified on 03.01.2025

About the User Event Export
This feature allows you to export data containing the events (interactions) a User had with your Guides.

This article covers

the requirements
the benefits
what data is exported
how to export the data
troubleshooting

 

Requirements
It requires technical knowledge so the assistance of a developer is recommended. 

 

Why use it
Use the data to:

monitor the interaction with Guides for specific Users.

compare it against the statistics you are collecting internally with other tools. 

 

Overview of exported data
The exported data will contain details on the following events:

Guide started

Guide finished

Guide exited

For each of the events, you will see the following details:

Time of the event Shows the exact time the event was triggered (UTC)

https://app.knowledgeowl.com/#requirements
https://app.knowledgeowl.com/#benefit
https://app.knowledgeowl.com/#data
https://app.knowledgeowl.com/#export
https://app.knowledgeowl.com/#troubleshooting
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Type of the event
E.g. Guide was started or exited

User User ID of the User who triggered the event

Guide
Displays the ID of the Guide for which the event was triggered

Step number,

Total step numbers

Shown only when a Guide was exited. Displays the steps at which the Guide was
exited and the total number of steps in the Guide.

The results are exported to a JSON format which you can process for your needs with the help of a developer. 

Here is a sample result in JSON format:

 

Export the data
Prerequisites
This type of data export is protected and requires authentication by an Authorization Token. You can generate
your token under _My Account_ in the Userlane Portal.

�  The token is generated for each Userlane Manager individually. You can generate a new token at any
time using the same button in your Portal.

The API export can only be done with a special tool. We have made it available for you here. 

https://dev.userlane.com/reference/enduserevents
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Preparing a request
For the request to be successful, you will need to fill out the tool with the required data in the required format. 

This is the general view of the export page. We will go through all the required fields below:

Parameters

In order to target the data for your application and for a specific time span, you will need to enter search
parameters:

Property ID: the individual Userlane ID of your application

Start + End: here you can select a time span for the data you want to export. Use the following time
format: 2023-04-01T00:00:00+00:00 (the bold section sets the date, here, it is 1 April 2023, you can
leave the rest like in the example)

Page and Limit options: the maximum elements per page is 1000, if your result is bigger, you will need to
request the data for each page separately by changing the page number and running the query again

The API can export data from maximum 60 days in the past. 

Here is an example of properly filled out parameters:
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Authentication 

The request is only possible if authenticated with the correct token. Please paste it into the Authentication field:

Run the request

Once all the parameters are set, you can run the query by clicking on the “Try it” button in the CURL section. 

If everything goes well, you will see the results in the Response section below.
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You can copy the results by clicking on the Copy icon. 

The request code can be copied as well and used in another tool. 

 

Troubleshooting
If the request is not successful, you will see an error message in the result section. You may look for possible
issues based on the message it contains. 

The most common errors relate to the wrong date format or incorrect/ invalid token being used, like in this
example:

If you see any errors, please revise all the data based on the article. If the issue still occurs, please reach out to
us.
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User profile data export
Last Modified on 09.07.2024

About User Profile Data Export
This feature allows you to export data containing details on your Userlane end-users.

This article covers

the requirements
the benefits
what data is exported
how to export the data
troubleshooting

 

Requirements
It requires technical knowledge so the assistance of a developer is recommended. 

 

Why use it
Use the data to:

check if the correct details are saved for your users

compare it against the statistics you are collecting internally with other tools

check when your Users got activated for Userlane or when was the last time they were seen

 

Overview of exported data
The exported data will contain details on your end-users:

 Application User ID  The unique id in Userlane

First time seen The time and date the User was first detected by Userlane (UTC)

Last time seem The time and date the User was last time seen by Userlane (UTC)

Application attributes
 The attributes (additional information) that you pass for the User. Here you will

see a sub-list of attributes and   their values. If no value was set, you will see null. 

https://app.knowledgeowl.com/#requirements
https://app.knowledgeowl.com/#benefit
https://app.knowledgeowl.com/#data
https://app.knowledgeowl.com/#export
https://app.knowledgeowl.com/#troubleshooting
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Company User Id  Only for Browser Extension Users: User ID for your Company in Userlane

Company Attributes
 Only for Browser Extension Users: attributes collected for the company users

mentioned above

The results are exported to a JSON format which you can process for your needs with the help of a developer. 

Here is a sample result in JSON format:

The first ID is an internal one and can be ignored. 

 

Export the data
Prerequisites
This type of data export is protected and requires authentication by an Authorization Token. After this feature
is enabled on your account, you can generate your Authorization Token on the Userlane Portal under Settings >
API Token. 

�  The token is generated for each Userlane Manager individually. You can generate a new token at any
time using the same button in your Portal.

The export can only be done with a special tool. We have made it available for you here

Preparing a request
For the request to be successful, fill out the tool with the required data in the required format. 

https://docs.userlane.com/docs/user-data-export
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This is the general view of the export page. We will go through all the required fields below:

Parameters

In order to target the data for your application and for a specific time span, enter search parameters:

Property ID: the individual Userlane ID of your application

lastSeenAfter: will include only users active after a specific time

Page and Limit options: the maximum elements per page is 1000, if your result is bigger, you will need to
request the data for each page separately by changing the page number and running the query again

Here is an example of properly filled out parameters:
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Authentication 

The request is only possible if authenticated with the correct token. Paste it into the Authentication field:

Run the request

Once all the parameters are set, run the query by clicking on the “Try it” button in the CURL section. 

If everything goes well, you see the results in the Response section below.

Copy the results by clicking on the Copy icon. 

The request code can be copied as well and used in another tool. 

 

Troubleshooting
If the request is not successful, you will see an error message in the result section. You may look for possible
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issues based on the message it contains. 

The most common errors relate to the wrong date format or incorrect/ invalid token being used, like in this
example:

If you see any errors, please revise all the data based on the article. If the issue still occurs, please reach out to
us.
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HEART Analytics API
Last Modified on 12.09.2024

About the HEART Analytics API
Userlane offers an HTTP REST API that allows you to export HEART analytics data in JSON format for your
internal reporting needs.

This article covers

the requirements
the benefits
what data is exported
how to export the data
troubleshooting

 

Requirements
It requires technical knowledge so the assistance of a developer is recommended. 

 

Why use it
Use the data to:

send data from Userlane HEART to your BI tool of choice for deeper analysis and to enrich other data you
gather internally

bring Userlane HEART data to a wider audience of stakeholders at your organization

 

Overview of exported data
When you export data using the Userlane HEART API, you will get a breakdown of HEART data for all dates
in the request. This means that for each date you will receive the overall HEART score as well as the individual
letter scores, plus the number of users and number of sessions.

The results are exported to a JSON format which you can process for your needs with the help of a developer. 

Here is a sample result in JSON format:

https://app.knowledgeowl.com/#requirements
https://app.knowledgeowl.com/#benefit
https://app.knowledgeowl.com/#data
https://app.knowledgeowl.com/#export
https://app.knowledgeowl.com/#troubleshooting
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Export the data
Prerequisites
This type of data export is protected and requires authentication by an Authorization Token. You can generate
your token under Settings/Your Profile/API Token in the Userlane Portal.

�  The token is generated for each Userlane Manager individually. You can generate a new token at any
time using the same button in your Portal.

To perform the API export, navigate to https://dev.userlane.com/reference/heartdata and follow the steps
outlined below.

Preparing a request
For the request to be successful, you will need to fill out the tool with the required data in the required format. 

This is the general view of the export page. We will go through all the required fields below:

https://dev.userlane.com/reference/heartdata
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Parameters

In order to target the data for your application and for a specific time span, you will need to enter search
parameters:

Application ID: the individual Userlane ID of your application

Start + End: here you can select a time span for the data you want to export. Use the following time
format: 2023-04-01T00:00:00+00:00 (the bold section sets the date, here, it is 1 April 2023, you can
leave the rest like in the example)

Page and Limit options: the maximum number of elements per page is 1000, if your result is bigger, you
will need to request the data for each page separately by changing the page number and running the
query again

Below is an example with parameters:
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Authentication 

The request is only possible if authenticated with the correct token. Please paste it into the Authentication field:

Run the request

Once all the parameters are set, you can run the query by clicking on the “Try it” button in the CURL section
and you will see the results in the Response section below.

You can copy the results by clicking on the Copy icon. 

The request code can be copied as well and used in another tool. 

 

Troubleshooting
If the request is not successful, you will see an error message in the result section. You may look for possible
issues based on the message it contains. 

The most common errors relate to the wrong date format or incorrect/ invalid token being used, like in this
example:
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If you see any errors, please revise all the data based on the article. If the issue still occurs, please reach out to
us.
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Implement the removeUserlane
command
Last Modified on 24.03.2025

About the removeUserlane command

The removeUserlane command withdraws the initialized Userlane property present in the application. When
triggered, the Userlane Assistant and associated content will disappear and HEART analytics will no longer be
active for that user.

You can use this command to specify when and where Userlane is available. For example, if a user who
previously accepted all cookies adjusts their preferences to no longer accept Userlane cookies, the
removeUserlane command be utilized to no longer inject the Userlane product for that user.

Requirements

This option is only available 

if your application has the Userlane Snippet implemented
your developers have added the removeUserlane command to the specific button or action in your
application

Dev Task: Implement the removeUserlane command

Below you will find the command to be implemented:

// remove Userlane  
Userlane('removeUserlane');
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Userlane Cookie Inclusion Policy
Last Modified on 31.03.2025

1. When Userlane Does Not Need to Be Included in a Cookie Policy

Userlane does not need to be included if:

It is used internally for software used by an organization’s employees. 

It is used externally in a B2B environment, where the users are business users accessing software in a
professional capacity.

Reason: In these cases, the use of cookies falls under corporate IT policies rather than consumer data
protection regulations (e.g., GDPR).

2. When Userlane Must Be Included in a Cookie Policy

Userlane must be included in the cookie policy if:

It is used in a B2C (Business-to-Consumer) platform, where the end-users are private individuals (not
business users).

Reason: In B2C environments, consumers must be informed about cookies and tracking technologies under
GDPR and similar regulations.

Note: Userlane places several cookies, and they should either all be set to “essential” or all to “functional”,
depending on whether Userlane is implemented to 

a. support regulatory duties, e.g. mandatory onboarding or training of functionalities related to
security/privacy (essential) or 

b. is used for analytics only (functional)

3. Userlane as an Essential Cookie (No Opt-Out Required)

Userlane should be classified as an essential cookie (without opt-out) if:

Both Userlane Guides and Analytics are used to comply with legal or regulatory requirements (e.g.,
GDPR, DORA) by training users in specific features related to compliance, such as setting up 2FA or
guiding them through critical workflows.

Reason: Essential cookies are required for the platform to meet regulatory obligations, and user consent is not
required for their use.

4. Userlane as a Functional Cookie (Opt-Out Required)

If Userlane is used only for analytics purposes, it should be categorized as a functional cookie, requiring user
consent with an opt-out option.

Action:
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The cookie policy should state that users can opt out of Userlane analytics tracking.

Implement the process outlined in Annex 2 for enabling opt-out.

Reason: Functional cookies enhance user experience but are not necessary for the platform’s core functionality.
Therefore, under GDPR, users must have the choice to opt out. 

Note: Userlane sets several cookies Opting out also disables the option to display Userlane guides or any
other Userlane content in the application.

5. Userlane Is Not a Marketing Cookie

Userlane must never be classified as a marketing cookie as:

It does not track users for advertising purposes.

It does not collect or share data for remarketing or third-party ad platforms.

It is used strictly for platform guidance, usability, and analytics.

Conclusion: Userlane is either an essential or functional cookie, never a marketing cookie.

Summary Table

Use Case
Include in Cookie
Policy?

Cookie Category
Opt-Out
Required?

Internal employee use (B2B, training, onboarding) � No Not applicable Not applicable

External B2B use (business users, corporate
software)

� No Not applicable Not applicable

B2C use (private individuals as end-users) � Yes
Functional or
Essential

Depends on
category

Userlane used for regulatory compliance (e.g.,
GDPR, DORA)

� Yes Essential � No opt-out

Userlane used only for analytics � Yes Functional
� Opt-out
required

A comprehensive list of Userlane cookies can be found here.

Required Actions

https://docs.userlane.com/docs/userlane-cookies
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Evaluate if Userlane needs to be included in your cookie policy.

Ensure Userlane is correctly categorized in your cookie policy.

Include Userlane cookie policy statement.

Implement opt-out functionality if Userlane is classified as a functional cookie.

https://docs.userlane.com/docs/cookie-policy-statement
https://docs.userlane.com/docs/cookie-opt-out
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Userlane Cookie List
Last Modified on 31.03.2025

This help doc provides a comprehensive overview of the cookies used at Userlane and their purpose. 

List of Cookies

Here is a summary of all Cookies and LocalStorage items that Userlane’s embeddable frontend package
(userlane.js) might store on the user’s device.

Name Type Purpose
Storage
Duration

Required

userlane-context Cookie
Storing status of the UI and
related context of Userlane

5 minutes Yes

userlane-app-session Cookie
Storing status of Userlane
analytics session

30 minutes
Only when HEART
analytics is enabled

userlane-user Cookie
Identify the user to show
consistent status of content
(e.g. mark guide as done)

5 years

Only in cases when no
user identifier is
passed into the
Snippet

userlane-assistant-context LocalStorage
Storing status of the UI and
related context of Userlane

indefinitely Yes

AUTH_SESSION_ID 
Cookie (third-
party)

Storing the user
authentication session ID.

Session
Yes (if end user has
access to the Portal)

KEYCLOAK_IDENTITY
Cookie (third-
party)

Storing a token used to verify
the identity of the user.

Session
Yes (if end user has
access to the Portal)

KEYCLOAK_SESSION 
Cookie (third-
party)

Storing information about the
user session.

Session
Yes (if end user has
access to the Portal)

Detailed information on the cookies and local storage items listed above:

Name Detailed information
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userlane-context

It has two purposes:

1.  When starting a guide on domain A, Userlane saves information about the current
guide (e.g. guide ID, current step index, etc.) inside this Cookie. When the user
switches to domain B while playing the guide, Userlane initially doesn’t know
anything about the current guide because it’s a new environment. This Cookie
informs Userlane about the current context so that the guide can be continued
seamlessly. 

2. Show the Userlane Editor for end users who create and manage content across
different pages or domains. When the end user opens the Editor on page or
domain A, the information that the Editor is open is stored in this Cookie. When
the end user switches to page or domain B, the end user can continue working in
the Editor from the same section.

userlane-app-session

It contains app session information which is used for Userlane-related analytics.
With this Cookie, the app analytics events can be aggregated and assigned correctly.
It is stored in a Cookie so the user session can be tracked correctly.

userlane-user

This cookie is only used for a special implementation case when there is no user ID
passed within the snippet. In this case, Userlane generates a random ID and stores
this ID in this cookie. It is used so the Userlane assistant can show the end user the
correct progress (e.g. played guides or announcements already shown).

userlane-assistant-
context

It contains information about the state of the Assistant. For example, the user can
move the Userlane Assistant to different positions by dragging and dropping it
around. This position (e.g., “bottom-right”) is stored in this local storage entry so that
the Assistant can be displayed correctly for each user based on their preference.

AUTH_SESSION_ID

It contains the ID of the authentication session for a user during the authentication
process. It is used by Keycloak to identify the user in the authentication flow (e.g.,
after the user has typed the email, before the password is typed).

KEYCLOAK_IDENTITY

It contains an authentication token for an authenticated user in the format of JWT
(JSON Web Token). It contains information about the user, its authorization roles, and
other information useful for the application to determine and identify the user and its
permissions.

KEYCLOAK_SESSION
It contains the ID of the session for an authenticated user. It is used by Keycloak to
determine if a user is logged in.
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Userlane Cookie Policy Statement
Last Modified on 31.03.2025

If Userlane is used in a B2C environment targeting private individuals, we recommend including one of the
following statements in the cookie policy.

Userlane places several cookies, and they should either all be set to “essential” or all to “functional,”
depending on whether Userlane is implemented to 

a) support regulatory duties, e.g. mandatory onboarding or training of functionalities related to security/privacy
(essential) or 

b) is used for analytics only (functional)

Userlane is classified as an essential cookie.

Our platform uses Userlane, to provide in-app guidance and ensure compliance with regulatory and security
requirements. These cookies enable critical workflows and help users navigate required processes. Disabling
these cookies would impact the platform’s ability to fulfill compliance requirements.

Purpose: Ensuring compliance with regulatory requirements, guiding users through mandatory security
and operational workflows, and ensuring users understand required platform features.

Data Processed:

Session data (e.g., active session ID, authentication status) to ensure continuous access to required
compliance processes.

Interaction data (e.g., completed steps in mandatory workflows) to verify that users have followed
necessary procedures.

Feature usage data (e.g., whether a compliance-related feature was used or acknowledged) to
document adherence to legal requirements.

Navigation events (e.g., page visits related to legal training) to confirm that regulatory training was
completed.

Retention Period: Data is retained only as long as necessary to demonstrate compliance with legal
requirements.

Opt-Out Option: These cookies are essential for compliance and security purposes and cannot be
disabled.

More detailed information is available at Userlane’s End-User Privacy Policy at userlane.com/end-user-privacy

Userlane is classified as a functional cookie.

Our platform uses Userlane to enhance user experience and improve usability by analyzing how users interact
with features and guidance elements. These cookies help us optimize workflows, identify areas where users
need more support, and enhance overall usability. As these cookies are not required for the platform’s core

http://userlane.com/end-user-privacy
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functionality, you can choose to disable them.

Purpose: Tracking platform engagement, improving usability, and understanding user interactions.

Data Processed:

User interactions (e.g., clicks, hovers, engagement with tooltips and guides) to analyze feature
adoption.

Navigation patterns (e.g., pages visited, time spent on certain sections) to identify usability
bottlenecks.

Guide completion data (e.g., whether users finish an onboarding tutorial) to improve tutorial
effectiveness.

Error tracking data (e.g., failed actions or frequent exits from a process) to optimize platform
guidance.

Retention Period: Data is stored for analytics purposes and is anonymized where possible. Retention
follows standard data protection policies.

Opt-Out Option: You can disable these cookies in your [cookie settings] or [privacy preferences].

More detailed information is available at Userlane’s End-User Privacy Policy at userlane.com/end-user-privacy

http://userlane.com/end-user-privacy
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Implementing the Cookie Opt-Out
Functionality
Last Modified on 31.03.2025

Note: This should only be implemented if Userlane is on an external application for private individuals (B2C)
and only the Userlane analytics (not guidance) is in use. 

Userlane should be configured as a functional cookie in the cookie banner. If a user opts out of the functional
cookie, Userlane won’t load, and no Userlane content will be available for this specific user.

Please complete the following instructions:

1. Executing Userlane after the user has provided cookie consent
1. The Userlane ‘init’ (short for initialize) command is used in conjunction with a Userlane-specific property

ID to execute a customer instance of Userlane.
2. Trigger the ‘init’ command after the user has accepted Userlane cookies. This can be done by configuring

a logic where the ‘init’ command is only triggered if and when the user has accepted the cookies.
3. The Userlane API ‘init’ command Userlane(‘init’, your_property_id); is customer-specific and requires your

specific property ID, which can be found in the Userlane Portal.

2. Removing Userlane if a user has adjusted their cookie preferences

1. The Userlane ‘remove’ command can be used to withdraw the initialization of the Userlane product.

2. Trigger the ‘remove’ command after the user has adjusted their cookie settings. This can be done by
configuring logic that triggers the ‘remove’ command if the user changes their cookie preferences and
chooses not to accept Userlane cookies if they have been classified as functional.

3. Notably, the customer must also ensure that this user's cookie preferences are stored and that the
Userlane ‘init’ command is not executed for that user again at a later time.

4. The Userlane API ‘remove’ command Userlane('removeUserlane'); is global and does not require the use
of a specific id in order to withdraw the Userlane product from the application.

More information on working with the Userlane API can be found in the Userlane API documentation.

https://docs.userlane.com/docs/list-of-api-commands-in-userlane


401

Data Security & Privacy Principles
of Userlane
Last Modified on 12.01.2024

The security and integrity of all data that enters or leaves any Userlane system are of high value to us. 

We constantly strive to build on our high standards and leverage them to provide our clients with the peace of
mind that their business is running in a secure environment. 

We do this by living and fostering a culture that is security-aware and privacy-aware. 

We built Userlane as a privacy-first company because we strongly believe that security and privacy must be a
deep-rooted and upheld value of organizations worldwide. 

Our approach to security and privacy is built on the following three principles:

Data frugality    

Userlane only stores data that is required to deliver its services. 

By default, we minimize the amount of data that runs through our systems. 

Thereby we ensure critical data is neither collected nor processed by us unless our customers explicitly
demand it for targeting, analytical or compliance purposes.

Proven technologies  

We validate our technology choices with industry best practices and vendor compliance processes. 

We rely on languages, frameworks, and systems that are used in business-critical applications by various
enterprises and governmental agencies around the world.

Highest security standards  

We apply high-security standards with every change we make. 

We are aware that a chain is only as strong as its weakest link, so every choice matters. 
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Our culture and values embody the high responsibility we take on.
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Security & Privacy Certifications
Last Modified on 09.08.2024

 � Userlane is ISO 27001 certified.

About ISO 27001

ISO 27001 is widely recognized and respected and provides a framework for information security management
practices. It establishes requirements for information controls to manage people, processes, and technology.
ISO 27001 is accepted worldwide to ensure that proper and continual measures have been taken to protect
valuable company data.

Statement of Applicability: Development, operation, and support of a digital adoption platform

ℹ️ The current certificate is valid from 25th July 2024 until 24th July 2027 and can be viewed here. 

Userlane will of course renew the certificate continuously.

https://www.userlane.com/wp-content/uploads/2024/07/2024_ISO-Certificate_English.pdf
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Rolling out the new Userlane
Browser Extension to all users
Last Modified on 19.06.2024

The following article is addressed to organizations that have rolled out the Userlane Browser Extension to their
employees. If you have implemented the Userlane snippet in the underlying application, no changes are
required.

Introduction

We have built a new Userlane Browser Extension to create a safer and more enjoyable browsing environment
for our end users. Adhering to the most recent extension architecture guidelines introduced by Google, known
as Manifest v3, our new Browser Extension comes with an improved performance alongside heightened
security.

What is Manifest v3?

Google introduced a new framework for the development of browser extensions, known as Google Manifest
v3. This framework is designed to enhance the privacy, security, and overall performance of browser
extensions. It is scheduled to be implemented in Google Chrome and Microsoft Edge by the end of 2024.
Meanwhile, Mozilla Firefox has already incorporated support for extensions based on Manifest v3.

If you want to get into more technical details, access the following documentation link from Google. 

Upcoming changes

The new Userlane Browser Extension is a security and performance upgrade. This upgrade will not impact
any existing user workflows.

Migration process

Throughout the summer of 2024, we will gradually introduce the upgrade to all of our Browser Extension
users, paying close attention to their feedback every step of the way. The upgrade procedure is designed to be
smooth and hassle-free. Users selected for the rollout will have the upgrade automatically installed by their
web browser.

However, there might be instances where the latest upgrade does not get installed:

If you are using an outdated version of your web browser, or
if your organization’s IT team has not yet allowed the Userlane Browser Extension upgrade to its users.

That is why we created a checklist you can share with your IT team to ensure a smooth rollout of the new
Userlane Browser Extension.

https://developer.chrome.com/docs/extensions/develop/migrate/what-is-mv3
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Checklist

1. Use a supported web browser

The following web browser versions are supported:

Chrome: 88 and above
Edge: 88 and above
Firefox: 109 and above

The Userlane Browser Extension will not work correctly if you use an unsupported web browser version.

2. Review the Browser Extension Update Management Process of your organization

Some organizations manage the time when the latest browser extension updates are deployed to their
employees. For example, they schedule these updates to happen weekly. As a result, it could take additional
time for the update to be available to you.

To ensure a smooth upgrade process, we recommend you allow the Userlane Browser Extension to receive
updates once they are available in the web browser stores.

If you have any questions about any Userlane Browser Extension requirements, reach out to your CSM
anytime.

How do I know if I use the latest version of the Userlane Browser Extension?

Access the settings of your web browser and navigate to Extensions. Check the version of the Userlane
Browser Extension:

version 23.x.x: you are using the old Userlane Browser Extension
version 30.x.x: you are using the new Userlane Browser Extension

What happens if I continue to use the old Userlane Browser Extension?

Userlane will stop supporting the old Userlane Browser Extension in September 2024.

The old Browser Extension may still work beyond September 2024, but we won’t provide any technical
support for it if you encounter any issues or bugs. Based on the Manifest v2 support timeline documentation,
Google will stop supporting Manifest v2 Browser Extensions in Q4 2024/Q1 2025. 

https://developer.chrome.com/docs/extensions/develop/migrate/mv2-deprecation-timeline
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Userlane Partners with Microsoft
for Secure Infrastructure & Hosting
Last Modified on 12.01.2024

� Userlane's availability is guaranteed to exceed 99.5%. We regularly achieve higher uptime and the live
status as well as historic data can be viewed on Userlane's Statuspage.

Why we chose Microsoft Azure

Userlane decided to work with Microsoft Azure to ensure the strict security and compliance requirements of our
enterprise and public service clients are met and allow us to provide a scalable, frictionless service at a global
scale.

Userlane is a certified partner of Microsoft.

By joining forces with the industry leader Microsoft, Userlane can rely on a proven security architecture: Over
3,500 dedicated Microsoft cybersecurity professionals help protect, detect, and respond to threats.

All of Userlane’s databases, application servers, and network infrastructure
are hosted by Microsoft Azure.

By relying on Microsoft, Userlane can leverage significant investments that have been made towards the
security and compliance of data centers:

Microsoft Azure is certified with ISO 27001 - a common standard in the industry.

Since the beginning of 2017, Microsoft Azure is also certified with ISO 27018 - a new standard for the
protection of personal data in the Cloud.

Read Microsoft’s Whitepaper about Microsoft Azure Security, Privacy, Compliance

https://status.userlane.com/
https://www.microsoft.com/TrustCenter/Compliance/ISO-IEC-27001
https://www.microsoft.com/TrustCenter/Compliance/ISO-IEC-27018
https://go.microsoft.com/fwlink/?LinkId=392408
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Security Operations
Last Modified on 15.01.2024

Encryption
Data at rest

All databases use a so-called "at rest" encryption. This means that data can only be read if proper
authentication takes place on the respective database system. The files in which the data is stored are stored in
encrypted form so that they can only be read by database systems that have the appropriate decryption key.
Userlane strives to keep its systems up to date with the newest and most secure encryption algorithms. The
standard algorithm for encrypting data at rest is currently AES256. Encryption keys are securely managed by
Microsoft Azure using Key Vault.

Read Azure’s principles on Encryption At-Rest

Data in transit

Userlane applies transport encryption whenever data has to be transmitted over an insecure or public network
(e.g. outside the virtual private cloud). The type of transport encryption depends on the encryption requested
by the client system. Userlane uses HTTPS connections with 256-bit SSL certificates and TLS version 1.2 or
newer for all communications with clients. This ensures that data is protected against interception or
modification.

Selection of encryption algorithms

Userlane follows the NIST standards for selecting strong encryption algorithms and approving built-in
encryption used by a Userlane subprocessor.

Read the NIST SP 800-175B guidelines

Segregation of traffic in multi-tenant environment

Userlane’s Cloud systems implement multi-tenancy in a shared cluster. Multiple customers are served from a
single cluster. Tenant separation is enforced on a logical level, not on a physical level. Userlane ensures strict
tenant separation through the following measures:

1. Input sanitization and pre-built queries

2. Request isolation

3. Use of frameworks

4. Extensive manual and automated testing

5. Security scans

https://docs.microsoft.com/en-us/azure/security/fundamentals/encryption-atrest
https://csrc.nist.gov/publications/detail/sp/800-175b/rev-1/final
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6. Penetration testing (see below)

Firewalls

Userlane works with Azure Network Security Groups to ensure that services running within the Azure
environment are accessible only to the networks that need it. Access to network ports of various services is
restricted to the extent that access is only possible through services that need access.

Penetration Tests

Userlane works with recognized security experts and researchers. Together we aim for the highest possible
security of our systems.

We perform penetration tests on a yearly basis. Our contractor Cobalt maintains a core of 200+ highly vetted,
certified security researchers.

Upon performing each penetration test, Cobalt provides Userlane with a report containing the list of detected
vulnerabilities along with recommended fixes. Userlane commits to implement fixes depending on the severity
of the vulnerability. The timeline for such fixes is set as follows:

Critical vulnerabilities: Fix immediately

High vulnerabilities: Fix within 30 days

Medium vulnerabilities: Fix within 60 days

Once a fix is implemented, the vulnerability is re-tested. The cycle is repeated until all vulnerabilities are
confirmed to be fixed.

Monitoring

Userlane uses various monitoring tools to ensure maximum availability, performance and security of the
application. The monitoring includes but is not limited to the following parameters:

Availability

Availability of the application

Accessibility of backend systems and services

Resources

CPU utilization

Utilization of network interfaces
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Utilization of persistent and volatile storage

Performance

Response times of the application

Response times of backend systems

Query times for database contents

Security

Update status of systems

Error logs

Access logs (IP address, URL, browser type and version)

Backups

Userlane drives continuous backups of databases. With those database systems that support it, the database
state can be restored to a previous state down to the second. Other databases are backed up regularly, e.g.
every 24hrs. The backups are stored in the same datacenter region, but a different availability zone. Backups
are retained for 30 days. These backups are treated as sensitive data. Only specific personnel can access these
backups after an internal authorization process.
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Data residency options
Last Modified on 12.01.2024

ℹ️ Data is completely separated between the hosting options to assure compliance with the requirements of
data being held either in the EU or the US. Hence, we offer 2 residency options that customers can choose
during Userlane account setup.

Userlane offers dedicated hosting in the EU 

In order to ensure full compliance with GDPR and the Schrems II ruling, Userlane guarantees to only use
Microsoft Azure Datacenters based in the EU. Microsoft is our trusted partner in keeping customer data secure
and operating in compliance with all EU regulations. 

Read Microsoft’s commitment to store and process EU data only in the EU.

EU datacenter: Microsoft Azure "Europe West" in Amsterdam, Netherlands

Userlane offers dedicated hosting in the US 

In order to ensure full compliance with CCPA, Userlane guarantees to only use Microsoft Azure Datacenters
based in the US. 

Microsoft is our trusted partner in keeping customer data secure and operating in compliance with all US
regulations.

US datacenter: Microsoft Azure "East US" in Virginia, USA

https://blogs.microsoft.com/eupolicy/2021/05/06/eu-data-boundary/
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Data flow for Userlane JavaScript
Snippet implementation
Last Modified on 09.01.2025

What is this article about?

This data flow maps out the flow of information from the end user to Userlane and back. 
Below, you can find a diagram of the data flow, followed by a list of the recorded data fields and their purpose.

Recorded data field Purpose

Userlane Application
and Company IDs

To identify which application Userlane is loaded upon and fetch relevant content.

Information that can be sent toUserlane based on the Portalconfiguration

https://dyzz9obi78pm5.cloudfront.net/app/image/id/6777ee57f48110c91608a0ab/n/1735913046900.png
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URL

To identify which application Userlane is loaded upon and fetch relevant content.

The URL is also used within HEART analytics if the corresponding options are enabled
in the Portal. For more information, please check below the type of events that
Userlane can collect based on your configuration.*

URL patterns To have the snippet detect whether Userlane should be loaded.

User ID

To identify the same user again when returning to the underlying application.

If no User ID is passed into the JavaScript Snippet, Userlane automatically creates one
and stores it in a Cookie. This can be an anonymous identifier that does not qualify as
personal data.

Once the user is identified, Userlane shows how many Guides have been completed,
whether the Announcement was already shown, etc.

Origin
To identify how the user was created (e.g., whether it was generated by the Userlane
JavaScript snippet, BX, via email invite, etc.) 

User Data

(optional)

To segment users with the help of attributes. Attributes are never automatically
collected by Userlane.

If no user data is passed into the JavaScript Snippet, Userlane works with
empty/anonymous user profiles.

Browser To guarantee browser compatibility.

Browser language and
page language

To guarantee that the content will be shown in the correct language.

Sign-up time
To be able to use date/time-related segments. For example, by knowing the sign-up
time, you can show certain onboarding materials only for one month.

User session
It passes user session-related information that is used to calculate various analytics-
related metrics in Userlane. For more information, please check below the type of
events that Userlane can collect based on your configuration.*

Recorded data field Purpose

* When the end user interacts with certain underlying apps or Userlane elements, data is sent to Userlane
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Cloud in the form of raw events. To learn more about Userlane-related events, please check the following
wiki documentation. 
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Data flow for Userlane Browser
Extension Implementation
Last Modified on 09.01.2025

What is this article about?

This data flow maps out the flow of information from the end user to Userlane and back.
Below, you can find a diagram of the data flow, followed by a list of the recorded data fields and their purpose.

Recorded data field 

 

Purpose

Userlane Application and
Company ID

To identify which application Userlane is loaded upon and fetch relevant
content.

Information that can be sent to Userlane
based on the Portal configuration

https://dyzz9obi78pm5.cloudfront.net/app/image/id/6777ec1857c3165ba30f6215/n/1735912472009.png
https://dyzz9obi78pm5.cloudfront.net/app/image/id/6777ec1857c3165ba30f6215/n/1735912472009.png
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URL

To identify which application Userlane is loaded upon and fetch relevant
content.

The URL is also used within HEART analytics and App Discovery if the
corresponding options are enabled in the Portal. For more information, please
check below the type of events that Userlane can collect based on your
configuration.* 

URL patterns
To have the Userlane Browser Extension detect whether Userlane should be
loaded on that page.

User ID

To identify the same user again when returning to the underlying application.

The User ID is automatically generated by Userlane when the Browser
Extension is used.

Once the user is identified, Userlane shows how many Guides have been
completed, whether the Announcement was already shown, etc.

Origin
To identify how the user was created (e.g., whether it was generated by the
Userlane JavaScript snippet, BX, via email invite, etc.) 

User Email Address

To authenticate the user on the Browser Extension. Depending on the
application setup, the user may have to share the email address:

when logging into the Userlane Browser Extension

when confirming the authentication process by clicking on the
confirmation link received in the email invite.

when the user authenticates via SSO.

User Data

(optional)

To segment users with the help of attributes. Attributes are never automatically
collected by Userlane. They can be passed in the following way:

via CSV file upload (in the Userlane Portal)

automatically if passed from the Identity Provider via SSO.

User session
It passes user session-related information that is used to calculate various
analytics-related metrics in Userlane. For more information, please check below
the type of events that Userlane can collect based on your configuration.*

Recorded data field 

 

Purpose
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Browser To guarantee browser compatibility.

Browser language and page
language

To guarantee that the content will be shown in the correct language.

Sign-up time
To be able to use date/time-related segments. For example, by knowing the
sign-up time, you can show certain onboarding materials only for one month. 

Recorded data field 

 

Purpose

* When the end user interacts with certain underlying apps or Userlane elements, data is sent to Userlane
Cloud in the form of raw events. To learn more about Userlane-related events, please check the
following wiki documentation.

https://docs.userlane.com/docs/analytics-privacy-settings
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Data flow with the Userlane Editor
Last Modified on 03.01.2025

When using the Userlane Editor, there are additional data flows. 

This applies to both the JavaScript Snippet and the Userlane Browser Extension.

In addition to the data fields recorded by the implementation method, the Editor records these fields:

Recorded data field Purpose

Element Selectors - potentially including

Node type

All node attributes (id, name, role, class, and
others that are set on the element)

Number of parents, siblings, and children

The same is also for all parents

The text content of the highlighted element
during the recording

To generate selectors that allow Userlane to highlight
the same element again in the Player. The text content
might be used as a fallback if there is a complex
element structure (e.g., dynamic CSS-IDs) for the
highlighted element.

URL of each step To identify which page each step was recorded on.
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AI & Data Security
Last Modified on 09.04.2024

At Userlane, we understand the importance of transparency, security, and privacy, when it comes to handling
your data and utilizing artificial intelligence (AI) technologies.

We are committed to follow these principles:

1. Your data is your data

Your data belongs to you, and we treat it with the utmost respect and confidentiality.

2. Always secure

We employ robust security measures to ensure that your data is always secure, whether it's in transit or at
rest.

3. Never shared with 3rd parties

Your privacy is paramount. We never share your data with third parties, ensuring complete confidentiality.

Frequently Asked Questions

Do you utilize AI? 

Yes, we utilize advanced AI technologies, including large language models and proprietary machine learning
models, to enhance our services.

What provider do you use? 

We leverage the Azure OpenAI service hosted within our own infrastructure, tailored to your location or
preferred data residency region.

 ℹ️ As Microsoft partners, we utilize Azure OpenAI services for some applications. This is an enterprise
service provided by Microsoft and should not be confused with OpenAI's own offerings. Azure OpenAI
service is a private deployment of OpenAI models that runs inside our own infrastructure and shares no
data with OpenAI or any other third party.

How is data handled?

Like with any other of our services, your data is exclusively used and/or stored within our private tenant in
Azure, guaranteeing its security and confidentiality.

Do you use customer data for training AI models?

No, we do not use customer data to train our AI models. We prioritize the privacy and security of our users'
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information.

Is it in compliance with AI related regulations? 

We are proactive in adhering to regulations such as the EU AI Act long before it entering into effect, prioritizing
the safe and responsible use of AI. 
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Frequently Asked Questions (FAQ)
Last Modified on 25.04.2024

This article includes the Frequently Asked Questions (FAQ), we receive from our customers. 

Account 
How can I change my Payment Details?

Please reach out to the Support Team or your Customer Success Manager.

Access to Userlane
I am having troubles logging in, what can I do?

Check whether your credentials are correct. 
Clear your cache and cookies.
Try logging in again.

Should you still face any issues logging in, please contact the Support Team.

I have forgotten my password, what can I do? 

You can reset it via this link here. Also check your spam folder. 

Should you still face any issues logging in, please contact the Support Team.

What is the difference between global settings and the setting under our "application drop-down"? 

The Global settings apply to all the applications that use Userlane and are listed in the Application dropdown.
The settings in the Application dropdown apply to a single Application only. For more details check out
this  article. 
  

Why can I not see my Guides in the assistant once I have created them?  

Per default, a newly created Guide is saved under draft and with the status private. You will first have to
publish it in order for it to appear in the assistant.   

What do I need the Portal for when I am creating Guides?    

On the Portal, you can manage your Guides, e.g. publish them, change order, move to a different chapter, set
the languages, customize Global settings, e.g. texts, the position of the avatar, and designs. Additionally, you
can use the Portal for Announcements, analytics, inviting team members and users.     

Will Userlane run on staging and production environments?      

We can configure Userlane so it runs either on staging or production or on both by allowing Userlane to be
shown only on specific pages or to specific users. For testing the Guides before going live you can use the

https://auth.userlane.com/auth/realms/userlane/login-actions/reset-credentials?
https://docs.userlane.com/docs/navigate-the-userlane-dashboard
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options described here.        

How do I make content available in only staging, not production environments?        

You can allow Userlane to show only on the Staging URL or only to users who have access to the staging
environment. This is usually needed for testing Guides before going live. You can read more about testing
Userlane in this article. About Page/ URL segmentation you can read more here. About user segmentation
check out this article.         

How do I move content from one environment to the other?          

You can "unlock" the content you tested on staging for the production environment by changing the segments
that were applied to Userlane and/or by rolling Userlane out to Production or you can move it to another
account if applicable.       

    

Content creation            
What are real-life examples of skip conditions? 

Check out this article to learn more about it.

Can I go back to an older version of a Guide?   

No, we recommend you be mindful of making changes to your Guides. Better make a copy of a Guide when you
need to make alterations.    

Is there an autosave for the Guides?     

As of now, there is no autosave option available.      

When do I use left clicks and when right clicks?      

You can learn more about the step types here.       

       

Can two people edit a Guide at the same time?          

No, by having more than one person working on the Guide you risk overwriting each others' changes.           

What should I test if a guide is not working?            

Please learn more about this here.            

How do I properly record drop-downs?             

You can learn more about this here.              

How can I make the selection in a drop-down, not for one but for all elements?               

You can either do this by repositioning the field or adjusting the code selector. You can learn more about this
here.      

          

https://docs.userlane.com/docs/how-to-test-your-guides-before-publishing
https://docs.userlane.com/docs/how-to-test-your-guides-before-publishing
https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/page-segmentation
https://docs.userlane.com/docs/user-segmentation
https://docs.userlane.com/docs/including-optional-steps-in-a-guide
https://docs.userlane.com/docs/record-a-guide
https://docs.userlane.com/docs/alert-notification
https://docs.userlane.com/docs/how-to-record-a-form
https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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Testing Userlane                 
How can we publish Guides to end-users for them to test?                  

Please check our article on that topic here.                    

I only saw an announcement once, what can I do?                    

Active Announcements are shown to the users either as Popups (only once per User) or are accessible via the
Assistant menu later in the Announcement Section (the bell icon). If you want to test an Announcement popup,
you will need to log in with a User who has not seen it yet.                       

Can we reset a user to start from scratch?                       

We cannot reset a user and have their interaction erased. The way to go would be to create a new user (if
needed for testing).     

                 

Security & Architecture                      

Do you offer SOC 2?                          

Userlane is ISO 27001 Certified. SOC 2 is in the planning phase.                           

                           

Why do I see a 401 login notification?                                                            

Userlane is authenticating who is currently using the Assistant. Users who are not logged in to the Userlane
Portal will see the notification 401 in the Browser console. It does not impact the performance of Userlane or
your app.

Is Userlane impacting my performance?

Userlane should not impact the performance of your application. Should you still be concerned or notice any
different behaviour, please do not hesitate to contact us for further investigation.

Branding
Can I have the "technology by Userlane" removed?

Please reach out to your Customer Success Manager.

Userlane Technology
Can I also use it on mobile, e.g. Android?                          

Userlane Technology is delivered in “Responsive Design”o Userlane also works on common mobile devices as
long as the OS and browser versions are up to date. The creation of the Guides rather happens though on the
actual online version of the application.

https://docs.userlane.com/docs/how-to-test-your-guides-before-publishing
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Can Userlane run on HTTP pages?                          

The underlying app needs to run with an encrypted protocol (HTTPS) to ensure a secure and encrypted
communication.

Is Userlane accessible?

The Userlane Suite is WCAG 2.1 certified accessible. You can find more information here.

https://www.userlane.com/accessibility/
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Improvements and Fixes - February
Last Modified on 10.03.2025

Improvements 
Portal

We improved wording in some areas of the Portal to increase clarity.

We improved the UI in the header and Snippet setup page to unify design.

We improved readability by updating colors in the UI

Assistant

We improved how Tooltips with linked Guides display the Guide title for multi-language use cases.

Other

We updated our IdP for Managers to a more recent version to improve authentication and avoid
vulnerabilities.

Released Keycloak 24, 25 which addresses the latest security threats and improves user’s authentication.

Fixes
Portal

We fixed an issue where users were unable to successfully configure the Confluence knowledge base
integration.

We fixed an issue on the Happiness page where the ‘Users Reached’ count was showing incorrectly.

Editor

We fixed an issue where the ‘test successful’ banner after testing a Tag would result in an undesired
animation.

Assistant

We fixed an issue where data in the event of a Guide Error was not being sent to Userlane content
analytics if the error occurred on a step with a skip condition applied.

We fixed an issue where text in the Guide Error modal was not showing line breaks correctly.

We fixed an issue where global CSS affected the text formatting in Userlane content for some customers.

Other

We fixed an issue with cloning property - now while cloning it it doesn’t move all guides to Unsorted
folder which simplifies users life

We fixed an issue where Guides would break after a page reload on the underlying application.
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Improvements and Fixes - January
Last Modified on 05.02.2025

Improvements 
Portal

We have released the Benchmark Color Disabling feature flag. This update replaces dynamic color-based
benchmarking with a static interval system. Scores are now assigned colors based on fixed ranges (0-20,
21-40, 41-60, 61-80, 81-100) rather than their relative position in the overall distribution of all apps.

Editor

An important update has been released to the auto-translation functionality, allowing content creators to
easily translate longer Guides into multiple languages.

Assistant

We improved how Userlane interacts with dialog elements for end users who want to view Userlane
content on these elements.
We improved how our step automation behaves by triggering two additional event types for click
interactions.

Other

We have released a new functionality that will be connected to the Userlane features so that longer
processes (e.g., long automated translations) can be run in the background.
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Release Note - App Analytics URL
exclusions (BETA)
Last Modified on 12.01.2024

21 June 2022

App Analytics URL exclusions (Beta)

What is it:
Userlane cares about privacy. If you want to use App Analytics, but worry because your app has sensitive
pages (or for example, you just want to exclude internal staging from app tracking), you now have the
possibility to exclude certain parts of the application from the advanced app tracking. 

To exclude a page from app tracking you can:
Just paste a full URL or a path and the underlying events will not be sent to us when users are on this
page
If you have a variable part of the path, you can use a wildcard * (instead of pasting all the link variables).
URLs can only have the wildcards at the beginning (e.g. *.google.com will exclude both test.google.com
or instance.google.com) and paths could have them anywhere (e.g. /test/* will exclude from tracking
/test/123 and /test/456). This logic is similar to the one we have on the App URLs part.

� Userlane events about guides and announcements are still being tracked on these pages, this is only for
the App Analytics tracking. That means we do not track underlying app activity from these pages (clicks,
navigation events, etc).

How to exclude a page: 
Exclude pages by entering a complete URL (e.g. fruits.com), a path (/apple/), or a combination of both. Note
that all subpages of the pages matching your pattern will automatically be excluded as well.
You can also use wildcards to exclude multiple pages with the desired pattern in two ways:

For the subdomain of the URL host (e.g. *.fruits.com will exclude both apple.fruits.com and
pear.fruits.com).
In the URL path (e.g. /fruit/*/apple will exclude from tracking /fruit/123/apple and /fruit/456/apple).

More in-depth about how to use this asterisk:
you can block different subdomains with an asterisk *
for example *.test.com will block cats.test.com and dogs.test.com
cats.test.com/123 will also be blocked
all the children all the time
you can block with asterisk part of the URL
test.com/123/cats will be blocked by test.com/*/cats
test.com/456/cats will also be blocked
Small improvement: You can only asterisk part of the path /cats/search=*
that will block /cats/search=cat-food or /cats/search=dog-food
so if you have cats/tuna it will not be blocked
or just go to the search and have a link like /cats/search then it will not be blocked

Please note that:

http://cats.test.com/123
http://test.com/123
http://test.com/456/cats
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/apple/ and /apple are the same
you cannot block the parent and not the children, for example, if /fruits/ is blocked then /fruits/apple
cannot be unblocked

If you have specified a path, it will also block its children, for example:

/passwords/ is blocked
It will also block /passwords/3121222
HTTP or HTTPS is not going to be compared, they block the same thing
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Release note - App analytics
Last Modified on 29.11.2023

xx October 2022

What's new

Now under your Analyze page, you would be able to see details on your application usage with Userlane App
analytics and not only an overview of your Guides and Announcements performance. 

Userlane's App analytics provides a holistic overview of your application, helping you to understand the level
of engagement that users have with your underlying applications. The reports provide you with the insights
you need to help you inform and validate your decisions.

With Userlane's App analytics, you will get reports on your users, sessions, and time spent within your
application. You will be able to see valuable information on user engagement and application usage to decide
accordingly. For more details, check out this article. 

 

https://docs.userlane.com/docs/app-analytics
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Userlane Roadmap
Last Modified on 12.01.2024

In order to compete in an ever-changing landscape, you need to constantly innovate and adapt to your
software users' needs, and so do we.

At Userlane, we believe in sharing our projects and giving you the chance to provide valuable input in our
Product Roadmap.

What is on it

Our Roadmap offers an overview of:

Released features
High-priority topics coming up
The direction we're heading

You additionally have the option to

submit own ideas
indicate which topics matter most to you

Where to find it

See our Roadmap here.

Become a member of our Customer Research Community!

As a member of the community you 

actively participate in the design of new functionalities
get early access to our newest features
share your feedback 
help us to better tailor product updates to your needs prior to release.

Join now here.

https://roadmap.userlane.com/
https://www.userlane.com/performance/customer-research-community/
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Improvements and Fixes -
December
Last Modified on 03.01.2025

Improvements 
Portal

We improved Segment dropdowns by sorting them alphabetically, making them easier to browse and
use.

Editor

We improved our ability to record Guides on top-layer elements when they present as dropdowns in the
underlying application.

Fixes
Editor

We fixed an issue where Tooltips with linked Guides specified to start from a certain step could not be
successfully updated and saved if the linked Guide was updated separately.

We fixed an issue where Guides would not end for one customer due to a cookie handling update.

Assistant

We fixed an issue where Guides that were started and then either completed or exited would launch
again without user input due to cookie duplication.

We fixed an issue where text formatting did not appear as expected in Userlane due to global styles
from the underlying application still being applied.

We fixed an issue where the Welcome Slide text alignment was changed from center to left.
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Improvements and Fixes -
November
Last Modified on 03.12.2024

Improvements 
Other

We implemented a queuing service that will later be connected to multiple Userlane features. Our goal is
to make Userlane more scalable when Managers run multiple features in parallel (e.g., user
import/export, languages import/export auto-translation, PDF export, etc.).

Fixes
Editor

We fixed an issue where the close (‘X’) button was misaligned on enlarged images in Guides and
Messages.

We fixed an issue where the code selector did not accept all CSS syntax.

Assistant

We fixed an issue where Next Button step types were behaving like Left Click step types in a customer
environment.

We fixed an issue where the scroll position on long texts in Guide steps was maintained when navigating
to the next step.

Other

We fixed an issue where users with invalid user sessions could not re-authenticate with Userlane to
receive valid user sessions again.
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Improvements and Fixes - October
Last Modified on 05.11.2024

Improvements 
Portal

We have updated the custom date range to display all data, allowing customers to filter for any
timeframe they need.

Editor

We added the step automation functionality to right click and double click step types in the Editor.

Other

We added support for slot elements to allow Managers to record Userlane content on slot elements.

Fixes
Assistant

We fixed an issue that impacted the order in which end users can access Guides.

We fixed an issue where the ‘X’ button on enlarged images was misaligned.

We fixed an issue where a load event was triggered multiple times for single clicks.

Other

We fixed an issue where images in our automated user invite emails were not loading properly. 
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Improvements and Fixes -
September
Last Modified on 11.10.2024

Improvements 
Portal

We aligned user calculations on the Retention page to be consistent with the Adoption and Engagement
pages in HEART.

Editor

We added support for top-layer elements in Guides so that Guide steps can be recorded on these
elements.

Other

We improved how we handle errors during the authentication process, when Userlane receives the user's
ID instead of the email address from the Identity Provider.

Fixes
Portal

We fixed an issue where deleted segments were still being shown in the usage section for Attributes.

Editor

We fixed an issue where Tooltip icons bounced on scroll for Tooltips created in tables.

We fixed an issue where searching for and selecting a Segment to apply to a Tooltip or Tag caused the
Editor to close. 

We fixed an issue where the Editor closed when a customer was trying to edit the name of Tags.

We fixed an issue where the userlane-context cookie was being saved at both the subdomain and
domain level and caused Guide to re-trigger upon page reload.

Other

We fixed an issue that caused the Browser Extension to not fetch the latest SSO configuration from the
Portal if the integrity token contained certain special characters.
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Fixes and Improvements - August
Last Modified on 09.09.2024

Portal improvements 
UX/UI

We added Tooltips & Tags to the usage section of Segments in the Portal so you have a complete
overview of where your segments are being used.

We added an end date error to Messages when you configured your end date to be sooner than your
start date.

Technical & other improvements

For customers who do not wish to show any user-identifiable information in the Portal:

we removed the tables "time spent per page" on the Engagement dashboard and "pages your users
visited" on the Adoption dashboard.

we hide the user on the error log table in guide step analytics.

Technical improvements

We can now temporarily remove the Userlane snippet from the underlying application to aid in
debugging issues.

Fixes
Portal 

We fixed an issue where Surveys could be created with an end date set before the start date. 

We guard the Tooltips analytics page so it won’t be accessible when the Tooltips feature is disabled for a
customer.

The privacy & terms link in the login pages has been fixed.

We fixed an issue where company attribute titles could not be edited when the attribute was in use.

Editor

We fixed an issue in the new browser extension that prevented the RegEx from being generated correctly
via AI.

We fixed an issue where Tooltip titles could not be edited in the Editor.
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Fixes and Improvements - July
Last Modified on 02.08.2024

Portal improvements 
UX/UI

HEART: The cards for the individual HEART metrics now have a hover effect for a better user experience. 

We redesigned the page to set up the first URL

Scalability & Performance

The tables for segments and Messages now remembers the previously used filter when navigating to
another page in the Portal.

Task Success page: The dropdown list to select individual Tags to show interactions over time in the
respective graph is now sorted alphabetically.

HEART: We improved the prompts used to generate the AI insights for each of the HEART metrics.

Technical & other improvements

App Discovery now tracks more applications, and we improved the URL tracking for existing apps. 

App Discovery: We optimized the pipeline for data events used to track new applications.

HEART: We optimized the data pipeline that calculates the HEART scores on the multi-app dashboard.

App Discovery: We optimized the pipeline for data events used to track new applications.

The start and end date in Messages are now shown in the selected time zone instead of the local time
zone of the user.

Editor improvements
UX/UI

We now allow empty strings for the guide completion success step instead of the default “Well Done!”.

Technical & other improvements

We optimized our infrastructure capacity to handle an increased load.

Technical improvements

We updated the UI of the page that is shown to users when the Browser Extension authentication fails.

We added a search functionality in the Browser Extension that is displayed if Userlane is available on
more than 7 applications.
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We added various performance improvements to the new Userlane Browser Extension built using the
Manifest v3 guidelines.

Fixes
Portal 

HEART: We fixed the condition that determines whether the Happiness page should be blurred or not.

HEART: We fixed an issue on the Happiness page that showed different results when a user segment
was applied.

Content Analytics: We fixed an issue for Guides and Announcements tables that caused published
content to be hidden.

We fixed some translation issues on the User Detail page.

We fixed the header truncation on the Error Log page.

Editor

We fixed an issue where tooltips on selected elements outside of the initial window size were not being
scrolled down to.

Other

We fixed an issue where the Search functionality in the Userlane assistant was not working via the new
Browser Extension.

We fixed an issue where Userlane was not appearing on certain pages of an application.
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Fixes and Improvements - June
Last Modified on 01.07.2024

Portal improvements 
UX/UI

We removed duplicate headers to streamline the design on certain pages in the Userlane Portal.

We added the option to repeat Announcements automatically at weekly and bi-weekly intervals.

Scalability & Performance

We upgraded core services for our analytics to the latest versions to improve performance and resolve
vulnerabilities.

Technical & other improvements

We improved how the HEART scores are calculated for the all-apps page so that HEART scores will be
shown as long as there was activity for that application in the past 90 days.

We improved how the Engagement page in HEART measures the time users spend on a page by adding
additional checks.

Editor improvements
Technical & other improvements

We improved the way in which Userlane interacts with Cookiebot.

Technical improvements
We improved the way in which the new Userlane Browser extension handles the SSO authentication
process.

Fixes
Portal 

We fixed an issue where the User Import would not complete if an attribute in the upload file existed but
was in an archived state.

We fixed an issue where users with the role Contributor could see the User Segments filter for analytics
but not successfully filter with them.

Editor

We fixed an issue causing linked Guides to Tooltips to crash under specific circumstances.

Other

We've enhanced our data-deletion and anonymization process, ensuring even greater security and
compliance with GDPR standards. Your data protection is our top priority.
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We continuously squash security vulnerabilities as they are discovered, ensuring our platform remains
robust and secure.

We have enhanced the URL Exceptions list logic to cover more specific scenarios.
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Fixes and Improvements - May
Last Modified on 05.06.2024

Portal improvements 
UX/UI

We improved how Page Segments are shown in the dropdown when adding them to a Guide. Previously
they were unsorted and now they are shown in alphabetical order just like User Segments.

We improved the filters in the analytics to make it possible to search for User Segments to use as filters
and also make it clearer when no filter has been applied. 

Technical improvements

We implemented a stack upgrade to ensure optimal performance of the Userlane Portal.

Editor improvements
Performance & Stability

Users can now publish more Tags per page without impacting the performance of the underlying app.

We implemented a stack upgrade to ensure optimal performance of the Userlane Portal.

Fixes
Portal

We fixed an issue where expanding the results of a Survey displayed the incorrect Survey title.

We fixed an issue where the response rate metric for Surveys was not showing the correct calculation.

We fixed an issue where the email invitation option was not being triggered in the user invite modal.

We fixed an issue where the ‘draft’ status for Guides was not disappearing from the Portal after a Guide
had been successfully published.

We fixed an issue where the count of imported users who had not received an invitation email was not
updated after invitation emails had been successfully sent. 

We fixed an issue where the publish toggle on Guides when accessed via search did not change when
clicked. 

We fixed an issue where a URL was not being displayed in the URL table on the Engagement page of
HEART.

We fixed an issue where the date picker for Messages and User Segments was not saving the date
selected by the user.

Editor

We fixed an issue that prevented an image from being applied to all languages if “Apply to all
languages” was enabled.
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We fixed an issue causing Userlane Editor not to load on an underlying application.

Guides are now shown in the correct language if linked to a Tooltip.
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Fixes and Improvements - April
Last Modified on 07.05.2024

Portal improvements 
UX/UI

We improved the line charts in our analytics so that animations are bottom up instead of top down and
line segments connect in a more visually appealing way

We added a ‘Last Updated’ icon to the tooltip views over time chart to display when a Tooltip was last
updated

We updated old message and notifications boxes to align with new design components

We improved that Company Attributes page to ensure that long attributes can be fully read

We added a helpful note regarding SAML certificates to the User Single Sign-On page

Technical improvements

We added pagination to the User Segment preview so that all users belonging to that segment can be
found if thre are more than 30

We implemented new error messages for invalid integration URLs to correspond with new backend
checks

We added validation to the name and email fields of the Team Member invite modal

We resolved an issue so that Team Members can be re-added or edited in the team as expected

Editor improvements
UX/UI

Updated the Guide Completion check icon animation

Performance & Stability

Fixed various small issues with the new event schema

Technical improvements

Language settings in the editor now update button texts like "Let's Go" immediately, ensuring a seamless
experience when switching languages

Fixes
Portal 

We fixed an issue where the ‘Announcement interaction over time graph’ showed Views and Users on the
incorrect Y-axes

We fixed an issue where the search in the User or Page Segments dropdown on the Guide edit page was
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broken

Fixed an issue where some admins could see a blank App URLS page

Editor

Fixed language switching issue where Step UI language was not updated when switching languages in a
guide.

Other

Addressed and corrected access restrictions in our API, ensuring only Admin users can reach certain
sensitive functions, enhancing security measures
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Fixes and Improvements - March
Last Modified on 03.04.2024

Portal improvements 
UX/UI

We implemented a new date range picker in both the HEART and Content Analytics pages as well as the
Survey and NPS builder pages. The new date picker offers a cleaner and improved experience when
selecting date ranges in the Userlane Portal.

Technical improvements

We improved how the ‘Guides started over time’ graph on the Guide’s Performance page is calculated so
that archived Guides are not included and the graph total matches the ‘All Guides’ table.

Editor improvements
Performance & Stability

We now offer content creators the possibility to use CTRL to (un)pause the Recording mode. For more
information, please contact your Customer Success Manager.

Fixes
Portal 

We fixed an issue where the BypassSSO setting was not consistently shown as set for Admins as
expected.

We fixed an issue where the self-hosting download was not available for self-hosting customers.

Other

We fixed an issue that prevented the Guide from starting automatically when opened through a direct
link.

Fixed a problem ensuring moderators now reliably receive email notifications about any errors identified
in Guides.

Strengthened protection against Server-Side Request Forgery (SSRF) attacks in our HelpDesk integration,
implementing stricter controls to safeguard internal services.
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Fixes and Improvements - February
Last Modified on 18.03.2024

Portal improvements 
UX/UI

We improved and synchronized fonts and styles across NPS and Survey previews.

We removed the ‘New’ label from App Discovery.

We improved how long URLs are displayed in the URL tables for the Engagement and Adoption pages,
and allowed the full URL to be viewed on hover.

Technical improvements

We improved the analytics date picker so that previous date selections (e.g. the past 30 days) are now
properly reflected when switching to a custom date range.

We improved the URL processing algorithm for the Engagement and Adoption pages in HEART to
accommodate for complex URL patterns in MS Dynamics.

We improved the export handling for large amounts of data. Content exports with 20-40 languages, and
100-1K guides is now more reliable. These export capabilities ensure customers can access and leverage
content for backups, internal workflows, or any other purpose seamlessly.

Editor improvements
Customization & Design

We updated the design of the well-done check mark shown when a Guide is completed.

Performance & Stability

We now allow the use of the CTRL button instead of ALT to enter the pause mode when recording
content. For more information, please reach out to your Customer Success Manager.

Technical improvements

When a Tooltip is appended to the target element (appendToTarget is set to true), that Tooltip will also
be isolated in a Shadow Dom. This way, we limit the impact of the underlying app’s styling on the
Tooltip.

Fixes
Portal 

We fixed an issue causing the Alignment and Automation settings to be overwritten if the Guide was
updated in the Portal.

We fixed an issue where if you had no published Surveys, the loading state for the Surveys list on the
Happiness page would continue forever.

We fixed an issue where Chapter titles were not being updated immediately after editing. 

https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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We fixed an issue where applications shown on the multi-app dashboard had the wrong loading state.

We resolved an issue preventing moderators and contributors from accessing Personal details and Team
Management pages.

Editor

Line breaks are now correctly applied in the Guide exit confirmation view if texts are long.

We fixed a broken link located in the Tags section of the Editor.

We fixed an issue causing the Editor to close on specific pages.

We fixed an issue causing the Guide to close when interacting with a certain type of module.

We fixed an issue causing the Refine Selector section to close when a comma was manually added to the
selector value.
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Fixes and Improvements - January
Last Modified on 08.02.2024

Portal improvements 
UX/UI

We updated the multi-app dashboard so that applications that have been disabled in General Settings
are not shown there.

We updated the text to make the explanation for the Activate Userlane toggle clearer.

We removed the info box on the API Token Page explaining which applications have the API Token
enabled as this is now enabled for all by default. 

We increased the available space for Guide titles on the Manage page to make it easier to read and
recognize longer Guide titles.

Stability & Performance

We updated how we calculate Announcement views so that total views on the Announcements
Performance page matches that of the Content Analytics overview page.

Technical Improvements

We updated the logic for the ‘is one of’ and ‘is not one of’ data connection types when creating user
segments so that entered values are lowercased and the behavior is aligned with all other data
connection types. 

We improved the Guide behavior when consuming content located inside pop-ups and modals with
scrollbars.

We added additional logs to the Browser Extension Options page to help us debug issues more easily.

Editor improvements
Performance & Stability

We optimized the way in which Userlane handles elements located inside cross-origin iFrames. We have
added additional support for elements located within an iframe that is part of another iframe.

We improved Userlane’s performance in underlying applications that rely on long URLs.

Fixes
Portal 

We fixed an issue where unpublished Guides were available in the dropdown to link a Guide to an
Announcement

We fixed an issue where users were directed to Announcements instead of Standard Surveys from the
‘View Usage’ page for Languages.

We fixed an issue where Moderators could see the HEART scores of applications where they did not have
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access in the multi-app dashboard.

Editor

We fixed an issue where Userlane was breaking a functionality available in the underlying application.

We fixed an issue that was causing Guides to break on certain web pages.

Other

We enhanced security by updating our NodeJS framework and tightening our checks, along with
implementing automated solutions to ensure our platform stays up-to-date.

We enhanced the verification process for setting up enterprise search integrations (such as Confluence,
SharePoint, Zendesk, etc.), ensuring a more reliable connection by thoroughly analyzing the response
content beyond just confirming availability. This improvement ensures that our integrations not only
connect but also function as expected, offering a robust and dependable search experience.
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Fixes and Improvements -
December
Last Modified on 08.02.2024

Portal improvements 
UX/UI

We updated the Create an Announcement page. Now, it matches the Survey page.
You can now search for Segments you wish to add to an Announcement.
You can now edit the search hint text in the Customize section

Editor improvements
Performance & Stability

We have added the version number to the Editor.
When visualizing a step within a Guide, users can scroll through the whole element as long as it is visible
on the screen.

UX/UI

You can now edit the Guide title from the Editor.
We have updated the Guide title, Tooltip, and Tag name field designs.
We have updated the Tooltips-related icons from the Editor.

Technical improvements
We fixed an issue causing the SSO initial setup not to run for US-based customers.
We updated Node.js to the latest version for multiple services.
We added the Options section in the Browser Extension. It provides you and our team access to relevant
browser configuration information for debugging purposes.
The Browser Extension can now load Userlane if the accessed URL's domain and path parameters match
the URL set in the Application URLs list. For more information, please get in touch with your Customer
Success Manager.

Fixes
Portal 

We fixed an issue where NPS response rate calculation could lead to a score of over 100%.
We fixed an issue where images were not being shown in the Announcement builder for US clients.

Editor

We fixed an issue causing the Editor to crash if “appendToTarget” is added to the code selector when
refining the selected element.
We fixed an issue causing Userlane to block specific actions in popups.
We fixed a user segmentation-related issue causing linked Guides to Tooltips not to be shown to users.
We fixed an issue causing the “Skip if next element is found” condition not to work correctly under
specific circumstances.
Userlane displays the empty Tags section correctly if no Tag has been created.
We fixed an issue causing page segmentation to fail if the condition contained subdomain and path
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parameters.
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Fixes and Improvements -
November
Last Modified on 01.12.2023

Portal improvements 
UX/UI

We added an export option to the multi-app dashboard.
We made the date picker dropdown more user-friendly and intuitive.
We added a UI update to tooltips to indicate the status of them.
The API Token page is now available for all customers by default.

Performance

We increased the performance of the Manage Guides page.

Other

We upgraded the Portal authentication service to a newer version.

Editor improvements
Performance & Stability

Users can now easily complete guides that require scrolling through a large highlighted area connected
to a step.
We fixed an issue causing the Tags list view not to be displayed correctly if no Tags were created.
We improved how the Editor search works to provide more relevant results.
We improved the behavior of Page Segments that use different URL patterns (including subdomains and
path parameters).

UX/UI

We added new icons for Hints.
You can now filter Tags to display only those available on the current page.
We fixed several issues that improve the UX in the Editor list.

Technical improvements
We increased the security and reliability of our password policy.

Fixes
Portal 

We fixed an issue for Page Segments that displayed an error “page segment name already exists”.

We fixed an issue where the translation import was not working as expected.

Editor

We fixed an issue that caused a step to be skipped if it was between other steps that contained skip
conditions.
We fixed an issue blocking Userlane from grabbing the right element when recording inside a dropdown.
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We fixed a specific app issue causing simple and NPS surveys to remain open after the response was
submitted.
We fixed an issue causing the Hint icon or Beacon to be shown twice in the Editor mode when manually
adjusting the icon placement.
We fixed an error thrown when using the Editor search functionality.
We fixed a charset-related issue causing the Userlane snippet not to load in certain apps. 

Assistant

We fixed an issue where the SharePoint enterprise search integration was not displaying results.
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Fixes and Improvements - October
Last Modified on 06.11.2023

Portal improvements 
Customization & Design

We introduced a new design for our registration and magic link pages. The designs are now aligned with
our login page layouts. Our input fields are optimized to seamlessly integrate with all password
managers.

We merged the two separate pages for User segments and Page segments into one. A single table now
displays all your created segments and allows you to filter them by segment type.

Other

We added missing help documentation to several pages in the Portal.

Editor improvements
Stability

We implemented several general improvements to better support recording inside Cross-Origin iFrames.

We improved the stability of the auto-translate feature for long Guides.

Other

We updated several Editor buttons to follow our Design System.

Technical improvements

We implemented various improvements to remove the flickering when a Tag or Tooltip is deleted in the
Editor list view.
We unified the logic used for Page Segmentation and the URL Exceptions List.

Fixes
Portal 

We fixed a bug that returned the wrong usage number for user segments in the NPS builder.

We fixed several UI issues.

Editor

We fixed an issue causing the RegEx generation process to throw an error under specific circumstances.

We fixed an issue causing drop-downs in the Editor not to close after they were clicked.

We fixed a UI issue connected to the way in which the search icon was positioned in drop-downs.

We fixed an edge case where the Welcome Slide couldn’t be closed.

Other
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We fixed a bug where translations for Indonesian could not be uploaded via the language import.
We fixed a bug where special characters in application attributes like German umlauts were not being
lowercased in the backend.
We fixed an issue causing the Browser Extension not to load the available Userlane applications under
specific circumstances.
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Fixes and Improvements -
September
Last Modified on 02.10.2023

Portal improvements 
Customization & Design

Before, we only displayed the title of the message in the Messages table. Now, we show both the name
and title, making it easier to identify Messages.
We've introduced an app switch to simplify app management for our Managers on the multi-app
dashboard.
On your multi-app dashboard, you can now view and manage your global settings.
We updated some illustrations and wording in the Portal.

Scalability & Performance

Our new Analytics settings page is out! It's a page that combines all the Analytics privacy settings in one
place. Previously, you had to navigate through each property individually to enable HEART analytics.
We now show how many Tooltips are using a User Segment in the View usage column.
We’ve improved the success and error bar in the Portal.

Technical improvements

We have upgraded our Portal authentication service to a newer version.

Editor improvements
Stability

The Hint and Beacon icon position is calculated faster now (after each interaction with the underlying
application).
You can now publish a Tooltip in all languages with a few clicks either from the List view or from the Edit
mode.
When recording a new Guide or Tooltip, the recording is now always started in the default language set
in the Portal.
The Editor now goes to the last step you saw when exiting the Preview mode.
If steps with Skip conditions are delayed (for example for heavy web applications) and their
corresponding elements can be found on the page, the delay will no longer be applied.

Other

We changed the Editor buttons to follow the Design System.

The Editor now uses the word “archive” instead of “delete” for Guides.

Technical improvements

We have improved the stability of the Player/Editor tech stack with a major infrastructure upgrade.

Fixes
Portal 
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Historical HEART URL data now shows parameters better (meaningful content after the “?” character).
We fixed an issue where the UI was blinking while the user was typing a segment name.
We fixed some discrepancies between the preview of an Announcement and how it was shown in the
actual Player.

Editor

We fixed an issue causing a step to be skipped too quickly if the “Skip if the next element is found”
condition was enabled.
We provided additional stability improvements for the Cross-Origin-iframe support.
We fixed an issue causing the Editor to stop working without a valid session.
We updated the layout in the Assistant if Passive Mode is enabled.
We fixed a focus issue when editing the code selector of a Tooltip.

Other

We fixed an issue causing end users to be logged out from Userlane (Browser Extension - SSO) when
using Firefox.
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Fixes and Improvements - August
Last Modified on 04.03.2024

Portal improvements 
Customization & Design

Our loading states in the Portal have been improved and are more consistent now. You will notice all of
them have nicely rounded corners and a smoother transition to the loaded state.

When navigating the Portal, you will now automatically be scrolled to the top of the page, instead of
having to scroll up every time you go to a new page or subpage.

We have improved the UI in the “add users” flow.

We have updated the API token page and modal.

The navigation sidebar has new labels and icons, and will initially be expanded. Your choice to leave it
expanded or collapsed will be stored.

Scalability & Performance

When a Guide is published, the Delete button is disabled now.
Analytics graphs are now more performant and re-render only when the actual data is changed.
The design system tables used on analytics pages and most of the Portal are now much more performant.
You will no longer have to wait for a long time after setting the page size to 100 or more rows.

Technical improvements

We reduced the idle session timeout to 12 hours from the previous value of 30 days to increase the
security for Portal sessions.

Other

We have introduced a feature that, if enabled, redirects invited Edge users to the Chrome Web Store for
the Userlane Browser Extension installation.

Editor improvements
Stability

The recording mode now always starts in the default language set in the Userlane Portal.

When a Guide is published, the Delete button is disabled.

When a Tooltip is published, the Delete button is disabled.

We fixed an issue causing the Delete modal not to pop up when trying to delete a non-selected step.

The Editor now shows the Unpublish button if a Guide is published.

Fixes
Portal 
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The Announcement builder will now show the correct "Live since" date, while previously it would show
the date the announcement was published.

We fixed an issue where you couldn’t unpublish the NPS Survey from the messages table.

Editor

We fixed an issue causing the "In progress" message to still be shown even after the auto-translation
process was completed.

We fixed an issue causing auto-translation to skip certain languages during the translation process.

We fixed a specific scenario causing the Editor to disappear once the recording was started.

We provided additional fixes to better support element recording inside Cross-Origin iFrames.

We fixed an issue causing the cross button to not be aligned with the assistant if the latter was located
on the top of the screen.

We fixed an issue causing the links not to be visible if the assistant was on the top of the screen.

We fixed an issue causing the Editor to close when changing the language.

We fixed an issue causing the subselector not to work for elements located outside ShadowDOMs and
iFrames.

We fixed an issue causing classes not to work with the subselector and content selector when manually
refining the selector.

We fixed an issue causing a Hint to close after moving the cursor away from the selected element.
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Release note - Surveys
Last Modified on 04.03.2024

What is new

Understanding user sentiment is the key step to improve your digital adoption efforts. Previously, we used NPS
surveys to measure the user loyalty. However, NPS surveys are limited to one consistent question that checks
how likely users are to recommend your application. 

To enhance your ability to collect the user opinions about your app and its features, we've added a more flexible
Survey type. This enables you to ask any question and publish multiple Surveys across various pages and user
segments within your application. 

With the new smiley-based scale, Survey participants can easily provide feedback by selecting from a range of 5
smileys representing different sentiments. You will be able to see your overall Happiness score on your HEART
dashboard. This score will include results from both NPS and survey responses. Each survey will have its own
analytics page, where you can track its responses and view and export the comments users have left.

How to find it

To create a new survey: go to the Messages in the Portal > 'Add a message' > Standard survey 

To see the responses: go to the HEART > Happiness > Choose a Survey in the "All Surveys" table

Your browser does not support HTML5 video.
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CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Process automation
via Guides
Last Modified on 04.03.2024

Release Demo

What’s new

Some processes require a lot of steps by the user that have no deeper purpose other than navigating to the
correct place in the application or entering the same information repeatedly. To reduce the effort for your users,
Userlane can now perform repetitive actions. 

Managers can now automate individual and sequences of steps in Guides, making the process learning
experience more efficient.

Step automation is supported in the following step types:

Left click
Left mouse button down
Specific value

How to do this

Start Editor > Access a step supporting automation -> Click on the automation icon next to the step type, and
choose the preferred automation method.

ℹ️ Please delete the browser cache if you do not see the new functionality in the Editor.

Your browser does not support HTML5 video.
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Release Note - Improved HEART
scores
Last Modified on 04.03.2024

What is new

Instead of visually presenting the scores with circles, we've transitioned to using a speedometer to represent
your main scores for HEART letters. Currently, we are using a 5-point scale for every letter's assessment.
Previously we've used a 4-point scale.

New scores for each letter have the following ranges: Very low (0-20), Low (21-40), Fair (41-60), High (61-
80), and Excellent (81-100).

How to find it

Go to your HEART page: /analytics/heart/overview

ℹ️ Please keep in mind that we use a 4-point scale for NPS results to ensure consistency with industry
standards for NPS. We grade NPS in the 4 point scale: Poor (-100-0), Good (0-30), Great (31-70) and
Perfect (71-100).

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Export Guides as
PDFs
Last Modified on 18.03.2025

Release Demo

What is new

Not every user, content reviewer, or translator has access to your application or Userlane. To solve this
problem, Managers can now easily share existing Guides in their original app context by exporting them as
PDF files.

The Guide export feature comes with the following:

Multi-language support (support for screenshots per Guide language)
Guide-level screenshot capabilities
Step-level screenshot capabilities
Screenshot-related notifications in the Editor

If you would like to learn more about this functionality, check the following support article.

How to do this

Start Editor > Access a Guide or a Step -> Open the corresponding Options menu, then click the Take
Screenshots button.

To export a Guide as a PDF > Access Portal > Guides > Access the Guide that contains screenshots> Click on
the Options menu > Export Guide as a PDF file.

ℹ️ If you would like to get access to this feature, please contact your Customer Success Manager for more
information.

Your browser does not support HTML5 video.

https://docs.userlane.com/docs/export-a-guide-as-a-pdf
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Fixes and Improvements - July
Last Modified on 06.02.2024

Portal improvements 
Customization & Design

Smaller UI improvements, e.g. paddings have been adjusted in the HEART Analytics pages.
Smaller UI updates of buttons in the Portal.

Scalability

The date picker in the Portal now uses "Current month", "Previous month" and "Last 3 months", and it
automatically calculates the "Last 30 days", "Last 60 days" and "Last 90 days".

The date picker now contains new options for "Yesterday" and  the "Last 7 days".

Editor improvements
Stability

We improved the support of the Editor on smaller screens.
We updated the Tags overview page to include the case when there are no Tags.
We added additional improvements for the "appendtoTarget" setting to support more complex scenarios.

Other

We removed the dark background and element highlight when Managers pause the recording.
The help docs icon is now linked to individual content pages.
We removed the pop-over from Tooltips and Tags that have a title that is not truncated.
Empty states were improved in the Player for empty chapters and announcements. 

Fixes
Portal 

Password managers now work with our Portal login form. 
We fixed some wordings in Announcements.

Editor

The content attached to elements located in Cross-Origin iFrames can now be visualized and interacted
with by end users.
You can now reselect the position for Hints with an icon that have auto-position enabled.
The lists of page and user segments are now correctly shown when the Manager navigates to another
page or changes the language.
Long words and links get correctly wrapped in tooltip text boxes.
You can preview from a skip step if the element is found on the page.
When refining the selector or positioning the step, you can no longer interact with step settings and the
underlying application.
Hints with icons close when hovering away in a Guide.
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We fixed the cursor behavior when hovering over the alerts column header.
Drop-downs located inside the Editor all use the same UI now.
The keyboard shortcut labels for Any Value Steps are now correctly displayed in the step box.
The options menu now closes when interacting with one of its elements.
The pop-overs for Contributors have been updated in the step options section.
Contributors can now edit the title of a Tooltip.
The options menu in the Guide List view no longer overlaps with the Delete Guide pop-up.
The “+” Add Media button was removed from the alignment mode.
We fixed an issue causing the Editor buttons to inherit the custom design color.
We fixed an issue where the content selector was not saved in the code selector.
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Release Note - Auto-translation for
Guides
Last Modified on 04.03.2024

Release Demo

What’s new

Managers now have the option to auto-translate Guide content from a selected source language into any
number of target languages with the click of one button.

The auto-translation feature is available in the Guide menu of the Editor, and may require a review of the
Userlane language keys, which have to be based on the ISO language codes in order for the translation to
work.

How to do this

Start Editor > Access a Guide or a Step -> Open the corresponding three-dots menu, and then click on the
Auto-Translate button.

ℹ️ Please delete the browser cache if you do not see the new functionality in the Editor.

Your browser does not support HTML5 video.
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Release Note - URL parameters in
HEART
Last Modified on 06.02.2024

What is new

We are excited to announce the latest improvement to our analytics. The HEART analytics displayed
application URLs by removing everything after the "?" character, commonly known as parameters. This made it
easier to see the URLs in a clean way.

However, in certain applications, the parameter section of the URL contains essential information about your
application. We have implemented a solution to display the parameter part in these specific cases while
keeping the URLs clean where they are not needed. This should improve your URL display so that you can
know which parts of your application are being used.

Please be aware that not all scenarios may be covered. We encourage you to provide us with feedback and
inform us of any aspects we might have overlooked.

How to find it

To find this URL table, just visit Adoption or Engagement section of your HEART.

HEART analytics > Adoption > Table "Pages your users visited"
HEART analytics > Engagement > Table "Time spent per page"

ℹ ️This change is released and will take effect on the URLs from this moment onward. We plan to improve
the historic data as well, which will happen in the second half of the August. 
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Release Note - Element selector:
Improved UX and functionality
Last Modified on 23.01.2024

Release Demo

What’s new

We have revamped the code selector section. The update brings new functionalities that help Managers refine
the selector:

Element uniqueness informs Managers if multiple similar elements are on the respective web page

You can refine the selector by navigating the HTML element tree

Use additional selector options to define the selected area's size or the selected element's sibling

You can now easily preview the impact of the code selector changes as you apply them

How to do this

Start Editor > Access a Step, a Tooltip or a Tag > Click on Refine selector > Start refining the selected element.

Please delete the browser cache if you do not see the new functionality in the Editor.

Your browser does not support HTML5 video.
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Release Note - Logos on the
Applications dashboard
Last Modified on 19.01.2024

What is new

Logos on the "Your application" dashboard were taking the Avatar image. In many cases, this was the same
image so every application looked the same at first glance. 

We now catch the favicon of the default URL to present it as a logo. If the favicon is not available we create a
logo out of first two letters in the Application's name.

This is useful in case you have many applications on that page and it gives you a quick visual indicator of what
application you are looking at.

How to find it

In your Portal, click on the Userlane logo. 
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Release Note - NPS AI insights
Last Modified on 12.01.2024

What is new

Your NPS analytics now has AI insights. Our intention was to offer you a short and quick overview of the user
sentiment. This enables you to quickly understand and identify areas that require attention, without the
necessity of reading through every comment.

How to find it

Heart > Happiness (NPS) page

ℹ️ The insight might slightly differ when you refresh the page.

CHECK OUR
ROADMAP

Your browser does not support HTML5 video.

https://roadmap.userlane.com/
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Fixes and Improvements - June
Last Modified on 12.01.2024

Portal improvements 
Customization & Design

We updated the UI of the Guide section (previously Manage section). Visual changes include a new hover
state that aligns better with the overall appearance. The "Promote" action can now be found in the
“more” dropdown. Buttons have been replaced with our design system component.

We improved the Engagement graphs on our HEART page with a few minor wording updates.

Scalability

The "Messages" section got an update. Apart from viewing announcements in the table, you can now
access your NPS (Net Promoter Score) and, in the future, your surveys as well. Release note.

Other

You can now export the user list from the "Users" settings page to CSV, which helps you to keep track of
pending users and determine who needs to be invited again. The user table is now paginated.
Additionally, you can also export the "Team" section to CSV to monitor which apps your colleagues can
access. Release note

Editor improvements
Stability

Tooltips are now displayed correctly when attached to elements positioned in fixed containers.

You can now use appendToTarget inside the code selector to group a content type (Tooltip) with the
target element. For more information, check how you can further refine element selection with the code
selector.

Other

Several UI improvements that bring the Editor in line with our design system.

Technical improvements
End User API

We added a query parameter for lastSeenAfter to allow customers to pre-filter the API query by users
active after a certain date. This generates a faster and more targeted data export.

Other

We have improved the performance of the Assistant.

https://docs.userlane.com/docs/messages-page
https://docs.userlane.com/docs/release-note-settings-user-team-export
https://docs.userlane.com/docs/refine-element-selection-with-the-code-selector
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Fixes
Portal 

Fixed wrong URLs in the Alert email and in the Error log.

Fixed the Disabled button when adding an integration.

Fixed duplicate URLs in the Adoption table, as well as the sorting issue on the same table.

Editor

We fixed an issue that was causing the Editor to crash under specific circumstances.

We fixed an issue that was causing the Editor to crash when no action key was selected for any specific
value step type.

We fixed a redirect issue connected to the Analyze button.
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Release Note - User and team
(settings) export
Last Modified on 12.01.2024

What is new

You can now export the list from two "Settings" pages: Team and User.

You can use Team export to track what apps your colleagues have access to. On the other hand, use User
export to track easier which uploaded user is still pending or who should be invited again or removed from
your user list. We have also added the pagination to the User's table and you can load (and export) 200 rows
per page. 

How to find it

Settings > Team

Settings > Users 

ℹ️ Keep in mind that you can only export what you see on the page. Extend the "items per page" to 200
rows for smaller amount of pages. Moreover, in your Google sheet  or Excel, you can use the "Import"
option followed by "Append to this sheet" when importing results from multiple pages to one sheet. 

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - New messages
page
Last Modified on 12.01.2024

Release Demo

What is new

We have made some changes to the messages intro section. When you click on messages, instead of only
seeing announcements in the table, you will also see a table with all your messages, including announcements,
NPS (Net Promoter Score) messages, and in future your Surveys. 

If possible, the table will display the headline of the announcement or the actual question for NPS or future
surveys.

When click on "create a message," you can choose the type of message you want to publish.

How to find it

ℹ️ Please note that the survey feature is still in development.

CHECK OUR
ROADMAP

Your browser does not support HTML5 video.

https://roadmap.userlane.com/
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Release Note - Manage Guides in
the Editor more easily
Last Modified on 12.01.2024

Release Demo

What is new

Identifying which element corresponds to each step when creating or maintaining Guides can become tricky,
especially when they are longer. With the new redesign of step card panels, Managers will get access to
additional visual context for each step directly in the Editor panel, helping them manage Guides with greater
ease and efficiency.

The new step card panel contains:

The step preview for better visual context

The “Preview from this Step” button and a “More” menu to easily access important step functions

Icons that indicate if an element is not available on the page or has an error

And other UI-related improvements, such as colors.

How to find it

The new changes are available in the Editor -> Guides.

CHECK OUR
ROADMAP

Your browser does not support HTML5 video.

https://roadmap.userlane.com/
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Release Note - Beacons Clicked
Metric
Last Modified on 18.12.2023

What is new

In order to make it easier for managers to track the performance of different content types, we have added
interaction metrics for Beacons to the Content Analytics overview page in the Portal. This small improvement
allows you to differentiate between your different Tooltip types:

 - Hints opened - user was hovering over an element with a hint

 - Beacons clicked - clicking on a pulsating beacon to open it

How to find it

Analytics > Content analytics overview > All content types table

ℹ️ Currently, this includes only aggregated metrics. Stay tuned for a separate subpage in future with more
detailed information on individual Tooltips interaction.

CHECK OUR
ROADMAP

Your browser does not support HTML5 video.

https://roadmap.userlane.com/
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Fixes and Improvements - May
Last Modified on 08.12.2023

Portal improvements 
Customization & Design

The Beacons color can now be set in the Portal.

General step-related improvements in the Design section to better reflect the latest stepbox interaction
improvements.

We implemented a new datepicker in the Announcement and NPS builder. 

Login pages got redesigned.

All radio buttons in the Portal are now using our standardized design system component.

Scalability

We now show the complete view number in the Announcement analytics table, previously it was cut off
due to a set limit.

The NPS responses table now has the “items per page” option, so you can select 100 responses per page
for easier export. 

Deleted Tags and Tooltips can now be shown in the Analytics section.

Other

We removed the “Delete” button from segments that are used in active Tooltips to avoid content creators
from accidentally deleting a segment that is still in use.

Deleted tags now have a “deleted” label in the Task success page.

We have removed the “Interactive Tour” input field.

Small wording changes. 

Editor improvements
Stability

Beacons disappear only after the end-user interacts with them. Managers will continue to see them in the
Editor mode.

Scalability

We have refined the permission system for the Tags creation process.

Other

In the list view, you can now visualize the Chapter a Guide belongs to by hovering over the Guide.

https://docs.userlane.com/docs/release-note-step-box-interaction-improvements
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Guides in the Editor are now linked to their corresponding analytics page in the Portal.

The Preview button for Guides is now available at the bottom of the Editor.

A new sidebar design has been released.

Technical improvements
User Authentication

We improved our passwordless authentication via Browser Policy by allowing the use of various
parameters for either openURL or a token authentication.

Fixes
Portal 

Fixed the NPS response export; the user response was down in multiple rows.

Fixed the bug where the "Open application" button did not open the URL setup page in case the
application has no URLs added.

Fixed the bug in the “Adoption” table where the percentage of users on the page was wrongly calculated.

Guide ID was missing from the Manage section, so we brought it back.

Fixed the bug in the Retention page. Some applications had 0 for daily and multiple times a day.

Editor

Fixed an issue where the Userlane Avatar was positioned outside the viewport when added on the right
side of the screen.

Steps are no longer recorded twice within Same Origin iFrames.

Links are no longer getting cut in the Announcement popup (when the Announcement is pushed for the
first time).

The property icon now fits the Editor bar.

Footer buttons in the code selector view are now aligned to the right.

You can now scroll again in the RegEx view (specific input value type). 

Fixed an issue that prevented Tags and Tooltips from being saved on certain pages

Current tutorial element is refreshed every 500ms to avoid “step not found” issues for iframes/dynamic
content.

Other

We fixed the broken links and images from the Error alert email.
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We updated some texts used in the Browser Extension.

Fixed an issue where Properties were still seen by Manager Users after being removed from their
Company.
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Fixes and Improvements - April
Last Modified on 08.12.2023

Portal improvements 
Performance

We removed the "show 200 rows” per page option from the tables so that it doesn't affect the
performance.

We added pagination to the Announcement and Guides analytics tables so that it doesn't break while
loading many items. 

Scalability

We added the Announcement ID to the CSV download.

We improved the Welcome Slide buttons.

Editor improvements
Stability

We added a maximum width for Tooltips.

Scalability

We improved Tooltips analytics to only track those that are available in the main viewport of the user.

Other

We reviewed and improved the Editor user interface of the Regular Expression tab in the Specific Value
Step type.

Technical improvements
Performance

We implemented a few under-the-hood improvements that allow Userlane to load much faster in the
web browser.

Userlane now requires fewer resources (MBs of data) to run.

We added additional property configuration information to the troubleshooting page of the Browser
Extension.

Fixes
Portal



489

Fixed a loading issue on the Retention page.

Fixed some cache issues, so that no cache refresh is needed after smaller text updates. 

Fixed an NPS response export issue.    

Fixed an NPS builder timezone issue so that the builder doesn’t break for customers in a different
timezone.

Fixed an issue with the Platform analytics not loading when a user segment was selected.

Fixed an issue where the wrong publish date was shown for Announcements.

Fixed an issue in the color display of hints (Tooltips and Beacons).

Fixed an issue where deleting a language did not work.

Editor

The list of available page segments is now correctly shown in Tags on smaller screen resolution.

The Editor no longer crashes when editing the Code Selector.

Other

The NPS is no longer animated while the user is typing in the text box.

Fixed an issue in the registration of new Manager users.

Fixed an SSO SAML authentication issue.
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Fixes and Improvements - March
Last Modified on 08.12.2023

Portal improvements
Performance

The “All Guides” table export includes a list of Guide names and their corresponding Guide IDs.

Stability

UI improvements of loading and empty states as well as numbers format and illustrations.

Scalability

The Portal now uses uniform UI hero boxes and buttons.
Our analytics wording has been simplified. All calculations remained the same.
Our csv export has totals added to it.

Editor improvements
Performance

We have updated the design of toggles and dropdowns in the Editor.
The speed of Autofill (step type: Specific value input) will adjust based on the length of the text.
We have provided under-the-hood improvements to the Editor to help us develop features connected to
Tooltips faster and more efficiently.

Stability

A new Guide step design was released to enable end users to interact with the underlying application
more quickly and easily
The Editor has received the following design updates: dark color update and new slide toggle sizes.
We added a "View Analytics" button in Tags List view to access the Portal and the Task Success page
easily.

Scalability

Tooltips with icons can now be used inside iFrames.
Tooltip content can now be targeted in context to the underlying page with the help of Page
Segmentation
Userlane will display an error alert for each active Tag if Advanced Analytics is not enabled.

Technical improvements
Stability

You can now record elements located inside an iFrame located inside a shadow root.
We have updated our Code Selector Engine to handle better elements located inside Shadow DOMs.
Improved debugging process for Browser Extension issues connected to iFrames.
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Fixes
Portal

Language codes are now displayed correctly in the activation choice.
The "Users" metric now matches on both the Retention and Engagement pages.  
You can see the NPS analytics even if you do not have HEART turned on.

Editor 

Prevent a created tooltip from overriding another tooltip name.
Display Tooltip when in Preview mode.
Userlane will show an error if you try to create a Tag with a duplicate name.

Other

Screenshots of the reselected elements are now shown in the exported PDF.
Screenshots of the elements located on different pages from where the Guide was started, are now
shown correctly in the exported PDF.
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Release Note - New Portal
navigation
Last Modified on 08.12.2023

What is new

We are thrilled to announce a significant improvements to the navigation experience within our Portal. Let's
dive into the exciting changes:

- Sidebar: Instead of the horizontal navigation all options are now in the new sidebar that enables you to
seamlessly navigate trough the Portal

-  Settings location change: In our new navigation all settings options, e.g. Application URLs, Team, Personal
Profile can be found when clicking on the settings icon. 

- Sign out button: It is now located under the settings icon.

- Switching between apps: Easily change applications you are operation in from the sidebar.

- Search: You can search through the side bar options.

- Your multi-application dashboard: Click on the Userlane logo to go to your dashboard

- Subpages: For example "Guide analytics" have been replaced with tabs so that they are easily discoverable.

- Contact us: Option to contact us is in a new contact form in our Assistant. 

- Userlane roadmap: Now our roadmap is located in the footer. 

How to find it

Log in to your Portal and you will see a sidebar on every page.

Your browser does not support HTML5 video.
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ℹ️ While some changes may not currently be visible in the Portal, they should be implemented within the
next two weeks. 

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Announcement API
Last Modified on 02.10.2023

Release Demo

What is new

We are excited to announce the expansion of our API export functionality to include announcement data. With
this update, you can now collect more comprehensive data on users' views and interaction with your
announcements. 

There are two event types provided in the Annoucement API: 

AnnoucementViewed: this event type is triggered when an Announcement is displayed to a user
AnnouncementInteracted: this event type is triggered when a user clicks on a button or link within the
Announcement

In addition, each event will include metadata to help you understand viewer behaviour:

Timestamp: the time the event occurred
User: the ID of the user who viewed or interacted with the announcement
Announcement ID: the unique identifier for the announcement

The expanded REST API functionality is available now, and we are excited to see the insights our users will
gain from this new data.

How to find it

Find more information here: Getting Started with Enduser Events (userlane.com)

ℹ️ Announcement events are created as a separate API call. It provides you with events and a User ID, if
you want additional information about the User ID, please use our EndUser API

CHECK OUR
ROADMAP

Your browser does not support HTML5 video.

https://dev.userlane.com/reference/enduser-events
https://roadmap.userlane.com/
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Release Note - User Segmentation
for Tooltips
Last Modified on 08.12.2023

Release demo

What is new

Now you can apply user segmentation to display Tooltips (Hints & Beacons) only to specific target groups.

For more information on user segmentation, please check the following help article.

How to find it

In Editor: Create > New Tooltip or click first on Tooltips icon > Create and select Segmentation

CHECK OUR
ROADMAP

Your browser does not support HTML5 video.

https://docs.userlane.com/docs/user-behavior-segmentation
https://roadmap.userlane.com/
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Release Note - Showing URL
fragments in HEART analytics
Last Modified on 08.12.2023

What is new

Your application’s web addresses were shown in the HEART analytics without the part that comes after the #
symbol (also called fragments). HEART analytics now include the fragments too, so you can track which parts
of the application are visited. For example, the URL with test.com/#123 will now be fully shown. 

How to find it

Adoption and Engagement pages in the HEART analytics. 

/analytics/heart/adoption

/analytics/heart/engagement

ℹ️  Remember that this change is only for the fragments, we still don’t display the URL parameters (the part
that follows “?”).

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Improved user
interaction experience with NPS
Last Modified on 04.03.2024

What is new

NPS can now be closed only if the user actively engages with them by clicking the Close button.

No action is required from your side, everything is handled by Userlane.

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Tooltips: Hints &
Beacons
Last Modified on 08.12.2023

What is new

We are expanding the use cases for which Tooltips can be used. Managers can now choose the tooltip type:
hint or beacon.

Hints are used to explain an element to help users complete a process. Beacons are used to highlight an
element by drawing the user's attention with the help of a pulsating icon.

How to find it

In the Editor: Create > Tooltip > Select element > Choose Tooltip type

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release note - Assist users when
completing tasks by validating
inputs
Last Modified on 08.12.2023

What is new

The process of validating data has been done so far with the help of pre-defined texts - the user cannot
continue the Guide if the text is not matched.

We have now expanded our data validation capabilities. If a specific value step type is chosen, regular
expressions (regex) can be used to check if what was typed in a field matches the pre-defined pattern.

For example, you can use regex to ask users to submit expenses only with two decimals, using dot (.) as a
decimal separator.

ℹ️ The Generate button is connected to the OpenAI API service provided by Microsoft. To learn more about
the integration, please visit the following help article.

How to find it

In Editor: Record a field > Select specific value step type > click on the Settings button

CHECK OUR
ROADMAP

https://docs.userlane.com/docs/add-step-input-validation
https://roadmap.userlane.com/
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Release Note - Step box interaction
improvements
Last Modified on 08.12.2023

What is new

The new and improved Guide step design enables end users to interact with the underlying application quickly
and easily.

You don’t have to do anything - Userlane will automatically adjust the step boxes following the updated
design pattern.

How to find it

In Editor: Access a Guide > Step > Click Step Type

In Portal: Access Customize > Texts > Access each step type

ℹ️ In case you do not have access to this functionality, please delete your browser cache. 

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Tags over time
Last Modified on 08.12.2023

23 March 2023

What is new

The Task success page now includes a time graph that shows how your tags are being used over time. This
graph will help you identify when the drop or increase appeared and if it was because of certain actions you
took. For example, if you introduced a Tooltip, the usage increased. Previously, the Task success page only
showed how many users interacted with your tagged elements.  

How to find it

In your Portal go to Analyze > HEART > Task success

ℹ️ The time graph shows all tags over time by default. However, you can choose an individual tag from the
dropdown menu above the graph.

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Page Segmentation
for Tooltips
Last Modified on 08.12.2023

21 March 2023

What is new

Now you can apply page segmentation to Tooltips to provide context-based help for your users.

For more information on how page segmentation works, please check the following wiki section.

Where to find it

In Editor: Create > New Tooltip or click first on Tooltips icon > Create and select Segmentation

CHECK OUR
ROADMAP

https://docs.userlane.com/docs/page-segmentation
https://roadmap.userlane.com/
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Release Note - Contact Form in the
Assistant
Last Modified on 08.12.2023

14 March 2023

What is new

We have improved the experience of reaching out to our Support Team. 

With the new Contact Form you can reach out to the team quicker and also upload files.

How to find it

In Portal: Click on Help > Contact Us or within the Assistant when clicking on Contact Support

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Analytics export to
CSV
Last Modified on 08.12.2023

27 February 2023

What is new

We have added an option to export your analytics data directly from the Portal. The export is currently
available in CSV.

You can export the graph's data that you see loaded on the page. The downloaded file will have the same date
range and segment that you've previously selected in the Portal.

How to find it

In Portal: Analyze > Choose a page and a graph you want to export > Select date and segment > Export icon

ℹ️  In order to export more rows from the tables, you can now extend the table from 20 to up to 200 rows. 

CHECK OUR
ROADMAP

https://roadmap.userlane.com/


505

Release Note - Tags
Last Modified on 08.12.2023

14 February 2023

What is new

Tags allow you to track users’ interactions with specific elements or features of the underlying application. 

The results can be visualized on the Task Success page, which helps you understand whether users are
completing predefined processes.

How to find it

In Editor: Create > New Tag or click first on Tags icon > Create

ℹ️ To learn more about Task Success and HEART analytics, please check the related articles below.

CHECK OUR
ROADMAP

https://docs.userlane.com/docs/task-success
https://roadmap.userlane.com/
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Release Note - Task Success
Last Modified on 08.12.2023

14 February 2023

What’s new

Now you can easily find out if users are interacting with important parts of your application! 

This metric will help you understand if users are interacting with tasks and interesting elements to be aware if
users complete tasks or interact with important features easily and efficiently.

This will enable you to tag in your Editor elements you want to track. After tagging we start measuring the
usage of the specific elements/features in your underlying app.

When to use this?

For example, you can tag elements like “submit” button, “save”, “finish” or anything that indicates an important
interaction. With this you will understand:

What percentage of your user base is doing tasks/interacting with these important elements?
Are important parts of your app being used? 
How many users interact with your killer feature?

After learning that a part of your application is not used enough, you can promote it with Userlane content
options and track if this is changing the usage metrics. This helps in making data-driven decisions, especially if
you do not have the possibility to add your own analytics solution to an application.

How to find this?

In Portal: Userlane Portal > Heart analytics > Task success
In Editor: Create > New Tag

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Multi-application
analytics
Last Modified on 08.12.2023

14 February 2023

What’s new

We’ve released a dashboard that shows you all your HEART scores and main metrics. 

It is a general overview of all the applications/tools that have Userlane’s HEART enabled across the business
and for each the main metrics can be accessed. 

When to use this

It tells you how well different tools are adopted across the business, and where can you focus your attention,
budget and energy with leading indicators.

ℹ️ Good to know

You can sort the cards by name, HEART scores and number of users. The view is available in card or list
(table) view.

How to find this

Go to Userlane Portal > Upper navigation button called the “Applications”
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CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Tooltip boxes
automatically adjust their size
Last Modified on 08.12.2023

10 January 2023

What’s new

A Tooltip is used to provide additional information to the end user. That is why we improved how the Tooltips
are displayed based on the amount of text.

Userlane will automatically adjust the dimensions of each Tooltip's box to its content and no action is required
from you. 

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Analytics Data for
more than one year
Last Modified on 08.12.2023

04 January 2023

What's new?

We have expanded the time frame for the Analytics data. Now, you have the possibility to see data back since
you were with us.

Earlier this year, you could only see the last 6 months of data in analytics. Last quarter we expanded it to 12
months. We have listened to your feedback and we want you to have enough information to evaluate
Userlane's performance, so we have expanded the time frame to all time. 

We are adding the “All time” option to see all the time data. This will be helpful to reflect on the longer time
period on how Userlane adds value as well as to see your content’s performance for a period longer than a
year.

How to find this?

Go to your Userlane Portal > Analyze > Click on the calendar dropdown > All time.

What has changed?  

In the analytics date picker, now you have the “all-time” option

If you select this date range and have more than 1 year of data the graphs in the analytics will show
years 

Predefined time periods: current, previous month, last 3, 6, and 12 months, and all time 

In the “custom” option you use the date picker to define a custom period in which you can go up to all
time. 



511

CHECK OUR
ROADMAP

https://roadmap.userlane.com/
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Release Note - Copy Guides
between multiple applications
Last Modified on 12.01.2024

05 December 2022

What’s new

There is good news for customers who manage multiple similar applications.
We are very excited to announce that Guides can now be copied from one application to another that you have
access to.

When to use 

In case you are using a staging environment before any new version release, you can copy the Guides
over to the live environment. This allows fast activation and avoids mistakes in production.

If you use separate Userlane applications for different language application versions (e.g. salesforce Asia
versus Salesforce US), now you can create the Guides and copy them over. 

If you manage multiple accounts for a dedicated application you are able to copy some Guides over to
another application to speed up the Guide creation process.

Where to find it

You can access this new functionality from Portal > Manage > Guides > Single action menu.

ℹ️ This is not applicable to self-hosting customers. 
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Release Note - Manage Single
sign-on (SSO) and Browser
Extension configuration from the
Portal
Last Modified on 12.01.2024

30 November 2022

What's New

There is good news for customers that are using Single sign-on (SSO) and the Browser Extension. It now is
possible to manage the configuration for both of these functionalities from within the Portal, without having to
wait for Userlane’s Customer Support for assistance.

ℹ️ Single sign-on (SSO) allows your users to authenticate using their company credentials. They do not
need to remember multiple credentials. 

When to Use

In case you are just setting up Single sign-on (SSO) for your End Users or need to update the configuration, you
can now change these settings in the Portal. This allows you to take control of these settings proactively and
swiftly.

If you are deploying Userlane with the Browser Extension you can also configure its settings in the Portal.

Where to find it

ℹ️ SSO and Browser Extension are features that need to be enabled by your customer success manager
during setup. Only those will see those configuration options.

You can access this new functionality in the Portal > Account > Global Settings
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ℹ️ SSO is available only for browser extension implementation with Userlane. 
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Release Note - Guide step boxes
automatically adjust their size
Last Modified on 06.02.2024

17 November 2022

What’s new

We have improved the way in which Guide steps are shown to the user. 

Userlane will automatically adjust the dimensions of each box to its content, as not every step within a Guide
requires a lot of text.

ℹ️ No action is required from your side.
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Release Note - Engagement Page
Last Modified on 04.03.2024

18 November 2022

What's New

Within Userlane Analytics you will be able to see new useful metrics on the Engagement page and you can
check if the users actively engage and interact with your application. 

Where to find it

Sign into Portal > Analyze > Heart Analytics > Engagement

In more detail, engagement metrics show the user’s involvement with the application by tracking how many
engaged sessions they had. This metric will also present how much time on average users spent and how
much time they spend on each part of an application.
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Release Note - Adoption Page
Last Modified on 04.03.2024

07 November 2022

What's new

Within Userlane Analytics you will be able to see new useful metrics in the Adoption page, now you would be
able to check how many (expected) users are visiting your application and how widely they use. 

How to find it

Sign into Portal > Analyze > Heart Analytics > Adoption

In more details, the user number is the key metric you need to measure. With this metric, you can see how many
users arrived and you can track this number compared to the ratio of the expected number of users. You will also
see the percentage of new users and you will be able to understand if your users are declining or if they are
remaining stable or growing. Thus, with this metric, you would be able to understand your application’s coverage
and how widely users use it. 
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ℹ️ For getting access to the Adoption page under your Analyze tab, please contact your customer success
manager.
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Release note - Analytics Data up to
one year
Last Modified on 12.01.2024

22 June 2022

What's new?

We have listened to your feedback that six months of data were not enough to evaluate Userlane's
performance. 

Based on this, we have expanded the time frame for the Analytics data. Now, you have the possibility to see
data back to one year in your Userlane Analytics.

How to find this?

Go to your Userlane Portal > Analyze > Click on the calendar dropdown > Last 12 months.



522

Release Note - Retention Page
Last Modified on 04.03.2024

07 November 2022

What is new

Now you can check if the users continue utilizing the application and if they keep coming back. 

Retention metric tracks how likely your users are to return to your application with metrics like stickiness,
retention rate, or percentage of high-frequency users. 

How to find it

Sign into Portal > Analyze > Heart Analytics > Retention

ℹ️ For getting access to the Retention page under your Analyze tab, please contact your customer success
manager.
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Release Note - Cross Origin iFrame
support for Userlane Browser
Extension
Last Modified on 29.11.2023

16 November 2022

Some web applications use iFrames to render content from other sources. We call these "cross-origin
iFrames". 

What's New

We have improved the Userlane selector algorithm to support the selection of elements within a cross-origin
iFrame for both Snippet and Browser Extension implementations. 

To find out more about Cross-Origin iFrame support in Userlane, please check here. 

https://docs.userlane.com/docs/cross-origin-iframe-support-in-userlane


524

Release Note - Drag & Drop Steps
Last Modified on 29.11.2023

14 November 2022

What's new

Now you can drag and drop steps within a Guide in Editor. In case that you need to change the order of a Guide
or you just made a mistake now easily you can move the step and change the order.

Restructure a Guide fast and easily by moving steps via drag and drop.

How to do this: 

Start Editor > Open the editing mode of the Guide that you need to adjust > just start dragging and dropping
steps.

In case you do not have access to this functionality, please delete your browser cache. 
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Release Note - NPS
Last Modified on 29.11.2023

18 October 2022

What's New

NPS stands for Net Promoter Score, a metric used in customer experience. NPS measures the loyalty of your
users and how likely they are to recommend your application to other users.

Now you can measure your NPS with Userlane added to where your users are - inside your application.
Userlane now provides you with the tool to set up and automate your NPS and your users can choose a range
from 0-10. 

Check out this article to learn more about NPS and how to set up NPS with Userlane. As well as our best
practices article. 

https://docs.userlane.com/docs/nps
https://docs.userlane.com/docs/tips-on-how-to-set-up-nps
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Release Note - Understand your
Guides' performance with a new
metric: failure rate
Last Modified on 06.02.2024

21 December 2022

What's New

We have added a new metric that is called Failure rate and you will find it in your step details report for you to
prioritize better what needs to be fixed within your Guides.

 

In case you deal with multiple steps errors, we understand that it could be hard to prioritize what error to fix
first. We wanted to provide you with some valuable information metrics to assist you with prioritization and for
that reason, we created the failure rate metric. As well as, you can check per step how many users left the Guide
due to an error. 

� Failure rate: It's the percentage of users that leave a Guide because of an error, in ratio to all users that
started the Guide. 

https://docs.userlane.com/docs/guide-step-details
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Release Note - Tooltips Language
Translation
Last Modified on 12.01.2024

10 October 2022

What's New

Now you can translate your Tooltips' text by exporting and importing the global translation file (which can be
downloaded in CSV or XLSX format).

How to do this? 

You can translate your Tooltips' text in Userlane Portal: 

Sign into Portal > Customize > Languages > Press Export/Import Text > Select file export Format 

Then, add the Tooltip text in the file in the preferred language > Import the file back to Userlane using the
Export/Import Text functionality.
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Release Note - SharePoint
Integration
Last Modified on 12.01.2024

21 September 2022

What’s New

We have implemented our SharePoint integration, our latest offering to our integrations feature. Now your
users can access your SharePoint content directly from the Userlane Assistant.

Where to find it

You can access our Integrations page from the Userlane Portal by selecting  Account > Global Settings >
Integrations. See our SharePoint integration article to learn how to set it up. 

https://docs.userlane.com/docs/sharepoint-integration
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Release Note - global vs.
application roles
Last Modified on 12.01.2024

25 August 2022

What’s New

Now the admins have the option to assign moderators and contributors of the company to all applications or to
a number of applications. Therefore, moderators and contributors, if required, get access and edit rights only to
specific applications and not the whole company. 

 
Benefits:

Manage more applications within one company without running into permission issues across these
applications.
Assign the proper access to each application expert to avoid any potential risk.

ℹ️ Check out the User role article for further information. 

https://docs.userlane.com/docs/user-roles
https://docs.userlane.com/docs/user-roles
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Release Note - Manage languages
for Tooltips
Last Modified on 12.01.2024

19 August 2022

What's New

Now you can see the usage of Tooltips per language in your Portal.

How to check this?

To get an overview of how many Tooltips are published in a language:

Log in to Portal > Customize > Languages > check "your language" Report.
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Release Note - Use Pause in all
Record Modes
Last Modified on 26.09.2023

15 August 2022

What’s new

We are very excited to announce that our pause mode is now available for both record modes and Tooltips.
We have introduced a simpler pause mode experience for content creators. 

How to use

Now, if you need to pause during the recording of any Guide or Tooltip press the ALT key (or Option for Mac),
and the recording will pause. To leave the pause mode, press again the ALT key (or Option for Mac) to get
back to the record mode.
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Release Note - End User SSO:
Updating User Profiles
Last Modified on 12.01.2024

05 August 2022

What is New

This is an update for customers who have single sign-on enabled for their end users and user attributes
mapped between their active directory and Userlane. 

From now on those attributes and their values will automatically be synchronized on a fortnight basis.
Consequently, if an update happens to any of the attributes (or values) in the active directory, the change will
also be updated in the relevant user profiles in Userlane.

This will allow you to automatically allocate the matching user segments to your users, based on the latest
profile changes.

ℹ️ Keep in mind that this change could impact the existing attributes whenever users authenticate via SSO
the next time, especially if those attributes have changed from the last time they got updated.
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Release Note - Tooltip reposition
Last Modified on 12.01.2024

 20 June 2022

What's new?

We have listened to your feedback that you would like to choose where your tooltips sit. We have enabled the
option to adjust the position of your tooltips and place them in different 8 spots. 

Now you can:

Use the Auto option to let Userlane select the icon position for you, or select Manual to pick the icon
position yourself.
Manually select the icon position from eight positions, including four internal ones.

 

Try this out now!
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Release Note - Tooltips (Beta)
Last Modified on 12.01.2024

27 April 2022

What's new? 

Here we are with another great addition on how to create helpful content for your users. Here we are with
another great addition on how to create helpful content for your users. In addition to Guides and
Announcements, you now have the option to create a new content type called Tooltips.

What is it? 

Tooltips allow you to explain elements of the underlying application. Tooltips can be attached to any element
of the underline application. They provide descriptions or explanations for their paired element, without the
need to use other lengthy manuals or further documentation.

With tooltips, you can add additional information to an element such as a button or a form. You can support
your users whilst they are working, by informing them what happens next, what something means, or how
something works without disrupting the flow of using the underline app.

What does this mean? 

For users, this means there will be additional valuable info shown when hovering over the respective
element.

For you, we designed tooltips in a way that ensures they are easier and faster to create, with no code
required and creatable in a few clicks within the Editor 

What to expect? 

We are releasing Tooltips as a Beta to you, meaning we are still adding and tweaking functionality. Our aim is
to create the most valuable and enjoyable experience for you. Tooltips are fully functional and here to stay, and
there is more to come. Check out this article to learn how to create Tooltips. 

 

https://docs.userlane.com/docs/create-tooltips
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Release Note - New Editing
Experience
Last Modified on 08.12.2023

19 April 2022

What's new

We are very excited to be releasing a completely new editing experience for all our users, the week following
the Easter holidays.

The most visible change is that the Editor and content overview are now being displayed more intuitively along
the left-hand side of the screen, from where it can be moved to the right-hand side.

Benefits

The new engine will help with more speed on our development and faster and more intuitive content
creation for you (preview from step, updated recording button).

The new structure that displays the content overview vertically (left aligned) also means that you now
scroll down when working on a Guide with many steps. Also, this leads to higher scalability with new
content types and functionality to be released soon (e.g. tooltips)

Better navigation and organization (search bar, list view, segment info, language publishing info).

Additions

Small UI changes for a better user experience when it comes to organizing, searching for, and managing your
Guides. 

Search function: users will be able to find all existing Guides in an improved overview design.

Hamburger menu: Guides will be displayed within the familiar chapter structure where you can delete
and duplicate a Guide or jump straight to the Guide analytics within the Userlane Portal.

New list view: allows you to display all your Guides, regardless of chapter structure, in a list that can be
sorted by status, the date it was last updated, or the title.

Re-designed the record button: this will allow an easier recording and scanning of the content.

Code selector: has received technical enhancements, including an automated code check which will
ensure your custom code is correct and displayed as expected, plus the ability to reselect elements.

� Current Limitations (Browser Extension Users only):

Editing is currently not possible in Firefox via the Userlane browser extension. You may not be able to
create, preview, and modify new or existing Guides and Tooltips. Our teams are currently working to
resolve this issue.
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Workaround: Use another supported browser (e.g. Google Chrome) to edit content. 

What to expect? 

Upon beta tests, we have confirmed that the changes have greatly improved user experience and Guide
building processes. Thus, the new changes will be rolled out for all our users soon. Stay tuned!
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Release Note - UX improvements
within Guides
Last Modified on 12.01.2024

21 March 2022

What’s New

We have released the UX improvement to the step analytics to provide you with more insights into user
engagement and Guides' performance. 

The step details page will show the number of users that have reached each step in the Guide. Adding to the
existing metrics of how many times any step was shown, you will also see how many unique users saw any
step in the selected period or for the selected user segment.

New metrics added:

Users: Number of users that reached each step.
From previous steps: Value indicates how many times a step was shown following previous steps.
Back from next steps: Value indicates how many times a step was shown when users went to a
previous step.
Skips: Value indicates how many times an optional step was skipped.
Error exits: Guide exits due to occurring errors.

ℹ ️You will be able to check how many users reached or dropped off on a certain step. If many users drop
your Guide(s) then that’s a clear sign to review the content or reassess the complexity of your Guide(s).

Where is this located? 

These new metrics can be found within the step details section of the Guides’ performance analytics page.
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ℹ️ These changes are effective on all properties that are on the EU cluster setup. We are working now on
getting these changes to the US cluster as well.
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Release Note - Avatar Reposition
Last Modified on 29.11.2023

17 March 2022

What's new

Now end-users are able to move the Assistant avatar. 

Avatar Reposition lets your end-users move the Assistant avatar whenever it conflicts with your application’s
UI.

End-Users can hover over the Assistant avatar until their mouse pointer switches into a different crosshair
control. At that point, they can click-hold, then drag-and-drop the avatar from one of six different spots on the
screen to another.

Then, the avatar position will remain in the selected position until the user drags it into another one, or until
the feature is turned off for the property.

To enable this: 

Go to Portal > Customize > Assistant > ALLOW USERS TO REPOSITION AVATAR.
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Release note - Customize Help
image
Last Modified on 12.01.2024

21 January 2022

What's new

You can now customize the image in our Assistant Help feature. 

If you offer your users additional support with Userlane's Assistant Help feature, you can display a custom
image instead of the default Help image.

To change the Help image:

1. Go to Customize > Design in the Portal.
2. Locate Help Desk in the right sidebar.
3. Click Upload Image.
4. Drag an image file to the upload window or click Select File to choose an image from a storage folder. A

preview of the Help window display.
5. Click Save Your Changes.

ℹ️  You can upload a PNG, JPEG, or GIF file with a maximum size of 8MB. The recommended image
proportions are a 4:2 ratio and 652x320px resolution. See more about how Userlane renders your
images in our Working with images article.

If you haven't enabled a Help link for your users, why wait? Discover how you can easily support your users
directly from your application. 

https://docs.userlane.com/docs/working-with-images-in-userlane
https://docs.userlane.com/docs/userlane-assistant-help
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Release note - Dashboard
renaming
Last Modified on 29.11.2023

19 November 2021

Introducing the Userlane Portal

In line with our latest UX improvements, we have introduced a new name for the Userlane Dashboard. 

Why have we made this change?

We always strive to deliver an exceptional, user-friendly, and easy-to-navigate product for you! This change
was one way we could be better and we hope that you agree. �

What's changed?

You will now see Portal in place of Dashboard in:

Interactive Guides
Help Center articles
Blogs and Sales & Marketing material

What hasn't changed?

Userlane's Analytics remains your Analytics Dashboard and is still located under the Analyze tab of the Portal.

What's next?

In the coming weeks, we will implement 'Portal' throughout the Userlane experience, specifically:

Labels and headers in the browser
Labels in the Editor
Buttons and links that navigate to the Portal
References in tooltips
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Release note - KnowledgeOwl
integration
Last Modified on 29.11.2023

11 November 2021

What's new

KnowledgeOwl integration

We are happy to announce our latest knowledge base integration: KnowledgeOwl. Now your users can access
your KnowledgeOwl content directly from the Userlane Assistant.

Where to find it

You can access our Integrations page from the Userlane Portal by selecting Account > Global Settings >
Integrations. See our KnowledgeOwl integrations article to learn more.

See also

Search through the Userlane Assistant

https://docs.userlane.com/docs/knowledgeowl-integrations
https://docs.userlane.com/docs/search-through-the-userlane-assistant
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Release note - UX improvements
Last Modified on 29.11.2023

02 November 2021

UX improvements

We have released the following UX improvements to the Userlane Portal to make it easier for you to navigate
to relevant features and better distinguish company account settings from individual applications. 

An application drop-down menu has been introduced.
The Open Editor button is now located in the new application drop-down menu.

A Settings page has been introduced at the application level to organize those settings that were
previously located under Customize > General Settings and under My Account.

The text import/export feature has been moved to Customize > Languages.
The generate an API token feature has been moved to Account > Personal Profile > API token.
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Release note - Zendesk integration
Last Modified on 29.11.2023

05 October 2021

What's new

Zendesk integration

As promised, we have implemented our Zendesk integration, our latest offering to our integrations feature.
Now your users can access your Zendesk content directly from the Userlane Assistant.

Where to find it

You can access our Integrations page from the Userlane Portal by selecting  Account > Global Settings >
Integrations. See our Zendesk integrations article to learn more.

Related articles

Search through the Userlane Assistant

https://docs.userlane.com/docs/zendesk-integrations
https://docs.userlane.com/docs/search-through-the-userlane-assistant
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Release note - Integrations page
Last Modified on 29.11.2023

29 September 2021

What's new

Your Userlane solution can now be integrated with your organization's knowledge base or collaboration tool,
making its content more discoverable and easier to access. Simply set up the integration, then enable the
connection for the Search feature of the Userlane Assistant. 

Where to find it

We have introduced a new Integrations page to the Portal under Account > Global Settings:

ℹ️  If you have an existing Userlane account (activated prior to August 6, 2021), you first need to contact
your Userlane Customer Success Manager to enable your access to the integration feature.

Assistant search results for an enabled connection
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If you have not already enabled the Search feature for your users, you can learn more about its benefits in our
Search through the Userlane Assistant article. 

Supported platforms

Confluence (Since August 6, 2021)
Zendesk (coming soon)

Don't see your platform here? We are committed to supporting integrations with your favorite enterprise
systems. If you would like to see yours featured in our ambitious roadmap, let us know!

 

https://docs.userlane.com/docs/search-through-the-userlane-assistant
https://docs.userlane.com/docs/integrations-with-confluence
https://www.userlane.com/contact/
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Release note - error-alert
notifications
Last Modified on 29.11.2023

08 April 2021

What's New

Whenever an interactive guide breaks on a regular basis in a specific step, an alert is triggered within your
Portal. 

From April 8th on, you will receive an update on this similar to this one: 

https://downloads.intercomcdn.com/i/o/318843397/d4fda8c732b5a56cfd45b911/EmailSettings.png?expires=1620482400&signature=1d92f462b3a1215603a1ef0fada79565bedd6543c3f9cd95062452e1449f01da
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What is the benefit of having notifications?

It allows you to quickly review and update your guides to ensure your end-users can successfully complete a
guide. Email notifications are also the fastest way to keep you informed.

What does the email include?

The email includes information on

the account of the Guide

the chapter
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the Guide

the specific step number

How often will I receive this email? 

The error-alert notifications are sent only when one step experiences multiple errors based on the threshold
settings you have set up with your Customer Success Manager or our support team.

The threshold settings are based on the ‘x' number of errors that have occurred during a time span of ‘y’. 

For example: if your property’s threshold is set to 12 errors within 8 hours then the below email will be sent
to you every time a step within any guide faces 12 errors in the span of 8 hours. 

Good to know: 

You can change whether you want to receive such notifications or not within your Userlane Portal under
Account > Personal Profile > Notifications

If you want to have your threshold changed, please reach out to your Customer Success Manager or
our support team.

What action do I need to take after receiving the email?

We recommend that you go directly to your Dashboard and review the mentioned step from the email. In a
separate tab, you may also already open the Editor to easily update your Guide.

As errors can have various reasons, we have prepared an article on how to ensure your Guides work fine.

Should you not be able to fix the issue, do not hesitate to contact us.

https://family.userlane.com/support
https://docs.userlane.com/docs/alert-notification
https://family.userlane.com/support
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Release note - UX improvements
Last Modified on 29.11.2023

10 February 2021

What's new

UX improvements 

We have released the following UX improvements to the Userlane Portal to make it easier for you to navigate
to and better distinguish company account settings from personal user settings.

The My Account section has been renamed to Account.

It now contains a drop-down menu with a link to Global settings and the Personal profile of the user
that is currently logged in to the Portal, plus the option to sign out.

The Global settings page now contains:

Applications

Integrations

Team

Users

Attributes

Processes

The Personal profile page now contains (previously located in My Account > Profile):

Login

Notifications 

API Token

ℹ️ Visibility of the individual menu items might vary depending on user roles and feature activations for your
application.
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Release note - contrast and color
updates
Last Modified on 29.11.2023

Inclusive design for all users

We want everyone to be able to access our end-user solutions equally. Contrast and color are important in this
regard and we want to be inclusive and readable for all our users. 

Color accessibility enables people with visual impairments or color vision deficiencies to interact with digital
experiences in the same way as their non-visually-impaired counterparts.

So, as of November 24th we updated the contrast of elements within the assistant as well as within step boxes
of our interactive guides.

Therefore, we adjusted some of the element color intensity to reach this goal.

As an example on the left side you see what it looked like before and on the right side, the updated version:

In a nutshell what elements have been addressed with contrast changes remarkably?

Assistant navigation bar

Some text labels (mainly subtitles)

List icons

Announcement category color

Additionally - as colors are so important - we want you to be able to have your company colors represented all
over your Guide. 

So from now on your primary colors will be reflected in some outstanding elements as well, e.g. the border of
an element.

https://downloads.intercomcdn.com/i/o/267650191/ed17f99aac07c3ef87698683/Bildschirmfoto+2020-11-18+um+13.24.06.png
https://downloads.intercomcdn.com/i/o/267650593/e761dd5286670d86f56fe28b/Bildschirmfoto+2020-11-18+um+13.25.09.png
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In a nutshell what elements are connected to the primary color additionally?

Navigation bar icons

Chapter progress bar + chapter arrow

Back button

Guide CTA button

Announcement CTA button, primary and secondary links

Search icon, search result CTA buttons and external link graphics

Guide link box (only for the new react player

Announcement push navigation buttons

Assistant branding link



554

Release note - adjustment to slides
Last Modified on 29.11.2023

Every story has a beginning, a middle, and an end. We want to ensure that this is also reflected in your Guides.

From November 11th, 2020  you will be able to customize the button description appearing on your slides
individually from each other and from explanation steps. This button guides your users through your
interactive guide. 

Before all slides had a “Next Button” shared from the explanation step text label: 

With this new adjustment, you can customize the button description separately, for example:

Possible examples of an intro, explain step, and an outro slide

Do you want to make sure that you have all general texts set up?  ⇨ Start this Guide to learn how. 

If you have any questions (or feedback �), please reach out to us via our contact form.

https://downloads.intercomcdn.com/i/o/264809117/fad2a0e67c033795a1444022/Bildschirmfoto+2020-11-10+um+16.06.29.png
https://downloads.intercomcdn.com/i/o/264808837/a42dd13ab3074f26d0c7bb13/Bildschirmfoto+2020-11-10+um+16.05.54.png
https://go.userlane.com/31610/21106
https://family.userlane.com/support
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Release note - Search added to the
Assistant
Last Modified on 29.11.2023

The wait is over! You've seen it with your own eyes, tried it with your own hands, and now it's here for you. 

On the 19th of October, the new Search for the Userlane Assistant comes out for your users to enjoy! Do you
want to activate it right away? Click here! 

https://go.userlane.com/31610/48304
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Release note - new Assistant
navigation
Last Modified on 29.11.2023

Here you'll find a summary of the changes that come with the improved Userlane Assistant Navigation.

Thanks to this new navigation bar: 

Your users will be able to find your Announcements faster than ever: following your feedback we moved
the notification bell to a more prominent space. 

The famous red number will now reflect the number of unread Announcements, while uncompleted
Guides will be marked with a blue dot (see screenshot above). 

As soon as the Search function is released (yes we've been very busy lately!), your users will also be able
to search through your Userlane content thanks to the search tab. 

Isn't this exciting?! If you have any questions, please reach out to us via our contact form.

https://downloads.intercomcdn.com/i/o/247080399/e54ccf5d8c8307cd0cd26d18/userlane+navigation+bar.png
https://family.userlane.com/support
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